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Введение
В настоящее время существует множество графических редакторов и программ
геометрического моделирования. Компания Autodesk — один из ведущих произ-
водителей систем автоматизированного проектирования и программного обеспе-
чения для конструкторов, дизайнеров, архитекторов. Система AutoCAD, разрабо-
танная этой компанией, является лидирующей в мире платформой программного
обеспечения систем автоматизированного проектирования (САПР), предназначен-
ной для профессионалов, которым требуется воплощать свои творческие замыслы
в реальные динамические проекты. AutoCAD характеризуется, с одной стороны,
мощью и гибкостью, с другой — предельно четкой фокусировкой на максимальной
производительности. Кроме того, эту полностью расширяемую и адаптируемую
систему можно использовать в самых разных отраслях.

AutoCAD — программа с богатой и во многом уникальной историей. Впервые она
увидела свет в 1982 году под именем MicroCAD. Первая версия AutoCAD ознаме-
новала начало настоящей революции в автоматизированном проектировании. Се-
годня AutoCAD переводится на 18 языков мира, ее используют в своей работе мил-
лионы проектировщиков во всем мире на процессорах в тысячи раз мощнее тех,
которые были установлены на первых персональных компьютерах.

Настоящая книга посвящена новой версии универсальной графической системы
проектирования AutoCAD 2005, разработанной компанией Autodesk. Программа
получила широкое распространение в нашей стране и за рубежом и признается
стандартным средством автоматизации проектно-конструкторских работ. По срав-
нению с предыдущими версиями, система значительно переработана, в ней появи-
лись усовершенствования, которые помогают повысить производительность тру-
да и сэкономить время для творческой работы.

Новая версия AutoCAD усовершенствована в направлении документооборота.
Разработан новый Диспетчер наборов листов (Sheet Set Manager), призванный по-
мочь пользователям организовать размещение пакетов листов в зависимости от
типа чертежей и с возможностью эффективного создания, управления и совмест-
ного использования наборов логически связанных рисунков.
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В AutoCAD 2005 пересмотрен подход к работе с таблицами, что позволит сделать
управление данными более удобным, а создание крупноформатных таблиц — бо-
лее эффективным. Для этого разработано новое диалоговое окно Create Table, в
котором можно задать количество столбцов и строк, ввести данные о ширине и
высоте ячеек или же просто определить размеры таблицы. Таким образом, пользо-
ватели получают существенную экономию времени на создание и редактирование
таблиц, а также возможность производить обмен данных с другими приложениями.

В новой версии AutoCAD особое внимание уделено расширению возможностей
инструментальных палитр. Для использования в дальнейшей работе блоков,
штриховки, размеров пользователю достаточно перетащить их непосредственно из
текущего чертежа на палитры, не используя Центр управления, что позволяет
очень быстро создавать свои объектно-ориентированные библиотеки графических
элементов. Пользователю предоставляется возможность вызывать из палитры
практически все команды AutoCAD, включая те, что написаны на языке AutoLISP.
Организованные в группы палитры при желании теперь загружаются из контекст-
ного меню.

Впервые появилась долгожданная возможность автоматически формировать спе-
цификации сразу на листе AutoCAD 2005, для чего пользователю достаточно раз-
местить по чертежу метки-идентификаторы элементов. Информация с меток ав-
томатически считывается и передается в таблицы спецификации.

Дальнейшее развитие получил формат файлов .dwf (Design Web Format), позво-
ляющий просмотреть проектные файлы, сделать пометки и аннотации к каждому
чертежу, а затем распечатать или отправить их обратно проектировщику даже при
отсутствии инсталлированной системы AutoCAD. Для этих операций любому чле-
ну команды дизайнеров-проектировщиков достаточно наличие такого бесплатно-
го компонента, как Autodesk DWF Viewer.

Наряду с тем, что в AutoCAD 2005 закреплены все лучшие функциональные воз-
можности предыдущей версии, размеры файлов, по результатам тестирования,
уменьшены на 52 % и на 70 % повышена производительность программы.

Грамотный подход к проблеме автоматизации вовлекает конструктора в мир про-
ектирования без границ, предоставляя ему среду, работа в которой становится бо-
лее производительной и творческой.

Для удобства читателей и лучшего усвоения ими приемов работы в программе
в данной книге упоминается авторская тренинг-система по AutoCAD 2005. Все
упоминания выделяются так же, как данная врезка. Чтобы воспользоваться
тренинг-системой, нужно скачать с сайта Издательского дома «Питер» архив
с заданиями. Точный адрес страницы скачивания: http: //www.piter. com/
download/978546900630/ (объем архива — около 10Мбайт). Использование
тренинг-системы во многом определяет успех обучения, так что автор насто-
ятельно рекомендует своим читателям воспользоваться предоставленной воз-
можностью.



От издательства
Ваши замечания, предложения, вопросы отправляйте по адресу электронной поч-
ты shakhov@pi.ter .msk.ru (издательство «Питер», компьютерная редакция).

Мы будем рады узнать ваше мнение!

На web-сайте издательства http: / / w w w . piter. com вы найдете подробную ин-
формацию о наших книгах.
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Требования к системе

AutoCAD 2005 может работать как в автономном режиме, так и в локальной сети.
Для эффективной работы AutoCAD 2005 под управлением операционных систем
Windows необходимы следующие программные и аппаратные средства:

Q операционные системы: Microsoft Windows NT 4.0 SP 6a или выше, Microsoft
Windows 2000/XP Professional/XP Home Edition/XP Tablet PC Edition. Реко-
мендуется устанавливать и эксплуатировать AutoCAD либо в операционной
системе, локализованной на одном языке с программой, либо на англоязычной
версии одной из перечисленных систем;

G web-браузер: Microsoft Internet Explorer 6.0 и выше;

Q процессор: Pentium(r) III или выше, тактовая частота процессора минимум
800 МГц;

Q ОЗУ 256 Мбайт;

Q видеосистема: минимум 1024x768 VGA с цветовой палитрой True Color;

Q жесткий диск: свободное место — 300 Мбайт;

ГД манипулятор: мышь, трекбол или другой аналогичный;

Q привод CD-ROM: любой (только для установки программы);

Q необязательное оборудование: SD-видеоадаптер, совместимый с Open GL, прин-
тер или плоттер, дигитайзер, модем или устройство подключения к Internet че-
рез локальную сеть, сетевой адаптер.

Установка AutoCAD

Чтобы успешно установить AutoCAD, понадобится выполнить несколько подго-
товительных шагов.

Для подготовки к установке следует:

Q выяснить серийный номер — он должен быть напечатан на упаковке AutoCAD
2005. В случае обновления одной из прежних версий AutoCAD требуется исполь-
зовать серийный номер предыдущей версии. Его можно либо найти на соответ-
ствующей упаковке, либо узнать, выбрав из меню AutoCAD пункты Help t About;

Q воспользоваться правами администратора локального компьютера, на который
будет установлен AutoCAD. Иметь права администратора домена при этом не-
обязательно;

Q закрыть все работающие приложения;

Q отключить средства антивирусной защиты.

Установка AutoCAD выполняется с помощью специальной программы-инсталля-
тора, которая переписывает файлы с компакт-диска в папку, созданную на жест-
ком диске компьютера. В ходе установки AutoCAD автоматически настраивается
на работу с системным устройством указания и WH IP-драйвером монитора.
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Запуск системы AutoCAD

Запуск AutoCAD осуществляется следующими способами:

Q на панели задач выберите из меню Start пункт Programs, а в нем — подпункты
Autodesk > AutoCAD 2005;

Q на Рабочем столе Windows дважды щелкните по пиктограмме AutoCAD 2005.

При запуске AutoCAD создается новый неименованный рисунок. Можно либо начать
создавать в нем объекты, либо загрузить с диска один из уже имеющихся файлов.

При открытии ранее подготовленного имеющегося рисунка всем системным перемен-
ным присваиваются значения, которые они имели в ходе последнего сеанса рабо-
ты с ним. Это происходит благодаря тому, что переменные сохраняются в файле
вместе с рисунком. Если же вы начинаете работу «с нуля», следует предваритель-
но задать ряд установок. Обычно это делается автоматически с помощью програм-
мы мастера подготовки Wizard Description. AutoCAD позволяет менять установ-
ки и в ходе сеанса, если возникает такая необходимость.

В зависимости от установок после задуска AutoCAD выводится диалоговое окно
начала работы Startup (рис. 1.1).

И Startup

I

Рис. 1.1. Диалоговое окно начала работы

В диалоговом окне Startup пользователю предлагается четыре кнопки:

Open a Drawing для открытия ранее созданного чертежа. Позволяет выбрать из
списка один из пяти рисунков, открывавшихся самыми последними, и загру-
зить его в AutoCAD. Чтобы загрузить файл, отсутствующий в списке, следует
нажать кнопку обзора Browse...;

Start from Scratch для создания чертежа, где устанавливаются только единицы
измерения в области Default Settings — британские (футы и дюймы) или мет-
рические (миллиметры):
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• Imperial (feet and inches) — создание нового рисунка, использующего бри-
танскую систему единиц измерения по шаблону acad.dwt. При этом область
рисования, называемая еще лимитами рисунка, устанавливается равной
12x9 дюймов;

• Metric — создание нового рисунка, использующего метрическую систему еди-
ниц измерения по шаблону acadiso.dwt. При этом область рисования уста-
навливается равной 429x297 мм;

Я Use a Template для создания чертежа по шаблону — документу, установки кото-
; рого используются как основа для нового рисунка. В области Select a Template:

выбирается шаблон, содержащий необходимые установки черчения. В списке
перечисляются имена файлов шаблонов с расширением .dwt, которые найде-
ны по стандартному пути, заданному в диалоговом окне настройки Options.
В шаблонах определяются различные параметры рисунка, в том числе наборы
специально созданных слоев, типов линий и видов;

i\S Use a Wizard для установки параметров нового чертежа. В области Select a Wizard:
предлагается два режима автоматической настройки рабочей среды AutoCAD -
Advanced Setup и Quick Setup.

Диалоговое окно детальной подготовки Advanced Setup, показанное на рис. 1.2, по-
зволяет выполнить полную установку параметров рабочей среды AutoCAD: назна-
чить единицы измерения длины Units и угла Angle, задать начало отсчета угла Angle
Measure и направление его измерения Angle Direction, определить границы области
рисунка Area.

Рио. 1.2. Диалоговое окно детальной подготовки

Диалоговое окно быстрой подготовки Quick Setup, представленное на рис. 1.3,
позволяет выполнить быструю установку параметров рабочей среды AutoCAD:
выбрать единицы измерения длины Units и определить границы области черчения
Area.
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ширм

Рис. 1.3. Диалоговое окно быстрой подготовки

Диалоговое окно начала работы Startup вызывается при каждой загрузке сеанса
AutoCAD только один раз. В дальнейшем для создания рисунков в уже запущен-
ном сеансе AutoCAD открывается диалоговое окно создания нового рисунка Create
New Drawing.

Чтобы отключить или, наоборот, обеспечить вывод на экран диалогового окна
Startup, следует поставить соответствующий флажок в диалоговом окне Options.

Подробнее о шаблоне

Установленный набор параметров сеанса можно сделать доступным и для рисунков,
создаваемых впоследствии. Для этого следует сохранить документ как шаблон.
Шаблон обычно представляет собой рисунок, не содержащий никаких графиче-
ских объектов и используемый только для хранения стандартных значений систем-
ных переменных.

Шаблоны (файлы с расширением .dwt) — весьма удобное средство создания на-
бора рисунков с однотипными настройками. Можно использовать как шаблоны,
поставляемые с AutoCAD, так и созданные пользователем. Любой имеющийся
рисунок можно сохранить в качестве шаблона. В этом случае значения всех пара-
метров настройки сохраняемого документа будут наследоваться всеми создава-
емыми на его основе новыми рисунками.

Хотя в качестве шаблона подойдет любой рисунок, лучше всего подготовить на-
бор стандартных шаблонов, где представлены чаще всего используемые установ-
ки и базовые элементы:

Q тип и точность представления единиц;

Q лимиты рисунка;

Q настройки режимов шага SNAP, сетки GRID и ORTHO;
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Q организация слоев;

Q основные надписи, рамки и логотипы;

Q размерные и текстовые стили;

Q типы и веса (толщины) линий.

Никакие изменения, вносимые в рисунок, созданный на основе шаблона, на сам
шаблон не распространяются.

Вызов справочной системы
• Щ* В любой момент работы с AutoCAD вы можете получить доступ к электронной

документации по программе. Для этого необходимо выбрать в падающем меню
пункт Help. Альтернативный вариант — нажать клавишу F1 на функциональ-
ной клавиатуре, ввести символ ? в командной строке или щелкнуть мышью по
пиктограмме со значком вопроса на стандартной панели инструментов.

Пользовательский интерфейс AutoCAD
При первом запуске Рабочий стол AutoCAD настроен по умолчанию (рис. 1.4).

П AutoCAD 2005

tte t" Jision

'

Press ESC ar "xiti.~-.er
.oppositft;

Ш _'~~*1 ...1..1, • • : I ;..: 1 1 ,...' , ^Д

Рис. 1.4. Рабочий стол AutoCAD



16 * Глава 1. AutoCAD 2005. Общие сведения

В Рабочий стол AutoCAD для Windows включены:

Q падающие меню — верхняя строка непосредственно под заголовком окна про-
граммы;

Q необязательные панели инструментов:

• Standard и Styles — вторая строка от заголовка;

• Layers и Properties — третья строка;

• Draw и Modify — например, столбцы слева и справа;

О строка состояния — строка внизу окна программы;

О окно командных строк — выше строки состояния;

Q необязательное экранное меню — столбец справа;

О графическое поле, занимающее остальную часть Рабочего стола.

Падающие меню
Строка падающих меню может быть изменена путем добавления либо удаления
тех или иных пунктов. Для этого необходимо выбрать в падающем меню пункты
Tools > Customize > Menus..., в появившемся диалоговом окне Menu Customization пе-
рейти на вкладку Menu Bar и отметить требуемые пункты.

Загрузка другого меню AutoCAD производится либо в том же диалоговом окне
Menu Customization, на вкладке Menu Groups, либо с помощью команды MENU, введен-
ной в командной строке.

Строка падающих меню по умолчанию содержит следующие пункты:

Q File — команды работы с файлами: создание, открытие, сохранение, печать, экс-
порт файлов в другие форматы и пр.;

Q Edit — инструменты для редактирования частей графического поля Рабочего
стола программы, работы с буфером обмена;

fJ View — команды управления экраном, панорамирования, установки точки зре-
ния, удаления невидимых линий, закраски, тонирования, управления парамет-
рами дисплея; установка необходимых панелей инструментов;

Q Insert — команды вставки блоков, внешних объектов, объектов других прило-
жений;

rj Format — команды работы со слоями, цветом, типами линий; управления стилем
текста, размеров, видом маркера точки, стилем мультилинии; установки еди-
ниц измерения, границ чертежа;

Q Tools — средства управления системой, экраном пользователя; установки пара-
метров черчения и привязок с помощью диалоговых окон; работы с пользова-
тельской системой координат;

Q Draw — команды рисования;
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Q Dimension — команды простановки размеров и управления параметрами размеров;

Q Modify — команды редактирования элементов чертежа;

Q Window — многооконный режим работы с чертежами;

U Help — вывод на экран системы гипертекстовых подсказок.

Панели инструментов
Команды AutoCAD на панелях инструментов представлены в виде пиктограмм.
Если задержать указатель мыши на пиктограмме, рядом с ней появляется назва-
ние соответствующей команды, помещенное в маленький прямоугольник.

Если в правом нижнем углу пиктограммы изображен маленький черный треуголь-
ник, это значит, что она содержит подменю с набором родственных команд. Для
вызова подменю необходимо на некоторое время задержать на пиктограмме ука-
затель мыши, нажав ее левую кнопку.

Панели инструментов могут быть плавающими (float) или закрепленными (dock),
с фиксированным местоположением. Допускаются изменения размеров плава-
ющих панелей, а также их перемещение по графическому полю (рис. 1.5). Плава-
ющую панель можно сделать закрепленной, перетащив ее мышью за пределы гра-
фического поля. И наоборот, как только закрепленная панель попадает в область
графического поля, она превращается в плавающую.

Рис. 1.5. Плавающая панель инструментов

При первой загрузке AutoCAD на экране присутствует шесть панелей инстру-
ментов:

Q стандартная — Standard, панель стилей — Styles;

О панель слоев — Layers, панель свойств — Properties;

О панели рисования — Draw и редактирования — Modify.

Вывести на Рабочий стол требуемую панель инструментов можно, указав ее имя
на вкладке Toolbars диалогового окна Customize (рис. 1.6). Это диалоговое окно за-
гружается из падающего меню View > Toolbars..., или Tools > Customize > Toolbars...,
или из пункта Customize... контекстного меню, выводимого на экран нажатием пра-
вой кнопки мыши в фоновой области панелей инструментов (рис. 1.7).

Удобно выбирать имя требующейся панели инструментов из списка контекстно-
го меню (рис. 1.8), которое появляется при нажатии правой кнопки мыши, если ее
указатель находится на любой пиктограмме панелей инструментов. Если же ука-
затель мыши находится в фоновой области панелей инструментов, то список
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панелей инструментов можно получить после выбора пункта ACAD контекстного
меню, показанного на рис. 1.7.
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Рис. 1.6. Диалоговое окно выбора панелей инструментов

ц >

Си-.' :

Рис. 1.7. Контекстное меню выбора
панелей инструментов

Рис. 1.8. Список панелей инструментов

Для удаления панели инструментов необходимо сделать ее плавающей, если она
закреплена, и щелкнуть по кнопке закрытия, расположенной в правом верхнем
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углу заголовка панели. Другой вариант — отключить ее отображение на вкладке
Toolbars диалогового окна Customize или в соответствующем контекстном меню.

Стандартная панель инструментов

Стандартная панель Standard показана на рис. 1.9. Она содержит следующие ин-
струменты:

Рис. 1.9. Стандартная панель инструментов
,

Щ QNew — создание нового файла рисунка;

|Ц Open (Ctrl+0) — загрузка существующего файла;

Д Save (Ctrl+S) — сохранение текущего файла;

Щ Plot (Ctrl+P) — вывод рисунка на плоттер, принтер или в файл;

Щ Print Preview — предварительный просмотр чертежа перед выводом на печать,
позволяющий увидеть размещение чертежа на листе бумаги;

Щ Publish — публикация листов рисунка в формате .dwf;

; j| Cut to Clipboard (Ctrl+X) — копирование объектов в буфер обмена с удалением их
из рисунка;

|Ц Copy to Clipboard (Ctrl+C) — копирование выбранных элементов чертежа в буфер
Windows без удаления их из исходного документа;

ЩИ Paste from Clipboard (Ctrl+V) — вставка данных из буфера Windows;

Л Match Properties — копирование свойств заданного объекта другому объекту;

|HP|Urido — отмена последнего действия;

ЦЦ Redo — восстановление только что отмененного действия;

fjp Pan Realtime — перемещение изображения на текущем видовом экране в режи-
ме реального времени;

Щ Zoom Realtime — увеличение или уменьшение видимого размера объектов на
текущем видовом экране в режиме реального времени;

||р Подменю ZoomWindow — раскрывающийся набор инструментов, в котором
можно задать различные способы увеличения и уменьшения видимого разме-
ра объектов на текущем видовом экране;
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|Ц Zoom Previous — возврат к показу предыдущего вида;

•If Properties (Ctrl+1) — загрузка палитры управления свойствами объектов;

Щ: DesignCenter (Ctrl+2) — диалоговый интерфейс, позволяющий быстро находить,
просматривать, вызывать, переносить в текущий рисунок ранее созданные
рисунки, управлять вхождениями блоков, внешними ссылками и другими эле-
ментами рисунков, такими как слои, листы и текстовые стили;

Щ Tool Palettes (Ctrl+3) — отдельные вкладки в специальном окне, которые слу-
жат эффективным средством хранения/вставки блоков и штриховки. Палит-
ры могут содержать инструменты, предоставленные сторонними разработчи-
ками;

•Щ Sheet Set Manager (Ctrl+4) — диспетчер наборов листов, позволяющий организо-
вать размещение пакетов листов в зависимости от типа чертежей и с возмож-
ностью эффективного создания, управления и совместного использования
наборов логически связанных рисунков;

Щ M a r k u p Set Manager (Ctrl+7) — диспетчер, позволяющий организовать работу
с рисунками формата .dwf;

Щ Help — вызов справочной системы.

Панель слоев
Панель слоев Layers, показанная на рис. 1.10, чаще всего размещается на Рабочем
столе и обеспечивает работу со слоями. В нее входят следующие инструменты:

Рис. 1.10. Панель слоев

Щ Layer Properties Manager — вызов диалогового окна установки параметров слоев
Layer Properties Manager;

Г»'Щг -•!»«(' ЗЕЕШЯС. ' :Аill Filter applied — раскрывающийся список управле-
ния слоями. Каждая строка содержит пиктограммы управления свойствами
слоя или отображения его свойств, а также его имя. Ниже перечисляются на-
значения пиктограмм (слева направо):

• Turn a layer On or Off — включение/отключение слоя;

• Freeze or thaw in ALL viewports — замораживание/размораживание на всех ви-
довых экранах;

• Freeze or thaw in current viewport — замораживание/размораживание на те-
кущем видовом экране;

• Lock or Unlock a layer — блокирование/разблокирование слоя;
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• Color of layer — цвет слоя;

• Имя слоя;

Make Object's Layer Current — установка текущего слоя в соответствии со слоем
выбранного примитива;

Layer Previous — возврл i к предыдущему состоянию слоев.

Панель свойств объектов

Панель свойств объектов Properties, показанная на рис. 1.11, предназначена для
работы с цветом, типом и весом линий.

Рис. 1.11. Панель свойств объектов

В нее входят следующие инструменты:

Control — раскрывающийся список установки текущего цве-
та, а также изменения цвета выбранных объектов;

|'__-i. i| Linetype Control — раскрывающийся список установки текущего
типа линии, а также изменения типа линии для выбранных объектов;

шят ' | Lineweight Control — раскрывающийся список установки текущего веса
(толщины) линии, а также изменения толщины линий выбранных объектов;

Plot Styles Control — раскрывающийся список установки стилей печа-
ти. Здесь можно изменять внешний вид вычерчиваемого на плоттере рисунка.
В стилях печати при необходимости переопределяются цвета, типы и веса
(толщины) линий объектов. Кроме этого, имеется возможность указывать ис-
пользуемые при печати стили концов линий, соединений и заполнений, а так-
же различные выходные эффекты — размывание, оттенки серого, присвоения
перьев и интенсивность. Манипулируя стилями печати, можно получить на
бумаге различные варианты одного и того же рисунка. Допускается примене-
ние стилей печати к объектам или слоям.

Строка состояния

Строка состояния расположена в нижней части Рабочего стола. Она содержит те-
кущие координаты курсора, а также кнопки включения/выключения режимов
черчения (рис. 1.12):

Q SNAP — Snap Mode, включение и выключение шаговой привязки курсора;

Q GRID — Grid Display, включение и выключение отображения сетки;

Q ORTHO — Ortho Mode, включение и выключение ортогонального режима;
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POLAR — Polar Tracking, включение и выключение режима полярного отслеживания;

OSNAP — Object Snap, включение и выключение режимов объектной привязки;

OTRACK — Object Snap Tracking, включение и выключение режима отслеживания
при объектной привязке;

LWT — Show/Hide Lineweight, включение и выключение режима отображения
линий в соответствии с весами (толщинами);

M O D E L / P A P E R — Model or Paper space, переключение из пространства модели
в пространство листа.

Рис. 1.12. Строка состояния

Окно командных строк
Окно командных строк обычно расположено над строкой состояния; оно служит
для ввода команд и вывода подсказок и сообщений AutoCAD. Размеры окна, а сле-
довательно, и количество выводимых строк протокола можно изменять. При на-
личии в окне команд более одной строки перемещение по строкам осуществляет-
ся с помощью полосы прокрутки.

По умолчанию окно команд закреплено и равно по ширине окну AutoCAD (рис. 1.13).
Если текстовая строка не помещается в окне, ее полное содержимое выводится в рам-
ке вблизи командной строки.

Рис. 1.13. Закрепленное окно командных строк

Изменить высоту окна можно с помощью разделительной полосы, находящейся
в его верхней части (если оно закреплено внизу) или в нижней (если оно закреп-
лено вверху). Чтобы изменить размер, следует захватить разделительную полосу
мышью и отбуксировать ее до требуемой высоты.

Окно может быть как закрепленным, так и плавающим. Закрепление отменяется
путем выбора рамки окна в любом месте и последующей буксировки за пределы
зоны закрепления до тех пор, пока граница окна не примет вид широкой контур-
ной линии. Если отпустить окно в этот момент, оно станет плавающим и приобре-
тет размер, который имело до закрепления. Плавающее окно может быть переме-
щено в любую позицию экрана; при этом пользователю разрешено изменять его
ширину и высоту (рис. 1.14).

Закрепляется окно команд путем буксировки к верхней или нижней зоне закрепле-
ния окна AutoCAD. В окне командных строк можно прокручивать текст, выполнять
его редактирование и повторно вводить команды. Для этого используются стан-
дартные клавиши: <—, Т, —», 1, Insert, Delete, Home, End, Page Up, Page Down, Backspace.
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Рис. 1.14. Плавающее окно командных строк

При повторении ранее введенных команд удобно воспользоваться комбинацией
клавиш Ctri+C, чтобы копировать выделенный текст в буфер обмена, и Ctrl+V — что-
бы вставить содержимое буфера в текстовое окно или окно команд.

При щелчке правой кнопкой мыши в области окна командных строк или тексто-
вого окна AutoCAD вызывает контекстное меню, куда входят шесть последних ис-
пользованных команд, функции копирования выделенного текста или всего про-
токола команд, вставки текста, а также вызова диалогового окна Options.

Текстовое окно
Просмотреть большую часть протокола команд — так называемую историю ко-
манд (command history) можно, переключившись в текстовое окно, показанное на
рис. 1.15. Оно вызывается нажатием функциональной гславиши F2 или по команде
TEXTSCR из падающего меню View > Display > Text Window F2.

Specify next-poim v'Und
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Рио. 1.15. Текстовое окно

Текстовое окно подобно окну команд: в нем также можно вводить команды, на-
блюдать подсказки и сообщения, выдаваемые AutoCAD. .

Для перемещения по окну используются полоса прокрутки или клавиши«—, Т, —»,
4-, Page Up и пр.

Содержимое текстового окна предназначено только для чтения и не подлежит из-
менению. Но протокол команд можно копировать для последующей вставки в ко-
мандную строку или текстовый редактор.



24 * Глава 1. AutoCAD 2005. Общие сведения

Экранное меню
В AutoCAD 2005 сохраняется возможность отображения экранного меню. Его вклю-
чение и отключение выполняются на вкладке Display диалогового окна Options, за-
гружаемого из падающего меню Tools > Options.... Достаточно поставить или снять
флажок Display screen menu в области Window Elements.

«
Экранное меню AutoCAD имеет иерархическую структуру. Используя переходы
в различные подменю, можно передвигаться по дереву меню. Для перехода к кор-
ню дерева служит верхняя строка экранного меню, где всегда находится слово
AutoCAD.

Выполните упражнение N1 из раздела 1.

Установить экранное меню N1

Options
Падающее меню

Tools—•- Options...—•- Display
В диалоговом окне Options о области
Window Elements поднять флажок

Display screen menu
Щелкнуть по кнопке Apply — OK
В пробой части рабочего стола AutoCAD
появится панель экранного меню

Функциональные клавиши
Для удобной работы с системой сохраняется возможность использования функ-
циональных клавиш:

Q F1 — вызов справочной системы AutoCAD;

Q F2 — переключение между текстовым и графическим окнами;

Q F3 или Ctrl+F — включение/отключение текущих режимов объектной привязки
OS NAP;

Q F4 — переключение системной переменной TABMODE;

Q F5 или Ctrl+E — циклическое переключение изометрических плоскостей;

Q F6 или Ctrl+D — включение/отключение отображения текущих координат кур-
сора в строке состояния;

Q F7 или Ctrl+G — включение/отключение отображения сетки GRID;

Q F8 или Ctrl+L — включение/отключение ортогонального режима ORTHO;

d F9 или Ctrl+B — включение/отключение шаговой привязки SNAP;

Q F10 — включение/отключение режима полярного отслеживания POLAR;



Пользовательский интерфейс AutoCAD .;. 25

Q Fll — включение/отключение режима объектного отслеживания OTRACK;

Q Esc или Ctrl+[, Ctrl+\ — прерывание текущей операции;

Q Enter, Ctrl+M или Ctrl+J — повторение последней команды;

О Ctrl+A — включение и отключение выбора группы объектов;

Q Ctrl+C — копирование объектов в буфер обмена Windows;

Q Ctrl+N — открытие диалогового окна создания нового рисунка Create New Drawing;

Q Ctrl+0 — открытие диалогового окна выбора ранее созданного чертежа Select Fi le;

Q Ctrl+P — открытие диалогового окна вывода чертежа на печать Plot — Model;

Q Ctrl+R — смена видового журнала;

О Ctrl+S — сохранение текущего рисунка;

О Ctrl+V — вставка объектов из буфера обмена данных в текущий чертеж;

О Ctrl+X — удаление выбранных объектов из чертежа и копирование их в буфер
обмена данными;

Q Ctrl+Y — восстановление только что отмененного действия;

Q Ctrl+Z — отмена последней команды.

Контекстное меню
Для выбора пунктов меню и команд на панели инструментов часто используется
устройство указания — мышь. При работе с мышью нажатие левой кнопки обыч-
но обеспечивает выбор и указание точки на экране; щелчок правой кнопкой мыши
вызывает контекстное меню (см. рис. 1.7,1.8,1.16). Форма и содержание меню за-
висят от положения указателя мыши и состояния задачи: например, обеспечива-
ется быстрый доступ к опциям, необходимым для текущей команды.

1

!«>:!..•
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Рис. 1.16. Пример контекстного меню

При щелчке правой кнопкой мыши в области рисования вызывается одно из шести
контекстных меню:

Q стандартное — содержит набор стандартных функций, предназначенных,
в частности, для работы с буфером обмена, зумирования, панорамирования.
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Чтобы вызвать это меню, необходимо отменить выбор объектов, завершить те-
кущую активную команду и щелкнуть правой кнопкой мыши;

Q редактирование — объединяет функции, предназначенные для редактирования
объектов. Набор функций может изменяться в зависимости от типа выбранного
объекта. Чтобы вызвать меню, необходимо выбрать один или несколько объек-
тов, завершить текущую активную команду и щелкнуть правой кнопкой мыши;

Q команда — содержит набор функций, облегчающих выполнение команд с помо-
щью мыши. Сюда также включаются опции текущей команды, отображаемые
в командной строке. Для вызова данного меню необходимо при выполнении
какой-либо команды щелкнуть правой кнопкой мыши;

Q объектная привязка — позволяет выбрать или настроить режимы объектной
привязки, включить координатный фильтр. Для вызова меню следует щелк-
нуть правой кнопкой мыши, удерживая нажатой клавишу Shift;

Q ручки — содержит функции, позволяющие проводить редактирование с по-
мощью ручек. Для вызова меню необходимо выделить на объекте ручки и щел-
кнуть правой кнопкой мыши;

Q OLE — объединяет функции, позволяющие редактировать OLE-объекты. Для
вызова меню необходимо щелкнуть правой кнопкой мыши по вставленному в ри-
сунок OLE-объекту.

Контекстные меню объектная привязка, ручки и OLE всегда включены', а потому
их можно вызывать в любой момент. Контекстные же меню стандартное, редак-
тирование и команда можно отключить. В этом случае щелчок правой кнопкой
мыши будет соответствовать нажатию клавиши Enter. По умолчанию вызов этих
трех контекстных меню включен.

Для других элементов окна AutoCAD, кроме области рисования, можно вызывать
следующие контекстные меню:

Q панель инструментов. Для включения/отключения какой-либо панели или для
настройки панелей необходимо щелкнуть по любой из них правой кнопкой
мыши. Для отображения списка групп панелей следует щелкнуть правой кноп-
кой мыши по свободной области правее стандартной панели инструментов;

О командная строка. Для выбора одной из шести команд, выполнявшихся послед-
ними, или для вызова некоторых функций, используемых при работе с команд-
ной строкой, необходимо щелкнуть правой кнопкой мыши по командной стро-
ке или в окне команд;

Q диалоговое окно (это меню доступно не для всех диалоговых окон). Как прави-
ло, контекстные меню связаны либо с раскрывающимися списками, либо с по-
лями для ввода значений и позволяют удалять, переименовывать отдельные
пункты списка или работать с буфером обмена. Контекстные меню могут быть
связаны и с некоторыми другими элементами окон. Для вызова меню следует
щелкнуть правой кнопкой мыши по элементу диалогового окна;

О строка состояния. Для переключения режима рисования или изменения на-
строек необходимо щелкнуть правой кнопкой мыши по области строки, где
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выводятся текущие координаты, либо по любой кнопке переключения режима
рисования или изменения настроек;

О вкладки Model/Layout. Для вызова окон печати и настройки параметров стра-
ницы, а также управления листами следует щелкнуть правой кнопкой мыши по
вкладке Model или одной из вкладок Layout.

Настройка рабочей среды AutoCAD
Пользователь имеет возможность изменять различные параметры рабочей среды
AutoCAD, влияющие на конфигурацию интерфейса и условия рисования. Такие
настройки называются профилем. Различные пользователи, входящие в систему
под одним именем, могут загружать свои настройки из различных профилей. Це-
лесообразно использование профилей для сохранения настроек, присущих раз-
личным проектам.

Процедура настройки рабочей среды AutoCAD осуществляется в диалоговом окне
Options, которое вызывается из падающего меню Tools > Options... или из контекст-
ного меню при условии, что нет выполняющихся команд или выбранных объек-
тов. Диалоговое окно Options содержит 9 вкладок, описанных ниже.

Определение доступа к файлам поддержки
На вкладке Files диалогового окна Options, показанной на рис. 1.17, задаются пути
доступа к файлам поддержки, где хранятся шрифты, шаблоны рисунков, типы ли-
ний и образцы штриховок, используемые AutoCAD. Здесь перечисляются все пути
доступа к папкам, которые должны существовать в текущей структуре папок ло-
кального и подключенных сетевых дисков.

В области Search paths, file names, and file locations: содержатся тематические заго-
ловки путей доступа к файлам и папкам:

Q Support file Search paths — путь доступа к вспомогательным файлам;

Q Working Support file Search paths — путь поиска рабочих файлов поддержки, спе-
цифичных для системы пользователя;

Q Device Driver File Search Path — путь доступа к драйверам устройств;

Q Project File Search Path — путь доступа к файлам проектов;

Q Menu, Help, and Miscellaneous File Names — имена файлов меню, справочной систе-
мы и др.;

Q Text Editor, Dictionary, and Font File Names — имена файлов текстового редактора,
словаря и шрифтов;

d Print File, Spooler, and Prolog Section Names — имена файла печати, программы фо-
новой печати и раздела пролога;

О Printer Support File Path — путь к вспомогательным файлам поддержки печати;

О Automatic Save File Location — папка для файла автосохранения;
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Рис. 1.17. Диалоговое окно определения доступа к файлам поддержки

О Color Book Location — папки для альбомов цветов;

Q Data Sources Location — положение источников данных;

Q Template Settings — параметры шаблона рисунка;

Q Tool Palettes File Location — папки с файлами инструментальных палитр;

Q Log File Location — расположение файла журнала;

D Plot and Publish Log File Location — печать и публикация файла журнала;

Q Temporary Drawing File Location — папка для временных файлов;

Q Temporary External Reference File Location — папка для временных файлов внешних
ссылок;

Q Texture Maps Search Path — папка для поиска текстур;

Q i-drop Associated File Location — папка для связанных файлов точек загрузки.

Настройка параметров рабочего экрана
На вкладке Display диалогового окна Options, показанной на рис. 1.18, можно осу-
ществлять настройку параметров рабочего экрана AutoCAD:

Q в области элементов окна Window Elements:

• включаются/отключаются полосы прокрутки и экранное меню с гюмощыо
параметров Display scroll bars in drawing window и Display screen menu соответ-
ственно;
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Рис. 1.18. Диалоговое окно настройки параметров рабочего экрана

• изменяется цвет фона графической области и текстового окна, графического
курсора, текста в графической области и в области текстового окна при помо-
щи кнопки Colors.... Изменение цвета выполняется в диалоговом окне Color Opti-
ons (рис. 1.19). Достаточно указать объект изменения в списке Window Element:
и цвет в области Color:. Для возврата к параметрам, определенным в управ-
ляющей панели Windows, следует выбрать Default All или Default one element;

Рис. 1.19. Диалоговое окно изменения цвета элементов Рабочего стола

• изменяются шрифты, используемые в текстовом окне, при помощи кнопки
Fonts..., нажатие которой вызывает диалоговое окно C o m m a n d Line Window



30 •:• Глава 1. AutoCAD 2005. Общие сведения

Font (рис. 1.20). В этом диалоговом окне устанавливаются шрифт, стиль
шрифта и размер в областях Font:, Font Style: и Size: соответственно;

МИЙ*1Шi i • i . iii | I

Рис. 1.20. Диалоговое окно изменения шрифтов

Q в области Layout elements назначается отображение вкладок листа Layout и мо-
дели Model, поля листа, заданный формат, тень вокруг границ, вывод окна пара-
метров для новых листов и создание видовых экранов на новых листах;

Q в области Crosshair size устанавливается размер перекрестья в процентах от раз-
мера экрана;

Q в области экранного разрешения Display resolution определяются плавность дуг
и окружностей, число сегментов в дугах полилиний, плавность тонированных
объектов, число образующих в поверхностях;

О в области Display performance настраиваются параметры отображения объектов:

• Pan and zoom with raster & OLE — управляет динамическим отображением в ре-
альном времени растровых изображений. Текущее значение параметра хра-
нится в системной переменной RTDISPLAY;

• Highlight raster image frame only — управляет подсветкой растровых изображе-
ний при их выборе. Текущее значение параметра хранится в системной пе-
ременной IMAGEHLT;

• Apply solid fill — управляет закраской плоских фигур и полилиний ненуле-
вой ширины. Текущее значение параметра хранится в системной перемен-
ной FILLMODE;

• Show text boundary frame only — управляет отображением текста на экране.
Текущее значение параметра хранится в системной переменной QTEXTMODE;

• Show silhouettes in wireframe — управляет отображением контура трехмерно-
го объекта. Текущее значение параметра хранится в системной переменной
DISPSILH.

Выполните упражнение N2 из раздела 1.
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Установить цвет рабочего поля

Options

Падающее меню

Tools—•- Options... Display

В диалоговом окне Options о области
Window Elements щелкнуть по кнопке Color

6 диалоговом окне Color Options
быдрать из раскрывающегося списка Color:
цдет рабочего поля чертежа

Предлагаемые упражнения рекомендуется
выполнять на черном фоне

Настройка параметров открытия и сохранения файлов
Вкладка Open and Save диалогового окна Options, показанная на рис. 1.21, позволяет:

Q в области File Save сохранять файлы в заданном формате, назначать создание
образца для просмотра, определять процент для быстрых сохранений;
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Рис. 1.21. Диалоговое окно настройки параметров открытия и сохранения файлов

Q в области File Safety Precautions включать функцию автоматического сохранения
файла, задавать интервал между сохранениями в минутах, обеспечивать созда-
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ние резервных копий, ведение файла журнала, определять расширение для вре-
менных файлов и отображать информацию о цифровой подписи;

О в области File Open определять количество последних файлов, указываемых
в меню, и назначать полные пути в заголовках;

rj в области External References (Xrefs) управлять подгрузкой файлов внешних ссылок;

О в области ObjectARX Applications определять поведение приложений и сторонних
объектов ObjectARX.

Определение параметров вывода на печать

Параметры печати задаются на вкладке Plot and Publish диалогового окна Options
(рис. 1.22):

О в области Default plot settings for new drawings определяется устройство вывода,
добавляются и настраиваются плоттеры;

Q в области General plot options регулируется качество печати OLE-объектов.
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Рис. 1.22. Диалоговое окно определения параметров вывода на печать

Настройка системных параметров
Для настройки системных параметров AutoCAD используется вкладка System ди-
алогового окна Options (рис. 1.23):
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Q в области Current 3D Graphics Display определяются состояние видов при манипу-
ляции, динамическая аппроксимация, параметры тонирования;

Q в области Current Pointing Device выбирается текущее устройство указания —
мышь, дигитайзер и пр.;

Q в области Layout Regen Options настраиваются регенерация при переключении,
кэширование модели и последнего листа или всех листов;

Q в области dbConnect Options устанавливаются параметры подключения к базам
данных и обеспечивается хранение индекса связей в рисунке;

О в области General Options выбирается много- или однодокументный режим рабо-
ты, настраиваются вывод диалогового окна свойств OLE-объектов, отображе-
ние предупреждающих сообщений, оповещение об ошибках пользовательско-
го ввода, режим загрузки LISP-файла, использование длинных имен символов,
вывод диалогового окна начала работы Startup;

Q в области Live Enabler Options организуется поиск адаптеров объектов в Интернете.
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Рис. 1.23. Диалоговое окно настройки системных параметров

Настройка пользовательской среды

На вкладке User Preferences диалогового окна Options можно настроить среду рисо-
вания по своему усмотрению (рис. 1.24):

2 Зак. 1039



34 * Глава 1. AutoCAD 2005. Общие сведения

.„l^-^.i-.-' . L>,*w,gl|||j

l'Yc«4"

|1ШШЩШ$1Шщ|||11 • : . . ' . . ' . .
Г КсуЬщиа ёпйу : : • . : . " , . ; ' : • :• " . . • - ' .' jjj .

<r St.-. ' . . . H . . '

Рис. 1.24. Диалоговое окно настройки пользовательской среды

Q в области Windows Standard Behavior назначить клавиши быстрого вызова, ото-
бражение контекстных меню в области рисования, выбрать действия, к кото-
рым приводит нажатие правой кнопки мыши;

Q в области Drag-and-drop scale указать единицы исходного и целевого рисунков;

Q установить параметры гиперссылок, способы ввода координат и сортировки
объектов;

Q определить параметры невидимых линий, а также веса линий.

Управление точностью построения объектов

На вкладке Drafting диалогового окна Options, показанной на рис. 1.25, можно опре-
делить;

О параметры автопривязки — маркер, магнит, всплывающие подсказки, прицел,
а также цвет и размер маркера автопривязки;

d параметры автоотслеживания — бесконечные линии полярного и объектного
отслеживания, всплывающие подсказки, захват точек отслеживания, а также
размер прицела.
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Рис. 1.25. Диалоговое окно управления точностью построения объектов

Настройка параметров выбора объектов
Вкладка Selection диалогового окна Options, показанная на рис. 1.26, позволяет на-
строить:
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Рис. 1.26. Диалоговое окно настройки параметров выбора объектов
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О размер прицела, режимы выбора — предварительный выбор, использование
клавиши Shift для добавления объектов, выбор с помощью рамки и пр.;

Q размер и цвет выбранных и невыбранных ручек, цвет ручки под курсором, пре-
дельное количество выбранных объектов и пр.

Настройка профилей
Вкладка Profiles диалогового окна Options используется для создания профилей
и сохранения в них параметров среды рисования (рис. 1.27). Профиль — набор па-
раметров настройки AutoCAD, сохраненный с уникальным именем. Один из про-
филей является текущим; он определяет настройки рабочей среды рисования.
Пользователи, входящие в систему под одним именем, могут загружать свои на-
стройки из различных профилей. По умолчанию AutoCAD записывает текущие
параметры в «Unnamed Profile». Имена текущего профиля и рисунка всегда выво-
дятся над именами вкладок диалогового окна Options.

..offer Ц | '--1 Щ$ №ег* :
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Рис. 1.27. Диалоговое окно настройки профилей

На вкладке Profiles можно осуществлять следующие настройки:

Q выбирать необходимый профиль из перечня доступных в области Avai lable
Profiles:;

Q устанавливать выбранный профиль в качестве текущего нажатием кнопки Set
Current;

Q добавлять новый профиль, используя кнопку Add to List...;
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Q экспортировать настройки текущего профиля во внешний ARG-файл с по-
мощью кнопки Export...;

tJ импортировать настройки профиля из внешнего ARG-файла после щелчка по
кнопке Import...;

О переименовывать и удалять имеющиеся профили.

Инструментальные палитры
;Щ Инструментальные палитры представлены отдельными вкладками в специ-

альном окне. Они являются эффективным средством хранения/вставки бло-
ков и штриховки. Палитры могут содержать инструменты, предоставленные
сторонними разработчиками (рис. 1.28).

Рис. 1.28. Инструментальная палитра

На палитрах удобно размещать часто используемые блоки и штриховки. Для того
чтобы вставить блок или штриховку из палитры в рисунок, необходимо «захва-
тить» элемент палитры мышью и перетащить его в графическую область. Блоки и
штриховки, размещенные на палитре, носят название инструментов. Некоторые
свойства инструментов, включая масштаб, угол поворота и слой, могут устанавли-
ваться отдельно для каждого инструмента. Блоки, вставляемые в рисунок из па-
литр, часто требуется масштабировать и поворачивать. При перетаскивании бло-
ков с палитры можно использовать объектную привязку, однако шаговая привязка
в это время не действует.

При перетаскивании из инструментальной палитры в рисунок блок автоматиче-
ски масштабируется в зависимости от соотношения заданных единиц блока и еди-
ниц текущего рисунка. Например, если в качестве единиц измерения данного ри-
сунка используются метры, а в качестве единиц измерения блока — сантиметры,
то коэффициент пересчета составляет 1 к 100. Соответственно, при перетаскива-
нии блока в рисунок его размеры меняются в пропорции 1:100.
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В разных областях окна инструментальных палитр через контекстные меню мож-
но изменять следующие настройки:

Q автоматически убирать палитры с экрана — при этом окно инструментальных
палитр может автоматически разворачиваться и сворачиваться при подведении
указателя мыши к строке заголовка окна и отведении от нее;

ID прозрачность — окно палитры инструментов делается прозрачным, так чтобы
оно не скрывало находящихся за ним объектов (эта функция недоступна для
пользователей Microsoft Windows NT);

Q вид — изменяются стиль и размер отображаемых в палитре значков.

Окно инструментальных палитр при необходимости можно закрепить у правой
или левой границы окна приложения. Для того чтобы избежать закрепления, при
перемещении окна следует удерживать нажатой клавишу Ctrl.

Настройки инструментальных палитр сохраняются в профиле AutoCAD.

Для изменения масштаба блока и угла поворота образца штриховки необходимо
щелкнуть правой кнопкой мыши по инструменту, а затем выбрать из контекстно-
го меню пункт свойств объекта Properties.... Далее в диалоговом окне свойств ин-
струмента Tool Properties изменяются свойства (рис. 1.29):

Q параметры вставки или образца — масштаб, поворот и угол;

Q общие свойства — слой, цвет и тип линий.

Рис. 1.29. Диалоговое окно свойств инструментов палитры

Для добавления инструментов в палитру можно использовать следующие способы:

Q перетаскивать рисунки, блоки и штриховки из Центра управления на инстру-
ментальную палитру. Если туда занесен целый рисунок, то при перетаскивании
из палитры в графическую область он вставляется как блок;
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Q перемещать и копировать инструменты с одной палитры на другую при помо-
щи команд контекстного меню: Cut — вырезать, Сору — копировать и Paste —
вставить;

Q чтобы создаваемая палитра сразу оказалась заполнена инструментами — щел-
кнуть правой кнопкой мыши по папке, файлу рисунка или блоку в Центре
управления, а затем выбрать из контекстного меню пункт создания инструмен-
тальной палитры Create Tool Palette.

Порядок размещения инструментов на палитре изменяется в результате перетаски-
вания их мышью.

Последовательность вкладок палитры можно изменять с помощью контекстного
меню или на вкладке Tool Palettes диалогового окна Customize. Такими же способа-
ми можно удалять инструментальные палитры, необходимость в которых отпала.
Палитры будет легко восстановить, если перед удалением они были экспортиро-
ваны в файл (с расширением .xtp), в том числе и в локальной сети.

Если в нижнем углу палитры высвечивается значок замка, это значит, что файлу
инструментальной палитры присвоен атрибут «только чтение».

Открытие рисунков
Программа AutoCAD по умолчанию записывает внутреннее представление рисун-
ка в файл с расширением .dwg.

Кроме рисунка, файл содержит ряд параметров, определяющих значения переклю-
чателей режимов шага SNAP, сетки GRID, ортогонального режима ORTHO; принятые
единицы измерения и точность представления; границы рисунка; организацию
слоев; форматы и логотипы; размерные и текстовые стили; типы линий и т. п.

AutoCAD 2005 предлагает многооконную среду проектирования Multiple Design
Environment (MDE), которая допускает одновременное открытие нескольких чер-
тежей. В одном сеансе работы можно открывать неограниченное число рисунков
AutoCAD, не жертвуя при этом производительностью.

Среда МОЕ позволяет перетаскивать объекты, копировать их свойства, такие как
цвет, слой, тип линии, из одного рисунка в другой. Она обеспечивает параллель-
ную работу с несколькими рисунками, не прерывая выполнения текущей коман-
ды и не нарушая последовательности действий. Это существенно упрощает выпол-
нение многих операций и повышает эффективность работы.

Щ Открыть существующий рисунок можно при помощи команды OPEN, которая
вызывается из падающего меню File > Open или щелчком по пиктограмме Open
(Ctrl+О) на стандартной панели инструментов.

После обращения к команде OPEN на экране AutoCAD появляется диалоговое
окно выбора файла Select file, показанное на рис. 1.30. Здесь можно выбрать имя
файла из списка или ввести это название в поле File name:.
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Рис. 1.30. Диалоговое окно выбора файла

При выделении в списке одного из файлов в области Preview появляется соответ-
ствующий образец рисунка. Нажатие кнопки Views выводит список, изменяя па-
раметры которого, пользователь может выбрать форму представления файлов,
предлагаемых для открытия: список, таблицу, образцы.

Режим открытия файлов — Open, для чтения Open Read only, частично Partial Open,
для чтения частично Partial Open Read only — устанавливается в списке при нажа-
тии кнопки Open. Частичное открытие позволяет загружать только те объекты ри-
сунка, которые принадлежат определенным слоям или видовым экранам. Это ока-
зывается полезным при работе с большими файлами.

Для открытия нескольких рисунков одновременно следует выбрать необходимые
файлы в диалоговом окне Select file, используя клавиши Shift и Ctrl. Кроме того,
рисунки можно открывать путем перетаскивания из программы Windows Explorer.
Для этого один или несколько выделенных в дереве Проводника файлов следует
переместить мышью в любую часть окна AutoCAD, за исключением области ри-
сунка, например на командную строку или в ту часть панелей инструментов, кото-
рая не занята кнопками. Если же перетащить один файл в область рисования уже
открытого рисунка, то произойдет вставка содержимого перетаскиваемого доку-
мента в текущий рисунок в качестве внешней ссылки.

Для открытия рисунка можно дважды щелкнуть по имени соответствующего фай-
ла в Проводнике Windows Explorer, что приведет к автоматическому запуску
AutoCAD. Однако если в системе уже ведется сеанс работы в AutoCAD, то рису-
нок откроется в нем.

В AutoCAD имеется специальное средство просмотра небольших фрагментов рисун-
ков, открытия файлов рисунков и их поиска. Его можно использовать для поиска
файлов в структуре папок на одном или нескольких дисках. Для загрузки окна про-
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смотра и поиска файлов Find, показанного на рис. 1.31, необходимо в диалоговом
окне выбора файла Select file последовательно щелкнуть по кнопкам Tools и Find.
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Рис. 1.31. Диалоговое окно просмотра и поиска файлов

На вкладке Name & Location диалогового окна Find указываются имя, расширение
и область поиска файла.

AutoCAD разрешает выполнять поиск файлов по датам их создания, пользуясь
вкладкой Data Modified окна Find (рис. 1.32). Здесь организуется поиск файлов, со-
зданных или измененных в период между двумя указанными датами, либо за оп-
ределенное количество последних дней или месяцев. Имена найденных докумен-
тов отображаются в нижней части диалогового окна.

nd: Hies named ' l.dwg

_ _____
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Pvto, 1.32. Вкладка поиска файлов

Рисунки, созданные в AutoCAD любой предшествующей версии, открываются как
любой документ версии 2005 и автоматически преобразуются в новый формат.
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Создание рисунков

При создании рисунка могут использоваться различные стандарты. Иногда они
диктуются государственными и отраслевыми стандартами или нормами предпри-
ятия, иногда — требованиями заказчика. Ключевой момент как для непосредствен-
ных исполнителей, так и для руководителей групп, контролирующих ход выпол-
нения проекта, — грамотная подготовка начальных параметров рисунка.

Рассмотрим в качестве примера архитектурный проект. Он может включать в себя
множество разделов: планы этажей, схемы сетей водоснабжения, канализации, отоп-
ления, вентиляции и т. п.

Обычно каждый раздел проекта разрабатывается в отдельном подразделении, поэто-
му здесь остро встает проблема унификации. Наиболее грамотное ее решение —
обеспечение всех исполнителей файлами шаблонов, настроенными на использу-
емую систему единиц и содержащими стандартные рамку, основную надпись, слои
и типы линий.

Не менее важно, какие стили используются для текстовых надписей, штрихования
и нанесения размеров. Их также следует задавать заранее: это дает гарантию, что
каждый проектировщик будет действовать без отклонения от оговоренных стан-
дартов.

Следует ответственно подходить к выбору рабочего масштаба. Только четкое пред-
ставление о том, как соотносятся единицы рисунка на экране и единицы чертежа,
выводимого на плоттер, позволяет правильно выбрать высоту текста для поясни-
тельных надписей и размеров.

Хотя компоновка чертежа обычно производится на последних стадиях проектиро-
вания, грамотное планирование на предварительных этапах позволяет избежать
многих ошибок и избавить персонал от излишних операций редактирования.

При создании проекта работа, как правило, ведется в пространстве модели (здесь
объекты представляются в натуральную величину), а для компоновки чертежа выпол-
няется переход в пространство листа, где ко всем графическим объектам, текстам,
типам линий и размерам применяется необходимый масштабный коэффициент.

Все начальные установки рисунка могут быть сохранены в шаблоне для последу-
ющего использования в других документах. В качестве шаблона могут применять-
ся как рисунки, поставляемые с AutoCAD, так и любые другие, в том числе создан-
ные пользователем. Новый рисунок наследует всю инфррмацию из используемого
шаблона. Имеется также возможность запускать AutoCAD без шаблона.

Щ Создать рисунок позволяет команда NEW, вызываемая из падающего меню
File » New... или щелчком по пиктограмме QNew на стандартной панели инстру-
ментов.

После запуска команды необходимые настройки параметров рабочей среды AutoCAD
производятся в диалоговом окне Create New Drawing (рис. 1.33).
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Рис. 1.33. Диалоговое окно создания нового рисунка

При создании рисунка по простейшему шаблону используется пиктограмма Start
from Scratch. В данном режиме устанавливается британская или метрическая систе-
ма единиц. Значения многих системных переменных, принятые по умолчанию, за-
висят от того, какая из двух систем выбрана. Эти переменные управляют текстом,
размерами, сеткой, режимами привязки, а также устанавливают действующие по
умолчанию тип линий и файл образцов штриховки:

Q Imperial (feet and inches) — создается рисунок, использующий британскую систе-
му единиц измерения, по шаблону acad.dwt. При этом область рисования, ина-
че называемая лимитами рисунка, устанавливается равной 12x9 дюймов;

Q Metric — создается рисунок, где используется метрическая система единиц из-
мерения по шаблону acadiso.dwt. При этом устанавливается область рисования
429x297 мм.

Чтобы создать рисунок с использованием шаблона, необходимо в диалоговом окне
Create New Drawing щелкнуть по пиктограмме Use a Template и в списке Select a Template:
указать нужный шаблон (рис. 1.34).

iefpcfi
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Рис. 1.34. Выбор шаблона рисунка
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В AutoCAD имеется так называемый Мастер подготовки, Wizard — служебное
средство для создания нового рисунка. С помощью.Мастера можно, взяв за осно-
ву текущий шаблон, модифицировать некоторые базовые установки. Например,
пользователь может автоматически настраивать масштабные коэффициенты для
текста в зависимости от общих размеров рисунка. Если рисунки крупные, выби-
рается большая высота символов, если мелкие — меньшая; таким образом обеспе-
чивается разборчивость текстовых надписей, когда рисунок отображается на эк-
ране целиком.

Для вызова Мастера подготовки необходимо в диалоговом окне Create New Drawing
щелкнуть по пиктограмме Use a Wizard — откроется окно, показанное на рис. 1.35.

ra,«i

Рис. 1.35. Создание нового рисунка с помощью Мастера подготовки

Мастер быстрой подготовки Quick Setup позволяет задать для нового рисунка па-
раметры Units — единицы измерения и Area — область рисования. Поддерживают-
ся следующие типы единиц для рисования и вычерчивания: Decimal — десятичные,
Engineer ing — инженерные, Archi tectural — архитектурные, Fractional — дробные,
Scientific — научные (см. рис. 1.3). Указывая ширину Width и длину Length области
рисования, пользователь тем самым задает граничные пределы рисунка, так назы-
ваемые лимиты. Именно лимитами определяется размер чертежа, впоследствии
выводимого на плоттер. После того как все параметры заданы, Мастер быстрой
подготовки запускает сеанс рисования в пространстве модели.

Мастер детальной подготовки Advanced Setup (см. рис. 1.2) позволяет задать для
нового рисунка тип линейных единиц измерения Units и способ измерения углов
Angle, задать начало отсчета угла Angle Measure и направление измерения угла Angle
Direction, определить границы области рисунка Area.

В отличие от Мастера быстрой подготовки, который настраивает только простран-
ство модели, Мастер детальной подготовки воздействует как на пространство мо-
дели, так и на пространство листа.

Любая из установок, произведенных в начале рисования, в дальнейшем может
быть изменена.
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Определение границ рисунка
Команда LIMITS позволяет установить границы текущего рисунка в пространстве
модели и в пространстве листа. Она вызывается из падающего меню Format > Draw-
ing Limits. В AutoCAD границы рисунка выполняют три функции:

Q определяют диапазон изменения координат точек;

Q контролируют фрагмент рисунка, покрытый видимой координатной сеткой;

Q определяют, какая часть рисунка отображается на экране по команде ZOOM ALL.

Границы рисунка — это пара двумерных точек в мировой системе координат: коор-
динаты левого нижнего и правого верхнего углов, определяющие прямоугольную
область. По оси Z границы не устанавливаются.

Запросы команды LIMITS:

Reset Model space limits :—переустановка лимитов пространства модели;

Specify lower left corner or [ON/OFF] <current>: — указание левого
нижнего угла;

Specify upper right corner <current>:— указание правого верхнего
угла, где:

Q ON — включается контроль соблюдения границ. При этом AutoCAD отвергает
все попытки ввести точки с координатами, выходящими за границы рисунка;

Q OFF — отключается контроль соблюдения границ рисунка;

Q <current> — задается новое текущее значение левого нижнего, а затем право-
го верхнего угла.

Если текущее значение границ рисунка вас устраивает, достаточно нажать клави-
шу Enter.

Лимиты должны полностью охватывать полномасштабную модель/Например, если
ее размеры 100x200 мм, значения лимитов должны слегка превышать эти цифры.

В пространстве листа лимиты обычно задают равными формату листа бумаги.
Следовательно, сетка (если она включена) покрывает при этом весь скомпонован-
ный чертеж, включая графические объекты, размерные элементы, основную над-
пись и т. п. Например, если формат листа равен 210x297 мм, следует установить
десятичный формат единиц и определить лимиты указанием точек (0,0) для лево-
го нижнего угла прямоугольника и (210, 297) — для правого верхнего угла.

Если в пространстве листа отображаются поля листа или подложен заданный фор-
мат, нельзя задать границы рисунка с помощью команды LIMITS. В этом случае
лимиты вычисляются и устанавливаются в зависимости от размеров выбранного
листа. Включение и отключение отображения полей и разметки листа производят-
ся на вкладке Display диалогового окна Options.
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В пространстве модели лимиты могут быть заданы при создании нового 'рисунка
с помощью Мастера быстрой подготовки или Мастера детальной подготовки.

Определение параметров сетки
Сеткой называется упорядоченная последовательность точек, покрывающих область
рисунка в пределах лимитов. Работа в режиме сетки GRID подобна наложению на
рисунок листа бумаги в клетку. Использование сетки помогает выравнивать
объекты и оценивать расстояние между ними. Сетку можно включать и отключать
в ходе выполнения других команд. На печать она не выводится.

Включение сетки и определение ее частоты осуществляется на вкладке Snap and
Grid диалогового окна режимов рисования Drafting Settings, которое загружается из
падающего меню Tools > Drafting Settings... или при выборе пункта Settings... кон-
текстного меню, вызываемого щелчком правой кнопки мыши по кнопке GRID в стро-
ке состояния (рис. 1.36).

Рис. 1.36. Диалоговое окно определения параметров сетки и шага привязки

Сетка включается при установке флажка Grid On (F7). В области Grid текстового
поля Grid X spacing: устанавливается частота горизонтальных делений сетки. Если
частота вертикальных и горизонтальных делений сетки должна быть одинаковой,
следует нажать клавишу Enter или щелкнуть мышью в текстовом поле Grid Y spacing:.
В противном случае понадобится ввести частоту по вертикали в соответствующем
поле.

Удобно включать и отключать сетку щелчком мыши по кнопке GRID в строке со-
стояния или нажатием функциональной клавиши F7.

После зумирования рисунка для лучшего согласования с новым коэффициентом
экранного увеличения может потребоваться изменение частоты сетки.
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Определение шага привязки
В режиме шаговой привязки SNAP курсор может находиться только в определен-
ных точках согласно установленному значению шага и при этом движется не
плавно, а скачкообразно между узлами воображаемой сетки, как бы «прилипая» к
ее узлам. Активность режима SNAP можно определить визуально, по скачкообраз-
ному движению курсора на экране. Шаговая привязка обычно используется для
точного указания точек с помощью мыши. Интервал привязки задается отдельно
по осям X и Y. Включение и отключение режима шаговой привязки может произ-
водиться в ходе выполнения другой команды.

Шаг привязки не обязательно совпадает с частотой сетки. Сетку часто делают до-
статочно редкой, используя ее исключительно для наглядности, а шаг привязки
устанавливают меньшим. Допустимо и обратное: установка большего по сравне-
нию с сеткой шага привязки.

Включение шаговой привязки SNAP и настройка ее параметров осуществляются на
вкладке Snap and Grid диалогового окна режимов рисования Drafting Settings, кото-
рое загружается из падающего меню Tools > Drafting Settings... или при выборе пунк-
та Settings... из контекстного меню, вызываемого щелчком правой кнопки мыши
по кнопке SNAP в строке состояния (см. рис. 1.36).

Шаговая привязка включается при установке флажка Snap On (F9). В области Snap
текстового поля Snap X spacing: задается шаг привязки по горизонтали. Если шаг
привязки по вертикали должен быть таким же, следует нажать клавишу Enter или
щелкнуть мышью в текстовом поле Snap Y spacing:. В противном случае значение
шага по вертикали вводится в соответствующем поле.

Удобно включать и отключать шаговую привязку щелчком мыши на кнопке SNAP
в строке состояния или нажатием функциональной клавиши F9.

Выполните упражнение L4 из раздела 2.

используя привязку координат к узлам сетки \М>

Line /
LINE Specify first point: из точки 1

Specify next point or [Undo]: 8 точку 2
Specify next point or [Undo]: 6 точку 3

Specify next point or [Close/Undo]: 6 точку 4
Specify next point or [Close/Undo]: fl точку 5
Specify next point or [Close/Undo]: С замкнуть

S
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/

/

I/

5 .5

/ .
/

/
4 у
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Включить привязку
к узлам сетки:

SNA* <F9>

координатную сетку:

<F7>
Точки указыбать

щелчком мыши
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Сохранение рисунков
Щ Команда сохранения рисунка QSAVE вызывается из падающего меню File > Save

или щелчком мыши по пиктограмме Save (Ctrl+S) на стандартной панели ин-
струментов. Команда QSAVE используется в тех случаях, когда уже существу-
ющий рисунок сохраняется без изменения его имени. Если рисунок новый
и его имя не определено, то QSAVE действует так же, как команда SAVEAS.

Команды SAVE и SAVEAS предназначены для сохранения рисунка под другим име-
нем. Команда SAVE может вызываться только из командной строки, a SAVEAS —
из падающего меню File > Save As.... В обоих случаях имя документа задается в поле
File name: диалогового окна Save Drawing As (рис. 1.37).

j .Я Jwg
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Рис. 1.37. Диалоговое окно сохранения рисунка

Предыдущей копии рисунка на диске присваивается расширение .bak вместо .dwg
(все предыдущие .bak-файлы с данным именем удаляются).

Обновленный рисунок записывается с расширением .dwg. Если при указании име-
ни файла оказывается, что рисунок с таким названием уже существует, выдается
предупреждение и предоставляется возможность перезаписать файл или ввести
другое имя.

Любой рисунок можно сохранить как шаблон. Для этого в раскрывающемся спи-
ске Files of type: диалогового окна Save Drawing As необходимо выбрать пункт AutoCAD
Drawing Template File (*.dwt).

Чтобы обеспечить автоматическое сохранение рисунка через заданные интервалы
времени, следует использовать системную переменную SAVETIME или вкладку
Open and Save диалогового окна Options, показанного на рис. 1.21. Оно вызывается
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из падающего меню Tools > Options.... В последнем случае необходимо поставить
флажок автосохранения Automatic save в области File Safety Precautions и установить
интервал в минутах в поле Minutes between saves.

Получение твердой копии рисунка
Распечатка чертежа — последний этап при работе с рисунком. Процесс оформле-
ния и вывода рисунков на печать в AutoCAD 2005 стал более управляемым и гиб-
ким по сравнению с предыдущими версиями.

Перед выводом рисунка на печать необходимо его скомпоновать, то есть опреде-
лить, какие виды должны быть вычерчены. Работа над рисунком ведется на раз-
ных этапах либо в пространстве модели, либо в пространстве листа.

Пространство модели предназначено для создания модели — изображения в ре-
альном масштабе.

Пространство листа представляет собой аналог листа бумаги, на котором произ-
водится создание и размещение видов перед вычерчиванием.

Как в пространстве модели, так и в пространстве листа может быть один или не-
сколько видовых экранов, на которых представлены различные виды модели. Ком-
поновка чертежа, по сути дела, представляет собой процесс создания и размеще-
ния таких экранов. По завершении компоновки чертеж выводится на принтер или
плоттер.

Щ Перед выводом рисунка на плоттер можно предварительно просмотреть, как
он будет размещаться на листе бумаги. Для этого используется команда пре-
дварительного просмотра PREVIEW, вызываемая из падающего меню File > Plot
Preview или щелчком по пиктограмме Plot Preview на стандартной панели ин-
струментов. При этом автоматически включается изменение масштаба изоб-
ражения в режиме реального времени для просмотра мелких деталей чертежа.
Для изменения режима масштаба изображения, вывода на плоттер, использо-
вания панорамирования или выхода из предварительного просмотра исполь-
зуется контекстное меню (рис. 1.38), которое вызывается в ответ на нажатие
правой клавиши мыши.

Рис. 1.38. Контекстное меню

Ц Все установки вывода рисунка на плоттер осуществляются в диалоговых ок-
нах Plot-Model и Plot-Layout (рис. 1.39). Эти окна загружаются командой PLOT,
вызываемой из падающего меню File > Plot... или щелчком мыши по пикто-
грамме Plot (Ctrl+P) на стандартной панели инструментов.
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Рис. 1.39. Диалоговое окно вывода на печать пространства модели

Выход из AutoCAD

Для выхода из AutoCAD используется команда QUIT, которая вызывается из па-
дающего меню File > Exit (Ctrl+Q).

Рис. 1.40. Диалоговое окно сохранения изменений в рисунке

Команда позволяет сохранить или проигнорировать сделанные в рисунке измене-
ния и выйти из AutoCAD. Если все сделанные изменения сохранены, при выходе
из программы не появится никаких дополнительных сообщений. В противном
случае на экран будет выведено диалоговое окно AutoCAD (рис. 1.40), где пользова-
телю предлагается выбор: сохранить изменения, отказаться от них или продол-
жить сеанс работы. Если текущему рисунку не было присвоено имя и вы хотите
его сохранить, откроется диалоговое окно Save Drawing As (см. рис. 1.37).
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Ввод координат
Когда программа AutoCAD запрашивает точку, команда ожидает ввода координат
какой-либо точки текущего рисунка. В AutoCAD может быть включен контроль
лимитов рисунка, осуществляемый командой LIMITS. В этом случае, если введен-
ная точка выходит за пределы рисунка, AutoCAD выдает сообщение:

** Outside limits — вне лимитов

и отвергает введенную точку.

В представлении рисунка во внутренней графической базе данных координаты
каждой точки задаются с точностью не менее 14 значащих цифр.

Ввод координат в AutoCAD может осуществляться двумя способами:

U непосредственно с клавиатуры, путем указания численных значений;

Q с использованием графического маркера (курсора), который движется по экра-
ну с помощью устройства указания. Ввод координат осуществляется щелчком
левой кнопки мыши.

Как следствие, в строке состояния, расположенной внизу Рабочего стола, проис-
ходит отображение текущих значений координат. Существует три режима отобра-
жения координат:

Q динамический, при котором обновление координат происходит постоянно по
мере перемещения указателя мыши;

Q статический, при котором координаты обновляются только после указания
точки;

О режим относительных координат, формат расстояние<угол, при котором об-
новление значений происходит по мере перемещения указателя мыши во вре-
мя рисования объекта, содержащего более одной точки.

Включение отображения координат в строке состояния осуществляется с по-
мощью либо функциональной клавиши F6, либо системной переменной COORDS.
Значение 0 соответствует статическому отображению, 1 — динамическому, 2 — от-
носительному.

Для определения координат точек существующих объектов (например, точки пе-
ресечения или середины отрезка) можно воспользоваться командой ID. При этом
следует применять объектную привязку, иначе полученные координаты могут
оказаться неточными.

Для определения координат сразу всех характерных точек объекта пригодится
команда LIST. Еще один метод получения координат характерных точек — выбор
объекта с помощью ручек.

Ручки представляют собой маленькие прямоугольники, располагающиеся в харак-
терных точках объектов, например, конечных точках и середине отрезка. При при-
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вязке курсора к одной из ручек в поле координат строки состояния отображаются
ее координаты.

Для удобства ввода координат можно использовать:

Q орторежим, когда изменение координат происходит только по осям X или Y.
Орторежим включается либо нажатием функциональной клавиши F8, либо
щелчком мыши по кнопке ORTHO в информационной строке;

Q привязку к узлам невидимой сетки, определенной с некоторым шагом по X и Y.
Такую привязку можно установить, либо нажав функциональную клавишу F9,
либо щелкнув мышью по кнопке SNAP в строке состояния. Если включен шаг
привязки, то при перемещении мыши перекрестье будет «перепрыгивать» с од-
ного узла невидимой сетки на другой.

Значения координат, независимо от способа ввода всегда, связаны с некоторой
системой координат.

По умолчанию в AutoCAD используется так называемая мировая система коор-
динат, МСК — World Coordinate System (WCS). Она определена так, что ось ОХ
направлена слева направо, ось OY— снизу вверх, ось 02— перпендикулярно эк-
рану, вовне.

Как правило, для выполнения конкретного проекта удобнее определить пользова-
тельскую систему координат, ПСК — User Coordinate System (UCS), которую мож-
но сместить относительно мировой и/или повернуть под любым углом. Допуска-
ется существование нескольких пользовательских систем координат, и в любой
момент возможен переход от одной к другой.

Никакие изменения МСК не допускаются. AutoCAD позволяет одновременно ис-
пользовать и координаты, связанные с текущей ПСК, и координаты, связанные с
МСК. При этом для МСК при вводе с клавиатуры значению координат должен
предшествовать символ «звездочка» (*).

Декартовы и полярные координаты

В двумерном пространстве точка определяется в плоскости XY, которая называет-
ся также плоскостью построений. Ввод координат с клавиатуры возможен в виде
абсолютных и относительных координат.

Ввод абсолютных координат производится в следующих форматах:

Q декартовы (прямоугольные) координаты. При этом для определения двумер-
ных и трехмерных координат применяются три взаимно перпендикулярные
оси: X, Y и Z. Для ввода координат указывается расстояние от точки до начала
координат по каждой из этих осей, а также направление (+ или -). При начале
нового рисунка текущей системой всегда является мировая система координат
World Coordinate System (WCS), следовательно, ось X направлена горизон-
тально, ось У — вертикально, а ось Z перпендикулярна плоскости XY;
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О полярные координаты. При вводе координат указывается расстояние, на котором
располагается точка от начала координат, а также величина угла, образованно-
го полярной осью и отрезком, мысленно проведенным через данную точку и
начало координат. Угол задается в градусах против часовой стрелки. Значение
О соответствует положительному направлению оси ОХ.

Относительные координаты задают смещение от последней введенной точки.
При вводе точек в относительных координатах можно использовать любой фор-
мат записи в абсолютных координатах: @ dx, dy — для декартовых, @ г<А — для по-
лярных.

Относительные декартовы координаты удобно применять в том случае, если из-
вестно смещение точки относительно предыдущей.

Выполните упражнения L1-L3 из раздела 2.

Построить многоугольник, (\ Д
задавая точки в абсолютных координатах \|- у

Line / Падающее пеню

LINE Specify first poin
Specify next point or [Undo]
Specify next point or [Undo_

Specify next point or [Close/Undo]
Specify next point or [Close/Undo_
Specify next point or [Close/Undo]

/1
5 .

v

J

2

Draw- — — Line
: 240, 20 из точки ^
: 390, 20 Ъ точку 2
: 390, 100 8 точку 1
: 330, 40 8 точку 4
: 330, 100 6 точку 5
: Close замкнуть

Л

z

Undo

f *
о/пмена

последнего

действия

Л

\
I

J

Построить многоугольник,
задавая точки в относительных координатах

LinG f" © - комбинация клавиш Shift + 2
LINE Specify first point: 240, 20 из точки 1

Specify next point or [Undo]: @ 150, 0 6 точку 2
Specify next point or [Undo]: @ 0, 80 в точку З

Specify next point or [Close/Undo]: @ —60, —60 в точку 4
Specify next point or [Close/Undo]: © 0, 60 в точку 5
Specify next point or [Close/Undo]: Close замкнуть

/ I
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( Построитьмногоугольник, (\ ̂
задавая точки в полярных координатах \|~ v

Line /"
LINE Specify first point:

Specify next point or [Undo]:
Specify next point or [Undo]:

Specify next point or [Close/Undo]:
Specify next point or [Close/Undo]:
Specify next point or [Close/Undo]:

t/\
V

5 .J

240, 20
© 150 < 0
© 80 < 90
© 85 <-135
© 60 < 90
Close

s

/

1
I
I
I
V

из /почки 1
б точку 2
б точку 3
b точку 4
б точку 5
замкнуть

/

Л
/ I/ I

I
•I

I

Формирование точек методом «направление-расстояние»
Вместо ввода координат допускается использование прямой записи расстояния,
что особенно удобно для быстрого ввода длины линии. Такой ввод может произ-
водиться во всех командах, кроме тех, которые предполагают указание просто дей-
ствительного значения, например, в командах построения массива ARRAY, разметки
MEASURE и деления объекта DIVIDE. При использовании прямой записи рассто-
яния в ответ на запрос точки достаточно переместить мышь в нужном направле-
нии и ввести числовое значение в командной строке. Например, если таким спо-
собом задается отрезок, то он строится путем указания числового значения длины
и направления под определенным углом. При включенном орторежиме этим спо-
собом очень удобно рисовать перпендикулярные отрезки.

Определение трехмерных координат
Трехмерные координаты задаются аналогично двумерным, но к двум составля-
ющим по осям X и Y добавляется третья величина — по оси Z. В трехмерном про-
странстве аналогично двумерному моделированию можно использовать абсолют-
ные и относительные координаты, а также цилиндрические и сферические, которые
схожи с полярными в двумерном пространстве.

Значения координат независимо от способа ввода всегда связаны с некоторой си-
стемой координат. При работе в трехмерном пространстве значения х, у и z указы-
вают либо в мировой системе координат World Coordinate System (WCS), либо
в пользовательской User Coordinate System (UCS).

Правило правой руки
При работе в трехмерном пространстве в AutoCAD все системы координат фор-
мируются по правилу правой руки. Оно определяет положительное направление
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оси Z трехмерной системы координат при известных направлениях осей X и У,
а также положительное направление вращения вокруг любой из осей трехмерных
координат.

Для определения положительных направлений осей необходимо поднести тыль-
ную сторону кисти правой руки к экрану монитора и направить большой палец
параллельно оси X, а указательный — по оси Y. Если согнуть средний палец пер-
пендикулярно ладони, как показано на рис. 2.1 справа, то он будет указывать по-
ложительное направление оси Z.

X

Рис. 2.1. Правило правой руки

Для определения положительного направления вращения следует ориентировать
большой палец правой руки в положительном направлении оси и согнуть осталь-
ные пальцы, как показано на рис. 2.2 слева. Положительное направление враще-
ния совпадает с направлением, указываемым согнутыми пальцами.

Ввод трехмерных декартовых координат
Трехмерные декартовы координаты (x,y,z) вводятся аналогично двумерным (х,у).
Дополнительно к координатам по осям X и Y необходимо ввести еще и значение
по оси Z. На самом деле в AutoCAD не существует двумерных координат, и если
введены значения только хну, это означает, что отсутствующая координата z бе-
рется по умолчанию равной нулю (системная переменная THICKNESS). При ука-
зании декартовых трехмерных координат с клавиатуры вводятся три числа через
запятую,например:

3,5,2

В трехмерном пространстве, так же как и в двумерном, широко используются и аб-
солютные координаты (отсчитываемые от начала координат), и относительные
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(отсчитываемые от последней указанной точки). Признак относительных коорди-
нат — символ @ перед координатами вводимой точки, которая в этом случае берет-
ся относительно последней введенной точки.

Определение пользовательской системы
координат

Как было сказано выше, в AutoCAD существуют: мировая система координат World
Coordinate System, WCS, и пользовательская система координат User Coordinate
System, UCS. Ось Xмировой системы координат направлена горизонтально, ось Y —
вертикально, а ось Z проходит перпендикулярно плоскости XY.

Начало координат — это точка пересечения осей X и У; по умолчанию она совме-
щается с левым нижним углом рисунка. В любой текущий момент активна только
одна система координат, которую принято называть текущей. В ней координаты
определяются любым доступным способом.

Основное отличие мировой системы координат от пользовательской заключается
в том, что мировая система координат может быть только одна (для каждого про-
странства модели и листа) и она неподвижна. Применение пользовательской
системы координат не имеет практически никаких ограничений. Она может быть
расположена в любой точке пространства под любым углом к мировой системе
координат. Разрешается определять, сохранять и восстанавливать неограниченное
количество ПСК. Проще выровнять систему координат с существующим геоме-
трическим объектом, чем определять точное размещение трехмерной точки. ПСК
обычно используется для работы с несмежными фрагментами рисунка. Поворот
ПСК упрощает указание точек на трехмерных или повернутых видах. Узловые
точки и базовые направления, определяемые режимами привязки SNAP, сетки GRID
и ортогонального режима ORTHO, поворачиваются вместе с ПСК.

При работе в ПСК допускается поворачивать ее плоскость XY и смещать начало
координат. Все они при вводе отсчитываются относительно текущей пользователь-
ской системы координат. Соответствующая пиктограмма дает возможность судить
о положении и об ориентации текущей ПСК, помогая визуализировать эту ориен-
тацию относительно мировой системы координат, а также относительно объектов,
содержащихся в рисунке.

Пиктограмма ПСК всегда изображается в плоскости XYтекущей ПСК и указывает
положительное направление осей X и Y. Сама пиктограмма может располагаться
как в начале пользовательской системы координат, так и в другом месте. Эту пози-
цию регулирует команда управления пиктограммой системы координат UCSICON.
С помощью той же команды можно выбрать одну из трех пиктограмм (рис. 2.2).
В трехмерной пиктограмме допускается изменение размера, цвета, типа стрелок
осей и толщины линий.

Различные варианты пиктограмм ПСК используются для облегчения восприятия
изображения (рис. 2.3).
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2D знак ПСК

Рис. 2.2. Пиктограммы системы координат

Раскрашенный
знак ПСК

ЗОзнаквМСК 2D вид сбоку 20изометрия 20 снизу

* Z

а >Г о t>Y

ЗОзнаквМСК 3D вид сбоку ЗОизометрия 3D снизу

Рис. 2.3. Варианты пиктограмм системы координат

Появление символа + (плюс) в нижнем левом углу пиктограммы указывает на ее
расположение в начале ПСК. Пользовательская система координат используется
для перемещения начала системы координат и/или изменения ориентации осей
системы координат в пространстве, что значительно упрощает процесс создания и
редактирования объектов. При создании объекта удобно поместить начало систе-
мы координат в базовую точку объектов, особенно если в данной точке формиру-
ется много объектов.

Пиктограмма с изображением сломанного карандаша говорит о том, что плоскость
XY практически параллельна направлению взгляда. В этом случае при указании
значений координат мышью происходит выбор точек с нулевыми координатами z,
что обычно не соответствует желанию пользователя. Перед вводом точек или ре-
дактированием модели по виду пиктограммы следует оценить угол между направ-
лением взгляда и пиктограммой ПСК: если этот угол мал, точный выбор точек
с помощью мыши или другого манипулятора затруднителен.

Выбор пользовательской системы координат
в пространстве
Для изменения положения ПСК применяются следующие способы:

Q указание новой плоскости ХУ или новой оси Z;

О ввод нового начала координат;
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Q совмещение ПСК с имеющимся объектом;

Q совмещение ПСК с гранью тела;

Q совмещение ПСК с направлением взгляда;

Q поворот ПСК вокруг одной из ее осей;

Q расположение плоскости XYTICK перпендикулярно выбранному в качестве
оси Z направлению;

rj восстановление ранее сохраненной ПСК;

О применение имеющейся ПСК к любому видовому экрану.

Размещение, перемещение, вращение и отображение пользовательских систем ко-
ординат производится с помощью команды UCS. Вызвать ее или варианты ее ис-
полнения можно из командной строки или из падающего меню Tools. Наиболее
удобным представляется вызов этой команды из плавающей панели инструмен-
тов UCS (рис. 2.4).

Рис. 2.4. Панель инструментов UCS

ЦЦ Команда UCS — определение новой пользовательской системы координат. За-
прос данной команды:

Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/
Apply/?/Wor ld] <World> : — задать опцию [Новая/Перенести/Ортогональ-
ная/Предыдущая/Восстанить/Сохранить/Удалить/Применить/?/Мир] <Мир>

Щ Display UCS Dialog — управление имеющимися пользовательскими системами
координат из диалогового окна UCS (рис. 2.5);

Щ UCS Previous — восстановление предыдущей ПСК. При этом сохраняется де-
сять последних определенных ПСК;

Ц World UCS — переход к мировой системе координат;

Щ Object UCS — выравнивание системы координат по существующему объекту;

Щ Face UCS — определение пользовательской системы координат путем простого
указания на грань;

Щ View UCS — выравнивание системы координат в направлении текущего вида, то
есть определение новой системы координат с плоскостью XY, перпендикуляр-
ной направлению вида (иначе говоря, параллельно экрану);
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Ц| Origin DCS — размещение ПСК в начале координат;

Щ ZAxis Vector DCS — определение нового положительного направления оси;

Щ 3Point DCS — определение нового начала координат и направления осей X и У
по трем точкам;

Щ: X Axis Rotate UCS — поворот системы координат вокруг оси X;
•ЙЙйВД:

Ш У Axis Rotate UCS — поворот системы координат вокруг оси Y;

И Z Axis Rotate DCS — поворот системы координат вокруг оси Z;

Щ Apply UCS — применение текущей ПСК к выбранному видовому экрану.

РИе. 2.5. Диалоговое окно DCS

Изменение текущей ПСК не влияет на изображение рисунка на экране, если не
включена системная переменная UCSFOLLOW; в противном случае показывается
вид в плане текущей ПСК.

Если пиктограмма ПСК активизирована, она перерисовывается в соответствии
с ориентацией новой системы координат.

С ПСК связаны следующие системные переменные:

Q UCSXDIR, UCSYDIR определяют направление осей X и У в мировых координа-
тах. Переменные доступны только для чтения;

Q UCSNAME определяет имя текущей ПСК;

Q WORLDUCS равна 1, если текущая ПСК совпадает с мировой системой коорди-
нат, и 0 — в противном случае;

Q UCSORG определяет начало координат текущей системы координат для текуще-
го пространства.
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jjj Управление системами координат осуществляется с помощью команды DDUC S,
вызываемой из падающего меню Tools > Named DCS.... На вкладке N a m e d UCSs
диалогового окна UCS, загружаемого командой DDUCS, можно присвоить лю-
бой пользовательской системе координат уникальное имя.

В дальнейшем, открыв вкладку именованных ПСК Named UCSs диалогового окна
UCS, можно по ранее заданному имени восстановить пользовательскую систему
координат. На рис. 2.6 показана вкладка Named UCSs этого окна с тремя пользова-
тельскими системами координат. Чтобы сделать систему координат текущей, не-
обходимо навести указатель мыши на ее имя и щелкнуть по кнопке Set Current.

Рис. 2.6. Диалоговое окно управления именованными ПСК

Для удаления пользовательской системы необходимо навести на ее имя указатель
мыши и нажать клавишу Delete.

При щелчке по кнопке Details раскрывается подробное диалоговое окно UCS Details,
в котором отражена вся информация о координатах точки начала и направлении
осей относительно текущей системы координат по каждой именованной ПСК
(рис. 2.7).
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Рис. 2.7. Диалоговое окно DCS Details
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Чтобы добавить новую пользовательскую систему координат, необходимо присво-
ить текущей ПСК со стандартным именем Unnamed уникальное название. Для это-
го достаточно щелкнуть мышью по имени текущей ПСК и набрать новое с клави-
атуры в появившемся поле. Другие стандартные названия — World и Previous —
зарезервированы для мировой системы координат и для той, которая использова-
лась перед текущей. Именованные пользовательские системы координат приме-
няются в случаях, когда установленная ПСК, с которой неоднократно придется
работать в дальнейшем, не совпадает со стандартной. Если пользовательские си-
стемы координат были определены как именованные, их легко восстановить в ди-
алоговом окне UCS, на вкладке Named UCSs.

Работа с ПСК на видовых экранах
На видовые экраны выводятся различные виды модели. Например, иногда требу-
ется создать четыре видовых экрана для показа модели сверху, справа, слева и сни-
зу. Чтобы повысить удобство работы, для каждого видового экрана можно задать
и сохранить отдельную ПСК. В этом случае при переключении между видовыми
экранами не происходит потери информации о ПСК каждого из них.

Сохранение ПСК для каждого видового экрана обеспечивается системной пере-
менной UCSVP. Если для видового экрана она установлена в 0, то ПСК этого видо-
вого экрана всегда совпадает с ПСК текущего активного видового экрана. Если для
видового экрана системная переменная UCSVP установлена в 1, то заданная для
этого экрана ПСК запоминается и не изменяется при переходе на другой.

Вкладка Settings диалогового окна UCS позволяет устанавливать различные режи-
мы отображения пиктограммы ПСК. Причем параметры отображения можно за-
давать либо отдельно для текущего видового экрана, либо сразу для всех активных
видовых экранов текущего рисунка. Здесь же можно указать, следует ли сохранять
систему координат вместе с видовым экраном, а кроме того, нужно ли на видовом
экране всегда показывать вид модели в плане.

Выбор стандартной пользовательской системы координат

Ориентацию текущей ПСК в зависимости от мировой системы координат, преды-
дущей ПСК или ПСК, установленной для текущего вида, можно изменить в диа-
логовом окне DCS, на вкладке Orthographic UCS, показанной на рис. 2.5: достаточно
выбрать объект и выполнить команду DDUCSP.

С помощью данной команды можно определить новую пользовательскую систему
координат либо по отношению к мировой, либо к текущей, выбрав соответствующий
слайд в диалоговом окне. Команду DDUCSP используют в основном для переноса
пользовательской системы координат из одной ортогональной проекции в другую.

В AutoCAD имеются шесть стандартных ортогональных ПСК: верхняя, нижняя,
передняя, задняя, левая и правая. По умолчанию параметры ортогональных ПСК
рассчитываются относительно МСК.
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Стандартной системой координат удобно пользоваться при переходе от одной ор-
тогональной проекции трехмерного объекта к другой.

Обычно эти проекций располагаются в соседних окнах, и признаком правильной
установки ПСК считается отображение в нужном окне правильной пиктограммы
системы координат (ось X направлена вправо, ось У— вверх).

Так как набор стандартных систем координат ограничен, оптимальным является
табличный способ их определения.

Выполните упражнения Ucs1-Ucs3 из раздела 4.

Задать пользовательскую
систему координат UCS1

Падающее меню Tools New UCS Origin

Current UCS name: «WORLD*
Enter an option [New/Move/orthoGraphic/Prev/Restore/
Save/Del/Apply/?/World] <World>: _o
Specify new origin point <0,0,0>: указать новую точку ПСК

Задать пользовательскую
систему координат

ucs k!
Падающее меню Tools - New UCS -3 Ро/П t

Current UCS name: *WORLD*
Enter an option [New/Move/orthoGraphic/Prev/Restore/
Save/Del/Apply/?/World] <World>: _3
Specify new origin pojnt <0,0,0>: указать центр ПСК точку 1
Specify point on positive portion of X—axis точку 2 (ось ОХ)
Specify point on positive-Y portion of the UCS XY plane точку З (ось Of)
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Задать мировую систему координат (Ucs3

ucs t>*
Падающее меню TOO/S •New UCS World

Current UCS name: *NO NAME* .

Enter an option [New/Move/orthoGraphic/Prev/Restore/

Save/Del/Apply/?/World] <World>: _w



ГЛАВА 3 Свойства примитивов

Q Разделение рисунка по слоям
Q Управление видимостью слоя
Q Блокировка слоев
Q Назначение цвета слою
Q Назначение типа линии слою
[Л Назначение веса (толщины) линии

слою
О Фильтрация слоев
Q Использование свойств слоев
Q Палитра свойств объектов

3 Зак. 1039
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Слои подобны лежащим друг на друге прозрачным листам кальки. На различных
слоях группируются различные типы данных рисунка. Любой графический объект
рисунка обладает такими свойствами, как цвет, тип и вес (толщина) линии, стиль
печати. При создании объекта значения этих свойств берутся из описания слоя, на
котором он создается. При необходимости свойства любого объекта можно изме-
нить. Использование цвета позволяет различать сходные элементы рисунка. При-
менение линий различных типов помогает быстро распознавать такие элементы,
как осевые или скрытые линии. Вес (толщина) линии определяет толщину начер-
тания объекта и используется для повышения наглядности рисунка. Расположе-
ние объектов на различных слоях позволяет упростить многие операции по управ-
лению данными рисунка.

Разделение рисунка по слоям

Построенные объекты всегда размещаются на определенном слое. Например, один
слой может содержать несущие конструкции, стены, перегородки здания, другой
слой — коммуникации, электрику и т. п., а третий — мебель, элементы дизайна
и т. д. Таким образом, комбинируя различные сочетания слоев, можно компоно-
вать необходимые комплекты конструкторской документации.

Слои могут применяться по умолчанию, а также определяться и именоваться са-
мим пользователем. С каждым слоем связаны заданные цвет, тип, вес (толщина)
линии и стиль печати. Размещая различные группы объектов на отдельных слоях,
можно структурировать рисунок. Послойная организация чертежа упрощает мно-
гие операции по управлению его данными.

Например, можно создать отдельный слой для размещения осевых линий, назначить
ему голубой цвет и штрихпунктирный тип линии CENTER. Впоследствии, если
потребуется построить осевую линию, достаточно переключиться на этот слой и
начать рисование. Таким образом, перед каждым построением осевых линий не
требуется вновь устанавливать их цвет и тип. Кроме того, при необходимости ото-
бражение слоя можно отключить. Возможность использования слоев — одно из
главнейших преимуществ рисования в среде AutoCAD перед черчением на бумаге.

Работая в пространстве листа или с плавающими видовыми экранами, можно
установить видимость слоя индивидуально для каждого видового экрана. При не-
обходимости показ какого-либо слоя на экране или его вывод на печать легко
отключить. Для всех слоев действуют одни и те же установки лимитов рисунка,
системы координат и коэффициента экранного увеличения. Если какая-либо со-
вокупность слоев используется часто, то эти слои, цвета и типы линий рекоменду-
ется сохранить в шаблоне. Слои представляют собой неграфические объекты, ко-
торые также хранятся в файле рисунка.

Щ Управление установками свойств слоев осуществляется в диалоговом окне
Layer Properties Manager, показанном на рис. 3.1. Оно загружается из падающего
меню Format > Layer... или щелчком по пиктограмме Layer Properties Manager на
панели инструментов Layers.
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Рис. 3.1. Диалоговое окно управления слоями

При создании нового рисунка автоматически создается слой, названный 0, кото-
рому присваиваются белый цвет, непрерывный тип линии Continuous, вес (толщи-
на) линии Default, по умолчанию соответствующий толщине 0.25 мм. Этот слой не
может быть удален и переименован.

Слои обладают следующими свойствами:

О Status — состояние слоя. Назначение слою статуса текущего;

Q Name — имя слоя. Состоит из алфавитно-цифровой информации, включающей
специальные символы и пробелы;

О On — видимость слоя. При этом на экране изображаются только те примитивы,
которые принадлежат видимому слою, однако примитивы в скрытых слоях яв-
ляются частью рисунка и участвуют в регенерации;

О Freeze — замораживание слоя. Означает отключение видимости слоя при реге-
нерации и исключение из генерации примитивов, принадлежащих заморожен-
ному слою;

G Lock — блокировка слоя. Примитивы в блокированном слое отображаются,
но их нельзя редактировать. Блокированный слой можно сделать текущим, ри-
совать в нем, замораживать и применять к его примитивам команды справок
и объектную привязку;

Q Color — цвет примитивов заданного слоя;

Q Linetype — тип линии, которым будут отрисовываться все примитивы, принад-
лежащие слою;

Q Lineweight — вес (толщина) линии, которой будут отрисовываться все прими-
тивы, принадлежащие слою;
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Q Plot style — стиль печати для заданного слоя;

Q Plot — разрешение/запрет вывода слоя на печать;

Q Description — описание слоя.

|Ц| Для создания нового слоя необходимо щелкнуть мышью по пиктограмме New
Layer (Alt+N), которая находится в верхней части диалогового окна Layer Properties
Manager, показанного на рис. 3.1. Создается слой, по умолчанию названный
Layerl. Далее все новые слои автоматически именуются Layer2, Layers и т. д. —
в порядке их создания. Чтобы присвоить слою уникальное имя, необходимо
двойным щелком мыши по текущему названию активизировать поле ввода
текста, а затем набрать имя с клавиатуры и нажать клавишу Enter.

Если при создании нового слоя выделен один из имеющихся, то новый слой на-
следует его свойства. При необходимости свойства нового слоя можно изменить.

Все вновь создаваемые в AutoCAD объекты размещаются на текущем слое. При
установке нового текущего слоя все объекты будут создаваться на нем с использо-
ванием назначенных ему цвета и типа линии. Замороженные и зависимые от ссы-
лок слои нельзя сделать текущими.

Для того, чтобы сделать слой текущим, необходимо установить указатель
мыши в графе Status соответствующего слоя и щелкнуть по пиктограмме Set
Current (Alt+C), находящейся в верхней части диалогового окна Layer Properties
Manager (см. рис. 3.1). Сделать слой текущим можно двойным щелчком мыши
в графе Status соответствующего слоя, или использовать системную перемен-
ную CLAYER.

Установить текущий слой также можно, выбрав его из раскрывающегося списка
управления слоями на панели инструментов (рис. 3.2).

•

•a ц*?

Рис. 3.2. Список управления слоями

ЛЩ Кроме того удобно устанавливать слой объекта текущим. Для этого следует
выбрать этот объект, а затем щелкнуть по пиктограмме Make Object's Layer
Current на панели инструментов Layers.

Для удобства список слоев, выводимый в диспетчере свойств слоев Layer Properties
Manager, можно упорядочить по любому свойству слоя. Допускается сортировка
слоев по их имени, видимости, цвету, типу, весу (толщине) линии или стилю пе-
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чати. Для сортировки списка достаточно щелкнуть по заголовку столбца того па-
раметра, по которому нужно отсортировать слои. Имена слоев могут быть отсор-
тированы в алфавитном порядке, как прямом, так и обратном.

Выполните упражнение La из раздела 2.

Создать новый слой Оси
с типом линии Center2 La

Llayer Подающее меню Form О t •- Layer...

В диалоговом окне Layer Properties Manager оыорать U-—te—IJ .
8 появившемся поле нового слоя ввести имя Оси.

В области Linetype слоя Оси выбрать CONTINUOUS.
В диалоговом окне Select Linetype Ьыорать кнопку ;' i1"**-: J.

8 диалоговом окне Load or Linetypes выбрать CENTER2.
б диалоговом окне Layer Properties Manager установить CENTER2.

Сформировать отрезок о слое Оси,

Управление видимостью слоя
AutoCAD не отображает на экране объекты, расположенные на невидимых слоях,
и не выводит их на плоттер. Если при работе с деталями рисунка на одном или
нескольких слоях чертеж слишком загроможден, допускается отключение или за-
мораживание неиспользуемых слоев. Кроме того, чтобы запретить вывод на печать
объектов определенных слоев, например для вспомогательных линий, можно оста-
вить эти слои видимыми, но отключить их вывод на печать.

Выбор способа отключения показа слоев зависит от характера их использования
и от сложности рисунка. Замораживать слои лучше в тех случаях, когда отображе-
ние слоя можно отключить на длительное время. При этом ускоряется выполне-
ние команд зумирования ZOOM, панорамирования PAN и VPORTS, упрощается вы-
бор объектов и снижается время регенерации сложных рисунков.

Объекты замороженных слоев не обрабатываются функциями регенерации, скры-
тия и тонирования. Разрешается замораживать и размораживать слои только на
активном плавающем видовом экране.

При создании новых плавающих видовых экранов можно автоматически замора-
живать на них определенные слои. Например, допустимо скрытие размеров путем
замораживания слоя с размерными линиями для всех новых видовых экранов.
Если же на новом видовом экране требуется отображение размеров, для этого ви-
дового экрана можно разморозить соответствующий слой. Включение или отклю-
чение заморозки слоев для новых видовых экранов не изменяет видимость слоев
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на уже имеющихся видовых экранах. В тех случаях, когда требуются частые на-
стройки отображения слоев, лучше использовать их отключение, а не заморажи-
вание. При размораживании слоя выполняется регенерация рисунка, после чего
находящиеся на этом слое объекты становятся видимыми.

На печать могут выводиться только объекты включенных и размороженных сло-
ев. Видимый слой печатается только в том случае, если не отключен его вывод на
печать.

Объекты отключенных слоев участвуют в регенерации, хотя и не выводятся на
экран или плоттер. Чтобы сделать слой временнй невидимым, его лучше отклю-
чить, а не заморозить, так как при размораживании слоя всегда выполняется реге-
нерация рисунка. При включении слоя выполняется перерисовка объектов данно-
го слоя.

Для отключения слоя необходимо в диалоговом окне Layer Properties Manager, пока-
занном на рис. 3.1, навести указатель мыши на имя отключаемого слоя и затем
щелкнуть по пиктограмме On. Аналогично происходит и замораживание слоя при
щелчке по пиктограмме Freeze.

Кроме того, управлять видимостью слоев можно в раскрывающемся списке управ-
ления слоями на панели инструментов (см. рис. 3.2).

Предусмотрена возможность запрещать печать любого слоя, даже видимого. Если
слой содержит, например, только справочную информацию, то его вывод на печать
можно отключить. Запрещение печати слоя не изменяет его отображения на экра-
не. Поэтому запрет печати удобно использовать для слоев, содержащих вспомога-
тельные элементы построений. При этом перед выводом рисунка на печать такие
слои не требуется отключать. Запрет печати любого слоя осуществляется в диало-
говом окне Layer Properties Manager (см. рис. 3.1). С этой целью требуется выделить
слои, для которых необходимо разрешить или запретить вывод на печать, и щелк-
нуть мышью по пиктограмме Plot.

Блокировка слоев
Блокировку слоев полезно применять в случаях, когда требуется редактирование
объектов, расположенных на определенных слоях, с возможностью просмотра объек-
тов на других слоях. Редактировать объекты на блокированных слоях нельзя. Од-
нако они остаются видимыми, если слой включен и разморожен. Можно сделать
блокированный слой текущим и создавать на нем объекты.

Допускается также применение на блокированных слоях справочных команд
к объектам и привязка к ним с помощью режимов объектной привязки.

Блокированные слои можно включать и отключать, а также изменять связанные
с ними цвета и типы линий.

Блокировка слоя включается либо в диалоговом окне Layer Properties Manager, по-
казанном на рис. 3.1, либо в раскрывающемся списке управления слоями из стро-
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ки свойств объектов (см. рис. 3.2) — щелчком мыши по пиктограмме Lock соответ-
ствующего слоя.

Назначение цвета слою
Присвоение цветов слоям осуществляется в диспетчере свойств слоев Layer Properties
Manager, показанном на рис. 3.1, для чего необходимо щелкнуть мышью по пикто-
грамме Color соответствующего слоя. При этом загружается диалоговое окно Select
Color, предлагающее выбрать оттенок из палитры (рис. 3.3). Можно ввести либо его
имя, либо номер в таблице индексов цветов ACI (AutoCAD Color Index). Стандарт-
ные имена присвоены только цветам с номерами от 1 до 7.

Рис. 3.3. Диалоговое окно выбора цвета

Кроме того, могут быть заданы ключевые слова ByLayer и ByBlock. ByLayer означает,
что примитив будет создаваться в соответствии с цветом, определенным для те-
кущего слоя. ByBlock означает, что объекты будут изображаться белым цветом до
тех пор, пока их не объединят в блок. Куда бы затем ни был вставлен блок, объек-
ты приобретут текущий цвет.

Интерес представляет работа с альбомами цветов (вкладка Color Books), которые
содержат именованные образцы, что позволяет улучшить вид рисунка и подгото-
вить высококачественные презентационные материалы.

Назначение типа линии слою
Применение различных типов линий — еще один способ визуального представле-
ния информации. Различные типы линий отражают их разное назначение. Тип
линии описывается повторяющейся последовательностью штрихов, точек и про-
белов. Линии сложных типов, кроме того, могут включать в себя различные сим-
волы. Пользователь имеет возможность создавать собственные типы линий.
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Конкретные последовательности штрихов и точек, относительные длины штрихов
и пробелов, а также характеристики включаемых текстовых элементов и форм
определяются именем типа линии, а также его описанием.

Назначение типа линии слою осуществляется в диспетчере свойств слоев Layer
Properties Manager. Для этого необходимо щелкнуть мышью по пиктограмме Linetype
соответствующего слоя. В открывшемся диалоговом окне Select Linetype, показан-
ном на рис. 3.4, выбирается подходящий тип линии.
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Рис. 3.4. Диалоговое окно установки типа линии

Если в предлагаемом списке нет нужного варианта, следует подгрузить его, щелк-
нув мышью по кнопке Load... и указав в открывшемся диалоговом окне Load or
Reload Linetypes подходящий образец линии (рис. 3.5). Затем, вернувшись в диало-
говое окно Select Linetype, установить указатель мыши на требуемый тип линии.
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Рис. З.5. Диалоговое окно подгрузки различных типов линий

Ключевое слово ByLayer означает, что примитив будет создаваться в соответствии
с типом линии, определенным для текущего слоя. Ключевое слово ByBlock означа-
ет, что примитивы будут изображаться сплошными (continuous) линиями. Если
эти объекты объединены в блок, им присваивается тип линии, установленный для
слоя, которому принадлежит точка вставки блока.
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Длина штрихов и пробелов, составляющих штрихпунктирную линию, измеряется
в условных единицах.

Начальная установка масштаба типа линии для каждого рисунка — одна единица.
AutoCAD позволяет изменять масштаб изображения линии. Текущее значение
масштабного коэффициента хранится в системной переменной LTSCALE.

Имеется возможность переименовывать типы линий в любой момент редактиро-
вания рисунка.

Переименование какого-либо типа линии приводит к изменению его описания,
используемого в текущем рисунке. Название этого типа линии в библиотечном
LIN-файле остается прежним.

Нельзя изменить имена типов линий ByLayer, ByBlock и Continuous, а также типов
линий, зависящих от внешних ссылок.

Типы линий можно сортировать по имени и по описанию. При этом типы линий
ByLayer и ByBlock всегда находятся в начале списка. Названия типов линий могут
быть отсортированы в алфавитном порядке, как прямом, так и обратном.

Типы линий можно назначать любым объектам AutoCAD, кроме текстовых объек-
тов, точек, видовых экранов, бесконечных прямых, лучей, трехмерных полилиний
и блоков. Если длина объекта меньше длины элементарного фрагмента типа ли-
нии, такой объект отрисовывается сплошной линией.

Для двумерной полилинии имеется возможность центрировать образец типа ли-
нии в пределах каждого сегмента либо размещать образец непрерывно по всей ее
длине. Управляет этими режимами системная переменная PLINEGEN.

Назначение веса (толщины) линии слою
Веса линий определяют толщину начертания объектов и используются при выво-
де объектов как на экран, так и на печать. Веса (толщины) линий игнорируются
для шрифтов True Type, растровых изображений, точек и заливок (для плоских
фигур). Назначение слоям и объектам различных весов позволяет повысить на-
глядность рисунка. Веса линий можно выбирать из определенного ряда значений,
среди которых есть специальный вес под названием Default. По умолчанию вес
линии Default соответствует толщине 0.25 мм (0,01 дюйм).

Вес линии устанавливается в диспетчере свойств слоев Layer Properties Manager. Для
этого необходимо щелкнуть мышью по пиктограмме Lineweight соответствующего
слоя, а затем в раскрывшемся диалоговом окне Lineweight выбрать из списка под-
ходящее значение (рис. 3.6).

Веса линий позволяют получать тонкие и толстые линии, что требуется при оформ-
лении чертежей (при построении разрезов, сечений, нанесении размеров), карт
и т. д. Например, назначив слоям различные веса линий, можно облегчить иден-
тификацию зданий, находящихся в эксплуатации, строящихся или подлежащих
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сносу. Веса линий могут применяться для графического выделения различных
объектов и информации аналогично тому, как это делается при черчении с по-
мощью карандаша и линейки. Однако веса линий лучше не использовать в тех слу-
чаях, когда у объектов должны быть произвольные или нестандартные значения
толщины начертания. Например, если толщина линий объекта должна составлять
ровно 5 мм, то для его построения следует использовать двумерную полилинию
шириной 5 мм.

РИС. 3.6. Диалоговое окно установки веса линии

При выводе на печать толщина начертания объекта определяется назначенным
ему весом линии.

Веса линий могут выбираться из фиксированного ряда значений, среди которых
есть специальные веса ByLayer, ByBlock и Default. Значения весов линий могут вы-
ражаться в миллиметрах или дюймах (по умолчанию используются миллиметры).

Новым слоям по умолчанию назначается вес линии Default. В пространстве моде-
ли нулевое значение веса линии соответствует линии толщиной в один пиксел, а
при выводе на печать — наименьшей величине, обеспечиваемой используемым
печатающим устройством. Все объекты, вес линии которых не превышает 0,025 мм
(0,01 дюйм), отрисовываются в пространстве модели линией толщиной в один
пиксел. Значения весов линии, вводимые в командной строке, округляются до
ближайшей стандартной величины.

Информация о весе линии сохраняется при экспорте рисунка в другие форматы
и при копировании объектов в буфер обмена. Выбрать единицы представления
веса линий и задать значение для веса Default можно в диалоговом окне Lineweight
Settings, показанном на рис. 3.7.

Для вызова этого окна необходимо либо щелкнуть правой кнопкой мыши по кноп-
ке LWT в строке состояния и выбрать пункт Settings... из контекстного меню, либо
нажать кнопку Lineweight Settings... на вкладке User Preferences диалогового окна
Options, либо использовать команду LWEIGHT.



Назначение веса (толщины) линии слою * 75

j ' b slaii'.'••;';;

!
|pI;Dilii:J№

Рис. 3.7. Диалоговое окно установки параметров весов линий
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Системная переменная LWUNITS.устанавливает единицы представления весов ли-
ний (миллиметры или дюймы), используемые при создании новых объектов и сло-
ев. Переменная LWDEFAULT устанавливает значение веса линии Default.

Способы отображения весов линий в пространствах модели и листа несколько раз-
личаются.

В пространстве модели каждому значению веса линии соответствует определен-
ное число пикселов, определяющих видимую на экране толщину линий.

В пространстве листа видимая на экране толщина начертания объекта устанавли-
вается пропорциональной текущему коэффициенту экранного увеличения. Ис-
пользование в пространстве модели фиксированного числа пикселов для каждого
веса линии облегчает идентификацию объектов по их толщине при любом коэф-
фициенте экранного увеличения. При этом необходимо помнить, что в простран-
стве модели видимая толщина линий может не соответствовать их действительной
толщине. Значению веса линии 0 в пространстве модели всегда соответствует ли-
ния толщиной в один пиксел. Толщина отображения остальных весов линий
(в пикселах) устанавливается пропорционально их точным значениям.

В пространстве модели, когда включен режим отображения весов линий, в точках
соединения концов отдельных отрезков используется соединение со скосом без
окончаний линий. При этом угол скоса подбирается автоматически. Окончания
линий определяют способ изображения концов отрезков и могут, например, пред-
ставлять закругление или скос. При выводе на печать с помощью стилей печатей
можно задавать различные типы соединений и окончания линий для различных
весов линий.

В пространстве модели в режиме отображения весов линий толщина начертания
любого объекта не зависит от коэффициента экранного увеличения. Например,
если весу линии соответствует толщина четыре пиксела, то объекты с таким весом
всегда отрисовываются линией толщиной четыре пиксела даже при уменьшении
экранного изображения до максимально возможного значения.

Можно задавать масштаб отображения весов линий и изменять таким образом
число пикселов, соответствующих весам линий в пространстве модели. Изменение
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масштаба отображения не влияет на толщину линий при выводе на печать. Сле-
дует отметить, что если используемые веса линий представлены более чем одним
пикселом, то время регенерации рисунка возрастает. Если устанавливаемый по
умолчанию масштаб отображения не изменялся, то веса линий, меньшие или рав-
ные 0,025 мм (0,01 дюйм), отображаются толщиной в один пиксел и потому не сни-
жают скорость работы AutoCAD. При изменении масштаба отображения весов
линий число весов, соответствующих толщине в один пиксел, также изменяется.
Для повышения скорости работы AutoCAD в пространстве модели можно умень-
шить масштаб экранного отображения весов линий или вообще отключить веса
линий.

Фильтрация слоев

Иногда требуется, чтобы в списке имеющихся слоев диалогового окна Layer Properties
Manager перечислялись только определенные слои. Для указания выводимых в спи-
сок слоев используется функция фильтрации.

Фильтрация слоев может производиться по следующим критериям:

Q по именам, цветам и типам линий, весам линий и стилям печати, назначенных
слоям;

Q по состояниям слоев «включен/отключен»;

Q по состояниям слоев «заморожен/разморожен»;

FJ по состояниям слоев «блокирован/разблокирован»;

О по состояниям слоев «печатать/не печатать»;

d по наличию/отсутствию слоев в текущем рисунке;

Q по наличию/отсутствию зависимостей слоев от внешних ссылок.

Использование свойств слоев
Имеется возможность присваивать свойства как слоям, так и непосредственно
объектам рисунка. При построении нового объекта ему автоматически назначают-
ся цвет, тип и вес линии, а также стиль печати ByLayer. Если свойство объекта име-
ет специальное значение ByLayer, фактическое значение этого свойства определя-
ется параметром того слоя, на котором находится объект.

Например, при построении на слое, которому назначены зеленый цвет, тип линии
Continuous, вес линии 0.25 мм и стиль печати Default, новый объект отображается с
использованием именно этих значений. Применение специального значения ByLayer,
доступного для таких свойств объекта, как цвет, тип линии, вес линии и стиль пе-
чати, упрощает управление и манипуляцию объектами рисунка. Кроме того, по-
слойная организация чертежа упрощает визуальную идентификацию различных
его элементов (болтов, прокладок, номеров деталей и т. д.) по свойствам слоев, на
которых они располагаются.
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Если необходимо, любому объекту можно присвоить цвет, тип линии, вес линии
или стиль печати, отличный от соответствующего свойства слоя, на котором рас-
полагается объект. Свойство объекта может иметь какое-либо определенное зна-
чение (например, «красный» для цвета) или одно из специальных значений ByLayer
либо ByBlock. Новое значение свойства объекта используется вместо соответству-
ющего свойства слоя до тех пор, пока этому свойству не будет возвращено значе-
ние ByLayer.

При выборе значения ByBlock свойства новых объектов используют стандартные
значения до тех пор, пока объекты не будут объединены в блок. После создания
блока из таких объектов значения их свойств определяются свойствами слоя, в ко-
торый вставляется блок.

Рассмотрим пример: блок с именем СТУЛ образован из двух объектов, сиденья
и спинки. Исходные объекты, изображающие сиденье и спинку стула, находятся
соответственно на слоях СИДЕНЬЕ и СПИНКА. Пусть блок СТУЛ вставляется
в слой с именем МЕБЕЛЬ, которому назначен фиолетовый цвет. Если до созда-
ния блока объекты, соответствующие спинке и сиденью, имели цвет ByLayer, то не-
зависимо от слоя, в который вставлен блок, цвет сиденья и спинки будет опреде-
ляться текущим значением цвета слоев СИДЕНЬЕ и СПИНКА. Если до создания
блока объекты, соответствующие спинке и сиденью, имели цвет ByBlock, то цвет си-
денья и спинки будет определяться текущим цветом того слоя, в который встав-
лен блок (в данном случае это фиолетовый цвет).

Для быстрого просмотра и изменения цвета, типа линии и ее веса можно исполь-
зовать строку свойств объектов (см. рис. 1.10).

При выборе объекта, если ни одна из команд не активна, динамически отобража-
ются слой, цвет, тип и вес линии данного объекта. Параметры выбранного объекта
можно изменить, настроив их в раскрывающихся списках управления цветом, типом
или весом линии, но при этом не должна выполняться ни одна команда. Чтобы
сделать цвет, тип или вес линии текущими, достаточно выбрать их соответствен-
но из раскрывающихся списков управления свойствами линии.

Палитра свойств объектов

Щ Палитра Properties, показанная на рис. 3.8, — это единый инструмент, управля-
ющий практически всеми свойствами объектов рисунка. В палитре собрано
около 40 диалоговых окон и команд, которые были разрознены в более ранних
версиях AutoCAD. Загружается она командой PROPERTIES, либо из падающе-
го меню Modify > Properties, либо щелчком по пиктограмме Properties (Ctrl+1) на
стандартной панели инструментов.

Палитра Properties позволяет производить фильтрацию наборов выбранных объек-
тов по их типу, предоставляя возможность редактировать свойства каждого объек-
та. В случае если текущий набор объектов не создан, показывается текущее состо-
яние таких свойств рисунка, как стиль вывода на печать, ПСК, данные о видовых
экранах, гиперссылки.
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Рис. 3.8. Палитра свойств объектов
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Изменить цвет объекта

Properties^
Падающее меню Modify •- Properties

Выдрать редактируемый объект.

В палитре свойств Properties щелкнуть мышью Ъ поле Color.

Щелкнуть мышью по появившейся справа стрелочке

и выбрать в раскрывающемся списке желаемый оттенок.

Назначить контуру цвет Red.

Осевой линии назначить цвет Yellow.
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Properties *f
Падающее меню Modify •- Properties

Выбрать редактируемый объект.
В палитре свойств Properties щелкнуть мышью в поле Linetype.

Щелкнуть мышью по появившейся справа стрелочке

и выбрать в раскрывающемся списке желаемый тип линии.
Осевой линии назначить тип CENTER.
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Изменить тип линии объекта Грг4
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Properties"^
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Выбрать редактируемый объект.
В палитре свойств Properties щелкнуть мышью о поле Layer.

Щелкнуть мышью по появившейся справа стрелочке
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Изменить текст и его стиль

Properties 'L.
Падающее меню Modify ^-Properties

Выбрать редактируемый текст.
В палитре свойств Properties
6 поле Contents ввести NEW TEXT
в поле J u s t i f y установить Left
в поле Layer установить ГРАФИКА

в поле Style установить Нобый текст

Изменить ширину полилинии (Ре?
V ̂

Select polyline: указать на контур детали
Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/
/Decurve/Ltype gen/Undo]: W режим изменения ширины полипинии

Specify new width for all segments: 3 ширина

Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/
/Decurve/Ltype gen/Undo]: Enter
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Q Зумирование
О Панорамирование
Q Использование окна общего вида
Q Перерисовка и регенерация
Q Изменение порядка рисования

объектов
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Система AutoCAD обладает широкими возможностями отображения различных
видов рисунка. Предусмотрены команды, которые позволяют при редактировании
чертежа быстро перемещаться от одного его фрагмента к другому для визуального
контроля внесенных изменений. Можно зумировать изображение, изменяя его
экранное увеличение, или производить панорамирование, перемещая рисунок по
видовому экрану; также допускаемся сохранение выбранного вида с его последу-
ющим восстановлением для вывода на печать или просмотра. Кроме того, обеспе-
чивается одновременный просмотр различных участков рисунка путем разделе-
ния его области на несколько неперекрывающихся видовых экранов.

Зумирование
Видом называется совокупность экранного увеличения, положения и ориентации
части рисунка, видимой на экране. Основной способ изменения вида — выбор од-
ного из имеющихся в AutoCAD режимов зумирования, при котором размер изоб-
ражения фрагмента в области рисунка увеличивается или уменьшается.

При зумировании либо увеличивают изображение с целью большей детализации,
либо уменьшают для того, чтобы на экране помещалась большая часть рисунка
(рис. 4.1,4.2).

Рис. 4.1. Уменьшенное изображение рисунка

Рис. 4.2. Увеличенное изображение рисунка
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При зумировании абсолютные размеры рисунка остаются прежними — изменяет-
ся_лишь размер его части, видимой в графической области. В AutoCAD существу-
ют различные способы изменения вида, в том числе указание его границ рамкой,
изменение коэффициента увеличения/уменьшения на заданную величину и по-
каз рисунка в его границах.

Операция зумирования осуществляется командой ZOOM, вызываемой из падающе-
го меню View > Zoom, как показано на рис. 4.3, либо же из стандартной (рис. 4.4) или
плавающей панели инструментов Zoom.

>

Рис. 4.3. Команда зумирования в падающем меню

lillfpiieillpll

Рис. 4.4. Команда зумирования в стандартной панели инструментов

Запрос команды ZOOM:

Specify corner of window, enter a scale factor (nX or n X P ) , or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real
time>: — указать угол рамки, ввести масштаб.

Команда ZOOM на стандартной панели инструментов имеет несколько исполнений.
Ниже приводится подробное описание каждого их них.
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Щ; Zoom Realtime — увеличение и уменьшение масштаба изображения в режиме
реального времени.

Команда ZOOM с ключом real time обеспечивает возможность интерактивного
зумирования изображения. При перемещении указателя мыши по видовому экра-
ну происходит динамическое увеличение или уменьшение выводимого на экране
рисунка. Для активизации функции зумирования в реальном времени можно либо
выбрать команду из падающего меню View > Zoom > Realtime (см. рис. 4.3), либо
щелкнуть мышью по пиктограмме Zoom Realtime на стандартной панели инстру-
ментов (см. рис. 4.4), либо ввести слово ZOOM в командной строке с ключом real
time. Этот ключ используется по умолчанию при вызове команды ZOOM. При на-
жатии клавиши Enter после ввода команды в командной строке устанавливается
режим зумирования в реальном времени. В этом режиме пользователь может из-
менять экранное увеличение выводимого изображения, перемещая вверх или вниз
по видовому экрану указатель мыши. Поместив его в середину изображения на
экране и удерживая нажатой кнопку мыши, можно увеличить или уменьшить
изображение на 100 %, переместив указатель соответственно в верхнюю или ниж-
нюю часть видового экрана.

Если отпустить кнопку мыши, зумирование приостанавливается. Пользователь мо-
жет отпустить кнопку, переместить указатель в другую позицию на рисунке, а за-
тем снова нажать, чтобы продолжить зумирование в новой позиции.

Для выхода из режима зумирования можно использовать контекстное меню, вы-
брав в нем опцию Enter или нажав на клавиатуре клавишу Esc.

Если применяется функция предварительного просмотра печатаемого чертежа, то
пределы зумирования ограничены разрешающей способностью используемого
плоттера. При увеличении изображения в окне предварительного просмотра опе-
рация зумирования прекращается в тот момент, когда точка на экране в точности
соответствует точке (или шагу) используемого плоттера. Увеличение изображе-
ния при зумировании в окне предварительного просмотра допускается только до
тех пределов детализации изображения, которые может обеспечить плоттер или
принтер.

По достижении предела увеличения изображения на текущем виде символ «плюс»
(+) на указателе зумирования исчезает, что свидетельствует о невозможности
дальнейшего зумирования в данном направлении. Аналогичным образом при
уменьшении рисунка до предела (до границ текущего вида) на указателе зумиро-
вания исчезает символ «минус» (-). Еще больше уменьшить рисунок после выво-
да границ текущего вида нельзя.

Щ Zoom Window — определение области отображения с помощью рамки. Для это-
го следует задать два противоположных угла прямоугольной рамки. При этом
левый нижний угол обозначенной рамки становится левым нижним углом
нового вида. Форма нового вида может несколько отличаться от формы рам-
ки, так как при зумировании вид вписывается в область рисунка. Команда
ZOOM с ключом Window выдает следующие запросы:
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Specify corner of window, enter a scale factor (nX or n X P ) , or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real
time>: _W

Specify f irst corner:— указать первый угол рамки;

Specify opposite corner:—указать противоположный угол рамки.

Ц| Zoom Dynamic — динамическое определение области отображения. Используется
для изменения вида без регенерации рисунка. Команда ZOOM с ключом Dynamic
отображает видимую часть рисунка в рамке, представляющего текущий вид.
Путем перемещения этой рамки и изменения ее размеров выполняются зуми-
рование и панорамирование рисунка. Видовое окно перемещается по рисунку
при нажатой левой кнопке мыши; аналогичным способом изменяются и раз-
меры окна. Видовое окно можно передвигать по изображению, когда окно со-
держит символ X, и изменять его размеры в состоянии, когда имеется символ ®.
Переключение из одного состояния в другое осуществляется щелчком левой
кнопки мыши. При нажатии клавиши Enter изображение, заключенное в видо-
вом окне, выводится на видовой экран. В зависимости от используемого ви-
деомонитора границы текущего вида обозначаются зеленой пунктирной линией,
а границы рисунка — синей. Границы рисунка в данном случае либо соответ-
ствуют лимитам рисунка, либо ограничивают область, реально занимаемую
изображением (если она выходит за пределы лимитов).

Ц1 Zoom Scale — установка масштабного коэффициента увеличения. Масштаби-
рование вида используется в том случае, если изображение требуется умень-
шить или увеличить на точно заданную величину. При этом необходимо ука-
зать коэффициент экранного увеличения одним из трех способов:

Q относительно лимитов рисунка;

Q относительно текущего вида;

Q относительно единиц пространства листа.

Команда ZOOM с ключом Scale выдает следующие запросы:

Specify corner of window, enter a scale factor (nX or n X P ) , or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real
time>: _S

Enter a scale factor (nX or nXP) : —указать масштабный коэффициент.

Чтобы экранное увеличение было задано относительно лимитов рисунка, доста-
точно лишь ввести значение коэффициента. Например, если это 1, то в графиче-
ской области будет располагаться рисунок в своих лимитах. Центр рисунка совпа-
дает с центром предыдущего вида. Для увеличения или уменьшения изображения
следует указать соответственно большее или меньшее значение коэффициента.
Если ввести 2, изображение будет вдвое больше, чем при коэффициенте 1, а если
ввести 0.5, — вдвое меньше.
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Для масштабирования вида относительно текущего нужно после значения коэф-
фициента добавить латинскую букву х. Так, для увеличения изображения текуще-
го вида вдвое понадобится ввести 2х, а для уменьшения вдвое — 0 . 5х. Ввод 1х не
изменяет изображение.

ЛЦ Zoom Center — определение области изображения путем ввода точки центра
и высоты окна в единицах рисунка. Команда ZOOM с ключом Center выдает
следующие запросы:

Specify corner of window, enter a scale factor (nX or n X P ) , or
[All/Center/Dynamic/Extents/Previous/Sca-le/Window/Object] <real
time>: _C

Specify center point :— указать центральную точку;

Enter magnification or he ight :— указать увеличение или высоту.

Для указания высоты можно использовать абсолютное значение — число. При этом
изменение происходит относительно полного вида.

Если требуется задать изменение масштаба относительно текущего вида, за чис-
лом следует ввести латинскую букву х.

При работе с плавающими видовыми окнами для увеличения вида относительно
пространства листа необходимо ввести после числа латинские буквы хр.

Щ Zoom Object — отображение области, которая содержит выбранные объекты. Ко-
манда ZOOM с ключом Object производит вычисление коэффициента экран-
ного увеличения с учетом границ, в которые вписан выбранный объект, и вы-
дает следующие сообщения:

Specify corner of window, enter a scale factor (nX or n X P ) , or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real
time>: _0

Select objects: — выбрать объекты.

• Zoom In — увеличение изображения. Команда ZOOM с ключом 2х выдает следу-
ющие сообщения:

Specify corner of window, enter a scale factor (nX or n X P ) , or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real
time>: 2x

ЛЦ Zoom Out — уменьшение изображения. Команда ZOOM с ключом . 5х выдает сле-
дующие сообщения:

Specify corner of window, enter a scale factor (nX or n X P ) , or
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real
time>: .5x
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Щ) Zoom All — отображение всей области чертежа или области внутри границ,
если они заданы. Команда ZOOM с ключом All позволяет увидеть на экране
рисунок целиком. Если некоторые его объекты расположены вне лимитов, он
изображается в своих собственных границах. При этом происходит регенера-
ция рисунка. Если все объекты находятся в пределах лимитов, команда выво-
дит чертеж в его лимитах. С помощью данного метода удобно контролировать
размещение объектов относительно области рисования.

Щ Zoom Extents — отображение области, которая содержит все примитивы черте-
жа. Команда ZOOM с ключом Extents производит вычисление коэффициента
экранного увеличения с учетом границ текущего видового экрана, а не текуще-
го вида. Чаще всего видовой экран отображается полностью; в таком случае
результат работы функции очевиден и понятен. Однако, когда команда ZOOM
используется в пространстве модели при работе в видовом экране простран-
ства листа для зумирования за пределами границ этого видового экрана, не-
которая часть зумируемой области может остаться за пределами видимости.

Щ Zoom Previous — использование предыдущего вида рисунка. При работе с мел-
кими деталями часто возникает необходимость уменьшить изображение, что-
бы просмотреть сделанные изменения в общем виде. Для быстрого возврата к
предыдущему виду служит команда ZOOM с ключом Previous. Она восстанав-
ливает только экранное увеличение и положение вида, но не содержимое ре-
дактируемого рисунка.

Программа AutoCAD способна восстанавливать последовательно до 10 преды-
дущих видов.

В это число входят виды, полученные не только при зумировании, но и при пано-
рамировании, восстановлении и установке вида в перспективе или в плане.

Выполните упражнения Z1-Z3 из раздела 2.

Задать область отображения
с помощью рамки Z1

Zoom Window в̂ . Падающее меню View ——- Zoom

Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/.../Previous/Scale/Window] <real time>: _w

Specify first corner: указать точку 1
Specify opposite corner: указать точку 2

Zoom PreVIOUS в*ч отображение предыдущей области рисунка
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Отобразить всю область чертежа Z2

Zoom All Я

Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/.../Scale/Window] <real time>: _all

Задать область отображения
в режиме реального времени

Zoom Realtime LJ
Specify corner of window, enter a scale factor (nX or nXP), or

[All/Center/Dynamic/Extents/Previous/Scale/Window] <reaf timeX

Press ESC or ENTER to exit, or right-click to display shortcut menu.

Для увеличения изображения переместить мышь вверх, удерживая кнопку быбора.

Una уменьшения изображения переместить мышь вниз, удерживая кнопку быбора.

Для выхода из команды нажать Еп 1&Г—•" Exit u/iu CSC

Панорамирование
Щ Pan Realtime — панорамирование в реальном времени.

Команда PAN обеспечивает возможность интерактивного панорамирования изоб-
ражения. При перемещении указателя мыши по видовому экрану происходит ди-
намическое перемещение изображения. Для активизации функции панорамиро-
вания в реальном времени можно либо щелкнуть мышью по кнопке Pan Realtime на
стандартной панели инструментов, либо выбрать команду из падающего меню
View > Pan > Realtime.

Режим панорамирования в реальном времени используется по умолчанию при
вызове команды PAN.

Чтобы изменить положение изображения на видовом экране в режиме панорами-
рования в реальном времени, следует перемещать указатель мыши, удерживая ее
левую кнопку нажатой. Панорамирование может выполняться в одном направле-
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нии до тех пор, пока не потребуется полная регенерация изображения или не бу-
дут достигнуты лимиты рисунка. В этом случае к изображению указателя панора-
мирования добавляется соответствующий направлению символ-ограничитель.

Для выхода из режима панорамирования или переключения между режимами па-
норамирования и зумирования можно использовать контекстное меню; при этом
надо нажать клавишу Enter или Esc.

Выполните упражнение Ра1 из раздела 2.

Г Панорамировать изображение
в режиме реального времени И

Pan Realtime ̂
Press ESC or ENTER to exit, or right-click to display shortcut menu.

Для изменения положения изображения следует

перемешать мышь, удерживая кнопку Ьыбора.

Для быхода из команды нажать Еп {&Г—*- Exit или Esc

Использование окна общего вида
Окно Aerial View, показанное на рис. 4.5, вызывается из падающего меню View > Aerial
View. В нем отображается общий вид рисунка и предоставляется возможность бы-
строго перемещения в любую его часть. Если окно Aerial View открыто в ходе рабо-
ты, можно производить панорамирование и зумирование, не используя опции
меню или ввод команд.

Рис. 4.5. Окно общего вида
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При каждой регенерации рисунка в AutoCAD происходит обновление содержимо-
го виртуального экрана, то есть он очищается и заполняется заново. Окно Aerial
View обеспечивает возможность просмотра содержимого виртуального экрана
AutoCAD.

Это окно работает со всеми видами пространства модели. Его легко отбуксировать
в любое место экрана. Изменение размеров окна производится при помощи бук-
сировки границ.

Открыв окно Aerial View, можно оставить его видимым в ходе работы, а затем, ко-
гда необходимость в нем отпадет, закрыть. Оно позволяет зумировать и панорами-
ровать изображение в окне рисунка AutoCAD в реальном времени.

Зумирование вида может производиться путем создания в окне Aerial View новой
рамки вида. Для увеличения видимых размеров рисунка рамка должна быть мень-
ше, для уменьшения — больше. При создании или изменении размера рамки соот-
ветствующие изменения вида параллельно отображаются в области рисунка.

Панорамирование рисунка выполняется путем перемещения рамки вида без изме-
нения ее размеров. При этом изменяется только вид — экранное увеличение оста-
ется прежним.

Перерисовка и регенерация

Чтобы обновить изображение на экране монитора, его можно перерисовать или
регенерировать.

При регенерации, кроме перерисовки изображения текущего видового экрана,
производится пересчет экранных координат (преобразование значений с плава-
ющей точкой из базы данных в соответствующие целочисленные экранные коор-
динаты) всех объектов базы данных рисунка. Таким образом, перерисовка проис-
ходит быстрее, чем регенерация.

Иногда в процессе работы возникает необходимость полной регенерации рисунка
с пересчетом экранных координат всех объектов. В этом случае AutoCAD выпол-
няет регенерацию автоматически, выдавая соответствующее сообщение.

Команда REDRAWALL перерисовывает или «освежает» текущий видовой экран.
Она вызывается из падающего меню View > Redraw.

Для регенерации рисунка используется команда REGEN, вызываемая из падающе-
го меню View > Regen или View > Regen All.

Изменение порядка рисования объектов

Щ По умолчанию объекты отображаются на экране в порядке их создания. По-
рядок отображения можно изменить, поместив один объект перед другим.
Это существенно, когда один объект перекрывает другой. Изменение порядка
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отображения объектов производится с помощью команды DRAWORDER, кото-
рая вызывается с панелей инструментов Modify II и Draw Order, показанных на
рис. 4.6, 4.7, а также из падающего меню Tools > Draw Order > Bring to Front или
Tools > Draw Order > Send to Back. Эти команды меню обеспечивают соответствен-
но размещение объекта на переднем или заднем плане.

Рис. 4.6. Панель инструментов Modify II

Рис. 4.7. Панель инструментов Draw Order

Выбор пунктов Bring Above Object или Send Under Object приводит к размещению
объектов соответственно впереди или позади заданного объекта.
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Q Объектная привязка координат
G Геометрический примитив
G Точка
О Построение линий
Q Построение криволинейных объектов
Q Текст
Q Блок
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Объектная привязка координат
Объектная привязка — наиболее быстрый способ точно указать точку на объекте,
не обязательно зная ее координаты, а также построить вспомогательные линии.
Например, объектная привязка позволяет построить отрезок от центра окружно-
сти, от середины сегмента полилинии, от реального или видимого пересечения
объектов.

Объектную привязку можно задать в любой момент, когда AutoCAD ожидает вво-
да координат точки. В этом случае указанный режим применяется только к следу-
ющему выбранному объекту. Кроме того, имеется возможность установки одного
или нескольких режимов объектной привязки в качестве текущих.

Таким образом, активизация объектной привязки может осуществляться двумя
способами:

Q разовые режимы объектной привязки, действующие при указании только те-
кущей (одной)точки;

Q текущие режимы объектной привязки, действующие постоянно до их отклю-
чения.

Режимы объектной привязки выбираются на плавающей панели инструментов
Object Snap (рис. 5.1).

Рис. 5.1. Панель инструментов объектной привязки

Можно для выбора ключей объектной привязки использовать контекстное меню,
которое вызывается щелчком правой кнопки мыши в любом месте области рисо-
вания при нажатой клавише Shift.

В режиме объектной привязки точка помечается маркером; его форма зависит от
используемого режима, имя которого появляется возле точки в виде подсказки.

Отел ежи ва н и е

Iff Temporary Tracking Point — точка отслеживания.

Отслеживание применяется для наглядного указания точек, связанных с другими
точками рисунка. Оно может использоваться в любой момент, когда AutoCAD за-
прашивает координаты точки. После включения режима Temporary Tracking Point и
указания первой точки AutoCAD включает ортогональный режим ORTHO и ставит
выбор следующей точки в зависимость от положения вершины вертикальной или
горизонтальной траектории, проведенной из первой точки. Для смены направле-
ния траектории необходимо вернуть указатель мыши в первую точку, а затем пе-
ремещать его в нужном направлении (вертикальном или горизонтальном).
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Направление траектории определяет, какая из координат первой точки (х или у)
сохраняется неизменной, а какая получает новое значение. Если резиновая линия
траектории направлена по горизонтали, изменяется координата х; если же по вер-
тикали — изменяется координата у.

После выбора второй точки и нажатия клавиши Enter для завершения отслежива-
ния AutoCAD фиксирует точку, которая находится на пересечении воображаемых
ортогональных линий, проходящих через две выбранные точки.

Использование режима Temporary Tracking Point — наиболее легкий способ обнару-
жения центральной точки прямоугольника.

Чтобы включить режим отслеживания, необходимо щелкнуть мышью по пикто-
грамме Temporary Tracking Point на стандартной панели инструментов, а затем ука-
зать центры вертикальной и горизонтальной сторон прямоугольника.

Режим Temporary Tracking Point в комбинации с прямым вводом расстояния может
использоваться для размещения объектов или текста на заданном расстоянии от
другого объекта.

После включения режима отслеживания AutoCAD не отображает выбираемые
точки до тех пор, пока этот режим не будет отключен нажатием клавиши Enter.
Поэтому для отслеживания можно использовать любое количество точек.

Смещение

Ц| Snap From — смещение.

Режим объектной привязки From отличается от остальных тем, что позволяет уста-
новить временную базовую точку для построения следующих точек.

Обычно режим смещения используется в сочетании с другими режимами объект-
ной привязки и относительными координатами, поскольку довольно часто требу-
ется определить точку, у которой известны координаты относительно некоторой
точки уже нарисованного объекта.

Конечная точка

Щ Snap to Endpoint — привязка к ближайшей из конечных точек объектов (отрез-
ков, дуг и т. п.).

В случае пространственного моделирования, если объект имеет ненулевую высо-
ту, допускается привязка к его нижней и верхней границам.

В режиме Endpoint привязка может производиться к границам трехмерных тел
и областей, например, к конечной точке (вершине) параллелепипеда.

Выполните упражнение L5 из раздела 2.
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Привязка к конечным точкам примитивов ( L5

Line У
LINE Specify first point: об. прибязка ENDpoint / указание 1

Specify next point or [Undo]: об. прибязка ENDpoint ̂  указание 2

Specify next point or [Undo]: Enter

Средняя точка
ЦР Snap to Midpoint — привязка к средним точкам объектов (отрезков, дуг и т. п.).

Привязка для бесконечных прямых и лучей производится к первой из определя-
ющих их точек. Для сплайнов И.ЭЛЛИПСОБ в режиме Midpoint осуществляется при-
вязка к точке объекта, расположенной на равных расстояниях от начальной и ко-
нечной точек.

В случае пространственного моделирования, если отрезок или дуга имеет ненуле-
вую высоту, можно осуществлять привязку к серединам верхней и нижней границ
объекта. Режим Midpoint позволяет также производить привязку к границам трех-
мерных тел и областей.

Выполните упражнение L6 из раздела 2.

Привязка к средним точкам примитивов (L6

Line /"
LINE Specify first point: об. прибязка MIDpoint / указание )

Specify next point or [Undo]: об. прибязка MiDpoint /• указание 2

Specify next point or [Undo]: Enter
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Пересечение
Цр Snap to Intersection — привязка к точкам пересечениий объектов (отрезков,

окружностей, дуг, сплайнов и т. п.).

В случае пространственного моделирования в режиме Intersection допускается
привязка к угловым точкам объектов, имеющих ненулевую высоту выдавливания.

Если два таких объекта с пересекающимися основаниями имеют одинаковое на-
правление выдавливания, можно произвести привязку к пересечениям их верхней
и нижней границ.

Если высоты объектов различны, точка пересечения определяется объектом с мень-
шей высотой.

Привязка к пересечениям дуг и окружностей, входящих в блоки (в них группы объек-
тов рассматриваются как единый объект), производится только в том случае, если
масштабы вставки блока по осям равны.

К пересечениям отрезков внутри блока сказанное не относится.

Можно осуществлять привязку к пересечениям границ областей и кривых, за ис-
ключением криволинейных границ трехмерных тел.

Режим Intersection позволяет выполнить привязку к точке воображаемого пересе-
чения любых двух объектов. Если в прицел попадает только один из них, AutoCAD
предлагает указать второй и производит привязку к точке, в которой эти объекты
пересекались бы при их естественном удлинении.

Режим расширенного пересечения Extended Intersection включается автоматически
при выборе режима объектной привязки Intersection.

Выполните упражнение L8 из раздела 2.

Привязка к точке пересечения примитивов (|_8

Line /
LINE Specify first point: об. привязка INTersection X указание I

Specify next point or [Undo]: об. прибязка INTersection vv указание 2

Specify next point or [Undo]; Enter

4 Зак. 1039
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Предполагаемое пересечение
:|р Snap to Apparent Intersection — привязка к точке видимого на экране предпола-

гаемого пересечения.

Режим Apparent Intersection ищет точку пересечения двух объектов, которые не име-
ют явной точки пересечения в пространстве. Режим предполагаемого пересечения
обеспечивает эффективную работу с границами областей и кривыми, но не рабо-
тает с границами и углами трехмерных тел. Если объекты находятся в одной пло-
скости, то описываемый режим повторяет возможности режима Intersection. Режим
Apparent Intersection включает в себя два отдельных режима: собственно Apparent
Intersection и расширенное кажущееся пересечение Extended Apparent Intersection.
Привязка в этих режимах может применяться к пересечениям границ областей и кри-
вых, кроме криволинейных границ трехмерных тел.

В режиме Apparent Intersection выполняется привязка к точке пересечения двух
объектов, которые реально не пересекаются в трехмерном пространстве, но на те-
кущем виде выглядят пересекающимися. Если существует несколько точек кажу-
щихся пересечений, AutoCAD производит привязку к пересечению, расположен-
ному ближе ко второй точке выбора.

Режим Extended Apparent Intersection позволяет осуществить привязку к точке во-
ображаемого пересечения двух любых объектов. Если в прицел попадает только
один объект, AutoCAD предлагает указать второй и производит привязку к точке,
в которой эти объекты пересекались бы при их естественном удлинении.

Режим Extended Apparent Intersection включается автоматически при выборе режи-
ма объектной привязки Apparent Intersection; при этом он активен тогда, когда в
прицел попадает только один объект и другие режимы объектной привязки отклю-
чены. Оба указанных режима могут использоваться как для разовой привязки точ-
ки, так и в качестве текущих режимов привязки.

Выполните упражнение L9 из раздела 2.

Привязка к точке
кажущегося пересечения примитивов L9

Line /
LINE Specify first point: об. привязка Apparent intersection Ж указ. 1,2

Specify next point or [Undo]: об.при&яэка Apparent Intersection X, указ. 3.4

Specify next point or [Undo]: Enter
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Продолжение объекта
Ц! Snap to Extension — привязка к продолжениям объектов. Она необходима в том

случае, когда при построении объектов требуется использовать линии, являющи-
еся временным продолжением существующих линий и дуг. Данный режим мож-
но совмещать с режимом Apparent Intersection с целью осуществить привязку к
точке воображаемого пересечения объектов, для чего нужно медленно переме-
щать указатель мыши рядом с конечной точкой отрезка или дуги. Появляющий-
ся символ «плюс» (+) свидетельствует о захвате конечной точки отрезка или
дуги. После этого следует провести указатель вдоль временной линии продол-
жения. Если включен режим привязки Apparent Intersection, можно найти точку
пересечения воображаемого продолжения отрезка или дуги с другим объектом.

Точка центра
Щ Snap to Center — привязка к центру дуги, окружности или эллипса.

При использовании режима Center необходимо указывать мышью на линию дуги,
окружности или эллипса, а не на их центр. В этом режиме можно осуществлять
привязку и к центрам окружностей, являющихся частью тел и областей. При при-
вязке к центру нужно выбирать видимую часть дуги, окружности или эллипса.

Выполните упражнение L7 из раздела 2.

Г Привязка к центру окружности,
дуги или эллипса (Ч)

Line /
LINE Specify first point: об. привязка CENter Щ указание 1

Specify next point or [Undo]: об. прибязка CENter (g указание 2

Specify next point or [Undo]: об. прибязка CENter :ф указание 3

Specify next point or [Close/Undo]: Close

Квадрант

Ц| Snap to Quadrant — привязка к ближайшему квадранту (точке, расположенной
под углом 0°, 90°, 180° или 270° от центра) дуги, окружности или эллипса.

Расположение точек квадрантов окружностей и дуг определяется текущей ориента-
цией ПСК. Если дуга, окружность или эллипс входят в блок, вставленный с ненуле-
вым углом поворота, точки квадрантов ориентируются в соответствии с этим углом.
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Касательная

Ц1 Snap to Tangent — привязка к точке на дуге, окружности, эллипсе или плоском
сплайне, принадлежащей касательной к другому объекту.

С помощью режима объектной привязки Tangent можно, например, построить по
трем точкам окружность, касающуюся трех других окружностей.

При выборе точки на дуге, полилинии или окружности в качестве первой точки
привязки в режиме Tangent автоматически активизируется режим задержанной
касательной Deferred Tangent, который может быть использован для построения
окружностей по двум и трем точкам, при формировании окружности, касательной
к трем другим объектам.

Режим Deferred Tangent неприменим к эллипсам и сплайнам. Если необходимо по-
строить отрезок, касательный к эллипсу или сплайну, функция привязки будет
выдавать ряд точек на эллипсе или сплайне, через которые может быть проведен
касательный отрезок, но положения этих точек непредсказуемы.

Режим привязки Tangent работает с дугами и окружностями, входящими в блоки,
только если масштабные коэффициенты вставки блока по осям равны, а направ-
ления выдавливания объектов параллельны текущей ПСК. Для сплайнов и эллип-
сов вторая указанная точка должна лежать в той же плоскости, что и точка при-
вязки.

При совместном использовании режимов привязки From и Tangent для построения
объектов, отличных от касательных отрезков к дугам и окружностям, первая точ-
ка объекта лежит на касательной к дуге или окружности, проведенной через по-
следнюю указанную в пространстве рисунка точку.

Выполните упражнение L12 из раздела 2.

1—-.
Построить касательную
из точки 1 к окружности

Line /°

LINE Specify first point: об. прибязка NODe

Specify next point or [Undo]: об. привязка TANgent

Specify next point or [Undo]: Enter

указание 1

указание 2
(urn 3j
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Нормаль

ЦЦ Snap to Perpendicular — привязка к точке объекта, лежащей на нормали к друго-
му объекту или к его воображаемому продолжению.

Режим Perpendicular может использоваться для таких объектов, как отрезки, окруж-
ности, эллипсы, сплайны и дуги.

Если режим привязки Perpendicular применяется для указания первой точки отрез-
ка или окружности, происходит построение отрезка или окружности, перпендику-
лярных выбранному объекту. Если-должна быть указана вторая точка отрезка или
окружности, AutoCAD производит привязку к точке объекта, которая принадле-
жит нормали, проведенной к первой указанной точке.

Когда описываемый режим используется для сплайнов, функция выполняет привяз-
ку к точке на сплайне, через которую проходит вектор нормали, проведенный из
указанной точки. Вектором нормали в любой точке сплайна является вектор, перпен-
дикулярный касательной в данной точке. Если указанная пользователем точка
лежит на сплайне, то в режиме Perpendicular она будет считаться одной из возмож-
ных точек привязки. В некоторых случаях при работе со сплайнами положение
точек привязки оказывается неочевидным. Кроме того, для некоторых сплайнов
в данном режиме объектной привязки таких точек может вообще не существовать.

Выполните упражнение L13 из раздела 2.

Построить перпендикуляры
из точки 1 к дуге и отрезку

Line /

LINE Specify first point: об. привязка NODe " указание 1

Specify next point or [Undo]: об. прибязка PERpendicular _)_ указание 2

Specify next point or [Undo]: Enter ^U/HJ ̂

Параллель

Snap to Parallel — привязка объектов к параллелям.

Эта привязка удобна при необходимости построения прямолинейных объектов,
параллельных имеющимся прямолинейным сегментам. В области прицела должен
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находиться только один отрезок. Появление символа параллельной привязки сви-
детельствует о выборе отрезка. Теперь следует медленно перемещать указатель
мыши из начальной точки в направлении, приблизительно параллельном выбран-
ному объекту. При этом появляется линия отслеживания, отображаемая пункти-
ром. Ее положение и ориентация определяются заданной начальной точкой и вы-
бранным объектом. Чтобы в качестве конечной точки создаваемого параллельного
отрезка использовать точку пересечения линии отслеживания с имеющимися
объектами, можно включить режимы привязки пересечения Intersection и кажуще-
гося пересечения Apparent Intersection.

Точка вставки

Щ Snap to Insert — привязка к точке вставки блока, формы, текста, атрибута (со-
держащего информацию о блоке) или определения атрибута (задающего ха-
рактеристики атрибута).

При выборе атрибута, входящего в блок, AutoCAD производит лривязку к точке
вставки атрибута, а не блока. Таким образом, если блок не содержит ничего, кроме
атрибутов, привязка к точке вставки самого блока возможна только в случае, если
эта точка совпадает с точкой вставки одного из атрибутов.

Точечный элемент

(Ц Snap to Node — привязка к объекту «точка», сформированному командой POINT.

Точки, входящие в определение блока, после его вставки могут служить узлами
привязки.

Выполните упражнение L11 из раздела 2.

Г Построить многоугольник /Г /\
с привязкой к точечному элементу V^ ' J/

Line /
LINE Specify first point: об. прибязка NODe ; '•".'••

Specify next point or [Undo]: об. прибязка NODe :>

Specify next point or [Undo]: об. прибязка NODe °
Specify next point or [Close/Undo]: об. прибязка NODe |
Specify next point or [Close/Undo]: об. прибязка NODe '»>
Specify next point or [Close/Undo]: Close

j

S

/

Г/

V

5 . 3

/
/

' /

, ?

л-
/ I

/ I'"
' .-Т1

1 '

указание 1

указание 2

указание 3

указание 4

указание 5
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^ -ту
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Ближайшая точка
Щ Snap to Nearest — привязка к точке на объекте, которая является ближайшей

к позиции перекрестья.

Выполните упражнение L10 из раздела 2.

Привязка к произвольной точке примитивов

Line. /
LINE Specify first point: об.прибязка NEArest ̂  указание I

Specify next point or [Undo]: об.прибязка NEArest /?'. указание 2

Specify next point or [Undo]: об.прибязка NEArest js? указание}

Specify next point or [Close/Undo]: Enter

Отмена объектной привязки
|jf Snap to None — режим отмены всех текущих и разовых режимов объектной при-

вязки.

Выбор режимов привязки
JUJJ Object Snap Settings — установка режима текущей объектной привязки на вклад-

ке Object Snap диалогового окна Drafting Settings (рис. 5.2). Это окно также за-
гружается из падающего меню Tools > Drafting Settings... или из контекстного
меню, которое вызывается при щелчке правой кнопки мыши по кнопке OSNAP
в строке состояния и последующем выборе пункта Settings...

Если требуется несколько раз подряд произвести привязку определенного типа
(например, к конечным точкам или центрам), можно задать один или несколько
текущих режимов объектной привязки. Следует иметь в виду, что режим объект-
ной привязки From не может быть установлен текущим. Специальные средства
повышения наглядности, называемые автопривязкой AutoSnap, облегчают выбор
точек привязки и повышают эффективность использования объектной привязки.
Средства автопривязки включают в себя следующие элементы:

Q маркеры обозначают тип объектной привязки в точке привязки с помощью
соответствующего символа;
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всплывающие подсказки автопривязки поясняют тип объектной привязки в точ-
ке привязки ниже позиции указателя мыши;

магнит автоматически перемещает в точку привязки указатель мыши, если он
находится около возможной точки привязки;

прицел окружает перекрестье указателя мыши и ограничивает область рисун-
ка, в пределах которой при перемещении указателя определяются возможные
точки привязки. Показ прицела можно включать и отключать, а его размер —
изменять.

5S
P it

х г

x: P |,!
^Ш^-':Е.й'
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ЙЩИШ -rt l̂n '̂P"?.:
cammirel. •? |̂ да«Ш

Рис. 5.2. Диалоговое окно установки режима текущей объектной привязки

Для включения или отключения сразу всех текущих режимов объектной при-
вязки без вызова диалогового окна Drafting Settings необходимо щелкнуть по кноп-
ке OSNAP в строке состояния (или нажать клавиши Ctrl+F или F3). Если текущие
режимы объектной привязки не заданы, вызывается диалоговое окно Drafting
Settings.

По умолчанию включены следующие элементы автопривязки: маркеры, всплыва-
ющие подсказки и магнит. Параметры автопривязки всегда можно изменить в
поле Autosnap Settings на вкладке Drafting диалогового окна Options, которое вызы-
вается щелчком мыши по кнопке Options... в диалоговом окне Drafting Settings либо
из падающего меню Toots > Options... (см. рис. 1.25).

Если задано Несколько режимов объектной привязки, AutoCAD использует ре-
жим, наиболее подходящий для выбранного объекта. Если в прицел выбора попа-
дают две точки, удовлетворяющие заданному режиму, система производит привяз-
ку к той из них, которая лежит ближе к центру прицела. При необходимости
можно переключаться между точками, нажимая клавишу Tab. Например, если ак-
тивизированы режимы привязки Quadrant и Center, а в прицел попадает часть
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окружности, то нажатие Tab позволит поочередно перебрать все возможные точки
привязки: четыре квадранта и центр окружности.

Автоотслеживание
Средства автоотслеживания AutoTrack облегчают построение объектов в опреде-
ленных направлениях или в определенной зависимости относительно других
объектов рисунка.

При включенных режимах автоотслеживания специальные временные линии от-
слеживания помогают выполнять точные построения. По умолчанию эти линии
являются бесконечными и продолжаются до границ области рисования. Однако
можно установить такой режим, при котором длина линий отслеживания ограни-
чивается текущим положением курсора.

Имеются два режима автоотслеживания: полярное отслеживание и отслеживание
при объектной привязке.

Режимы автоотслеживания можно быстро включать и отключать нажатием кно-
пок POLAR и OTRACK в строке состояния.

Для изменения параметров автоотслеживания используется вкладка Drafting диа-
логового окна Options, которое загружается из падающего меню Toots > Options....

В области AutoTrack Settings установливаются следующие флажки:

Q Display polar tracking vector — отображение линий полярного отслеживания в ви-
де бесконечных лучей. Если флажок снят, линия полярного отслеживания про-
водится от предыдущей указанной точки до курсора;

О Display full-screen tracking, vector — отображение линий объектного отслеживания
в виде бесконечных прямых. Если флажок снят, линия объектного отслежива-
ния проврдится от точки привязки до курсора;

О Display AutoTrack tooltip — отображение всплывающих подсказок к режимам ав-
тоотслежйвания, выводимых ниже позиции курсора. Всплывающие подсказки
дают информацию о типе объектной привязки (при объектном отслеживании),
текущем угле отслеживания и расстоянии до предыдущей точки.

Способ захвата характерных точек объектов для отслеживания устанавливается
в области Alignment Point Acquisition:

О Automatic — захват точек отслеживания осуществляется автоматически. Если
выбран данный способ, для предотвращения захвата характерной точки объек-
та можно удерживать нажатой клавишу Shift;

Q Shift to acquire — захват точек происходит только при нажатии клавиши Shift
в момент, когда курсор находится над точкой объектной привязки.

Системные переменные TRACKPATH и POLARMODE управляют соответственно ото-
бражением линий отслеживания и способом захвата точек отслеживания.
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Объектное отслеживание
Объектное отслеживание расширяет и дополняет возможности объектной привяз-
ки. Для его использования необходимо, чтобы были включены режимы объектной
привязки. При этом размер прицела определяет зону, в пределах которой проис-
ходит активизация линий отслеживания.

При объектном отслеживании по умолчанию захват подходящих точек осуще-
ствляется автоматически. Однако можно установить такой режим, при котором
захват точек происходит только по нажатии клавиши Shift.

Автопривязка позволяет более простыми способами строить объекты, имеющие
определенную геометрическую зависимость от других объектов. Удобно исполь-
зовать следующие рекомендации:

Q для выбора точек, лежащих на перпендикулярах к концам или серединам
объектов, объектное отслеживание следует применять совместно с режимами
привязки Perpendicular, Endpoint и Midpoint;

Q для выбора точек, лежащих на касательной к конечной точке дуги, объектное
отслеживание следует использовать совместно с режимами привязки Tangent
и Endpoint;

Q отслеживание можно осуществлять от так называемых временных точек отсле-
живания. Для указания такой точки в ответ на запрос команды выбрать точку,
ввести сочетание _ТТ и задать нужную точку. Она помечается маленьким мар-
кером в виде знака «плюс» (+). Далее по мере перемещения указателя мыши
поочередно появляются линии отслеживания, проходящие через временную
точку отслеживания. Для удаления временной точки при перемещении доста-
точно задержать указатель мыши на ее маркере (знаке «плюс»);

Q можно выбрать точку, находящуюся на заданном расстоянии от точки объект-
ной привязки вдоль линии отслеживания. Для этого после появления линии
отслеживания следует ввести в командной строке требуемое расстояние;

Q изменение способа захвата точек осуществляется на вкладке Drafting диалого-
вого окна Options с помощью опций Automatic и Shift to acquire. По умолчанию
устанавливается автоматический способ. Для предотвращения автоматическо-
го выбора точек в областях рисунка с высокой плотностью объектов можно
удерживать нажатой клавишу Shift.

Полярное отслеживание
Полярное отслеживание облегчает выбор точек, лежащих на воображаемых лини-
ях, которые можно провести через последнюю указанную в команде точку под
одним из заданных полярных углов. Если, например, шаг углов полярного отсле-
живания равен 45°, линии отслеживания и всплывающие подсказки могут появ-
ляться под углами, кратными 45° относительно текущего направления отсчета уг-
лов. Текущая линия полярного отслеживания исчезает, так же как и всплывающая
подсказка, если она оказывается вне прицела курсора.
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Полярное отслеживание может осуществляться под углами, кратными следу-
ющим стандартным значениям: 90°, 45°, 30°, 22,5°, 18°, 15°, 10° или 5°. Кроме того,
пользователь может определить другие значения углов.

Для включения полярного отслеживания необходимо нажать функциональную
клавишу F10 или кнопку POLAR в строке состояния.

Линия полярного отслеживания и всплывающая подсказка появляются, если прямая,
мысленно проведенная через предыдущую указанную точку и курсор, проходит
под углом, близким к одному из полярных углов отслеживания. По умолчанию
шаг полярных углов равен 90°. Линию полярного отслеживания и информацию,
содержащуюся во всплывающей подсказке, можно использовать при построении
объектов. Для нахождения точки пересечения линии полярного отслеживания с
другими объектами удобно задействовать режимы объектной привязки Intersection
и Apparent Intersection.

Режим ORTHO разрешает указание только тех точек, которые лежат на прямой, па-
раллельной оси X или У текущей ПСК и проходящей через последнюю указанную
в текущей команде точку. При включении режима ортогонального рисования ре-
жим полярного отслеживания автоматически отключается, поскольку они не мо-
гут быть активными одновременно. Аналогичным образом при включении поляр-
ного отслеживания отключается режим ORTHO.

Изменение параметров полярного отслеживания осуществляется на вкладке Polar
Tracking диалогового окна Drafting Settings (рис. 5.3). Это окно загружается из пада-
ющего меню Tools > Drafting Settings... или из контекстного меню, которое вызыва-
ется при щелчке правой кнопкой мыши по кнопке POLAR в строке состояния и по-
следующем выборе пункта Settings....
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;;Щ г̂|Щ1Щ|Й|

1̂ 3Яrial'^llH
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|*;:{Й
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Рис. 5.3. Диалоговое окно изменения параметров полярного отслеживания
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Геометрический примитив

Рисунки в AutoCAD строятся из набора геометрических примитивов, под которым
понимается элемент чертежа, обрабатываемый системой как целое, а не как сово-
купность точек или объектов. Графические примитивы создаются командами вы-
черчивания или рисования, которые вызываются из падающего меню Draw или
одноименной панели инструментов. Необходимо отметить, что одни и те же эле-
менты чертежа могут быть получены по-разному, с помощью различных команд
вычерчивания.

Точка

|й Команда POINT формирует точку, вызывается из падающего меню Draw У Point

или щелчком мыши по пиктограмме Point на панели инструментов Draw.

Точка определяется указанием ее координат (см. главу 2). Запрос команды POINT:

Current ppint modes: PDMODE=33 PDSIZE=10.0000 — текущие режимы
точек;

Specify a point:—указать точку.

Точки могут пригодиться, например, в качестве узлов или ссылок для объектной
привязки и отсчета расстояний. Форма символа точки и его размер устанавлива-
ются либо относительно размера экрана, либо в абсолютных единицах.

Задать форму точки можно с помощью системной переменной PDMODE, а ее раз-
мер — с помощью переменной PDSIZE. Если PDSIZE положительна, она указыва-
ет абсолютный размер маркера точки, а если отрицательна, то размер указывается
в процентах от размера экрана монитора. В последнем случае величина символа
точки инвариантна по отношению к текущему масштабу изображения.

Pont

Рис. 5.4. Диалоговое окно установки параметров точки
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Значения системных переменных PDMODE и PDSIZE пользователь устанавливает
в диалоговом окне Point Style, показанном на рис. 5.4. Оно вызывается из падающе-
го меню Format > Point Style.... Размер маркера точки задается в поле Point Size:. При
этом, если поднят флажок Set Size Relative to Screen, размер маркера определяется в
процентах от размера экрана монитора, а если поставлен флажок Set Size in Absolute
Units, указывается абсолютный размер маркера.

Построение линий
Линия в AutoCAD является базовым примитивом. Линии бывают различного
рода — одиночные отрезки, ломаные (с сопряжениями дугами или без них), пучки
параллельных линий (мультилинии), а также эскизные. Линии рисуют, задавая
координаты точек, свойства (тип, цвет и другие), значения углов.

Отрезок
ЦР Команда LINE формирует отрезок, вызывается из падающего меню Draw > Line

или щелчком мыши по пиктограмме Line на панели инструментов Draw.

Отрезки могут быть одиночными или объединенными в ломаную линию. Несмотря
на то что сегменты соприкасаются в конечных точках, каждый из них представляет
собой отдельный объект. Отрезки используются, если требуется работа с каждым
сегментом в отдельности; если же необходимо, чтобы набор линейных сегментов
представлял единый объект, лучше применять полилинии. Последовательность
отрезков может быть замкнутой — в этом случае конец последнего сегмента совпа-
дает с началом первого.

Запросы команды LINE:

Specify f i r s t point:—указать первую точку;

Specify 'next point or [Undo] :—указать следующую точку.

Specify next point or [Undo]:

Specify next point or [Close/Undo]:

Specify next point or [Close/Undo]:

Запросы команды LINK организованы циклически. Это означает, что при постро-
ении непрерывной ломаной линии конец предыдущего отрезка служит началом
следующего. При перемещении к каждой следующей точке за перекрестьем тянет-
ся «резиновая нить». Это позволяет отслеживать положение строящегося отрезка
ломаной линии. При этом каждый отрезок ломаной линии представляет собой от-
дельный примитив. Цикл заканчивается после нажатия клавиши Enter в ответ на
очередной запрос Specify next point or [ Close/Undo ]:. К аналогичному
результату приведет щелчок правой кнопкой мыши с последующим выбором пун-
кта Enter из появившегося контекстного меню (рис. 5.5).

• '
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Рис. 5.5. Контекстное меню

Ключи команды LINE:

Q Close — замкнуть ломаную;

Q Undo — отменить последний нарисованный отрезок.

Работа команды LINE проиллюстрирована упражнениями L1-L13 из раздела 2
(см. выше).

Выполните упражнения L1-L13 и тест 1 из раздела 2. .

ТЕСТ1
Построить прямоугольник в слое ГРАФИКА

НИ ^L

.
О *: ;^П ЗША4А
О %'3D ЗАПРОСЫ
О'% ''T^S КОМАНДА

Прежде чем формировать линию,
сделай слой ГРАФИКА текущим
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Прямая и луч
В AutoCAD 2005 допускается построение линий, не имеющих конца в одном или
в обоих направлениях. Такие линии называются соответственно лучами и прямы-
ми. Их можно использовать в качестве вспомогательных при построении других
объектов.

Наличие бесконечных линий не изменяет границ рисунка. Следовательно, беско-
нечные линии не влияют на процесс зумирования и на видовые экраны. Прямые и
лучи разрешается перемещать, поворачивать и копировать таким же образом, как
и любые другие объекты. Бесконечные линии обычно строятся на отдельном слое,
который перед выводом на плоттер можно заморозить или отключить.

|Ц| КомандаXLINE формирует прямую, вызывается из падающего меню Draw > Con-
struction Line или щелчком мыши по пиктограмме Construction Line на панели
.инструментов Draw.

Прямые могут располагаться в любом месте трехмерного пространства. Существуют
различные способы установки ориентации прямой. По умолчанию прямая стро-
ится путем указания двух точек, задающих ее ориентацию. Первая точка называ-
ется корневой — это условная середина прямой.

Запросы команды XLINE:

Specify a point or [Hor/Ver/Ang/Bisect/Offset]:

Specify through point:

Specify through point:

Ключи команды XLINE:

Q Ног — построение горизонтальной прямой, проходящей через заданную точку;

Q Ver — построение вертикальной прямой, проходящей через заданную точку;

Q Ang — построение прямой по точке и углу. Есть два способа задать угол для
построения прямых. Можно либо выбрать опорную линию и указать угол меж-
ду нею и прямой, либо (для построения прямой, лежащей под определенным
углом к горизонтальной оси) указать угол и точку, через которую должна про-
ходить прямая. Построенные прямые всегда параллельны текущей ПСК;

Q Bisect — по точке и половине угла, заданного тремя точками. При этом созда-
ется прямая, делящая какой-либо угол пополам. Нужно указать вершину угла
и определяющие его линии;

Q Offset — по смещению от базовой линии. При этом создается прямая, парал-
лельная какой-либо базовой линии. Следует задать величину смещения, вы-
брать базовую линию, а затем указать, с какой стороны от базовой линии долж-
на проходить прямая.

||| Команда RAY, формирующая луч, вызывается из падающего меню Draw > Ray
или щелчком мыши по пиктограмме Ray на панели инструментов.
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Луч представляет .собой линию в трехмерном пространстве, начинающуюся в за-
данной точке и уходящую в бесконечность. В отличие от прямых, бесконечных с
обеих сторон, луч не имеет конца только в одном направлении. Использование
лучей вместо прямых помогает избежать загромождения рисунка. Как и прямые,
лучи игнорируются командами, с помощью которых рисунок в его границах выво-
дится на экран.

Запросы команды RAY:

Specify start p o i n t : — указатьпервуюточку;

Specify through point: — указать точку, через которую проходит луч.

Полилиния
~|| Команда PLINE, формирующая полилинию, вызывается из падающего меню

Draw > Polyline или щелчком мыши по пиктограмме Polyline на панели инстру-
ментов Draw.

Полилиния представляет собой связанную последовательность линейных и дуго-
вых сегментов и обрабатывается системой как графический примитив. Полилинии
используют, если требуется работа с набором сегментов как с целым, хотя допус-
кается их редактирование по отдельности. Можно задавать ширину или полуши-
рину отдельных сегментов, сужать полилинию или замыкать ее. При построении
дуговых сегментов первой точкой дуги является конечная точка предыдущего сег-
мента. Дуги описываются путем указания угла, центра, направления или радиуса.
Кроме того, дугу можно построить, указав вторую и конечную точки.

Запросы команды PLINE:

Specify start point :—указать первую точку;

Current line-width is 0 . 0000 — текущая ширина полилинии равна 0.0000;

Specify next point or [Arc/Hal fwidth/Length/Undo/Width] :—ука-
зать следующую точку;

Specify next point .or [Arc/Close/Halfwidth/Length/Undo/Width]:

Запросы команды PLINE организованы циклически. Цикл заканчивается после
нажатия клавиши Enter в ответ на очередной запрос команды. К аналогичному ре-
зультату приводит щелчок правой кнопкой мыши с последующим выбором пунк-
та Enter в появившемся контекстном меню. Ключи команды PLINE:

Q Arc — обеспечивает переход в режим дуг;

Q Close — замыкает полилинию отрезком. Замыкающий отрезок существенно
отличается от обычного, проведенного от конечной точки к начальной. Они по-
разному обрабатываются при редактировании и сглаживании полилиний, а так-
же при подрезке углов стыков широких сегментов. Практически всегда пред-
почтительно использовать замыкающие отрезки;
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О Half width — позволяет задать полуширину, то есть расстояние от осевой ли-
нии широкого сегмента до края;

Q Length— задает длину сегмента, созданного как продолжение предыдущего
в том же направлении;

Q Undo — отменяет последний созданный сегмент;

Q Width — позволяет задать ширину последующего сегмента. AutoCAD запра-
шивает начальную и конечную ширину. Введенное значение начальной шири-
ны автоматически предлагается установить значением конечной ширины по
умолчанию. Начальная и конечная точки широких линейных сегментов лежат
на оси полилинии. Обычно угловые стыки смежных широких сегментов поли-
линии подрезаются; исключение составляют случаи, когда линейные сегменты
не являются касательными к смежным дуговым сегментам, а также если углы
схождения очень острые или при использовании штрихпунктирных линий.

При переходе команды PLINE в режим дуг запрос меняется следующим образом:

Specify next point or [Arс/HaIfwidth/Length/Undo/Width3: ARC —
переход в режим построения дуг;

Specify endpoint of arc or [Angle/Center/Close/Direction/
Halfwidth/Line/Radius/Second pt/Undo/Width] :

Ключи команды PLINE в режиме построения дуг:

Q Angle — ввести центральный угол. По умолчанию дуга отрисовывается против
часовой стрелки. Если требуется отрисовка дуги по часовой стрелке, необходи-
мо задать отрицательное значение угла;

О CEnter — указать центр дуги;

Q CLose — замкнуть дугой;

Q Direction — задать направление касательной;

Q Half width — определить полуширину полилинии;

Q Line — перейти в режим построения отрезков;

Q Radius — ввести радиус дуги;

Q Second pt — указать вторую точку дуги по трем точкам. Если дуга не являет-
ся первым сегментом полилинии, то она начинается в конечной точке преды-
дущего сегмента и по умолчанию проводится по касательной к нему;

Q Undo — отменить последнюю точку;

Q Width — определить ширину полилинии.

Заметим, что дуговые сегменты полилинии задаются любым из способов, харак-
терных для команды формирования дуги ARC (см. соответствующий раздел данной
главы). Кроме того, такие сегменты можно построить, задав радиус, центральный
угол и направление хорды. Это единственный случай, когда дуга, предлагаемая по
умолчанию, не строится по касательной.
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Выполните упражнение Р1-Р4 и тест 3 из раздела 2.

Построить полилинию с

Pline

Specify

Specify next
Specify next

установкой ширины ( P1

'.!!>. Падающее мена Draw •- Polyline
Specify start point: 230,10 начальная точка 1

Current line-width is 0.0000
next point or [Arc/Halfwidth/Length/Undo/Widlh]:

Specify starting width
Specify ending width

<0.0000>:
<1.0000>:

point or [Arc/Close/Halfwidth/Length/Undo/Width]:
joint or [Arc/Close/Halfwidth/Length/Undo/Width]:

Specify starting width <1.0000>:
Specify ending width <20.0000>:

Specify next
Specify next

1

V •"""

point or [Arc/Close/Halfwidth/Length/Undo/Widthj:
point or [Arc/Close/Halfwidth/Length/Undo/Widthj:

^^^'

(ширина полилинии по умолчанию)
w ширина полилинии
1
1
290,30
w
20
0
380,60
<Enter>

стартобая ширина
конечная ширина
точка 2
ширина полиаинии
стартовая ширина
конечная ширина
точка 3

1

J

Построить полилинию в режиме дуг ( Р2

Pline J5
Specify start point:

Specify
Current line-width is 0.0000

next point or [Arc/Holfwidth/Length/Undo/Width]:
Specify starting width <0.0000>:

Specify ending width <1.0000>:
Specify next point or [Arc/Close/Half»idth/Length/Undo/Width]:

230,10 начальная тачка 1
(ширина полилинии по умолчанию)
w ширина полипинии
0
15
Arc

стартовая ширина
конечная ширина
режим дуг

Specify endpoint of arc or
[Angle/CEnter/CLose/.../Second pt/Undo/Width]:

Specify included angle:
Specify endpoint of arc or [CEnter/Radius]:

Specify center Mint of arc:

Ang
70
Cen
270,60

задать углом
величина угла
задать центр
точка 2

Specify endpoint of arc or
[Angle/CEnter/CLose/.../Second pt/Undo/Width]: 350,10 тачка 4

Specify endpoint of arc or-
[Angle/CEnter/CLose/.../Second pt/Undo/Width]:

X.

<Enter>

J
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Построить окружность с помощью полилинии

Pline J>
Specify start point: 300,10 начальная точка 1

Current line-width is 0.0000 (ширина полилинии по умолчанию)
Specify next point or [Arc/Halfwidth/Length/Undo/Widthj: w ширина полилинии

Specify storting width <0.0000>: 2 стартовое ширина
Specify ending width <1.0000>: 2 конечная ширина

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: Arc режим дуг
Specify endpoint of arc or

[Angle/CEnter/CLose/.../Second pt/Undo/Width]: Center
Specify center point of arc: @0,30 задать центром

Specify endpoint of ore or [Angle/Length]: @0,30 точко 2
Specify endpoint of arc or

[Angle/CEnter/CLose/.../Second pt/Undo/Width]: Close замкнуть

Построить полилинию с помощью направления( P4

Pline _Э
Specify start point: 230,60 начальная точка 1

Current line-width is 0.0000 (ширина полилинии по умолчанию)
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: w ширина полилинии

Specify starting width <0.0000>: 2 стартовая ширина
Specify ending width <1.0000>: 2 конечная ширина

Specify next point or [Arc/Close/Holfwidth/Length/Undo/Width]: 260,60 точка ?

Specify next point or [Arc/Close/Holfwidth/Length/Undo/Width]: Arc режим дуг
Specify endpoint of arc or

[Angle/CEnter/CLose/Direction/.../Second pt/Undo/Width]: Dir
Specify the tangent direction for the start point of arc: 270 направление

Specify endpoint of the arc: 360,60 точка 3
Specify endpoint of arc or

[Angle/CEnter/.../Line/Radius/Second pt/Undo/Width]: Line режим лиши

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 390,60 точка <
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: <Enter>
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_
ТЕСТЗ

Построить полилинии толщиной 0,8
в слое ГРАФИКА

Мультилиния
Команда MLINE, формирующая мультилинию, вызывается из падающего меню
Draw > Multil ine или щелчком мыши по пиктограмме Multiline на панели инстру-
ментов.

Мультилиния состоит из пучка параллельных линий, называемых ее элементами
(рис. 5.6). Чтобы расставить элементы, необходимо указать смещение каждого из
них относительно исходной точки. Можно создавать и сохранять стили мультили-
ний или же пользоваться стилем по умолчанию (мультилиния из двух элементов).
Для каждого элемента задаются цвет и тип линии; соответствующие вершины эле-
ментов соединяются отрезками. Мультилинии могут иметь торцевые ограничите-
ли различного вида, например, отрезки или дуги.

Рис. 5.6. Примеры мультилиний
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Запросы команды MLINE:

Current settings: Justification = Top, Scale = 2 0 . 0 0 , Style =
STANDARD — текущие настройки: расположение, масштаб, стиль;

Specify start point or [Just i f ication/Scale/STyle]:—указать на-
чальную точку;

Specify next point:—указать следующую точку;

Specify next point or [Undo]:

Specify next point or [Close/Undo]:

Specify next point or [Close/Undo]:

Ключи команды MLINE:
Q Just i f icat ion — определение положения точки начала черчения: Тор —

верх, Zero — центр, Bottom — низ. Линия проходит соответственно с макси-
мальным положительным, с нулевым или максимальным отрицательным сме-
щением от заданной точки;

О Scale— коэффициент масштабирования. Смещение между линиями равняет-
• ся заданному коэффициенту, умноженному на величину Offset, определен-

ную в стиле;
Q Style — выбор стиля.

При построении мультилинии используется стиль мулыпилинит Он создается в ди-
алоговом окне Multiline Styles, которое вызывается из падающего меню Format > Mul-
tiline Style... (рис. 5.7). Щелчком мыши по кнопке Load... можно загрузить суще-
ствующий стиль; сохранить вновь созданный на диске — нажатием кнопки Save...,
добавить свой — нажатием кнопки Add. Имя добавляемого стиля должно быть за-
дано в текстовом поле Name:. По умолчанию используется стиль STANDARD.

' Маг»: : [STANDARD

п.'Ill

Рис. 5.7. Диалоговое окно создания стилей мультилинии
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Свойства элементов мулътилинии определяются в диалоговом окне Element Pro-
perties (рис. 5.8):

О в области Offset определяется смещение линий мультилинии друг относитель-
но друга;

Q нажатие кнопки Linetype... выводит на экран диалоговое окно определения
типа линии;

Q нажатие кнопки Color... загружает диалоговое окно определения цвета каждой
линии.

Add ;[:;!'-i0.ele>».'::

liiEj'li,:•-,, .̂ .;.;.v:;:y:.̂ .;..̂ ĵ MOT

S:L™&,,:; Г:':;

|0,5Ш

Рис. 5.8. Диалоговое окно определения свойств элемента мультилинии

Свойства мулътилинии определяются в диалоговом окне Multiline Properties (рис. 5.9):

О в области Fill установкой флажка On обеспечивается заполнение мультилинии
цветом;

Q в области формирования торцов Caps определяется вид концевых элементов;

а в поле An-gle определяется величина угла наклона концевого элемента к муль-
тилинии.

По умолчанию используется файл стиля с именем acad.mln.

Рис. 5.9. Диалоговое окно определения свойств мультилинии

Системная переменная CMLSTYLE содержит имя текущего стиля мультилинии.
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Многоугольник

И! Команда POLYGON, обеспечивающая формирование правильного многоуголь-
ника, вызывается из падающего меню Draw > Polygon или щелчком мыши по
пиктограмме Polygon на панели инструментов Draw.

Многоугольники представляют собой замкнутые полилинии; они могут иметь от
3 до 1024 сторон равной длины. Многоугольник можно построить, либо вписав его
в воображаемую окружность, либо описав вокруг нее, либо задав начало и конец
одной из его сторон. Так как длины сторон многоугольников всегда равны, с их
помощью легко строить квадраты и равносторонние треугольники.

Запросы команды POLYGON:

Enter number of sides < default > : — указать число сторон;

Specify center of polygon or [Edge} : —указать центр многоугольника.

Ключи команды POLYGON:

Q Edge — указание одной стороны. При использовании этого ключа команда
POLYGON выдает следующие запросы:

Specify f irst endpoint of edge:—указать первую конечную точку сто-
роны;

Specify second endpoint of edge: — указать вторую конечную точку сто-
роны.

При указании центра многоугольника команда POLYGON выдает следующие за-
просы:

Enter an option [Inscribed in circle/Circumscribed about circle] -
<I>: — задать опцию размещения;

Specify radius of circle:—задать радиус окружности,

где:

Q Inscribed in circle — формирование многоугольника, вписанного в окруж-
ность;

Q Circumscribed about circle — формирование многоугольника, описан-
ного вокруг окружности.

Вписанные многоугольники строятся, когда известно расстояние между центром
многоугольника и его вершинами. Описанные многоугольники — когда известно
расстояние между центром многоугольника и серединами его сторон. В обоих слу-
чаях это расстояние совпадает с радиусом окружности.

Выполните упражнение Pg1-Pg3 и Re 1 из раздела 2.
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Построить многоугольник
по известной стороне

Polygon О Падающее меню Draw •- Polygon

Enter number of sides <4>:
Specify center of polygon or [Edge]:

Specify first endpoint of edge:

Specify second endpoint of edge:

количество сторон

задать стороной

указание 1
указание 2

Построить многоугольник,
вписанный в окружность Рд2

Polygon О
Enter number of sides <4>: 5 количество сторон

Specify center of polygon or [Edge]: 310,60 иентр окружности 1

Enter an option [Inscribed in circle/Circumscribed about circle] <l>: i

вписанный многоугольник

Specify radius of circle: 50 радиус окружности

R50

Построить многоугольник,
описанный вокруг окружности

Polygon О
Enter number of sides <4>: 3 количество сторон

Specify center of polygon or [Edge]: 310,60 центр окружности 1

Enter an option [Inscribed in circle/Circumscribed about circle] <l>: С

описанный многоугольник

Specify radius of circle: 30 радиус окружности

R30
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Построить прямоугольник Re1

Rectang Д! падающее меню Draw—»- Rectangle
Specify first corner point or

[Chamfer/Elevation/Fillet/Thickness/Width]: указание 1
Specify other corner point: указание 2

Эскиз
Команда SKETCH, обеспечивающая рисование эскиза, вызывается из командной
строки.

Эскизы состоят из множества прямолинейных сегментов. Каждый сегмент пред-
ставляет собой либо отдельный объект, либо отрезок полилинии. Имеется возмож-
ность задавать минимальную длину, или приращение сегментов. Эскизное рисо-
вание используется при формировании линий неправильной формы и при снятии
копий с помощью дигитайзера. Состоящие из множества маленьких линейных сег-
ментов эскизы позволяют рисовать с достаточно высокой точностью, но при этом
резко возрастает объем файла рисунка. Поэтому данное средство следует приме-
нять только в крайнем случае.

При эскизном рисовании устройство указания используется как перо. После щел-
чка перо «опускается» и рисует на экране; следующий щелчок приводит к «подъе-
му» пера и прекращению рисования.

Запросы команды SKETCH:

Record increment <default>: — приращение сегментов;

Sketch. Pen eXit Quit Record Erase Connect.

Перед началом эскизного рисования следует убедиться, что системная переменная
CELTYPE задает тип линии Continuous. Если рисуется линия, включающая в себя
точки или штрихи, а величина приращения меньше длины точки или штриха, эти
элементы не будут видны на рисунке.

Кроме того, при эскизном рисовании рекомендуется отключать режимы ORTHO
и SNAP, иначе результаты могут быть непредсказуемы.

Выполните упражнение Sk1 из раздела 2.
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Построить произвольную эскизную линию

Sketch
Record increment <1.0000>: 1 приращение сегментов

Sketch. Pen eXit Quit Record Erase Connect.

<Pen down> щелчком мыши опустить перо и начертить линию

<Pen up> щелчком мыши поднять перо <Enter>

8 polylines with 275 edges recorded.

Построение криволинейных объектов

Сплайн
Щ Команда SPLINE формирует сплайн, вызывается из падающего меню Draw > Spli-

ne или щелчком мыши по пиктограмме Spline на панели инструментов Draw.

Сплайн представляет собой гладкую кривую, проходящую через заданный набор
точек. AutoCAD работает с одной из разновидностей сплайнов — неоднородными
рациональными В-сплайновыми кривыми NURBS. Использование NURBS обеспе-
чивает достаточную гладкость кривых, проходящих через заданные контрольные
точки. Сплайны применяются для рисования кривых произвольной формы, на-
пример горизонталей в географических информационных системах или при про-
ектировании автомобилей.

Сплайн можно строить путем интерполяции по набору точек, через которые он
должен проходить. Таким способом при построении кривых для двумерного и
трехмерного моделирования достигается намного большая точность, чем при ис-
пользовании полилиний. К тому же рисунок, использующий сплайны, занимает
меньше места на диске и в оперативной памяти, чем рисунок с полилиниями.

Запросы команды SPLINE:

Specify first point or [Object]: — указать первую точку;

Specify next point:—указать следующую точку;

Specify next point or [Close/Fit tolerance] <start tangent>:

Specify next point or [Close/Fit tolerance] <start tangent>:

Сплайн строится путем указания координат определяющих точек. Сплайны могут
быть замкнутыми; при этом совпадают как сами конечная и начальная точки, так
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и направления касательных в них. Кроме того, в ходе построения можно изменять
допуск сплайновой аппроксимации — величину, определяющую, насколько близ-
ко проходит сплайн к указанным определяющим точкам. Чем меньше значение
допуска, тем ближе сплайн к определяющим точкам; при нулевом допуске он про-
ходит прямо через них.

Окружность
Ц1 Команда CIRCLE, формирующая окружность, вызывается из падающего меню

Draw > Circle или щелчком мыши по пиктограмме Circle на панели инструмен-
тов Draw.

Окружности можно строить различными способами. По умолчанию построение
производится путем указания центра и радиуса. Можно задавать центр и диаметр
или только диаметр, указывая его начальную и конечную точки. Окружность так-
же может строиться по трем точкам. Кроме того, имеется возможность определять
окружность, касающуюся либо трех объектов рисунка, либо двух (в последнем
случае задается еще и радиус).

Запросы команды CIRCLE:

Specify center point for circle or [3P/2P/Ttr (tan tan radius) ] : -
указать центр окружности;

Specify radius of circle or [Diameter] : —указать радиус окружности.

Ключи команды CIRCLE:

Q 3 Р — строит окружность по трем точкам, лежащим на окружности. При исполь-
зовании этого ключа команда CIRCLE выдает следующие запросы:

Specify center point for circle or [3P/2P/Ttr (tan tan radius)] :
3P — переход в режим построения окружности по трем точкам;

Specify f irst point on circle :—указать первую точку окружности;

Specify second point on circle:— указать вторую точку окружности;

Specify third point on circle : — указать третью точку окружности.

О 2 Р — строит окружность по двум точкам, лежащим на диаметре. При использо-
вании этого ключа команда CIRCLE выдает следующие запросы:

Specify center point for circle or [3P/2P/Ttr (tan tan radius') ] :
2P — переход в режим построения окружности по двум точкам;

Specify f i rst end point of circle's diameter: — указать первую ко-
нечную точку диаметра окружности;

Specify second end point of circle's diameter:—указать вторую
конечную точку диаметра окружности.
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Q Ttr — строит окружность по двум касательным и радиусу. При использовании
этого ключа команда CIRCLE выдает следующие запросы:

Specify center point for circle or [3P/2P/Ttr (tan tan radius)] :
TTR — переход в режим построения окружности по двум касательным и радиусу;

Specify point on object for f irst tangent of circle : — указать
точку на объекте, задающую первую касательную;

Specify point on object for second tangent of circle: —указать
точку на объекте, задающую вторую касательную;

Specify radius of circle <default>: — указать радиус окружности.

Выполните упражнения С1-С8 и тест 2 из раздела 2.

Построить окружность по центру и радиусу (С1

Circle ® Падающее меню Draw "- С/ГС/в

Specify center point for circle

or [3P/2P/Ttr (tan tan radius)]: 320, 90 центр 6'точке 1

Specify radius of circle or [Diameter]: 60 радиус

Построить окружность
по двум точкам диаметра

Circle ©
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 2P

Specify first end point of circle's diameter: 320,30 точка 1

Specify second end point of circle's diameter: 320,150 точка 2
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Построить окружность по трем точкам

Circle :Ш
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 3P

Specify first end point of circle's diameter: 320,30 точка 1

Specify second end point of circle's diameter: 380,90 точка 2

Specify second end point of circle's diameter: 320,150 точка 3

Построить окружность, касательную
к двум примитивам

Circle ®
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: TTR
Specify point on object for first tangent of circle: указать на окружность 1
Specify point on object for second tangent of circle: указать на линию 2

Specify radius of circle: 15 радиус

Построить окружность,
касательную к двум другим С5)

Circle ©
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: TTR
Specify point on object for first tangent of circle: указать на окружность 1
Specify point on object for second tangent of circle: указать на окружность 2

Specify radius of circle: 50 радиус
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Построить окружность, касательную к прямой (С6

Circle G)
Specify center point for circle or [3P/2P/Ttr]: V;

oo.привязке INTersection <\

Specify radius of circle or [Diameter]: ^.указание 2
оВ.прибязка TANgent

С Построить окружность по двум точкам
диаметра, лежащим на концах отрезка

Circle Ш
Specify center point for circle or [3P/2P/Ttr (tan tan
Specify first end point of circle's diameter:

oS. привязка ENOpoint
Specify second end point of circle's diameter:

об.прийязка ENDpoint

О

Щ
radius)]: 2P

/" указание 1

/ указание 2

J

Построить концентрическую окружность (С8

Circle ф
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:

o5.привязка CENter @г указание 1
Specify radius of circle or [Diameter]: 50 радиус
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ТЕСТ 2
Построить сопряжение окружностей в слое POST

RIO

Дуга
jjj Команда ARC, формирующая дугу, вызывается из падающего меню Draw > Arc

или щелчком мыши по пиктограмме Arc на панели инструментов Draw.

Дуги можно строить различными способами. По умолчанию построение произво-
дится путем указания трех точек: начальной, промежуточной и конечной. Дугу мож-
но также определить, задав центральный угол, радиус, направление или длину хор-
ды. Хордой называется отрезок, соединяющий начало и конец дуги. По умолчанию
дуга рисуется против часовой стрелки.

Ключи команды ARC:
\

О Center — точка центра дуги;

ГЛ End — конечная точка дуги;

Q Angle — величина угла;

О chord Length — длина хорды;

О Direction — направление касательной;

Q Radius — радиус дуги.

Существует несколько способов построения дуги при помощи команды ARC.

Q 3Point — построение дуги по трем точкам, лежащим надуге. Запросы коман-
ды ARC:

Specify start point of arc or [CEnter] : — указать начальную точку дуги;

Specify second point of arc or [CEnter/ENd] : — указать вторую точку
дуги;

Specify end point of arc: — указать конечную точку дуги.
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Q Start, Center, End— построение дуги по стартовой точке, центру и конеч-
ной точке дуги. Положительным направлением считается построение дуги про-
тив часовой стрелки. Запросы:

Specify start point of arc or [CEnter] : — указать начальную точку
Дуги;

Specify second point of arc or [CEnter/ENd] : С — переход в режим
построения дуги по центру;

Specify center point of arc: —указать центр дуги;

Specify end point of arc or [Angle/chord Length]: — указать конеч-
ную точку дуги.

О Start, Center, Angle— построение дуги по стартовой точке, центру и углу.
Положительным направлением считается построение дуги против часовой
стрелки; изменить направление на противоположное можно, задав отрицатель-
ное значение угла. Запросы:

Specify start point of arc or [CEnter] : — указать начальную точку
дуги;

Specify second point of arc or [CEnter/ENd]: С — переход в режим
построения дуги по центру;

Specify center point of arc: — указать центр дуги;

Specify end point of arc or [Angle/chord Length]: A — переход
в режим построения дуги по углу;

Specify included angle:—указать центральный угол.

Q Start, Center, Length — построение дуги по стартовой точке, центру
и длине хорды. Дуга строится против часовой стрелки от начальной точки, при-
чем по умолчанию — меньшая из двух возможных (то есть дуга, которая мень-
ше 180°). Если же вводится отрицательное значение длины хорды, будет нари-
сована большая дуга. Запросы:

Specify start point of arc or [CEnter] : — указать начальную точку
дуги;

Specify second point of arc or [CEnter/ENd] : С — переход в режим
построения дуги по центру;

Specify center point of arc:—указать центр дуги;

Specify end point of arc or [Angle/chord Length]: L — переход
в режим построения дуги по длине хорды;

Specify length of chord:— указать длину хорды.
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Q Start, End, Angle — построение дуги по стартовой точке, конечной точке
и углу. Положительным направлением считается построение дуги против ча-
совой стрелки, изменить направление на противоположное можно, задав отри-
цательное значение угла. Запросы:

Specify start point of arc or [CEnter] : — указать начальную точку дуги;

Specify second point of arc or [CEnter/ENd] : E — переход в режим
построения'дуги по конечной точке;

Specify end point of arc: —указать конечную точку дуги;

Specify center point of arc or [Angle/Direction/Radius]: A —
переход в режим построения дуги по углу;

Specify included: — указать центральный угол.

Q Start, End, Direction — построение дуги по стартовой точке, конечной
точке и направлению — углу наклона касательной из начальной точки. Запросы:

Specify start point of arc or [CEnter] : — указать начальную точку дуги;

Specify second point of arc or [CEnter/ENd]: E — переход в режим
построения дуги по конечной точке;

Specify end point of arc: — указатьконечную точку дуги;

Specify center point of arc or [Angle/Direction/Radius]: D —
переход в режим построения дуги по направлению касательной;

Specify tangent direction for the start point of arc: —указать
направление касательной от начальной точки дуги.

Q Start, End, Radius — построение дуги по стартовой точке, конечной точке
и радиусу. Строится меньшая дуга против часовой стрелки. Запросы:

Specify start point of arc or [CEnter] : — указать начальную точку
дуги;

Specify second point of arc or [CEnter/ENd]: E — переход в режим
построения дуги по конечной точке;

Specify end point of arc: —указать конечную точку дуги;

Specify center point of arc or [Angle /Direction /Radius] : R —
переход в режим построения дуги по радиусу;

Specify radius of arc: — указать радиус дуги.

•Q Center, Start, End — построение дуги по центру, стартовой и конечной
точке. Запросы:

5 Зак. 1039
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Specify start point of arc or [CEnter] : С — переход в режим постро-
ения дуги по центру;

Specify center point of arc: — указать центр дуги;

Specify start point of a r c : — указать начальную точку дуги;

Specify end point of arc or [Angle/chord Length] : — указать конеч-
ную точку дуги.

Q Center, Start, Angle — построение дуги по центру, стартовой точке и углу.
Запросы:

Specify start point of arc or [CEnter] : С — переход в режим постро-
ения дуги по центру;

Specify center point of arc:—указать центр дуги-

Specify start point of a r c : — указать начальную точку дуги;

Specify end point of arc or [Angle/chord Length]: A — переход
в режим построения дуги по углу;

Specify included angle: — указать центральный угол.

Q Center, Start, Length — построение дуги по центру, стартовой точке
и длине хорды. Запросы:

Specify start point of arc or [CEnter]: С — переход в режим постро-
ения дуги по центру;

Specify center point of arc:—указать центр дуги;

Specify start point of arc: —указать начальную точку дуги;

Specify end point of arc or [Angle/chord Length]: L — переход
в режим построения дуги по длине хорды;

Specify length of chord: — указать длину хорды.

Q ArcCont: — построение дуги как продолжения предшествующей линии или
дуги. При этом начальной точкой дуги и ее начальным направлением станут
соответственно конечная точка и конечное направление последней созданной
дуги или последнего созданного отрезка. Такой способ особенно удобен для
построения дуги, касательной к заданному отрезку. Запросы:

Specify start point of arc or [CEnter] : — указать начальную точку дуги;

Specify end point of arc: — указать конечную точку дуги.

Выполните упражнения А1-А5 из раздела 2.
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Построить дугу по трем точкам А1

АГС '?*'••. Падающее пеню Draw »~ Arc »- J Points

Specify start point of arc or [CEnter]: 320,130 начальная точка 1

Specify second point of arc or [CEnter/ENd]: 380,70 вторая точка 2

Specify end point of arc: 260,70 конечная точка З

Построить дугу
по начальной точке, центру и величине угла А2

Arc Г.. St,C,Ang
Specify start point of arc or [CEnter]: 240,70 начальная точка 1

Specify second point of arc or [CEnter/ENd]: с
Specify center point of arc: 300,70 иентр дуги точка 2

Specify end point of arc or [Angle/chord Length]: a
Specify included angle: 270 угол

ПОСТРОИТЬ Дугу / до
по начальной точке, центру и длине хордьЛмо

Arc f~ St.C.Len
Specify start point of arc or [CEnter]: 290,80 начальной точка I

Specify second point of arc or [CEnter/ENd]: с
Specify center point of arc: 350,80 центр дуги точка 2

Specify end point of arc or [Angle/chord Length]: L
Specify length of chord: —100 длит хорды

L = - ЮО дуга > 180
L= 100 дуга < 180 -л
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Построить дугу по двум точкам и радиусу (А4

Arc Г St,E,Rad
Specify start point of arc or [CEnter]: 290,70 начальная точка 1

Specify second point of arc or [CEnter/ENd]: e
Specify end point of arc: 370,120 конечная точка 2

Specify center point of arc or [Angle/Direction/Radius]: r
Specify radijs of arc: —60 радиус

R=-60 dyza > 180
R= 60 дуга < 180

Построить дугу по двум точкам и касательной (А5

Arc Г St.E.Dir
Specify start point of arc or [CEnter]: 270,60 начальная точка 1

Specify second point of arc or [CEnter/ENd]: e
Specify end point of arc: 350,110 конечная точка 2

Specify center point of arc or [Angle/Direction/Radius]: d
Specify tangent direction for the start point of arc: — 60 направление

D=-60 no часовой стрелке
D- 90 прошиб часовой стрелки

2

Эллипс
jfl Команда ELLIPSE, обеспечивающая формирование эллипса, вызывается из

падающего меню Draw > Ellipse или щелчком мыши по пиктограмме Ellipse на
панели инструментов Draw.

Имеется возможность строить эллипсы и эллиптические дуги, причем с матема-
тической точки зрения эти объекты — действительно эллипсы, а не какие-либо
аппроксимирующие их кривые.

По умолчанию построение эллипсов производится путем указания начальной
и конечной точек первой оси, а также половины длины второй оси.

Самая длинная ось эллипса называется его большой осью, самая короткая — малой.

Оси могут определяться в любом порядке.
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Запросы команды ELLIPSE:
С

Specify axis endpoint of ellipse or [Arc/Center] : —указатьконеч-
ную точку оси эллипса;

Specify other endpoint of a x i s : — указать вторую конечную точку оси;

Specify distance to other axis or [Rotation]:—указать длину дру-
гой оси.

Ключи команды ELLIPSE:

Q Center — указание центра эллипса. Запросы:

Specify axis endpoint of ellipse or [Arc/Center] : С — переход в ре-
жим указания центра эллипса;

Specify center of ellipse: — указать центр эллипса;

Specify endpoint of axis :—указать конечную точку оси;

Specify distance to other axis or [Rotation]:—указать длину дру-
гой оси.

Q Arc — режим построения эллиптических дуг. По умолчанию эллиптические дуги,
как и эллипсы, строятся путем указания конечных точек первой оси и полови-
ны длины второй. После этого задаются начальный и конечный углы. Нулевым
углом считается направление от центра эллипса вдоль его большой оси. На-
правление возрастания угла определяется значением системной переменной
ANGDIR. Если она равна 0, то возрастание угла происходит при движении про-
тив часовой стрелки; если 1 — по часовой стрелке. Если начальный и конечный
углы совпадают, строится полный эллипс. Вместо конечного угла можно ука-
зать центральный угол дуги, измеренный от начальной точки. Запросы:

Specify axis endpoint of ellipse or [Arc/Center] : A — переход в ре-
жим построения эллиптических дуг;

Specify axis endpoint of elliptical arc or [Center] : —указать
конечную точку оси эллиптической дуги;

Specify other endpoint of axis :—указать вторую конечную точку оси;

Specify distance to other axis or [Rotat ion]:—указать длину дру-
гой оси;

Specify start angle or [Parameter] : — указать начальный угол;

Specify end angle or [Parameter/Included angle] :—указать конеч-
ный угол.

Выполните упражнение EH из раздела 2.
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Построить эллипс по двум осям

Ellipse О Падающее меню Draw—•- Ellipse

Specify axis endpoint of ellipse or [Arc/Center]: 250,30 точка 1

Specify other endppint of axis: 360,100 точка 2

Specify distance to other axis or [Rotation]: 20 ло/швино оси

Кольцо
<Ш Команда DONUT формирует кольца, вызывается из падающего меню Draw > Donut

или щелчком мыши по пиктограмме Donut.

С помощью функции построения колец легко строить закрашенные кольцеобразные
объекты и круги. В действительности они представляют собой замкнутые полили-
нии ненулевой ширины. Для построения кольца необходимо задать его внутрен-
ний и внешний диаметры, а также центр. За один вызов команды можно построить
любое количество колец одинакового диаметра, но с разными центрами. Работа
команды завершается нажатием клавиши Enter. Если требуется построить запол-
ненный круг, следует задать нулевой внутренний диаметр кольца.

Текущее значение внутреннего диаметра кольца хранится в системной перемен-
ной DONUTID, а значение внешнего диаметра — в переменной DONUTOD. Закраской
колец и широких полилиний управляет системная переменная FILLMODE.

Запросы команды DONUT:

Specify inside diameter of donut <default>: — указатьвнутренний
диаметр кольца;

Specify outside .diameter of donut <defaul t>:— указать внешний
диаметр кольца;

Specify center of donut or <exit>: — указать центр кольца;

Specify center of donut or <exit>:— указать центр кольца;

Specify center of donut or <exit>: — для завершения команды нажать
клавишу Enter.

Выполните упражнение DO1 из раздела 2.



Текст 135

Построить кольцо (бублик)

Donut @ Падаюшее меню DfOW —~- Donut

Specify inside diameter of donut: 40 внутр. диаметр

Specify outside diameter of donut:. 50 внешний диаметр

Specify center of donut or <exit>: 290,40 точка 1

Specify center of donut or <exit>: <Enter>

О О
Текст

Текстовые стили
С каждой текстовой надписью в AutoCAD связан некоторый текстовый стиль.
При нанесении надписей используется текущий стиль, в котором заданы шрифт,
высота, угол поворота, ориентация и другие параметры. В одном рисунке можно
создавать и использовать несколько текстовых стилей, причем их быстрое копи-
рование из одного рисунка в другой обеспечивается благодаря Центру управле-
ния. Текстовые стили представляют собой неграфические объекты, которые так-
же хранятся в файле рисунка. Все текстовые стили, кроме Standard, пользователь
создает по своему желанию.

|Ц Создание и модификация текстового стиля производятся в диалоговом окне

Text Style, вызываемом из падающего меню Format > Text Style... (рис. 5.10).

;;2Щ||Ю«

i*K:. k̂ , Р̂Шй|||

IllllSil

lliibsffiiil!

Рис. 5.10. Диалоговое окно текстовых стилей
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Для создания нового стиля необходимо щелкнуть мышью по кнопке New... — при
этом будет загружено диалоговое окно New Text Style, показанное на рис. 5.11. Здесь
вводится имя создаваемого стиля. Ему присваиваются значения параметров, пер-
воначально заданные в окне Text Style и, как правило, нуждающиеся в изменении.

о-

Рис. 5.11. Диалоговое окно определения нового стиля

В области Font из раскрывающегося списка Font Name: следует выбрать подходя-
щий шрифт, определяющий форму текстовых символов (например, simplex.shx).
В списке присутствуют как откомпилированные SHX-шрифты AutoCAD, так и
системные шрифты TrueType. При выборе последних можно дополнительно за-
дать параметры начертания (например, полужирный или курсив). Для изменения
имени существующего текстового стиля используется кнопка Rename..., нажатие
которой выводит на экран соответствующее диалоговое окно Rename Text Style.

В области Effects доступны следующие опции:

d Upside down — обеспечивает поворот текста на 180° сверху вниз симметрично
горизонтальной оси;

Q Backwards — обеспечивает поворот текста на 180° слева направо симметрично
вертикальной оси;

rj Vertical — обеспечивает вертикальное расположение текста, то есть символы
выстраиваются один над другим;

Q в поле Width Factor: устанавливается степень сжатия/растяжения текста, то есть
масштабный коэффициент;

О в поле Oblique Angle: устанавливается угол наклона символов по отношению
к нормали, причем положительным считается угол наклона вправо — по часо-
вой стрелке, а отрицательным — влево, против часовой стрелки. Максимально
возможное значение данного параметра — 85°.

Сделанные изменения наглядно представлены в области Preview.

Высота текста задается в поле Height: и определяет размер знаков используемого
шрифта. Если в процессе описания стиля задана фиксированная высота текста,
при создании однострочных надписей запрос Height: не выводится. Если планиру-
ется наносить надписи разной высоты с использованием одного и того же тексто-
вого стиля, при его создании следует указать высоту 0.

Имеется возможность изменять параметры существующих текстовых стилей в диа-
логовом окне Text Style. Изменение типа шрифта или ориентации текста в каком-
либо стиле вызывает обновление всех текстовых объектов, использующих его. Из-
менение высоты символов, коэффициента сжатия или угла наклона не влияет на
имеющиеся текстовые объекты и применяется только при создании новых надписей.
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Однострочный текст

Текстовые надписи, добавляемые в рисунок, несут различную информацию. Они
могут представлять собой сложные спецификации, элементы основной надписи,
заголовки. Кроме того, надписи могут быть полноправными элементами самого
рисунка. Сравнительно короткие тексты, не требующие внутреннего форматиро-
вания, создаются с помощью команд DTEXT и TEXT и записываются в одну строку.
Однострочный текст хорошо подходит для создания заголовков.

Щ Команда DTEXT, формирующая однострочный текст, вызывается из пада-
ющего меню Draw > Text > Single Line Text или щелчком мыши по пиктограмме
Single Line Text.

Команда DTEXT предназначена для создания набора строк, расположенных одна
под другой. Переход к следующей строке производится нажатием клавиши Enter.
Каждая строка представляет собой отдельный объект, который можно перемещать
и форматировать.

Запросы команды DTEXT:

Current text style: "Standard" Text height: 2 . 5 О О О — т е к у щ и й тек-
стовый стиль и высота текста;

Specify start point of text or [Justi fy/Style] :—указать началь-
ную точку текста;

Specify height <de f au lt>: —указать высоту текста;

Specify rotation angle of text <0>: — указать угол поворота текста;

Enter text:—ввести текст;

Enter text: — ввести текст;

Enter text: — нажать клавишу Enter для завершения работы команды.

Запрос определения высоты Specify height <default>: появляется только
в том случае, если при описании текущего текстового стиля высота была задана
равной нулю.

Высоту текста можно установить графическим способом. От точки вставки текста
к указателю мыши в виде перекрестья протягивается «резиновая нить».

Если нажать левую кнопку мыши, то высоте будет присвоено значение длины этой
нити в момент нажатия.

При вводе символы отображаются на экране, но надпись еще не размещена окон-
чательно. Если в процессе ввода текста указать точку в любой части рисунка, кур-
сор перемещается в нее. После этого можно продолжать вводить текст. Фрагмент
текста, набранного после указания точки, представляет собой самостоятельный
объект.
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Ключи команды DTEXT:

Q Style — установить текущий стиль;

rj Just i fy — установить режим выравнивания текстовой строки с использова-
нием ключей выравнивания. При использовании ключа Justify команда DTEXT
выдает следующие запросы:

Current text style: "Standard" Text height: 2 .5000 —текущий тек-
стовый стиль и высота текста;

Specify start point of text or [Just i fy/Style] : J — переход в ре-
жим выравнивания текстовой строки.

Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/
MR/BL/BC/BR]:

где:

Q Align формирует вписанный текст, запрашивая его начальную и конечную
точки. Высота и ширина каждого символа вычисляются автоматически так,
чтобы текст точно вписывался в заданную область. При использовании ключа
Align команда DTEXT выдает следующие запросы:

Current text style: "Standard" Text height: 2 .5ООО—текущий тек-
стовый стиль и высота текста;

Specify start point of text or [Just i fy/Style]: J — переход в ре-
жим выравнивания текстовой строки;

Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/
MR/BL/BC/BR] : A — переход в режим формирования вписанного текста;

Specify f irst endpoint of text baseline: — указать первую конечную
точку базовой линии текста;

Specify second endpoint of text baseline: — указать вторую конечную
точку базовой линии текста;

Enter text: — ввести текст;

Enter text: — ввести текст;

Enter text: — нажать клавишу Enter для завершения работы команды.

Q Fit формирует вписанный текст, выровненный по ширине и высоте. Запраши-
вает начальную и конечную точки текста, а также его высоту. При использова-
нии ключа Fit команда DTEXT выдает следующие запросы:

Current text style: "Standard" Text height: 2 . 5 О О О — т е к у щ и й тек-
стовый стиль и высота текста;
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Specify start point of text or [Just i fy/Style] : J — переход в ре-
жим выравнивания текстовой строки;

Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/
BL/BC/BR] : F — переход в режим формирования текста, вписаннрго по ширине
и высоте;

Specify f irst endpoint of text baseline: —указать первую конечную
точку базовой линии текста;

Specify second endpoint of text baseline: — указать вторую конечную
точку базовой линии текста; .'

Specify height <2 .500 0> :—указать высоту текста;

Enter text: — ввести текст;

Enter text:—ввести текст;

Enter text: — нажать клавишу Enter для завершения работы команды.

D Center обеспечивает центрирование базовой линии текстовой строки относи-
тельно заданной точки. При использовании ключа Center команда DTEXT вы-
дает следующие запросы:

Current text style: "Standard" Text height: 2 . 5 О О О — т е к у щ и й тек-
стовый стиль и высота текста;

Specify start point of text or [Just i fy/Style] : J— переход в ре-
жим выравнивания текстовой строки;

Enter an option [Al ign/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/
MR/BL/BC/BR] : С — переход в режим формирования центрированного текста;

Specify center point of text:—указать центральную точку текста;

Specify height <2 . 500 0>: — указать высоту текста;

Specify rotation angle of text <0> : — указать угол поворота текста;

Enter text: —ввеститекст;

Enter text: — ввести текст;

Enter text: — нажать клавишу Enter для завершения работы команды.

Q Middle обеспечивает горизонтальное и вертикальное центрирование тексто-
вой строки относительно заданной точки. Различие между данным ключом и
ключом МС, о котором пойдет речь ниже, состоит в том, что используется не
средняя точка между верхом и базовой линией, а середина воображаемой рам-
ки, в которую заключена строка текста. Таким образом, разница видна при на-
личии символов, доходящих до нижней или верхней базовых линий. При ис-
пользовании ключа Middle команда DTEXT выдает следующие запросы:
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Current text style: "Standard" Text height: 2 . 5 О О О —текущий тек-
стовый стиль и высота текста;

Specify start point of text or [Just i fy/Sty le] : J — переход в ре-
жим выравнивания текстовой строки;

Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/
MR/BL/BC/BR]: M — переход в режим формирования текста, центрированного по
горизонтали и вертикали;

Specify middle point of text:—указать среднюю точку текста;

Specify height <2 . 50 00>: — указать высоту текста;

Specify rotation angle of text <0>:—указать угол поворота текста;

Enter text:—ввести текст;

Enter text: — ввести текст;

Enter text: — нажать клавишу Enter для завершения работы команды.

О Right служит для выравнивания текстовой строки по правому краю. При ис-
пользовании ключа Right команда DTEXT выдает следующие запросы:

Current text style: "Standard" Text height: 2 . 5ООО—текущий тек-
стовый стиль и высота текста;

Specify start point of text or [Just i fy/Styles] : J — переход в ре-
жим выравнивания текстовой строки;

Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/
MR/BL/BC/BR] : R — переход в режим формирования текстовой строки, выров-
ненной по правому краю;

Specify right endpoint of text baseline: —указать правую конечную
точку базовой линии текста;

Specify height <2 . 500 0>: — указать высоту текста;

Specify rotation angle of text < 0 > : — указать угол поворота текста;

Enter text:—ввести текст;

Enter text: — ввести текст;

Enter text: — нажать клавишу Enter для завершения работы команды.

Q TL формирует текстовую строку, выровненную по верхнему и левому краям;

Q ТС формирует текстовую строку, выровненную по верхнему краю и центриро-
ванную по горизонтали;

Q TR формирует текстовую строку, выровненную по верхнему и правому краям;



Текст * 141

О ML формирует текстовую строку, центрированную по вертикали и выровнен-
ную по левому краю;

Q МС формирует текстовую строку, центрированную по вертикали и по горизон-
тали относительно средней точки;

Q MR формирует текстовую строку, центрированную по вертикали и выровнен-
ную по правому краю;

Q BL формирует текстовую строку, выровненную по нижнему и левому краям;

О ВС формирует текстовую строку, выровненную по нижнему краю и центриро-
ванную по горизонтали;

О BR формирует текстовую строку, выровненную по нижнему и правому краям.

Выполните упражнения Т1-Т7 из раздела 2.

Сформировать динамический текст Т1
_ дт
Utext t\l

Падающее меню

__ Single Line Text

Current text style: Задание" Text height: 5.0000

Specify start point of text or [Justify/Style]: 240, 40 стартовая точка 1

Specify height <5.0000>: 20 высота текста

Specify rotation angle of text <0>: 0 угол поворота строки

Enter text: Строка формируемая надпись
Enter text: текста формируемая надпись
Enter text: <Enter>

,.Строка
текста

Сформировать вписанный текст

Dtext A!
Current text style: "Задание1 Text height: 5.0000
Specify start point of text or [Justify/Style]: Jus
Enter an option

[Align/Fit/Center/Middle/Right/TL/.../BC/BR]: Align

Specify first endpoint of text baseline: 240,40

Specify second endpoint of text baseline: 390,40
Enter text: Строка
Enter text:
Enter text:

Вписанного текста
<Enter>

писанный

точка 1

точка 2
формируемая надпись
формируемая надпись
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Сформировать текст, выровненный по центру (J3

Dtext А!
Current text style: "Задание" Text height: 5.0000
Specify start point of text or [Justify/Style]: Jus
Enter an option

[Align/Fit/Center/Middle/Right/TL/.../BC/BR]: Center no центру

Specify center point of text: 310,40 точка 7
Specify height <5.0000>: 15 высота символа

Specify rotation angle of text <0>: 0 угол поборота строки

Enter text: Центриробанной формируемая надпись
Enter text: текст формируемая надпись
Enter text: <Enter>

Центриррванный
текст

,_
Сформировать текст, выровненный по ширине ^Т4

Dtext Al
Current text style: "Задание" Text height: 5.0000
Specify start point of text or [Justify/Style]: Jus выровненный
Enter an option

[Align/Fit/Center/Middle/Right/TL/.../BC/BR]: Fit no ширине

Specify first endpoint of text baseline: 240,40 точка 1
Specify second endpoint of text baseline: 380,40 точка 2

Specify height <5.0000>: 10 высота символа

Enter text: Текст, формируемая надпись
Enter text: быробненныО по ширине формируемая надпись
Enter text: <Enter>

7

V
выровненный по ширине

•}

Сформировать текст, / -т-с
выровненный по середине * '

Dtext М
Current text style: "Задание" Text height: 5.0000
Specify start point of text or [Justify/Style]: Jus выровненный
Enter an option

[Align/Fit/Center/Midd!e/Right/TL/.../BC/BR]: Middle no середине

Specify middle point of text: 310,40 точка 1
Specify height <5.0000>: 10 высота символа

Specify rotation angle of text <0>: 0 угол поборота строки

Enter text: Текст, формируемая надпись
Enter text: Выровненный по середине формируемая надпись
Enter text: <Enter>

7
Текст,

выровненный по середине
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Сформировать текст, выровненный вправо т
Dtext ;A[
Current text style; 'Задание' Text height: 5.0000
Specify start point of text or [Justify/Style]: Jus выровненный
Enter an option

[Align/Fit/Center/Middle/Right/TL/.../BC/BR]: Right вправо

Specify middle point of text: 310,40 точка 1
Specify height <5.0000>: 10 высота символа

Specify rotation angle of text <0>: 0 угол поворота строки

Enter text: Текст, формируемая надпись
Enter text: выровненный вправо формируемая надпись
Enter text: <Enter>

Ч

Текст,
выровненный вправо

J

Создать наклонный стиль текста Т7

Style Падающее меню Format — »-Text Style...
В диалогобом окне Text Style Выбрать кнопку 1""'Е"<-. "" I

В поле Style Name: указать новое имя стиля

В раскрывающемся списке Font Name бьбрать: simplex. shx
В поле Oblique Angle (Угол наклона) указать: 15 градусов

В поле Height (Высота) указать: 0 (ноль III)

Используя команду Dtext Д£ , написать сбое имя.

у\о

Многострочный текст
Длинные сложные надписи оформляются как многострочный текст с помощью
команды МТЕХТ. Многострочный текст обычно вписывается в заданную ширину
абзаца, но его можно растянуть и на неограниченную длину. В многострочном тек-
сте допускается форматирование отдельных слов и символов.

Многострочный текст состоит из текстовых строк или абзацев, вписанных в ука-
занную пользователем ширину абзаца.

Количество строк не лимитировано. Весь многострочный текст представляет со-
бой единый объект, который можно перемещать, поворачивать, стирать, копиро-
вать, зеркально отображать, растягивать и масштабировать.

Возможности редактирования многострочного текста шире, чем однострочного.
Например, для многострочных надписей предусмотрены режимы подчеркивания
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и надчеркивания выделенных фрагментов; также разрешено указывать для них
отдельные шрифты, цвета, высоту символов.

!|S Команда МТЕХТ, формирующая многострочный текст, вызывается из пада-
ющего меню Draw > Text > Multiline Text... или щелчком мыши по пиктограмме
Multi l ine Text на панели инструментов Draw.

Запросы команды МТЕХТ:

Current text style: "Standard" Text height: 10.0000 — текущий
текстовый стиль и высота текста;

Specify f i rs t corner :— указать первый угол окна абзаца;

Specify opposite corner or[Height/Justify/Line spacing/Rotation/
Style/Width] : — указать противоположный угол окна абзаца.

После указания размеров абзаца загружается редактор многострочного текста,
содержащий панель форматирования текста Text Formattinq и контекстное меню
(рис. 5.12).

Multiline Text
Рис. 5.12. Редактор многострочного текста

Панель Text Formatting позволяет определить следующие параметры:

Q Style — список текстовых стилей, которые можно применить для многостроч-
ного текста. При этом соответственно изменяется исходный формат симвЪлов —
шрифт, высота и начертание. Выбор стиля не влияет на используемый стиль
форматирования отдельных символов (полужирный, курсивный, дробный и т. д.).
Если стиль, в котором задано вертикальное начертание, применяется к SHX-
шрифту, то в редакторе текст будет выведен горизонтально: Стили, в которых
заданс^обратное или перевернутое начертание символов текста, не применяют-
ся. Текущий стиль запоминается в системной переменной TEXTSTYLE;

Q Font — установка шрифта для нового текста или изменение шрифта выделен-
ного фрагмента. Шрифты TrueType упорядочиваются в списке по именам
шрифтовых семейств. AutoCAD выводит список шрифтов SHX, упорядочен-
ный по именам соответствующих им файлов;

Q Text Height — установка высоты символов или ее изменение для выделенного
фрагмента текста. Высота задается в единицах рисунка, причем для разных
символов может быть разной. Если высота символов не определена в выбран-
ном текстовом стиле, ее значение хранится в системной переменной TEXTS IZE;
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Р Bold — включение и отключение полужирного начертания символов для ново-
го или выделенного текста. Опция доступна только для символов, использу-
ющих шрифты TrueType;

Q Italic — включение и отключение курсивного начертания для нового или выде-
ленного текста. Опция доступна только для символов, использующих шрифты
TrueType;

Р Underline — включение и отключение подчеркивания для нового или выделен-
ного текста;

Q Undo — отмена последней операции редактирования;

Р Redo — повторение последней операции редактирования;

Р Stack — создание дробного текста. Для этого необходимо выделить фрагмент
текста, содержащий специальные символы: крышку Л, обычную косую черту /
или решетку #. Тексты, содержащие символ Л, преобразуются в выровненные
по левому краю значения допусков; содержащие символ / — в выровненные по
центру дроби с горизонтальным разделителем, длина которого соответствует
длине наибольшей из выводимых друг над другом строк; включающие символ
I — в числовые дроби с диагональным разделителем, длина которого зависит
от высоты обеих разделяемых строк; текст над диагональной чертой выравни-
вается вниз и вправо, под чертой — вверх и влево. Если был выделен дробный
текст, нажатие кнопки Stack превращает его в обычный. При преобразовании
обычного текста в дробный фрагмент, расположенный слева от специальных
символов, выводится над частью, расположенной справа от них;

Р Color — назначение цвета нового текста или изменение цвета выделенного фраг-
мента. Можно присваивать тексту цвет ByLayer, заданный для слоя, на котором
он расположен, или цвет блока, в который он входит, — ByBlock, а также задать
любой из цветов, перечисленных в списке;

Р OK (Ctrl+Enter) — сохранение сделанных изменений и выход из редактора. Тот
же результат можно получить, щелкнув мышью по рисунку вне окна редакто-
ра. Для завершения работы без сохранения изменений следует нажать клави-
шу Esc.

Контекстное меню, которое включено в редактор многострочного текста, содержит
пункты, используемые при редактировании как обычного, так и многострочного
текста. Меню вызывается щелчком правой кнопкой мыши в окне редактора. Пять
пунктов, расположенных в верхней части, — Undo,.Redo, Cut, Copy и Paste, — предна-
значены для редактирования текстов любого типа. Следующие команды доступ-
ны только в редакторе многострочного текста:

Р Indents and Tabs... — загружает диалоговое окно Indents and Tabs, показанное на
рис. 5.13. Там задаются отступы первой строки, абзаца и позиции табуляции.
Значения отступа первой строки и всего абзаца могут различаться;

Р Set Mtext Width — этот пункт находится в отдельном меню, вызываемом щелч-
ком правой кнопкой мыши по линейке в верхней части окна. При этом за-
гружается диалоговое окно установки ширины Set Mtext Width, показанное на
рис. 5.14. Ширина измеряется в единицах рисунка;
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Рис. 5.13. Диалоговое окно отступов и табуляции

BfflSet Mtext Width

Рис. 5.14. Диалоговое окно установки ширины

Q Justification — выбор типа выравнивания для многострочного текста. По умол-
чанию используется вариант Top Left. При выравнивании абзаца и разбиении
его на строки учитываются все пробелы. В горизонтальном направлении текст
может центрироваться либо выравниваться влево/вправо. По вертикали текст
может выравниваться по середине, вверх или вниз. Доступны следующие вари-
анты:

• Top Left — вверх влево;

• Middle Left — середина влево;

• Bottom Left — вниз влево;

• Top Center — вверх по центру;

• Middle Center — середина по центру;

• Bottom Center — вниз по центру;

• Top Right — вверх вправо;

• Middle Right — середина вправо;

• Bottom Right — вниз вправо;

Q Find and Replace... — загрузка диалогового окна Replace, где осуществляются по-
иск фрагментов текста и замена их новыми;

О Select All — выделение всего текста в окне редактора;

Q Change Case — изменение регистра выбранного текста. Раскрывает подменю, со-
держащее два пункта: UPPERCASE Ctrl+Shift+U и lowercase Ctrl+Shift+L;

Q AutoCAPS — преобразование вводимого и импортируемого текста в верхний ре-
гистр. Функция не влияет на уже набранный в редакторе текст. Для изменения
регистра имеющегося текста следует выделить нужный фрагмент, щелкнуть
правой кнопкой мыши и выбрать из контекстного меню пункт Change Case;
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Q Remove Formatting — отмена полужирного и курсивного начертаний, а также
подчеркивания выделенного текста;

Q Combine Paragraphs — слияние выбранных абзацев в один. При этом каждый знак
абзаца автоматически заменяется пробелом;

Q Symbol — вставка выбранного в списке символа или неразрывного пробела в те-
кущей позиции курсора. После выбора опции Other... выводится таблица сим-
волов, в которой представлен весь набор символов текущего шрифта. Для встав-
ки нужно последовательно выделить один или несколько символов, нажать
кнопку выбора, а затем — копирования; при этом отмеченные символы копи-
руются в буфер обмена. Далее необходимо в редакторе многострочного текста
выбрать из контекстного меню пункт Paste. Следует учесть, что символ диамет-
ра отображается как %%С, но после вставки в рисунок этот и другие специаль-
ные символы отображаются корректно;

Q Import Text... — вызов диалогового окна Select file. Для импорта следует выбрать
файл в формате ASCII или RTF. Импортированный текст сохраняет исходные
форматирование и свойства, заданные стилем, однако его можно отредактиро-
вать и переформатировать. Объем файла с импортируемым текстом не должен
превышать 32 Кбайт;

Q Background Mask... — вызов диалогового окна Background Mask...;

Q Help — переход к описанию команды МТЕХТ в справочной системе.

Допускается изменение свойств только выделенной части текста. Символ можно
выбрать одним щелчком мыши, слово — двойным щелчком, абзац — тройным.

Дробные тексты представляют собой фрагменты текста одной строки, располо-
женные на разных уровнях относительно базовой линии строки, и служат для за-
писи натуральных дробей, предельных отклонений размеров и т. д. Для указания
места разбиения текста используются специальные символы:

Q косая черта (/) — для создания двухуровневого текста в виде обыкновенной
дроби, числитель и знаменатель которой располагаются друг над другом и раз-
деляются горизонтальной чертой;

Q решетка (#) — для создания двухуровневого текста в виде обыкновенной дро-
би, числитель и знаменатель которой располагаются по диагонали и разделя-
ются косой чертой;

Q крышка (Л) — при создании двухуровневого текста для записи предельных от-
клонений, элементы которого располагаются один над другим без разделитель-
ной черты.

Например, если после 1#3 ввести какой-либо нецифровой символ или пробел,
средство автоформатирования разместит эти цифры в виде дроби с косой чертой.
Кроме того, можно автоматически удалять незначащие пробелы перед целой и дроб-,
ной частями числа.

Средство автоформатирования преобразует числа в дробный текст только в том
случае, если между цифрами и символом-разделителем (косой чертой, решеткой
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или крышкой) нет пробелов. Для преобразования в дробный вид произвольного
фрагмента, содержащего символ-разделитель, этот фрагмент следует выделить, а за-
тем нажать кнопку Stack на панели Text Formatting.

При редактировании дробного текста можно изменять содержимое верхнего и ниж-
него элементов текста по отдельности, применять стандартные параметры или со-
хранять текущие значения параметров в качестве стандартных.

Допускается вставка текста из другого приложения Windows в рисунок AutoCAD,
при этом связь с приложением не теряется. Можно либо импортировать текст,
либо захватить и отбуксировать в окно AutoCAD пиктограмму текстового файла
из Проводника Windows.

Импорт ASCII- и RTF-файлов, созданных в других приложениях, значительно
ускоряет работу с рисунками, где используются однотипные надписи. Например,
можно создать текстовый файл со стандартными примечаниями для включения в
рисунок и вместо того, чтобы каждый раз вводить их с клавиатуры, выполнять импорт
из файла. Импортированный текст становится текстовым объектом AutoCAD; его
можно редактировать так же, как и созданные в самой программе AutoCAD над-
писи. Исходное форматирование текста сохраняется.

Блок
Блоком называется совокупность связанных объектов рисунка, обрабатываемых
как единый объект. Формирование часто используемых объектов может быть про-
изведено всего один раз. Затем они объединяются в блок и при построении чертежа
выполняют роль «строительных материалов». Применяя блоки, легко создавать
фрагменты чертежей, которые будут неоднократно требоваться в работе. Блоки
можно вставлять в рисунок с масштабированием и поворотом, расчленять их на
составляющие объекты и редактировать, а также изменять описание блока. В по-
следнем случае AutoCAD обновляет все существующие вхождения блока и при-
меняет новое описание ко вновь вставляемым блокам.

Применение блоков упрощает процесс рисования. Их можно использовать, напри-
мер, в следующих целях:

О для создания стандартной библиотеки часто используемых символов, узлов и де-
талей. После этого можно неограниченное число раз вставлять готовые блоки,
вместо того чтобы каждый раз отрисовывать все их элементы;

Q для быстрого и эффективного редактирования рисунков п;»гтем вставки, переме-
щения и копирования целых блоков, а не отдельных геометрических объектов;

В для экономии дискового пространства путем адресации всех вхождений одно-
го блока к одному и тому же описанию блока в базе данных рисунка.

Блок может содержать любое количество графических примитивов любого типа,
а воспринимается AutoCAD как один графический примитив наравне с отрезком,
окружностью и т. д.
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Блок может состоять из примитивов, созданных на разных слоях, разного цвета,
с разными типами и весами линий. Все эти свойства примитивов сохраняются при
объединении их в блок и при вставке блока в рисунок. Однако необходимо учесть
следующее:

,

Q примитивы блока, созданные в специальном слое с именем 0, свойства которых
определены как ByLayer, при вставке генерируются в текущем слое, наследуя его
свойства;

О примитивы блока, свойства которых определены как ByBlock, наследуют те-
кущие значения;

СЗ свойства примитивов, заданные явно, сохраняются независимо от текущих зна-
чений свойств.

Один блок может включать в себя другие. Если внутренний блок содержит при-
митивы, созданные в слое 0 или характеризуемые цветом и типом линии ByBlock,
то эти примитивы «всплывают» наверх сквозь вложенную структуру блоков до тех
пор, пока не попадут в блок с фиксированным слоем, цветом или типом линии,
иначе они генерируются в слое 0.

Блоку может быть присвоено имя. AutoCAD создает блоки без имени (анонимные),
например, для ассоциативных размеров, то есть для примитивов, к которым не обес-
печен прямой доступ пользователя.

Применение блоков позволяет значительно сэкономить память. При каждой но-
вой вставке блока в рисунок AutoCAD добавляет к Имеющейся информации лишь
данные о месте вставки, масштабных коэффициентах и угле поворота.

С каждым блоком можно связать атрибуты, то есть текстовую информацию, ко-
торую разрешается изменять в процессе вставки блока в рисунок и которая может
изображаться на экране или оставаться невидимой.

При вставке блока на рисунке появляется так называемое вхождение блока. Во вре-
мя каждой вставки блока задаются масштабные коэффициенты и угол его поворо-
та. Масштабные коэффициенты по осям X, Y, Z могут быть различными.

Использование блоков в AutoCAD значительно упрощает создание, редактирова-
ние и сортировку объектов рисунка и связанной с ними информации.

Создание блока
Описание блока можно создать, сгруппировав объекты в текущем рисунке, или же
сохранить блок в отдельном файле. При создании описания блока задается базо-
вая точка и выбираются объекты, входящие в блок. Кроме того, необходимо ука-
зать, что происходит с исходными объектами: остаются ли они, удаляются или пре-
образуются в блок в текущем рисунке. Можно также ввести текстовое описание и
задать пиктограмму для обозначения блока в Центре управления AutoCAD. Опи-
сания блоков представляют собой неграфические объекты, которые, наряду с дру-
гими символами, хранятся в файле рисунка.
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Следует помнить, что имена DIRECT, LIGHT, AVE_RENDER, RM_SDB, SH_SPOT и OVERHEAD
не могут быть использованы в качестве имен блоков.

р> Команда BLOCK формирует блок для использования его только в текущем ри-

сунке. Она вызывается из падающего меню Draw > Block > Make... или щелчком
мыши по пиктограмме Make Block на панели инструментов Draw. В результате
открывается диалоговое окно Block Definition (рис. 5.15).

K i t " " 1 '"''
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Рис. 5.15. Диалоговое окно описания блока

При создании описания блока в диалоговом окне Block Definition следует:

Q в поле Name: ввести уникальное имя создаваемого блока;

Q в области Objects нажать кнопку Select objects и выделить мышью объекты, вхо-
дящие в блок. При этом диалоговое окно временно закрывается. По окончании
выделения необходимо нажать клавишу Enter, и диалоговое окно откроется сно-
ва. Воспользовавшись кнопкой быстрого выбора QuickSelect, можно применять
фильтры для выбора объектов;

Q в области Objects задать способ обработки выбранных объектов после создания
описания блока:

• Retain — выбранные объекты остаются в текущем рисунке в их исходном со-
стоянии;

• Convert to block — выбранные объекты заменяются вхождением блока;

• Delete — после создания описания блока выбранные объекты удаляются;

О в области Base point задать координаты базовой точки вставки или нажать кноп-
ку Pick point для выбора базовой точки с помощью мыши;
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Q в поле Description ввести текстовые пояснения для облегчения идентификации
и поиска блока впоследствии;

Q в области Preview icon указать, требуется ли создание пиктограммы для описа-
ния блока:

• Do not include an icon — изображение, используемое для предварительного
просмотра блока, не создается;

• Create icon from block geometry — изображение, используемое для предвари-
тельного просмотра блока, сохраняется с описанием блока.

Описание блока сохраняется в текущем рисунке.

Для получения блоков, которыми можно воспользоваться при создании любых чер-
тежей в AutoCAD, применяется команда WBLOCK. Она позволяет загрузить диало-
говое окно записи блока на диск Write Block (рис. 5.16), где доступны следующие
настройки:

Q Block: — указание блока, сохраняемого в отдельном файле;

Q Entire drawing — блоком становится весь рисунок;

Q Objects — указание объекта, сохраняемого в отдельном файле;

Q кнопка Pick point в области Base point — указание базовой точки на рисунке;

Q кнопка Select objects в области Objects — выбор объектов в файл блока;

Q ввод имени нового файла. Если выбран блок, то команда WBLOCK автоматиче-
ски использует его имя для нового файла;

О список Insert units: — выбор единиц вставки, используемых в Центре управле-
ния AutoCAD.

Описание блока сохраняется в отдельном рисунке.

I
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Рис. 5.16. Диалоговое окно записи блока на диск
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Выполните упражнение ВН из раздела 3.

Создать блок н
Block Щ

Падающее меню Draw ~-BldCk -~-Mdke...
В диалоговом окне Block Definition в поле Name: ввести

произвольное имя создаваемого блока, например: Hammer.
Щелкнуть мышью по кнопке Ш*и??".

Specify insertion base point: указать точку 1
Щелкнуть мышью по кнопке г̂**-**-*: .

Select objects: выбрать весь объект рамкой
Select objects: Enter „

Щелкнуть мытью по кнопке ' i ° ' s —>.

Вставка блока
|р Команда INSERT осуществляет вставку в текущий чертеж предварительно

определенных блоков или существующих файлов рисунков в качестве блока.

Команда INSERT вызывается из падающего меню Insert > Block... или щелчком
мыши по пиктограмме Insert на панели инструментов Draw. При этом загружается
диалоговое окно Insert (рис. 5.17).

Рис. 5.17. Диалоговое окно вставки блока

Имя вставляемого блока указывается в поле Name:. Если в областях определения
точки вставки Insertion point, масштаба Scale и угла поворота Rotation поставлены
флажки Specify On-screen, то команда INSERT выдает следующие запросы:

Specify insertion point or [ S c a l e / X / Y / Z / R o t a t e / P s c a l e / P X / P Y / P Z /
PRotate ] : — указать точку вставки блока;



Enter X scale factor, specify opposite corner,
<1>: — ввести масштаб по оси X;
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or [ C o r n e r / X Y Z ]

Enter Y scale factor <use X scale factor>: — ввести масштаб по оси У;

Specify rotation angle <0>: — ввести угол поворота.

Следует учесть, что при указании коэффициента масштабирования может быть
задано число или точка. Заданная точка вместе с точкой вставки определяют углы
масштабного прямоугольника, таким образом определяя одновременно масштаб
по осям X и Y. Если ввести ключ Corner, будет выдан запрос Other corner: на ввод
точки противоположного точке вставки угла масштабного прямоугольника. При
указании коэффициента масштабирования по оси Y по умолчанию принимается
значение, равное масштабу по оси X. Если коэффициент масштабирования задан
со знаком «минус», то осуществляется зеркальное отображение. При указании
угла поворота точка включения является центром поворота. Если для установки
угла поворота вводится точка, AutoCAD измеряет угол наклона линии от точки
вставки до этой точки и использует его в качестве угла поворота. Чтобы угол по-
ворота был кратен 90°, следует включить режим ORTHO.

При вставке одного рисунка в другой AutoCAD обрабатывает вставленный рису-
нок так же, как и обычное вхождение блока.

Выполните упражнение 1п1 из раздела 3.

Вставить блок в чертеж

Insert £§j
Падающее меню Insert ~-Block...

В диалоговом окне Insert 6 поле Name: двести имя вызываемого
блока, которое можно указать из раскрывающегося списка, например:
Detal. или Tree, или Саг и щелкнуть мышью по кнопке СЖЗ .
Specify insertion point or [Scale/X/Y/Z/Rotate/PScale/
/PX/PY/PZ/PRotate]: указать точку вставки блока

<о—-а"

jpl Команда EXPLODE разбивает блок на составляющие его объекты.

Команда EXPLODE вызывается из падающего меню Modify > Explode или щелчком
мыши по пиктограмме Explode на панели инструментов Modify.

При включении блока в чертеж AutoCAD обрабатывает его как графический при-
митив. Для обеспечения работы с его отдельными составляющими блок необхо-
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димо разбить или «взорвать». Это можно сделать и в момент вставки его в рису-
нок, поставив в диалоговом окне Insert флажок Explode.

Выполните упражнение Ер1 из раздела 3.

Взорвать(расчленить) блок

Erase. &
'" попробуйте удалить один иэ выделенных

Select objects: отрезкоЬ (указание 7 или 2).
Удаляется весь объект? Так и должно быть, поскольку бы пытаетесь
редактировать объект, являющийся блоком. Чтобы работать
с элементами блока, его необходимо взорвать.
Восстановите удаленный блок.

Explode *?': Падающее меню Modify »- Explode
Select objects: указать блок 6 любой точке контура
Select objects: Enter
Повторить команду удаления выделенных отрезков.



ГЛАВА 6 Команды оформления
чертежей

Q Штриховка
Q Простановка размеров
О Управление размерными стилями
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Штриховка
Штрихование — это заполнение указанной области по определенному образцу.

Щ! Команда ВНАТСН, формирующая ассоциативную штриховку, вызывается из
падающего меню Draw > Hatch... или щелчком мыши по пиктограмме Hatch на
панели инструментов Draw. При обращении к команде ВНАТСН загружается
диалоговое окно Boundary Hatch and Fill, показанное на рис. 6.1.

Рис. 6.1. Диалоговое окно штриховки

Команда ВНАТСН позволяет наносить не только ассоциативную, но и неассоци-
ативную штриховку. Ассоциативность здесь означает, что при изменении границ
контура изменяется и штриховка. Неассоциативная штриховка не зависит от кон-
тура границы. Определение контура в команде ВНАТСН производится автомати-
чески на основании указания точки, принадлежащей штрихуемой области. Все
объекты, полностью или частично попадающие в область штриховки и не явля-
ющиеся ее контуром, игнорируются и не влияют на процесс штриховки. В некото-
рых случаях контур содержит выступающие края и островки, которые можно либо
штриховать, либо пропускать. Островками называются замкнутые области, распо-
ложенные внутри области штрихования.

Команда ВНАТСН позволяет штриховать область, ограниченную замкнутой кри-
вой, как путем простого указания внутри контура, так и путем выбора объектов.
При этом контур определяется автоматически, а любые целые примитивы и их
составляющие, которые не являются частью контура, игнорируются.

В поставку AutoCAD входит более 50 образцов штриховки, удовлетворяющих
промышленным стандартам и служащих для обозначения различных компонен-
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Выбор образца штриховки осуществляется в области Pattern- Удобно поль-

е„
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Рис. 6.2. Диалоговое окно с образцами штриховки

выбъж^сТ* СТаВДарТНЫХ обРаз«ов штриховок необходимо в области Туре:
выбрать из раскрывающегося списка пункт Predefined. Имя образца штриховки
запоминается в системной переменной HPNAME. Текстовые поля Sca^e: и Angfe по

цГщЯтпих3оТЬпаСШТабНЫЙ КОЭ*Фи«иент и У^л наклона для выбранного образ-
ца штриховки. При этом введенные параметры запоминаются в системных пеое
менных HPSCALE И HPANG.

и П0льзовател^кий ^Разец штриховки, надо в области Type-
из раскрывающегося списка пункт User defined. При этом следует задать

угол наклона в поле Angle:, расстояние между линиями штриховки -в поле SpaSnq-

ний подН™Т° ' П°СТаВИТЬ ФЛаЖ°К D°Uble ДЛЯ °ТРИСОВКИ Дополнительных ли9:и под углом 90 к основным линиям штриховки.

В закладке Gradient диалогового окнами ndary Hatch and Fill, показанного на рис 6 3
«вливаются параметры градиентной заливки, которая может состоять из



158 * Глава 6. Команды оформления чертежей

оттенков одного цвета или представлять собой плавный переход из одного цвета
в другой.
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Ptto, 6.3. Диалоговое окно градиентной заливки

Ассоциативность штриховки устанавливается в области Composition выбором од-
ного из параметров: Associative или Noassociative.

Для автоматического определения контура штриховки путем указания точек не-
обходимо нажать кнопку Pick Points. При этом выдается запрос:

Select internal point: — указать внутреннюю точку;

Selecting everything. . . — осуществляется выбор всех объектов;

Selecting everything vis ible. . . — осуществляется выбор всех видимых
объектов;

Analyz ing the selected data. . . — осуществляется анализ выбранных
данных;

Analyzing internal i s lands. . . — осуществляется анализ внутренних ост-
ровков;

Select internal point:— указать внутреннюю точку;

Analyzing internal islands ... — осуществляется анализ внутренних ост-
ровков;

Select internal point: — нажать клавишу Enter по завершении выбора
штрихуемой области.
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При определении нескольких контуров штриховки необходимо выбрать несколь-
ко внутренних точек, а затем нажать клавишу Enter.

Если AutoCAD определяет, что контур не замкнут или точка находится вне кон-
тура, то на экране появляется диалоговое окно Boundary Definition Error с сообщени-
ем об ошибке.

Для выбора любым стандартным способом объектов в качестве контура штрихов-
ки необходимо нажать кнопку Select objects.

Контуры штриховки могут представлять собой любую комбинацию отрезков, дуг,
окружностей, двумерных полилиний, эллипсов, сплайнов, блоков и видовых экра-
нов пространства листа. Каждый из компонентов контура должен хотя бы частич-
но находиться в текущем виде. По умолчанию AutoCAD определяет контуры пу-
тем анализа всех замкнутых объектов рисунка.

Когда штрихование производится стилем Normal, островки остаются незаштрихо-
ванными, а вложенные островки штрихуются, как показано на рис. 6.4. При этом
штрихование производится вовнутрь, начиная от внешнего контура.

Если обнаружено внутреннее пересечение, штрихование прекращается, а на сле-
дующем пересечении возобновляется. Таким образом, данный стиль задает штри-
хование областей, отделенных от внешней части нечетным числом замкнутых кон-
туров; области, отделенные четным числом контуров, не штрихуются.

При использовании игнорирующего Ignore и внешнего стиля Outer штриховка ана-
логичного контура выглядит иначе (рис. 6.5, 6.6). Стиль Ignore задает штрихование
всей области, ограниченной внешним контуром, без учета вложенных контуров.
При использовании стиля Outer штрихование производится от внешнего контура
и окончательно прекращается при первом обнаруженном пересечении.

Рис. 6.4. Пример контура,
заштрихованного стилем
Normal

Рис. 6.5. Пример контура,
заштрихованного стилем
Ignore

Рис. 6.6. Пример контура,
заштрихованного стилем
Outer

Стили Normal, Ignore и Outer устанавливаются в области Island detection style на
вкладке Advanced диалогового окна Boundary Hatch (рис. 6.7).
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Рис. 6.7. Диалоговое окно определения стилей штриховки

Если на пути линии штриховки встречаются текст, атрибут, форма, полоса или
закрашенная фигура и данный объект входит в набор контуров, AutoCAD не на-
носит на него штриховку. В результате, например, читаемость текста, размещен-
ного внутри заштрихованного контура, не ухудшается. Если же перечисленные
объекты также нужно заштриховывать, следует воспользоваться стилем Ignore.

Выбор образца штриховки можно осуществить в окне инструментальной палит-
ры (см. рис. 1.28), перетащив образец штриховки на заданный контур.

Выполните упражнения Н1 и Н2 из раздела 2.

Выполнить штриховку замкнутой области (Н1

Hatch Падающее меню Draw Hatch...

В диалоговом окне Boundary Hatch о поле Pattern: Выбрать [J .

В диалоговом окне Hatch Pattern Palette Выбрать закладку ANSI.
В закладке ANSI выбрать шаблон ANSI31.
В диал. окне Boundary Hatch в поле Scale: указать масштаб 2.

Выбрать Щ Р*ЬР°"|«: , указать точку I внутри контура, ввести Enter.

в диалогобом окне Boundary Hatch ввести ОК.
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Выполнить штриховку замкнутой области (Н2

Hatch "Щ п

8 диалоговом окне Boundary Hatch в поле Pattern: выбрать Ы .

6 Зиал. окне Hatch Pattern Palette выбрать закладку Other Predefined.
В закладке Other Predefined выбрать шаблон ESCHER.
В диал. окне Boundary Hatch в поле Scale: указать масштаб 1.

Выбрать Й)'Р1(*Р™ПВ _ указать точку 1 на контуре, ввести Enter.

В диалоговом окне Boundary Hatch ввести ОК.

Простановка размеров

Размеры показывают геометрические величины объектов, расстояния и углы меж-
ду ними, координаты отдельных точек.

В AutoCAD используется 11 видов размеров, которые можно разделить на три ос-
новных типа: линейные (рис. 6.8-6.10),радиальные (рис. 6.11) и угловые (рис. 6.12).

Линейные размеры делятся на горизонтальные, вертикальные и параллельные, по-
вернутые, ординатные, базовые и размерные цепи.

Ниже будут приведены простые примеры их нанесения.

160

Рис. 6.8. Горизонтальный, вертикальный и параллельный размеры

6 Зак. 1039
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СЭ
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Рис. 6.9. Базовые размеры Рис. 6.10. Размерные цепи

Рис. 6.11. Радиальные размеры

Рис. 6.12. Угловые размеры

Команды простановки размеров находятся в падающем меню Dimension. Для удоб-
ства можно воспользоваться пиктограммами на одноименной панели инструмен-
тов (рис. 6.13).
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\

I

Рис. 6.13. Падающее меню и панель инструментов Dimension

В изображения размеров входят следующие составные элементы:

О размерная линия — линия со стрелками на концах, выполненная параллельно
соответствующему измерению. Как правило, размерные линии помещаются
между выносными. Если на короткой размерной линии не хватает места, раз-
мерные стрелки или текст размещаются снаружи в зависимости от настроек
размерного стиля. Для угловых размеров размерной линией является дуга;

Q размерные стрелки — стрелки, засечки или произвольный маркер, определя-
емый как блок, для обозначения концов размерной линии;

Q выносные линии проводятся от объекта к размерной линии. Могут быть постро-
ены перпендикулярно ей или быть наклонными. Формируются только для ли-
нейных и угловых размеров (используются, если размерная линия находится
вне образмериваемого объекта);

Q размерный текст — текстовая строка, содержащая величину размера и другую
информацию (например, обозначения диаметра, радиуса, допуска). Это необя-
зательный элемент, то есть его вывод на рисунок можно подавить. Есть возмож-
ность принять размер, автоматически вычисленный AutoCAD, или заменить
его другим текстом. Если принимается текст по умолчанию, к нему можно ав-
томатически добавить допуски и ввести префикс и суффикс;

Q выноски используются, если размерный текст невозможно расположить рядом
с объектом;

Q маркер центра — небольшой крестик, отмечающий центр окружности или
дуги;

Q осевые линии — линии с разрывом (штрихпунктирные), пересекающиеся в цен-
тре окружности или дуги и делящие ее на квадранты.

Все линии, стрелки, дуги и элементы текста, составляющие размер, будут рассмат-
риваться как один размерный примитив, если установлен режим ассоциативного
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образмеривания. Ассоциативные размеры изменяются в соответствии с изменени-
ем элементов, которые образмериваются.

Линейные размеры
AutoCAD обеспечивает несколько видов простановки линейных размеров, отли-
чающихся углом, под которым проводится размерная линия.

ЦР Команда DIMLINEAR позволяет создавать горизонтальный, вертикальный или
повернутый размеры. Команда вызывается из падающего меню Dimension > Linear
или щелчком мыши по пиктограмме Linear Dimension на панели инструментов
Dimension.

Запросы команды DIMLINEAR:

Specify f i rst extension line origin or <select object>: —указать
начало первой выносной линии;

Specify second extension line origin: —указать начало второй вынос-
ной линии;

Specify dimension line location or [Mtext/Text/Angle/Horizontal/
Vertical/Rotated] : — указать положение размерной линии;

Dimension text = измеренное значение.

Если на первый запрос нажать клавишу Enter, команда DIMLINEAR выдает следу-
ющие запросы:

Specify f irst extension line origin or <select object>: —нажать
клавишу Enter для указания объекта;

Select object to dimension:— выбрать объект для нанесения размера;

Specify dimension line location or [Mtext/Text/Angle/Horizontal/
Vertical/Rotated] : — указать положение размерной линии;

Dimension text = измеренное значение.

Ключи команды DIMLINEAR:

Q Mtext — позволяет редактировать размерный текст в редакторе многострочно-
го текста. Можно полностью изменить текст или сохранить измеренное значе-
ние с помощью угловых скобок о и при необходимости добавить любой текст
до и после скобок;

Q Text — позволяет редактировать размерный текст. При этом выдается запрос:

Enter dimension text <измеренное значение>:—ввести необходимую
текстовую строку.

Q Angle — позволяет задать угол поворота размерного текста. При этом выдает-
ся запрос:



Простановка размеров * 165

Specify angle of dimension t e x t : — указать угол поворота размерного
текста.

Q Horizontal — определяет горизонтальную ориентацию размера, отмеряет
расстояние между двумя точками по оси X;

Q Vertical — определяет вертикальную ориентацию размера, отмеряет рассто-
яние между двумя точками по оси У;

d Rotated — осуществляет поворот размерной и выносных линий, отмеряет рас-
стояние между двумя точками вдоль заданного направления в текущей ПСК.
При этом выдается запрос:

Specify angle of dimension line <0>: — указать угол поворота размер-
ной линии.

Выполните упражнения R1-R3 из раздела 2.

Проставить горизонтальный размер
VR1)

Dim/in ear l*~*
Падающее пеню Dimension - Linear

Specify first extension line origin or <select object>: указать точку 1
Specify second extension line origin': указать точку 2

Specify dimension line location or
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: указать точку З

Г

Dimension text

130 .
3

' 2

= 130

^Проставить вертикальный размер
с изменением размерного текста R2

Dim linear |~-
Падающее меню Dimension • - Linear

Specify first extension line origin or <select objectX указать точку /
Specify second extension line origin: указать точку 2

Specify dimension line location or
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: Т режим текста

Enter dimension text <70>: 230 ввести размерный текст
Specify dimension line location or

[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: указать точку З
Dimension text = 70
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Проставить повернутый размер

Dim linear hi
Падающее меню Dimension ~-Linear

Specify first extension line origin or <select object>: указать точку 1
Specify second extension line origin: указать точку 2

Specify dimension line location or
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: R повернутый

Specify angle of dimension line <0>: 135 угол поборота

Specify dimension line location or
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: указать точку З

Dimension text = 42

Параллельный размер

JU С помощью команды DIMALIGNED создается размер, параллельный измеря-
емой линии объекта; это позволяет выровнять размерную линию по объекту.
Размер создается подобно горизонтальному, вертикальному и повернутому.
Команда вызывается из падающего меню Dimension > Al igned или щелчком
мыши по пиктограмме Aligned Dimension на панели инструментов Dimension.

Запросы команды DIMALIGNED:

Specify f irst extension line origin or <select. object>: —указать
начало первой выносной линии;

Specify second extension line origin:
ной линии;

указать начало второй вынос-

Specify dimension line location or [Mtext/Text/Angle] : —указать
положение размерной линии;

Dimension text = измеренное значение.

Базовые размеры
Базовые размеры и размерные цепи представляют собой последовательность линей-
ных размеров. Базовые размеры — это последовательность размеров, отсчитываемых
от одной базовой линии. У размерных цепей начало каждого размера совпадает с
концом предыдущего. Перед построением базового размера или цепи на объекте
должен быть проставлен хотя бы один линейный, ординатный или угловой размер.

Щ Команда DIMBASELINE позволяет создавать базовые размеры. Вызывается
она из падающего меню Dimension > Baseline или щелчком мыши по пиктограм-
ме Baseline Dimension на панели инструментов Dimension.
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Запросы команды DIMBASELINE:

Specify a second extension line origin or [Undo/Select] <Se-
lect>: — указать начало второй выносной линии;

Dimension text = измеренное значение;

Specify a second extension line origin or [Undo/Select] <Se-
lect>: — указать начало следующей выносной линии;

Dimension text = измеренное значение;

Specify a second extension line origin or [Undo/Select] <Se-
lect>: — указать начало следующей выносной линии;

Dimension text = измеренное значение;

Specify a second extension line origin or [Undo/Select] <Se-
lect>: — указать начало следующей выносной линии или нажать клавишу Enter;

Select base dimension: — выбрать исходный размер или нажать клавишу
Enter для завершения команды.

Если предыдущий размер не был линейным или если в ответ на первый запрос
была нажата клавиша Enter, то предлагается выбрать линейный размер, который
будет использоваться в качестве базового. При этом выдается следующий запрос:

Select base dimension: — выбрать исходный размер.

Далее следуют стандартные запросы команды DIMBASELINE.

Расстояние между размерными линиями в базовых размерах задается системной
переменной DIMDLI.

Выполните упражнение R4-R5 из раздела 2.

Проставить параллельный размер (R4

Dima/igned 'V
падающее меню Dimension —— Aligned

Specify first extension line origin or <select objectx указать точку 1
Specify second extension line origin: указать точку 2

Specify dimension line location or
[Mtext/Text/Angle]: указать точку З

Dimension text = 139
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Проставить базовые размеры R5)

Dimbaseline ~
Падающее меню Dimension,—*-Baseline

Select base dimension: указать точку 1
Specify a second extension line origin or [Undo/Select] <Select>: указать точку 2

Dimension text = 130
Specify о second extension line origin or [Undo/Select] <Select>: указать точку З

Dimension text = 170
Specify a second extension line origin or [Undo/Select] <Select>: Enter

Select base dimension: Enter

5

7 70
130

80 •1 80

Размерная цепь

JH Команда DIMCONTINUE позволяет создавать последовательную размерную цепь.
Команда вызывается из падающего меню Dimension > Continue или щелчком
мыши по пиктограмме Continue Dimension на панели инструментов Dimension.

Запросы команды DIMCONTINUE:

Specify а second extension line origin or [Undo/Select] <Se-
lect>: — указать начало второй выносной линии;

Dimension text = измеренное значение;

Specify а second extension line origin or- [Undo/Select] <Se-
lect>: — указать начало следующей выносной линии;

Dimension text = измеренное значение;

Specify а second extension line origin or [Undo/Select] <Se-
lect>: — указать начало следующей выносной линии;

Dimension text = измеренное значение;

Specify а second extension line origin or [Undo/Select] <Se-
lect>: — указать начало следующей выносной линии или нажать клавишу Enter;

Select continued dimension: — выбрать исходный размер или нажать кла-
вишу Enter для завершения команды.

*

Если предыдущий размер не был линейным или если в ответ на первый запрос
была нажата клавиша Enter, то предлагается выбрать линейный размер, который
будет использован для продолжения.
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При этом выдается следующий запрос:

Select continued dimension: — выбрать исходный размер.

Далее следуют стандартные запросы команды DIMCONTINUE.

Выполните упражнение R6 из раздела 2.

f Проставить последовательную
размерную цепь

Dimcont/nue ~"|
Падающее мена Dimension "~СОП tinue

Select continued dimension: указать точку 1

Specify a second extension line origin or [Undo/Select] <Select>: указать точку 2
Dimension text = 50

Specify a second extension line origin or [Undo/Select] <Select>: указать точку З
Dimension text = 40

Specify a second extension line origin or [Undo/Select] <Select>: Enter
Select continued dimension: Enter

5

40 50 80

2
}

• 80

J

Радиальные размеры
Щ Команда DIMDIAMETER строит диаметр окружности или дуги. Команда вы-

зывается из падающего меню Dimension > Diameter или щелчком мыши по пик-
тограмме Diameter Dimension на панели инструментов Dimension.

Запросы команды DIMDIAMETER:

Select arc or circle: — выбрать дугу ил и круг;

Dimension text = измеренное значение;

Specify dimension line location or [Mtext/Text/Angle]:—указать
положение размерной линии.

При простановке размера диаметра текст по умолчанию начинается со знака 0.
Ключи команды позволяют изменять размерный текст и угол наклона размерного
текста. Маркеры центра и осевые линии автоматически появляются в центре дуги
или круга, если размер проставляется снаружи, и не наносятся, если размер про-
ставляется внутри круга или дуги, а также в случае, когда маркеры центра отклю-
чены. Имеется возможность произвести принудительное размещение размерного
текста и линии-выноски внутри круга или дуги.

Выполните упражнение R7 из раздела 2.
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Проставить диаметральный размер R7

Dim diameter >S;'
падающее меню Dimension —— Diameter

Select arc or circle: указать точку 1

Dimension text = 108
Specify dimension line location or [Mtext/Text/Angle]: указать точку 2

jjj Команда DIMRADIUS, позволяющая построить радиус окружности или дуги,
вызывается из падающего меню Dimension > Radius или щелчком мыши по пик-
тограмме Radius Dimension на панели инструментов Dimension.

Запросы DIMRADIUS аналогичны запросам команды DIMDIAMETER.

По умолчанию при простановке радиуса текст начинается с символа R.

Выполните упражнение R8 из раздела 2.

Проставить радиальный размер R8

Dimradius (••)
Падающее меню Dimension -~RadiuS

Select ore or circle: указать точку 1

Dimension text = 54

Specify dimension line location or [Mtext/Text/Angle]: указать точку 2

Угловые размеры

jjj Команда DIMANGULAR позволяет проставить угловой размер. Она вызывает-
ся из падающего меню Dimension > A n g u l a r или щелчком мыши по пиктограм-
ме A n g u l a r Dimension на панели инструментов Dimension.
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Запросы команды DIMANGULAR:

Select arc, circle, line, or <specify vertex>: —выбратьдугу,круг,
отрезок;

Select second line: — если первое указание было отрезком, следует указать
второй отрезок, непараллельный первому;

Specify dimension arc line location or [Mtext/Text/Angle] :—
указать местоположение размерной линии;

Dimension text = измеренное значение.

Если в ответ на первый запрос нажата клавиша Enter, то угловой размер строится
по трем точкам и команда DIMANGULAR выдает следующие запросы:

Specify angle vertex: — выбрать вершину угла;

Specify f irst angle endpoint:—указать первую конечную точку угла;

Specify second angle endpoint:— указать вторую конечную точку угла;

Specify dimension arc line location or [Mtext/Text/Angle]: —
указать местоположение размерной линии;

Dimension text = измеренное значение.

При простановке углового размера текст по умолчанию завершается знаком гра-
дуса °. Ключи команды позволяют изменять размерный текст и угол его наклона.
Когда угол образован двумя непараллельными прямыми, размерная дуга стягива-
ет угол между ними. Если в этом случае дуга не пересекается с обоими или с од-
ним из образмериваемых отрезков, AutoCAD проводит одну или две выносные
линии до пересечения с размерной дугой. Стягиваемый угол всегда меньше 180°.

Выполните упражнение R9 из раздела 2.

Проставить угловой размер

Dimongular -^
Падающее меню Dimension — Angular

Select arc, circle, line, or <specify vertex>: указать точку 1
Select second line: указать точку 2

Specify dimension arc line location or [Mtext/Text/Angle]: указать точку З
Dimension text = 118
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Ординатные размеры
Ординатные размеры определяют расстояние по оси координат от базовой точки
до образмериваемого объекта (например, до отверстия в детали). Применение та-
ких размеров предохраняет от накапливающихся ошибок, поскольку положение
объектов отмеряется от единой базовой точки.

Ординатный размер состоит из значения координаты х или у и выноски. Ординат-
ный размер по X выражает расстояние от начала координат до объекта вдоль оси X,
а ординатный размер по У — соответственно вдоль оси Y. Если указана точка,
AutoCAD автоматически определяет, по какой оси проставлять ординатный раз-
мер. Такой способ называется автоматическим нанесением ординатныхразмеров.

Текст ординатного размера располагается вдоль выноски независимо от ориента-
ции текста, заданной текущим размерным стилем. Ключи команды позволяют из-
менять размерный текст и угол его наклона.

Выноска-отрезок или каждый сегмент выноски-ломаной отрисовывается перпен-
дикулярно одной из осей координат, поэтому целесообразно включать режим ORTHO.

Щ Команда DIMORDINATE позволяет проставлять ординатные размеры. Она вы-
зывается из падающего меню Dimension > Ordinate или щелчком мыши по пик-
тограмме Ordinate Dimension на панели инструментов Dimension.

Запросы команды DIMORDINATE:

Specify feature location: — указать положение элемента;
г

Specify leader endpoint or [Xdatum/Ydatum/Mtext/Text/Angle] : -
указать конечную точку выноски или координату, которую необходимо изменить;
как следствие, изменится ориентация выносок и размерного текста;

Dimension text = измеренное значение.

Выноски и пояснительные надписи

Ji^ Команда QLEADER, предназначенная для построения выноски, вызывается из

падающего меню Dimension > Leader или щелчком мыши по пиктограмме Quick
Leader на панели инструментов Dimension.

Запросы команды QLEADER:

Specify f irst leader point, or [Settings] <Settings>: —указать пер-
вую точку выноски;

. . . . - ' /
Specify next point:—указать следующую точку выноски;

Specify next po int :— указать следующую точку выноски;

Specify text width <0>: —указать ширину текста;
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Enter f irst line of annotation text <Mtext>: —ввести первую строку
текста пояснения;

Enter next line of annotation text: — ввести следующую строку текста
пояснения;

Enter next line of annotation text :— нажатыславишу Enter для завер-
шения работы команды.

Выноской называется линия, соединяющая на рисунке пояснительную надпись
с объектом, к которому она относится. Выноски и пояснительные надписи ассоци-
ативны, то есть при редактировании одного из этих объектов соответственно из-
меняется и другой.

Выноску, состоящую из прямолинейных или сплайновых сегментов, можно на-
чать от любой точки и от любого объекта рисунка. Все свойства выноски, ее цвет,
вес линии, масштаб, тип стрелки, размер и прочее определяются установкой те-
кущего размерного стиля для первой размерной стрелки.

Для связи пояснительной надписи и выноски применяется короткий отрезок, ко-
торый называется полкой. Полки ставятся в случае, если отклонение от горизон-
тального положения превышает 15°. Для точного указания начальной точки вы-
носки следует использовать объектную привязку.

Пояснительные надписи могут представлять собой многострочные тексты, .рамки
допусков формы и расположения поверхностей или вхождения блоков. Они либо
строятся «с нуля», либо копируются из уже существующих пояснений.

Тексты пояснительных надписей вводятся построчно в командной строке или в диа-
логовом окне Text Formatting, если был введен Enter на запрос:

Enter f irst line of annotation text <Mtext>: — ввести первую строку
текста пояснения.

Параметры пояснения, линии-выноски и стрелки, а также способ расположения
текста относительно выноски можно задать в диалоговом окне Leader Settings:

Q на вкладке Annotation, показанной на рис. 6.14, задается тип пояснения, для ко-
торого строится выноска. В качестве пояснений могут использоваться много-
строчный текст, копии объектов, рамки допусков формы и расположения, бло-
ки. Параметр Copy an Object позволяет использовать в качестве пояснения уже
имеющийся объект, не создавая новый. Здесь можно также указать режимы
многострочного текста и настроить повторное использование пояснения для
последующих выносок;

Q на вкладке Leader Line & Arrow, представленной на рис. 6.15, указывается тип линии-
выноски: ломаная Straight или сплайновая Spline. В области Arrowhead из рас-
крывающегося списка можно выбрать тип стрелки, а в области Angle Constraints
задать ограничения углов для сегментов выноски. Чтобы обеспечить быстрое
нанесение выносок, можно в области Number of Points указать количество точек
на выноске;
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Q на вкладке Attachment, представленной на рис. 6.16, выбирается способ распо-
ложения многострочного текста относительно выноски.
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Рис. 6.14. Диалоговое окно параметров выноски
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Рис. 6.15. Вкладка выносок и стрелок
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Рис. 6.16. Диалоговое окно параметров выноски, вкладка Attachment
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Для загрузки диалогового окна Leader Settings необходимо выбрать из падающего
меню пункты Dimension > Leader, а затем нажать клавишу Enter.

Выполните упражнение R11 из раздела 2.

Выполнение надписи с выноской т
Qleader ̂

падающее пеню Dimension——Leader
Specify first leader point, or [Settings]<Settings>: указать точку 1

Specify next point: указать точку 2
Specify next point: указать точку З

Specify text width <0>: Enter
Enter first line of annotation text <Mtext>: Рифление

Enter next line of annotation text: ГОСТ
Enter next line of annotation text: Enter

ч

1 /
— 'Рифление

ГОСТ ...
I
|

I

J

Быстрое нанесение размеров

Щ Команда QDIM обеспечивает быстрое нанесение размеров. Она вызывается из
падающего меню Dimension > QDIM или щелчком мыши по пиктограмме Quick
Dimension на панели инструментов Dimension.

Запросы команды QDIM:

Select geometry to dimension: — выбрать объекты для нанесения раз-
меров;

Select geometry to dimension: — выбрать объекты для нанесения раз-
меров;

Select geometry to dimension: — нажать клавишу Enter по завершении
выбора объектов;

Specify dimension line position, or [Continuous/Staggered/Base-
line /Ordinate/Radius/Diameter/datumPoint/Edit/SeTtings]<Conti-
nuous>: — указать местоположение размерной линии.

Команда QDIM запрашивает лишь указание контуров, на которые необходимо про-
ставить размеры, и требует выбрать тип проставляемых размеров путем установ-
ки соответствующего ключа.

Выполните упражнение R10 из раздела 2.
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Быстрое нанесение размеров R10
НИ Падающее меню
щ Dimension — Quick Dimension

Select geometry to dimension: указать точку 1
Select geometry to dimension: указать точку 2
Select geometry to dimension: указать точку З
Select geometry to dimension: Enter

Specify dimension line position, or
[Continuous/Stoggered/Baseline/Ordinate

/Radius/Diameter/datumPoint/Edit]<Continuous>: указать точку 4

I

40 50

2

80
4
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Управление размерными стилями
Размерный стиль — это поименованная совокупность значений всех размерных
переменных, определяющая вид размера на рисунке.

Щ Команда DIMSTYLE обеспечивает работу с размерными стилями в диалоговом
окне Dimension Style Manager (рис. 6.17). Команда вызывается из падающего
меню Dimension > Style... или щелчком мыши по пиктограмме Dimension Style на
панели инструментов Dimension.

Диспетчер размерных стилей позволяет выполнить множество различных задач:

Q создать новый размерный стиль;

О изменить имеющийся размерный стиль;

Q установить текущий стиль;

Q просмотреть размерные стили рисунка и их свойства;

О воспользоваться предварительным просмотром размерных стилей;

Q сравнить два размерных стиля или создать перечень всех свойств стиля;

Q переименовать размерные стили;

Q удалить размерные стили.

Размерные стили задают внешний вид и формат размеров. Они позволяют обес-
печить соблюдение стандартов и упрощают редактирование размеров. Размерный
стиль определяет следующие характеристики:

Q формат и положение размерных линий, линий-выносок, стрелок и маркеров
центра;

Q внешний вид, положение и поведение размерного текста;
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Q правила взаимного расположения текста и размерных линий;

О глобальный масштаб размера;

Q формат и точность основных, альтернативных и угловых единиц;

Q формат и точность значений допусков.

on Style Manager

Ullieni

Рис. 6.17. Диалоговое окно управления размерными стилями

Для нанесения размера AutoCAD применяет текущий размерный стиль. По умолча-
нию в качестве такового используется ISO-25 (International Standards Organization),
если пользователем не задан иной.

Стиль STANDARD создан на основе стандарта ANSI (American National Standards
Institute, США), хотя и не полностью с ним совпадает. Если в рисунке использу-
ются британские единицы, то стиль STANDARD применяется по умолчанию. Сти-
ли DIN (Германия) и JIS (Japanese Industrial Standards, Япония) имеются в шаб-
лонах рисунков AutoCAD DIN и JIS.

Определение базового размерного стиля следует начать с присвоения ему имени
и сохранения. Новый стиль базируется на текущем и включает в себя все последу-
ющие изменения расположения размерных элементов, размещения текста и вида
пояснительных надписей. Для создания нового размерного стиля необходимо в
диалоговом окне Dimension Style Manager щелкнуть мышью по кнопке New.... Откро-
ется диалоговое окно Create New Dimension Style (рис. 6.18).

Рис. 6.18. Диалоговое окно создания размерного стиля

•
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После введения в поле New Style Name: имени создаваемого размерного стиля на
экране появится диалоговое окно New Dimension Style, показанное на рис. 6.19.
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Рис. 6.19. Диалоговое окно определения параметров размерного стиля: вкладка линий
и стрелок

Диалоговое окно New Dimension Style содержит следующие вкладки:

О вкладка Lines and Arrows — см. рис. 6.19 — позволяет осуществлять:

• управление внешним видом размерных линий в области Dimension Lines,
а также их подавление при установке флажков Dim Line 1 и Dim Line 2 в поле
Suppress:;

• управление внешним видом выносных линий в области Extension Lines, их
подавление при установке флажков Ext Line 1 и Ext Line 2 в поле Suppress:, a
также удлинение выносных линий за размерные в поле Extend beyond dim
lines: и настройка отступа выносных линий от объекта в поле Offset from
origin:;

• управление формой размерных стрелок в области Arrowheads, их геометрией
у первой/второй точек в полях 1st: и 2nd:, а также размерами стрелок в поле
Arrow size:;

• управление формой маркеров центра в области Center Marks for Circles, их гео-
метрией в раскрывающемся списке Туре: и размером в поле Size:;

Q вкладка Text обеспечивает управление размерным текстом: его стилем, высотой,
местоположением относительно размерной линии, зазором между текстом и раз-
мерной линией и т. п. (рис. 6.20):

• список Text style: в области Text Appearance содержит текстовые стили, исполь-
зуемые в текущем рисунке. Чтобы создать или отредактировать текстовый
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стиль, следует нажать кнопку, расположенную рядом с этим списком, и тем
самым загрузить диалоговое окно Text Style;

• для установки цвета текста и обведения надписи рамкой предназначены со-
ответственно список Text color: и опция Draw frame around text;

• если в текстовом стиле задана фиксированная высота, она имеет приоритет
перед величиной, указанной в списке Text height:. Поэтому, чтобы пользова-
тель имел возможность изменять данный параметр на вкладке Text, высота
в описании используемого текстового стиля должна быть равна 0;

• в области Text Placement определяется размещение текста относительно раз-
мерных и выносных линий, а также образмериваемого объекта. Результат
действия каждой опции сразу можно просмотреть на образце. Для того что-
бы текст располагался по вертикали, следует использовать список Vertical:.
Вариант Centered позволяет разместить текст в центре, с разрывом размер-
ной линии; Above — над размерной линией и параллельно ей. Обе опции учи-
тывают направление осей X и У. Outside означает, что текст всегда размеща-
ется за пределами образмериваемого объекта независимо от направления
осей X и У; JIS — над размерной линией, даже если не параллельно ей. Оп-
ции вертикального выравнивания основаны на горизонтальных размерах.
Для настройки расположения текста по горизонтали используется список
Horizontal:. При этом параметр Centered позволяет разместить текст по цент-
ру между двумя выносными линиями; At Ext Line 1 выравнивает текст влево
и располагает его у первой выносной линии вдоль размерной линии; At Ext
Line 2 — вправо; Over Ext Line 1 — вдоль первой выносной линии; Over Ext
Line 2 — вдоль второй выносной линии;

|
Т

т • 1

Рис. 6.20. Диалоговое окно определения параметров размерного стиля, вкладка управления
размерным текстом
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вкладка Fit позволяет установить правила взаимного расположения размерных,
выносных линий и текста (рис. 6.21). Здесь же задается глобальный масштаб
для размеров:

• в области Fit Options можно определить, как располагаются текст и стрелки
при недостатке места для них между выносными линиями;

• область Text Placement предназначена для установки правил перемещения
размерного текста. Они применяются, если текст был помещен программой
или вручную за пределы выносных линий. При этом текст может переме-
щаться вместе с размерной линией. Также он может быть отодвинут от раз-
мерной линии. Отодвинутый размерный текст бывает нанесен с выноской
или без выноски;

• в области Scale for Dimension Features опция Use overall scale of: позволяет ука-
зать коэффициент масштаба для всех параметров размерного стиля, зада-
ющих размеры, расстояния и отступы, включая высоту текста и величину
стрелок. Глобальный масштаб не влияет на отмеренные расстояния, коор-
динаты, углы и допуски. По умолчанию он принимается равным 1.0. Для
увеличения размерных элементов следует задать больший масштаб, для
уменьшения — меньший. Если поставлен флажок Scale dimensions to layout
(paperspace), используется масштаб видового экрана относительно простран-
ства листа;

• две опции в области Fine Tuning управляют подгонкой размерных элементов:
Place text manual ly when dimensioning дает пользователю возможность разме-
щать текст вручную; Always draw dim line between ext lines приводит к тому, что
размерная линия размещается между выносными, даже если стрелки и раз-
мерный текст вынесены за их пределы;
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Рис. 6.21. Диалоговое окно определения параметров размерного стиля, вкладка размещения
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О вкладка Primary Units — позволяет определить формат и точность основных ли-
нейных и угловых единиц, вид измеренных значений размеров (рис. 6.22):
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Рис. 6.22. Диалоговое окно определения параметров размерного стиля, вкладка
определения основных единиц

• в области Linear Dimensions задается формат для цепей, линейных, парал-
лельных, ординатных и неугловых базовых размеров, а также для радиусов
и диаметров:

Unit format: — определяется формат единиц: научные, десятичные, технические,
архитектурные, дробные или установленные в Windows. В последнем слу-
чае единицы берутся из настроек языка и стандартов на панели управления;

Precision — задается число десятичных знаков для единиц и в зависимости
от выбранных единиц показывается формат представления величин;

Fraction format: — определяется формат дробных единиц: с горизонтальной
чертой, с косой чертой или в одну строку;

Decimal separator: — назначается десятичный разделитель: точка, запятая или
пробел. Если выбраны единицы, установленные в Windows, AutoCAD ис-
пользует десятичный разделитель, заданный в настройках языка и стандар-
тов на панели управления;

Round off: — устанавливается точность округления величин всех линейных
размеров. Здесь можно вводить любое число, содержащее до пяти десятич-
ных знаков. Значение для округления не должно превышать величину точ-
ности, заданную на этой закладке;

Prefix: — указание префикса, добавляемого перед величиной размера. Задан-
ный здесь префикс заменяет обозначения радиуса и диаметра, которые
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AutoCAD автоматически проставляет для соответствующих размеров. Для
записи префикса можно использовать специальные символы и управля-
ющие коды;

Suffix: — указание суффикса, проставляемого после величины размера. Для
записи суффикса можно использовать специальные символы и управля-
ющие коды;

• в области Measurement Scale производятся следующие настройки:

Scale factor: — измеренные величины размеров (линейных, параллельных,
радиусов, диаметров, ординатных, базовых, цепей) умножаются на задан-
ный здесь масштабный коэффициент;

Apply to layout dimensions only: — масштабный коэффициент применяется
только к размерам, нанесенным на листах;

• в остальных областях вкладки Primary Units устанавливаются параметры уг-
ловых размеров и подавления нулей;

вкладка Alternate Units — позволяет определить формат и точность альтернатив-
ных единиц, которые используются для обозначения величин размеров в до-
полнительной системе единиц (рис. 6.23). Обычно с их помощью проставляются
значения размеров в метрических единицах, если рисунок выполнен в британ-
ской системе, и наоборот. Величина размера в альтернативных единицах нано-
сится в квадратных скобках [ ] непосредственно после размерного текста в
основных единицах. Для нанесения в размерах альтернативных единиц следу-
ет установить флажок Display alternate units.

ЩЩЙАт,ж|Тк1 | Fit \fjjjjjjjil

I I : '.

Рис. 6.23. Диалоговое окно определения параметров размерного стиля, вкладка
определения альтернативных единиц
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Формат альтернативных единиц, их точность, округление, префиксы и суф-
фиксы, подавление нулей задаются так же, как и для основных единиц. Однако
для альтернативных единиц можно задать еще два дополнительных параметра:

• Multiplier for alt units: — альтернативные единицы получаются путем умно-
жения основных единиц на заданный здесь коэффициент. По умолчанию
предлагается коэффициент 0,03937, используемый для пересчета миллимет-
ров в дюймы;

• Placement — настраивается размещение альтернативных единиц после или
под альтернативными единицами. При выборе параметра Below primary value
основные единицы размещаются над размерной линией, а альтернатив-
ные — под ней.

О вкладка Tolerances — управляет параметрами формата и точности простановки
допусков, показывающих пределы, в которых может варьироваться размер
(рис. 6.24):

Рис. 6.24. Диалоговое окно определения параметров размерного стиля, вкладка простановки
допусков

• в области Tolerance Format настраиваются следующие параметры нанесения до-
пусков:

Method: — способ нанесения допусков. Выбор None отключает нанесение допусков.
Если верхнее и нижнее отклонения равны, используется параметр Simmetrical,
если же различаются — параметр Deviation. С помощью опции Limits можно ука-
зать максимальную и минимальную величины размера. Параметр Basic, позво-
ляющий построить рамку вокруг размерного текста, обычно используется для
обозначения теоретически точных размеров;
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Precision — число десятичных разрядов в значениях допусков;

Upper value: — максимальное значение при нанесении отклонений и предельных
размеров. AutoCAD использует эту же величину для симметричных допусков;

Lower value: — минимальное значение при нанесении отклонений и предельных
размеров;

Scaling for height: — отношение высоты текста допусков к высоте основного раз-
мерного текста;

Vertical position: — вертикальное выравнивание текстов симметричных допусков
и отклонений. Для выравнивания текста допуска по верхней границе размер-
ного текста используется опция Тор, по середине текста — Middle, а по нижней
границе — Bottom.

Выполните упражнения RS1-RS6 и тест 4 из раздела 2.

Установить размер и форму стрелок (RS1

Dim style Ц '. .
Падающее меню Dimension

В диалоговом окне Dimension Style Manager выбрать
В закладке Lines and Arrows в области Arrowheads
в пале 1st: и 2nd: в раскрывающихся списках установить стиль стрелок:
в поле Arrow size: установить размер стрелок.
3 примере использовать следующие стили и размеры стрелок:
1. Closed Filed (размер 10) 3. Architectural Tick (размер 7)
2. Dot (размер 5) <• Datum Triangle (размер 12)

Проставить четыре линейных размера

1 160

760

760

760

Установить размер осей окружности и дуги

Dimstyle ̂  Падающее меню Dimension — *-Sty/e...
В диалоговом окне Dimension Style Manager 6ы5рать ОЕййЗ.
В закладке Lines and Arrows 6 области Center Marks for Circles
в полях Type: и Size: установить тип и размер маркера.
В примере использовать следующие типы и размеры маркеров:

1. Line (размер. 50) 2. Mark (размер 10)

jj обозначить центр окружности и дуги

Падающее меню Dim ens/on — *- Сеп ter Mark
Select arc or circle: указать окружность или дугу
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Подавить выносную линию

Dimstyle •*& падающее меню Dimension—— Style.

В диалоговом окне Dimension Style Manager выбрать '-•- Qve" '̂'J .
В закладке Lines and Arrows 8 области Extension Lines
в поле Suppress: (Подабить) поднять или опустить флажок
Ext Line 1 или Ext Line 2 у 7-0 или 2-й точки соответственно.

Проставить Ива линейных размера.

140

140

Подавить стрелку у размерной линии (R£11 ;
Dimstyle ̂  падающее меню Dimension — ~~Style. . .

В диалоговом окне Dimension Style Manager выбрать L4sSt,-J .

8 закладке Lines and Arrows в области Arrowheads

8 раскрывающемся списке 1st: установить None.

8 раскрывающемся списке 2nd: установить Closed Filed.

Проставить линейный размер.

110

V J

Установить стиль радиального размера RS5!
Dim style :,,̂  падаюшее меню Dimension—~-Style...
В диалоговом окне Dimension Style Manager выбрать LftafeJ.
J. 6 закладке Text 8 области Text Placement

6 раскрывающемся списке Vertical: установить Above.
6 области Text Alignment установить ISO Standard.

Проставить радиальный размер.
2. В закладке Text в области Text Placement

в раскрывающемся списке Vertical: установить Centered.
S области Text Alignment установить Aligned with dimension line

Проставить радиальный размер.

R30
ю
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Установить размерный текстовый стиль RS|

Dimstyle ^ подающее меню Dimension—

В диалоговом окне Dimension Style Manager быбрать

В закладке Text о области Text Appearance

fi раскрывающемся списке Text style: установить стиль Размеры.

В поле Text height: установить высоту 10.

6 области Text Placement в лоле Offset from dim line:

установить зазор межйу текстом и размерной линией 5.

Проставить линейный размер.

120

ТЕСТ 4
Сформировать в слое ГРАФИКА штриховку,

размеры и текстовую надпись

010

О 7; /г

R38

R38

Надпись
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Q Выбор объектов
Q Редактирование с помощью «ручек»
Q Удаление и восстановление объектов
О Перемещение объектов
Q Поворот объектов
О Копирование объектов
G Размножение объектов массивом
О Зеркальное отображение объектов
Q Создание подобных объектов
Q Масштабирование объектов
О Растягивание объектов
Q Удлинение объектов
Q Разбиение объектов на части
Q Обрезка объектов
G Расчленение объектов
Q Снятие фасок
G Рисование округлений
Q Разработка чертежей в среде

AutoCAD
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Выбор объектов

Большинство команд редактирования AutoCAD требует предварительного указа-
ния объектов для работы с ними. Выбранные объекты — один или несколько — на-
зываются набором. Он может, например, включать в себя все объекты определен-
ного цвета или объекты, расположенные на определенном слое. Такой набор
можно создать как до, так и после вызова команды редактирования. С одним и тем
же набором допустимо производить несколько операций редактирования. Если
установлена системная переменная HIGHLIGHT, выбранные объекты будут под-
свечены.

После того как вызвана одна из команд редактирования, AutoCAD предлагает
выбрать объекты. В командной строке появляется запрос:

Select objects: — выбрать объекты.

При этом перекрестье указателя мыши заменяется на прицел выбора. Выбор от-
дельных объектов производится с помощью мыши или одним из способов, кото-
рые описаны ниже в этом разделе.

При формировании набора можно выбрать последний созданный объект, текущий
набор объектов, а также все объекты рисунка. Имеется возможность добавлять
объекты в набор и удалять их оттуда. Различные объекты могут заноситься в на-
бор разными способами. Например, для выбора всех объектов области рисунка,
кроме нескольких, нужно сначала выделить все объекты, а затем удалить из набо-
ра те, которые не предназначены для редактирования.

Способы и ключи выбора объектов:

Q Add — включает режим добавления для пополнения существующего набора.
Это начальный режим, устанавливаемый для выбора объектов;

Q ALL — позволяет выбрать все примитивы, в том числе те, которые расположе-
ны на отключенных, заблокированных и замороженных слоях;

О AUto — выделяет'объект, на который установлен указатель мыши. Если не
было выбрано ни одного объекта, указанная точка становится первым углом
рамки;

Q BOX — задает прямоугольник по двум точкам. Если вторая точка находится
справа от первой, процесс выбора аналогичен выбору рамкой Window, а если
слева — выбору секущей рамкой Crossing;

О Crossing — секущаярамка выделяет все объекты, которые находятся внутри или
пересекают контур рамки. По умолчанию в ответ на запрос Select objects:
можно указать первый угол рамки, а затем второй в направлении справа нале-
во. Для того чтобы объект можно было выбрать, он должен быть хотя бы час-
тично видимым. При выборе секущей рамкой в командной строке появляются
запросы:

Select objects : С — переход в режим выбора объектов с помощью секущей
рамки;
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Specify f irst corner:—указать первый угол рамки;

Specify opposite corner:—указать другой угол рамки.

О CPolygon — сочетает режимы Crossing и Wpolygon и позволяет выбрать
объекты как полностью заключенные в многоугольник, так и пересекающие его
границу. Область задается путем указания точек вокруг объектов, которые сле-
дует выбирать. Многоугольник строится по мере установки этих точек; он мо-
жет быть любой формы, но без самопересечений, и автоматически замыкается
при указании каждой новой вершины. От последней заданной точки до указа-
теля мыши протянута «резиновая нить». При этом в командной строке появля-
ются запросы: ^

Select objects: CP — переход в режим выбора объектов с помощью много-
угольника;

First polygon point:—указать первую точку многоугольника;

Specify endpoint of line or [ Undo ] : — указать конечную точку отрезка;

Specify endpoint of line or [Undo] : — указать конечную точку отрезка;

Specify endpoint of line or [Undo] : — нажать клавишу Enter для завер-
шения выбора объектов с помощью многоугольника.

О Fence — выбирает только объекты, которые пересекает линия. В отличие от ра-
мочного или секущего многоугольника, она может пересекать саму себя. При
указании точек генерируется линия выбора, и «резиновая нить» протягивает-
ся к перекрестью графического курсора. При этом в командной строке появля-
ются запросы:

First fence point: — указать первую точку линии;

Specify endpoint of line or [Undo] : — указать конечную точку отрезка;

Specify endpoint of line or [ Undo ]:— указать конечную точку отрезка;

Specify endpoint of line or [Undo] : — нажать клавишу Enter для завер-
шения выбора объектов.

Q Group — выбирает все объекты внутри заданной группы;

Q Last — выбирает последний нарисованный объект, видимый на экране;

Р Multiple — одновременно выбирает несколько объектов. Процесс выбора не
считается законченным до тех пор, пока на очередной запрос выбора объекта
не нажата клавиша Enter или пробел;

Q Previous — выбирает текущий набор объектов;

Q Remove — устанавливает режим удаления указанных объектов из набора;

Q Single — устанавливает режим выбора единственного объекта. Когда указан
один объект или одна группа, выбор считается законченным и запрос выбора
объектов не повторяется;
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Q Undo — отменяет (удаляет) последний добавленный в набор объект;

Q Window — выбирает объекты, которые целиком попадают в рамку. По умолча-
нию в ответ на запрос Select ob j ects : можно указать первый угол рамки,
а затем второй угол по диагонали от первого в направлении слева направо;

Q WPolygon — аналогичен режиму Window, но при этом позволяет выбрать объек-
ты, содержащиеся внутри области, границы которой составляет многоугольник.

Если системная переменная PICKDRAG включена, определение рамки производит-
ся при нажатой левой кнопке мыши.

Если PICKDRAG отключена (такова настройка по умолчанию), то рамка задается
двумя нажатиями кнопки мыши в первой и второй точках.

Очень трудно выбирать объекты, которые лежат близко или непосредственно друг
на друге. Для этой цели удобнее пользоваться мышью, одновременно удерживая
нажатой клавишу Ctrl:, в результате включается режим циклического перебора, ко-
гда по щелчку мыши объекты выбираются один за другим, до тех пор пока не бу-
дет выделен требуемый.

Редактирование с помощью «ручек»
Выбранными объектами можно манипулировать с помощью ручек — маленьких
квадратиков, которые высвечиваются в определяющих точках выбранных объек-
тов (рис. 7.1).

Т
Рис. 7.1. Примеры примитивов с «ручками»

При включенном режиме работы с ручками выбор объектов производится до ре-
дактирования, а манипуляции с ними выполняются с помощью указателя мыши
или ключевых слов.

Таким образом, использование ручек позволяет минимизировать обращения
к меню.
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Графический курсор привязывается к ручке, по которой он проходит. Если режим
работы с ручками включен, то объекты, удаляемые из набора, перестают подсве-
чиваться, но ручки на них остаются.

Удаление ручек из набора объектов производится нажатием клавиши Esc. Для уда-
ления из набора, содержащего ручки, какого-либо объекта следует нажать клави-
шу Shift при его выборе.

Определением ручек в блоках управляет системная переменная GRIPBLOCK. Если
она равна 1, ручки устанавливаются на всех объектах, входящих в блок, а если О,
на блоке изображается только одна ручка в точке его вставки.

Для включения ручек используется команда DDGRIPS. При этом все установки на-
значаются на вкладке Selection диалогового окна Options, показанного на рис. 1.26.
Оно вызывается из падающего меню Tools > Options....

Параметры ручек устанавливаются в следующих областях:

Q Grip Size — определяет размер ручек при регулировании движком. При этом на
экранчике слева от движка показан текущий размер ручек;

Q Grips — ручки:

• в раскрывающемся списке Unselected grip color: задается цвет невыбранных
ручек;

• в раскрывающемся списке Selected grip color: задается цвет выбранных ручек;

• в раскрывающемся списке Hover grip color: задается цвет ручки под указате-
лем мыши;

• установка флажка Enable grips активизирует ручки для всех выбранных
объектов;

• установка флажка Enable grips within blocks обеспечивает выбор объектов
с помощью ручек внутри блоков;

• установка флажка Enable grip tips: позволяет задать подсказки к ручкам.

Для редактирования с помощью ручек нужно выбрать ручку, точка расположения
которой будет базовой точкой редактирования. После этого выбирается один из
режимов ручек: перенести — Move, зеркало — Mirror, повернуть — Rotate, масштаб —
Scale или растянуть — Stretch.

Переключение этих режимов осуществляется при вводе начальной буквы или
циклически, последовательным нажатием клавиши пробела или Enter. Например,
для установки режима Stretch нужно ввести S или нажимать Enter до тех пор, пока
в командной строке не появится ключ Stretch. Чтобы выйти из режима работы с
ручками и вернуться к подсказке Command:, необходимо ввести X или нажать кла-
вишу Esc.

Наиболее удобный способ выбора режима редактирования с помощью ручек —
использование контекстного меню «ручки» (рис. 7.2), которое открывается нажа-
тием правой кнопки мыши при выделенной ручке.
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Рис. 7.2. Контекстное меню «ручки»

Если при указании в команде редактирования первого нового положения для
объекта нажата клавиша Shift, активизируется режим многократного копирования
Например, в режиме Stretch функция многократного копирования

и копирует его в люб^ю «^ п и и
Другой способ активизировать режим многократного копирования - выбрать клю

Режим многократного копирования остается активным до тех пор, пока не будет
аН Enter для завершения

Удаление и восстановление объектов

Ц Команда ERASE осуществляет удаление (стирание) объектов. Она вызывает-
ся из падающего меню Modify > Erase или щелчком мыши по пиктограмме Erase

на панели инструментов Modify.

Запросы команды ERASE:

Select objects: — выбрать объекты;

Select objects: — выбрать объекты;

Select objects : - нажать клавишу Enter для завершения работы команды.

из доступ-

вателя, испытываемые в момент применения этой команды^

Выполните упражнения Ег1-ЕгЗ из раздела 3.
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Удалить набор объектов,
используя точечный выбор ЕМ

Erase -^ Падающее меню Modify «- Erase
Select objects: указание 1
Select objects: указание 2
Select objects: указание 3
Select objects: Enter

UOpS (ОЙШ) - восстановление последнего удаленного объекта.
Если при отсутствии активных команд выбрать объект курсором
то его можно удалить, нажав клавишу Delete на клавиатуре.

о? о
\2

О...Ю

0 С

^ г

)

у
С Удалить нижние окружности,

выбирая объекты рамкой (Ц
Erase Ш.

Select objects: указание 1
Specify opposite corner: указание 2

Select objects: Enter
Если точки окна выбора объектов указаны слева направо,
то используется выбор с помощью рамки Window.
При этом выбираются объекты, которые попадают в рамку ЦЕЛИКОМ.
Команда будет работать аналогично, если на запрос
Select objects: ввести ключ W.

7

V

О С

о с

)

J

k 7.

о с

D С

3

3
Удалить все объекты, кроме окружностей,

используя при выборе секущую рамку

Erase Ш.
Select objects: указание 7

Specify opposite corner: указание 2
Select objects: Enter

Если точки окна выбора обьектов указаны справа налево,
то используется выбор с помощью секущей рамки Crossing.
Чтобы объект попал в набор, его достаточно пересечь рамкой.
Команда будет работать аналогично, если на запрос
Select objects: ввести ключ С.

0 0

о о
V

С

с

) С

) С

)

)
J

7 Зак. 1039
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Перемещение объектов
|||| Команда MOVE осуществляет перемещение объектов. Она вызывается из пада-

ющего меню Modify > Move или щелчком мыши по пиктограмме Move на панели
инструментов Modify.

Запросы команды MOVE:

Select objects: — выбрать объекты;
Select objects : — нажать клавишу Enter по завершении выбора объектов;

Specify base point or displacement:—указать базовую точку или пере-
мещение;

Specify second point of displacement or <use f irst point as
displacement: — указать новое положение базовой точки.

Выполните упражнения Мо1 и Мо2 из раздела 3.

Переместить окружности

Move "Т" Падающее меню Modify - *- Move
Select objects: указание 1

Specify opposite corner: указание 2
Select objects: Enter

Specify base point or displacement: указать окружность >
и точке 3 с объектной привязкой Center $

Specify second point of displacement or
<use first point as displacements указать точку 4 •<*

с объектной привязкой Intersection ^S .

Переместить объекты с помощью ручек

Command: указать на окружность 6 точке 1.
Из появившихся ручек Ьыорать ту, что находится 6 центре окружности (точка 2).
** STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]: 320, 50 точка 3
Command: указать на отрезок о точке 4.
Из появившихся ручек 8ы5рать ти. что находится посередине отрезка (точка 5).
** STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]: 320, 50 точка 3
Аналогично переместить вертикальный отрезок.
йля удаления ручек с экрана дбажды нажать клавишу Esc.
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Поворот объектов
|Ц| Команда ROTATE осуществляет поворот объектов. Она вызывается из пада-

ющего меню Modify > Rotate или щелчком мыши по пиктограмме Rotate на па-
нели инструментов Modify.

Запросы команды ROTATE:

Current positive angle in UCS: ANGDIR=counterclockwise ANGBASE=0—
текущие установки отсчета углов в ПСК;

Select obj ects : — выбрать объекты;

Select objects: — нажать клавишу Enter по завершении выбора объектов;

Specify base point: —указать базовую точку поворота;

Specify rotation angle or [Reference] : —указать угол поворота.

Ключ Reference используется для поворота относительно существующего угла.
При этом выдаются следующие запросы:

Current positive angle in UCS: ANGDIR=counterclockwise ANGBASE=0—
текущие установки отсчета углов в ПСК;

Select objects: — выбрать объекты;

Select ob j ects: — нажать клавишу Enter по завершении выбора объектов;

Specify base point: — указать базовую точку поворота;

Specify rotation angle or [Reference]: R — переход в режим задания
угла со ссылкой;

Specify the reference angle <0>: —указать опорный угол;

Specify the new angle: —указать новый угол.

Выполните упражнения Ro1-Ro3 из раздела 3.

Повернуть объект

Rotate Щ падающее меню Modify—*- Rotate
Current positive angle in DCS: ANGDIR=counterclockwise ANGBASE=0
Select objects: указание 1
Select objects: Enter
Specify base point: указать центр поборота точку 2 ,v>:

с одьектной привязкой Intersection Ш>.
Specify rotation angle or [Reference]: 45 угол поборота
По умолчанию положительным значением угла поборота
принято напраопение протиб часобой стрелки относительно оси X.
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Повернуть объект
со ссылкой на известный угол

Rotate О
Current positive angle in UCS: ANGDIR=counterclockwise ANGBASE=0

Select objects: указание 7
Select objects: Enter

Specify base point: указать центр поборота точку 2 ^>;
с объектной привязкой Intersection /V

Specify rotation angle or [Reference]: R режим ссылки
Specify the reference angle <0>: указать точку 2 с о5. привязкой

Specify second point: указать точку З с о5. привязкой
Specify the new angle: указать точку 4 с о5. привязкой

Повернуть объект с помощью ручек Ro3

Command: указать на контур объекта Ь произвольной точке.
Из появившихся ручек аыбрать ту, которая будет центром поворота (точка 1).

** STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]: Ro режим поборота

** ROTATE **
Specify rotation angle or [Base point/Copy/Undo/Reference/eXit]: 45 угол
Для удаления ручек с экрана необходимо дЬажды нажать клавишу Esc.

Копирование объектов

||р Команда COPY осуществляет копирование объектов. Она вызывается из пада-
ющего меню Modify > Сору или щелчком мыши по пиктограмме Сору на панели
инструментов Modify.

Запросы команды СОРУ:

Select obj ects : — выбрать объекты;

Select ob j ects : — нажать клавишу Enter по завершении выбора объектов;

Specify base point or displacement, or [Multiple]: — указать базо-
вую точку;

Specify second point of displacement or <use f irst point as
displacement: — указать положение копии объекта.
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Ключ Multiple используется для Создания множества копий объектов. При его
применении последний запрос, требующий указания точки смещения, делается
многократно. Каждое смещение определяется относительно исходной базовой
точки. После получения нужного числа копий в ответ на запрос необходимо на-
жать клавишу Enter.

Выполните упражнения Со1 и Со2 из раздела 3.

Скопировать объект Со1

Сору °§ Падающее меню Modify
Select objects: указание 1
Select objects: Enter
Specify base point or displacement, or [Multiple]: указать

базовую точку 2 с использованием привязки любого типа
Specify second point of displacement or
<use first point as displacements указать новое положение
одьекта - точку 3. с использованием привязки к узлам сетки

7

2 L ' J

\

1

Ld L3
1

ij J
Скопировать объект,

используя многократный режим Со|
Сору °§

Select objects: указание 1
Select objects: Enter
Specify base point or displacement, or [Multiple]: M
Specify base point: указать базовую точку 2
Specify second point of displacement or

<use first point as displacements указать точку З
Specify second point of displacement or

<use first point as displacements указать точку 4
Specify second point of displacement or .

<use first point as displacements Enter

2,

Hri

Размножение объектов массивом
l|§ Команда ARRAY осуществляет размножение объектов массивом. Она вызыва-

ется из падающего меню Modify > Array... или щелчком мыши по пиктограмме
Array на панели инструментов Modify. При этом открывается диалоговое окно
Array, где можно настроить следующие параметры:
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Q режим установки значений прямоугольного массива Rectangular Array (рис. 7.3):

• в полях Rows: и Columns: указывается количество рядов и столбцов массива;

• в области Offset distance and direction, в полях Row offset:, Columns offset: и Angle
of array: задаются расстояния между рядами и столбцами массива, а также
угол поворота элемента. Расстояния можно ввести с клавиатуры в соответ-
ствующих полях или мышью, для чего необходимо воспользоваться кноп-
ками Pick Both Offset — указать оба расстояния, Pick Row offset — указать рас-
стояние между рядами и Pick C o l u m n offset — указать расстояние между
столбцами;

Cctanoltet

• I Hi

Рис. 7.3. Диалоговое окно формирования прямоугольного массива

Q режим установки значений кругового массива Polar Array (рис. 7.4):

• в строке Center Point:, в полях X: и Y: указываются соответствующие коорди-
наты центра массива. Для того чтобы ввести центр при помощи мыши, сле-
дует воспользоваться кнопкой Pick Center Point;

• в раскрывающемся списке способов построения Method: выбирается один из
параметров: Total n u m b e r of items & Angle to fill — число элементов и угол за-
полнения, Total n u m b e r of items & Angle between items — число элементов и
угол между элементами либо Angle to fill & Angle between items — угол запол-
нения и угол между элементами;

• в зависимости от выбранного способа построения активируются два поля из
следующих трех: Total n u m b e r of items: — число элементов, Angle to fill: — угол
заполнения, Angle between items: — угол между элементами;

• установкой флажка Rotate items as copied назначается поворот элемента мас-
сива вокруг своей оси. Базовую точку при желании можно указать в соот-
ветствующих полях, для чего понадобится развернуть окно щелчком по
кнопке More;

О кнопка Select objects служит для выбора элементов массива;
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Q результат работы команды можно оценить, нажав кнопку Preview< или просмот-
рев его на схеме справа в диалоговом окне.

m
jj

Рис. 7.4. Диалоговое окно формирования кругового массива

Зеркальное отображение объектов
Щ Команда MIRROR осуществляет зеркальное отображение объектов. Она вызы-

вается из падающего меню Modify > Mirror или щелчком мыши по пиктограмме
Mirror на панели инструментов Modify.

Запросы команды MIRROR:

Select objects: — выбрать объекты;

Select obj ects : — нажать клавишу Enter по завершении выбора объектов;

Specify f irst point of mirror l i n e : — указать первую точку оси отра-
жения;

Specify second point of mirror line: — указать вторую точку оси отра-
жения;

Delete source objects? [Yes/No] <N>:— указать: удалить или оставить
исходные объекты.

При зеркальном отображении тексты, атрибуты и их определения также приобре-
тают зеркальный вид. Это происходит из-за того, что операция зеркального ото-
бражения выполняется в строгом соответствии с математическими законами от-
ражения.
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Чтобы полученный в результате зеркального отображения текст имел привычный
вид, следует присвоить системной переменной MIRRTEXT значение 0. По умолча-
нию эта переменная включена. Если же ее отключить, отображенный текст будет
ориентирован и выровнен точно так же, как и исходный.

При этом команда MIRROR особым образом обрабатывает элементы текста и при-
митивы атрибутов, отображая их в прежней ориентации. Переменная MIRRTEXT
воздействует только на простые объекты текста, созданные командами TEXT,
DTEXT, МТЕХТ, а также на определения атрибутов и их переменные, не входящие
внутрь вставленного блока.

Тексты и постоянные атрибуты внутри блока отражаются, как и все составляющие
блока, зеркально, независимо от установки системной переменной MIRRTEXT.

Выполните упражнения МП-М13 из раздела 3.

Отобразить зеркально объект (МИ

Mirror $Ь Падающее меню Modify ~~М!ГГОГ

Select objects: указание 1
Select objects: Enter
Specify first point of mirror line: указать точку 2,

используя любой удобный режим привязки
Specify second point of mirror line: указать точку З,

используя любой удобный режим привязки
Delete source objects? [Yes/No] <N>: Enter

О 2- О
,.,.© ©

ч

Q~
Г /"Л

Отобразить зеркально объект \Mi2,

Mirror фь.
Select objects: указание 1
Select objects: Enter
Specify first point of mirror line: указать точку 2.

используя привязку к узлам сетки
Spec fy second point of mirror 1 ne: указать точку 3,

используя привязку к узлам сетки
Delete source objects? [Yes/No] <N>: Y

,--, 1 ,~4

rv; ~v-'"]
• > ~~ -< •
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Отобразить зеркально объект
с помощью ручек

Command: указать на контур объекта 6 произвольной точке.
Из появившихся ручек ЬыПрать ту, которая лежит на пинии симметрии (точка 1).

** STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]: Mi

режим симметрии
** MIRROR ** .
Specify second point or [Base point/Copy/Undo/eXit]: указать точку 2

Для удаления ручек с экрана дважды нажать клавишу Esc.

Создание подобных объектов
Цр Команда OFFSET осуществляет создание подобных объектов (эквидистант)

с заданным смещением. Она вызывается из падающего меню Modify > Offset
или щелчком мыши по пиктограмме Offset на панели инструментов Modify.

Можно строить подобные отрезки, дуги, окружности, двумерные полилинии, эл-
липсы, эллиптические дуги, прямые, лучи и плоские сплайны. Подобные окруж-
ности имеют диаметр, больший или меньший, чем исходный, в зависимости от
того, как задано смещение. Если оно указано точкой вне окружности, то новая
окружность имеет больший диаметр, а если внутри окружности — меньший.

Запросы команды OFFSET:

Specify o f f se t distance or [Through] <Through>: — указать величину
смещения;

Select object to o f f se t or <exit>: — выбрать объект для создания по-
добных;

Specify point on side to of f set: —указать точку, определяющую сторо-
ну смещения;

Select object to offset or <exit>: —нажать клавишу Enter для заверше-
ния работы команды.

Ключ Through позволяет задать смещение через точку. При этом выдаются сле-
дующие запросы:

Specify offset distance or [Through] <default>: Т — переход в ре-
жим указания смещения через точку;

Select/object to o f f se t or <exit>: — выбрать объект для создания по-
добных;

Specify through p o i n t : — указать точку;
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Select object to offset or <exit>: —нажать клавишу Enter для заверше-
ния работы команды.

Значение текущей величины смещения хранит системная переменная OFFSETDIST.
Переменная OFFSETGAPTYPE управляет способом создания подобных полилиний,
если при смещении образуется зазор между отдельными сегментами полилинии.

Выполните упражнение Of 1 из раздела 3.

Построить эквидистанту (подобие объекта) н
Offset <Ц; Падающее меню Modify *-Off Set

Specify offset distance or [Through] : 10 смещение
Select object to offset or <exit>: указать точку 1 (о5ьект)

Specify point on side to offset: указать точку 2 (сторону)
Select object to offset or <exit>: указать точку З (объект)

Specify point on side to offset:
Select object to offset or <exit>:

Specify point on side to offset:
Select object to offset or <exit>:

указать точку 3 (обьекп,
указать точку 2 (сторону)
указать точку 1 (объект)
указать точку 4 (сторону)
Enter

Масштабирование объектов
jfj Команда SCALE осуществляет масштабирование объектов. Она вызывается из

падающего меню Modify > Scale или щелчком мыши по пиктограмме Scale на
панели инструментов Modify.

Запросы команды Scale:

Select obj ects : — выбрать объекты;

Select ob j ects : — нажать клавишу Enter по завершении выбора объектов;
- . i

Specify base point :— указать базовую точку;

Specify scale factor or [Reference] : — указать коэффициент масшта-
бирования.

При масштабировании объектов масштабные коэффициенты по осям X и У оди-
наковы. Таким образом, можно делать объект больше или меньше, но нельзя из-
менять соотношение его размеров по этим осям. Масштабирование выполняется
путем указания базовой точки и новой длины объекта, из которой выводится мас-
штабный коэффициент для текущих единиц, или путем явного ввода коэффици-
ента. Кроме того, коэффициент может определяться путем указания текущей дли-
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ны и новой длины объекта. При масштабировании с указанием масштабного ко-
эффициента производится изменение размеров выбранного объекта во всех изме-
рениях.

Если масштабный коэффициент больше единицы, то объект увеличивается, а если
меньше единицы — уменьшается.

Ключ Reference применяется для определения коэффициента масштабирования
с использованием размеров существующих объектов в качестве ссылок. При этом
выдаются следующие запросы:

Select objects: — выбрать объекты;

Select obj ects : — нажать клавишу Enter по завершении выбора объектов;

Specify base p o i n t : — указать базовую точку;

Specify scale factor or [Reference]: R — переход в режим указания
масштабного коэффициента со ссылкой;

Specify reference length < 1 > : — указать длину опорного отрезка;

Specify new length:—указать новую длину.

Один из наиболее эффективных вариантов использования ключа Reference —
изменение масштаба всего рисунка. Если оказалось, что выбранные единицы ри-
сунка не соответствуют заданным требованиям, то для выбора всех объектов на
чертеже (например, при помощи рамки) можно воспользоваться командой SCALE,
а затем, применяя ключ Reference, указать два конца объекта, требуемая длина ко-
торого известна, и ввести данную длину. При этом масштаб всех объектов на ри-
сунке изменится соответствующим образом.

Выполните упражнения Sd-Sc3 из раздела 3.

Смасштабировать объект Scl}

Scale Падающее пеню Modify

Select objects: указать точку 1 (объект)
Select objects: Enter

Specify base point: указать базовую точку 2

Specify scale factor or [Reference]: 5 коэффициент
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Смасштабировать объект с помощью ручек (Sc2

Command: указать на контур о5ьекта 6 произвольной точке.
Из появившихся ручек выбрать ту, которая будет базовой (точка 1).
** STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]: Sc режим
** SCALE ** масштабирования
Specify scale factor or [Base point/Copy/Undo/Reference/eXit]: 5

коэффициент
Для удаления ручек с экрана доажды нажать клавишу Esc.

/ Смасштабировать объект far^
со ссылкой на известную длину v 3

Scale nj
Select objects: указать точку 1 (объект)
Select objects: Enter

Specify base point: указать базовую точку 2
Specify scale factor or [Reference]: R ссылка

V

Specify reference length <1>: указать точку 1
Specify second po nt: указать точку 4

Specify new length: указать точку 5

m с

_п ^4*7

-3

iM д. J
^

Растягивание объектов

Щ Команда STRETCH осуществляет растягивание объектов, сохраняя при этом
связь с остальными частями рисунка. Вызывается она из падающего меню
Modify > Stretch или щелчком мыши по пиктограмме Stretch на панели инстру-
ментов Modify.

Запросы команды STRETCH:

Select objects to stretch by crossing-window or .crossing-
polygon .. . — выберите растягиваемые объекты секущей рамкой или секущим
многоугольником;

Select objects: — выбрать объекты;
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Select objects: — нажать клавишу Enter по завершении выбора объектов;

Specify base point or displacement:—указать базовую точку;

Specify second point of displacement or <use f irst point as
displacement: — указать новое положение базовой точки.

Формирование набора объектов для этой команды должно производиться с клю-
чом секущей рамки Crossing или Cpolygon. Любые объекты, полностью заклю-
ченные в рамку или многоугольник, перемещаются командой STRETCH точно так
же, как командой MOVE. Отрезки, дуги и сегменты полилиний, пересекающие рам-
ку, растягиваются только путем перемещения конечных точек, находящихся вну-
три нее: конечные точки за рамкой остаются неизменными. В дугах центральная
точка и ее начальный и конечный углы регулируются таким образом, что стрелка
дуги (расстояние от центральной точки хорды до дуги) поддерживается постоян-
ной. Команда STRETCH не влияет на ширину полилиний, на информацию о сопря-
жениях и углах касания.

Вершины полос и фигур, находящиеся внутри рамки, также перемещаются, тогда
как вершины за пределами рамки остаются на месте. Другие примитивы переме-
щаются или остаются на месте в зависимости от того, находится ли определяющая
их точка внутри рамки. Определяющими точками являются центр круга, точка
вставки формы или блока (если точка вставки блока перемещается командой
STRETCH, то перемещаются и все его атрибуты), крайняя левая точка базовой ли-
нии для текста и для определения атрибута — независимо от типа выравнивания,
использованного при вычерчивании элемента.

Если команда STRETCH вызывается при действующем предварительном наборе, то
для рассмотрения определяющих точек, подпадающих под действие команды, исполь-
зуются только примитивы, выбранные с помощью обычной или секущей рамки.

Выполните упражнения St1-St3 из раздела 3.

Растянуть объект со смещением вправо (St1

Stretch Ok Падающее меню Modify ~~Stretch
Select objects to stretch by crossing-window or crossing-polygon...

Select objects: указать точку 1 (Ьыбор секущей рамкой)
Specify opposite corner: указать точку 2

Select objects: Enter
Specify base point or displacement: указать точку З

Specify second point of displacement or <use first point as displacement: указать точку 4
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Растянуть объект с помощью ручек (St2

Command: указать на контур объекта 6 произвольной точке.
Из появившихся ручек быбрать ту, зо которую следует тянуть контур (точку 1)

** STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]: указать

новое положение редактируемой вершины (точку 2)

Для удаления ручек с экрана дбажды нажать клавишу Esc.

Изменить объект с помощью ручек St3

Command: указать на объект 8 произвольной точке.
Из появившихся ручек, выбрать ту. за которую следует тянуть одьект (точку 1).

** STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]: указать

новое положение редактируемой точки (точку 2)
Для удаления ручек с экрана дбажды нажать клавишу Esc.

Удлинение объектов

•И Команда EXTEND, которая осуществляет удлинение объектов до граничной
кромки, вызывается из падающего меню Modify > Extend или щелчком мыши по
пиктограмме Extend на панели инструментов Modify.

Запросы команды EXTEND:

Current settings: Projection=UCS Edge=None — текущие установки
проекции кромки;

Select boundary edges . . .—выбрать граничные кромки;

Select objects: — выбрать объекты;
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Select objects : — нажать клавишу Enter по завершении выбора граничной
кромки;

Select object to extend or shift-select to trim or [Project/
Edge/Undo] : — выбрать удлиняемый объект;

Select object to extend or shift-select to trim or [Project/
Edge/Undo ] : — нажать клавишу Enter для завершения работы команды.

Для удлинения полилиний можно использовать только разомкнутые. Смысл этой
операции заключается в том, что первый или последний сегмент полилинии удли-
няется так, как если бы он был одиночным отрезком или дугой.

При удлинении широкой полилинии граничная кромка соприкасается с ее осевой
линией. Поскольку торцевой срез широкой полилинии проводится под углом 90°,
то, если граничная кромка не перпендикулярна удлиняемому сегменту, конец по-
лилинии частично заходит за кромку. При удлинении конусного сегмента конеч-
ная ширина сегмента корректируется так, чтобы текущая конусность оставалась
неизменной. Если в результате получается отрицательная конечная ширина, она
устанавливается равной 0.

Допускается удлинение лучей, но удлинение прямых невозможно. Так же, как
и окружность, прямая линия не имеет граничной кромки и конечной точки. Луч
является полуограниченным объектом, поэтому его можно удлинить до новой на-
чальной точки. Имеется возможность изменять центральные углы дуг и длин не-
которых объектов. В частности, допускается изменение длины разомкнутых по-
следовательностей отрезков, дуг, разомкнутых полилиний, эллиптических дуг и
разомкнутых сплайнов. В зависимости от ситуации этот процесс подобен либо
удлинению, либо обрезке. Изменение длины может производиться различными
способами:

Q динамически — буксировкой конечной точки объекта;

Q указанием новой длины в процентном отношении к текущей длине или углу;

Q указанием приращения длины или угла, откладываемого от конечной точки;

Q установкой полной абсолютной длины объекта или его центрального угла.

Граничными кромками могут служить отрезки, дуги, двумерные полилинии. Ко-
гда в качестве кромки используется двумерная полилиния, ее ширина игнориру-
ется и объекты удлиняются до ее осевой линии.

Удлиняемые объекты выбираются путем указания той части, которая должна
удлиняться. Объекты нельзя выделять рамкой, секущей рамкой или объявлять
последним набором; допустимы только прямое указание; ввод координат и выбор
линией.

Ключи команды EXTEND:

Q Project — определяет режим удлинения объектов до пересечения их проек-
ции с границей в трехмерном пространстве:
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• None — удлинение только тех объектов, которые пересекаются с заданной
границей;

• Ucs — определение проекции объекта в плоскости XYтекущей ПСК и удли-
нение объекта, не пересекающегося с границей;

• View — определение проекции объекта в направлении заданного вида и удли-
нение объекта, не пересекающегося с границей;

Q Edge — определяет режим поиска пересечения:

• Extend — удлинение объекта до воображаемой продолженной границы;

• No 'extend — удлинение объектов до границы без ее удлинения.

Если задано несколько граничных кромок, объект удлиняется до тех пор, пока не
достигнет первой из них. Этот же объект можно выбрать вновь, чтобы удлинить
его до следующей граничной кромки.

Выполните упражнение Ех1 из раздела 3.

Удлинить отрезки до границы дуги

Modify
Edge=None

Extend -/ Падающее меню
Current settings: Projection=UCS
Select boundary edges ...
Select objects: указать граничную кронкц о точке 1
Select objects: Enter
Select object to extend or shift-select to trim or
Select object to extend or shift-select to trim or
Select object to' extend or shift-select to trim or

Select object to extend or shift-select to trim or

Extend

Project/Edge/Undol: указать точку 2
Project/Edge/Undo]: указать точку 3
Project/Edge/Undo]: указать точку ^
Project/Edge/Undo]: Enter

Разбиение объектов на части
Ц! Команда BREAK, которая осуществляет разрыв объектов, вызывается из пада-

ющего меню Modify > Break или щелчком мыши по пиктограмме Break на пане-
ли инструментов Modify.

Запросы команды BREAK:

Select ob j ect: — выбрать объект;

Specify second break point or [First point] : — указать вторую точку
разрыва.
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В зависимости от используемых ключей разрыв можно осуществить без стирания
или со стиранием части отрезка, окружности, дуги, двумерной полилинии, эллип-
са, сплайна, прямой или луча. Для разбиения объекта можно либо выбрать объект
в первой точке разрыва, а затем указать вторую точку разрыва, либо вначале про-
сто выбрать объект, а затем произвести указание двух точек разрыва.

Выполните упражнение Вг1 из раздела 3.

/" ̂
Разорвать и удалить часть окружности (Вг1

v^ ̂

Break CJ падающее меню Modify—-~-Break ,

Select objects: указать точку разрыва ^

Specify second break point or [First point]: указать точку 2

Обрезка объектов

Ц Команда TRIM, которая осуществляет отсечение объектов по режущей кром-
ке, вызывается из падающего меню Modify > Trim или щелчком мыши по пик-
тограмме Trim на панели инструментов Modify.

Запросы команды TRIM:

Current settings: Projection=UCS Edge=None—текущие установки про-
екции кромки;

Select cutting edges . . .—выберите режущие кромки;

Select ob j ects: — выбрать объекты, являющиеся режущей кромкой;

Select objects : — нажать клавишу Enter по завершении выбора режущей
кромки;

Select object to trim or shift-select to extend or .[Project/
Edge/Undo] : — выбрать обрезаемый объект;

Select object to trim or shift-select to extend or [Project/
Edge/Undo] : — нажать клавишу Enter для завершения работы команды.
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Секущей кромкой могут служить отрезки, дуги, окружности, двумерные полили-
нии, эллипсы, сплайны, прямые, лучи. Объект, не пересекающийся с секущей
кромкой, можно отсечь в месте их воображаемого пересечения. Когда секущая
кромка определяется двумерной полилинией, ее ширина не учитывается и обрез-
ка проводится по осевой линии. В пространстве листа секущими кромками могут
служить границы видовых экранов. Ключи команды TRIM:

Q Project — определяет режим отсечения объектов по пересечению их проек-
ции с границей в трехмерном пространстве:

• None — отсечение только тех объектов, которые пересекаются с заданной
границей;

• Ucs — определение проекции объекта в плоскости ХУтекущей ПСК и отсе-
чение объекта, не пересекающегося с границей;

• View — определение проекции объекта в направлении заданного вида и от-
сечение объекта, не пересекающегося с границей;

Q Edge — определяет режим поиска пересечения:

• Extend — отсечение объекта по воображаемой продолженной границе;

• No extend — отсечение объектов по границе, с которой они имеют пересе-
чение.

Выполните упражнение Тг1 из раздела 3.

Отсечь части окружности И
Trim ^~ Падающее меню Modify *-ТГ1ГП
Current settings: Projection=UCS Edge=None
Select cutting edges ...

Select objects: указать секущую кромку о точке 1
Select objects: Enter

Select object to trim or shift-select to extend or [Project/Edge/Undo
Select object to trim or shift-select to extend or [Project/Edge/Undo
Select object to trim or shift-select to extend or [Project/Edge/Undo]: Enter

: указать точку 2
: указать точку 3

Расчленение объектов
Команда EXPLODE осуществляет расчленение блоков на составляющие их при-
митивы. Команда вызывается из падающего меню Modify > Explode или щелч-
ком мыши по пиктограмме Explode на панели инструментов Modify.
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Запросы команды EXPLODE:

Select obj ects : — выбрать объекты;

Select ob j ects : — нажать клавишу Enter по окончании выбора объектов и для
завершения работы команды.

При расчленении блока изображение на экране получается идентичным исходно-
му, но при этом цвет, тип и вес линии объектов могут изменяться. Так, у объектов,
входивших в блок, после его расчленения восстанавливаются исходные свойства.

Если расчленению подвергнута двумерная полилиния, то любая информация о ши-
рине или касательной игнорируется, получаемые отрезки и дуги следуют по осе-
вой линии полилинии. По завершении работы команды EXPLODE применительно
к полилинии, имеюшей ширину, отличную от нуля, будет выдано сообщение о том,
что при ее расчленении потеряны сведения о ширине:

Exploding this polyline has lost width information.

The UNDO command will restore it.

Действие команды EXPLODE в каждый момент распространяется только на один
уровень вложенности. Это значит, что если блок содержит полилинию, то при его
расчленении появится цельная полилиния. Если потребуются отдельные дуговые
или линейные сегменты, полилинию надо будет расчленить отдельно.

Расчленение блоков, вставленных с неравными масштабными коэффициентами
по осям X, Y и Z, может привести к самым неожиданным последствиям. Внешние
ссылки и связанные с ними блоки расчленить нельзя. При расчленении из блоков
удаляются атрибуты, однако их исходные описания при этом сохраняются.

Выполните упражнение Ер1 из раздела 3.

Взорвать (расчленить) блок т
Erase „лч"* попробуйте удалить один из выбеленных

Select objects: ompe3KOO (указание 7 или 2).
Удаляется весь обьект? Так и должно 5ыть, поскольку бы пытаетесь
редактировать обьект. являющийся блоком. Чтобы работать
с элементами блока, его необходимо взорвать.
Восстановите удаленный олок.

Explode Ш^, Падающее меню Modify *~Explode
Select objects: указать блок 6 любой точке контура
Select objects: Enter
Повторить команду удаления Выделенных отрезков.

1
2
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Снятие фасок
Щ Команда CHAMFER осуществляет снятие фасок на объектах. Команда вызыва-

ется из падающего меню Modify > Chamfer или щелчком мыши по пиктограмме
Chamfer на панели инструментов Modify.

Запросы команды CHAMFER:

(TRIM mode) Current chamfer Distl = 10.0000, Dist2 = 10 .0000-
режим с обрезкой, параметры фаски;

Select f i r s t line or [Poly l ine/Dis tance/Angle/Tr im/Method/
multiple] : — выбрать первый отрезок;

Select second line: — выбрать второй отрезок.

Процесс снятия фасок заключается в соединении двух непараллельных объектов
путем их удлинения или обрезки до пересечения либо друг с другом, либо с лини-
ей фаски.

Снятие фасок можно выполнять для отрезков, полилиний, прямых и лучей. При
установке фаски методом длин указываются расстояния, на которые каждый
объект нужно удлинить или обрезать.

При установке фаски методом угла также можно указать длину линии фаски
и угол, образуемый ею с первой линией.

Соединяемые объекты либо оставляют в том виде, который они имели до снятия
фаски, либо обрезают или удлиняют, используя линию фаски в качестве кромки.

Если оба соединяемых объекта лежат на одном слое, линия фаски проводится на
нем же.

В противном случае она располагается на текущем слое. То же справедливо в от-
ношении цвета, типа и веса линии фаски.

Если точка пересечения объектов находится за лимитами рисунка, а опция кон-
троля лимитов включена, то снятие фаски не выполняется.

Ключи команды CHAMFER:

Q Polyline — снятие фасок вдоль всей полилинии, то есть в каждом пересече-
нии ее сегментов. При этом обрабатываются только те сегменты, длины кото-
рых превосходят длину фаски. Построенные вдоль полилинии фаски становят-
ся ее новыми сегментами, даже если их длина равна нулю;

О Distance — настройка длины фаски, то есть расстояния между точкой реаль-
ного или воображаемого пересечения объектов и точкой, до которой удлиняет-
ся или обрезается объект при снятии фаски. Если обе длины фаски равны нулю,
то объекты обрезаются или удлиняются до точки их пересечения, а линия фаски



Снятие фасок * 213

не строится. В качестве значения первой длины фаски по умолчанию выступа-
ет последняя заданная длина. Значение второй длины по умолчанию совпада-
ет со значением первой длины, так что стандартными считаются симметричные
фаски, хотя значения по умолчанию можно изменить. Величины первой и вто-
рой длин запоминаются в файле рисунка. Исходные длины фасок нового ри-
сунка определяет шаблон. При использовании ключа Distance выдаются сле-
дующие запросы:

(TRIM mode) Current chamfer Distl = 0 .0000, Dist2 = 0.0000-
режим с обрезкой, параметры фаски;

Select f i r s t line or [Polyl ine/Distance/Angle/Trim/Method/
multiple ] : D — переход в режим настройки длины фаски;

Specify f irst chamfer distance <default>:—указать первую длину
фаски;

Specify second chamfer distance <default>:— указать вторую длину
фаски.

О Angle — позволяет задать длину для первой линии и угол относительно пер-
вой линии для подрезания второй;

Q Trim — позволяет определить, следует ли обрезать линии до снятия фаски.
Если следует, то первая линия отсекается на величину первого расстояния, а
вторая линия — на величину второго. Если расстояние равно нулю, то проис-
ходит подгонка в одну точку. По умолчанию соединяемые фаской объекты об-
резаются;

Q Method — позволяет выбрать один из методов установки размеров фасок: либо
расстояниями, либо расстоянием и углом.

Выполните упражнения Ch1 и Сп2 из раздела 3.

Снять фаски с детали .Chi

Chamfer'f падающее меню Modify—^-Chamfer
(TRIM mode) Current chamfer Dist! = 0.0000, Dist2 = 0.0000
Select first 'line or [Polyline/Distance/Angle/Trim/Method]: D
Specify first chamfer distance <0.0000>: 10 длина фаски
Specify second chamfer distance <10.0000>: Enter
Chamfer
(TRIM mode) Current chamfer Dist! = 10.0000, Dist2 = 10.0000
Select first line or [Polyline/Distance/Angle/Trim/Method/mUltiple]: указать точку 1
Select second line: указать точку 2
Аналогично снять вторую фаску.
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Снять фаски с детали

Chamfer Y
(TRIM mode) Current chamfer Distl = 10.0000, Dist2 = 10.0000

Select first line or [Polyline/Distance/Angle/Trim/Method/mUltiple]: P
режим полилинии
Select 2D polyline: указать на полилинию в любой точке
12 lines were chamfered

Рисование округлений
[)Й Команда FILLET осуществляет плавное скругление (сопряжение) объектов.

Она вызывается из падающего меню Modify К Fillet или щелчком мыши по пик-
тограмме Fillet на панели инструментов Modify.

Запросы команды FILLET:

Current settings: Mode = TRIM, Radius = 10 . О О О О — текущие настрой-
ки: режим, радиус сопряжения;

Select f irst object or [Polyline/Radius/Trim/ntUltiple] : —выбрать
первый объект;

Select second obj ect: — выбрать второй объект.

Сопряжением называется плавное соединение двух объектов дугой заданного
радиуса. AutoCAD не делает различия между внутренними и внешними сопряже-
ниями. Если оба сопрягаемых объекта лежат на одном слое, линия сопряжения
проводится на нем же. В противном случае она располагается на текущем слое.
Сказанное справедливо для цвета, типа и веса линии сопряжения. Можно сопря-
гать пары отрезков, линейные (но не дуговые) сегменты полилиний, прямые, лучи,
круги, дуги и реальные (то есть не многоугольные) эллипсы. Сопряжение отрез-
ков, прямых и лучей применимо даже к параллельным объектам. Сопряжения в
вершинах полилинии производятся друг за другом по одному. Сопрягать можно
отрезки и полилинии в любых комбинациях, а также все твердотельные объекты.

Допускается сопряжение отрезка и окружности, отрезка и дуги или окружности
и дуги. Правила скругления в этом случае такие же, как при сопряжении отрезков.
Однако в случае с дугами и окружностями возможно построение более одной дуги
сопряжения. AutoCAD выберет сопряжение, конечные точки которого ближе все-
го к точкам выбора объектов для скругления. Для плавного соединения с дугой
сопряжения отрезки и дуги могут обрезаться или удлиняться. Отсекаемый фраг-
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мент — это та часть на стороне дуги сопряжения, которая образует точку пересе-
чения с исходным объектом. Такая логика гарантирует плавность скругления и
обычно совпадает с интуитивным представлением, согласно которому сохраняет-
ся та часть, которая указана. Окружности никогда не обрезаются; при этом дуга
сопряжения плавно соединяется с окружностью.

Ключи команды FILLET:

Q Polyline означает, что операция сопряжения выполняется со.всей полилини-
ей. При этом выдаются запросы:

Current settings: Mode = TRIM, Radius = 0 .5000 —текущие настрой-
ки: режим, радиус сопряжения;

Select first object or [Polyline/Radius/Trim/mUltiple]: P — пе-
реход в режим сопряжения полилиний;

Select 2D polyline: — выбрать полилинию.

Q Radius позволяет задать радиус скругления, то есть радиус дуги, соединяющей
сопрягаемые объекты. По умолчанию радиус сопряжения равен 0,5000 или по-
следнему введенному значению. Изменение данного параметра действует толь-
ко на выполняемые после этого сопряжения, оставляя неизменными существу-
ющие. При установке радиуса выдаются запросы:

Current settings: Mode = TRIM, Radius = 0.5000—текущие настрой-
ки: режим, радиус сопряжения;

Select f irst object or [Polyline/Radius/Trim/mUltiple]: R — пе-
реход в режим указания радиуса скругления;

Specify fil let radius <default>: —указатьрадиус сопряжения.

Выполните упражнения Fi1-Fi3, тесты 5-7 и Лист из раздела 3.

Построить сопряжение (скрутление)

Fillet I Падающее пеню Modify ^-Fillet
Current settings: Mode = TRIM, Radius = 0.0000
Select first object or [Polyline/Radius/Trim/mUltiple]: R
Specify fillet radius <0.0000>: 20 радиус скругления

Fillet
Current settings: Mode = TRIM, Radius = 20.0000
Select first object or [Polyline/Radius/Trim/mUltiple]: указать точку 1
Select second object: указать точку 2
Аналогично построить второе сопряжение.

1
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Построить сопряжение (скругление)

Fillet Г
Current settings: Mode = TRIM, Radius = 30.0000
Select first object or [Polyline/Radius/Trim/mUltiple]: P режим палилиний
Select 2D polyline: указать на полилинию 6 любой точке
8 lines were filleted
1 was parallel 3 were too short:

Построить сопряжение (скругление) Fi3

Fillet Г
Current settings: Mode = TRIM, Radius = 50.0000
Select first object or [Polyline/Radius/Trim/mUltiple]: указать /почку 1 (или 3)
Select second object: указать точку 2 (или 4)

Fillet
Current settings: Mode = TRIM, Radius = 50.0000
Select first object or [Polyline/Radius/Trim/mUltiple]: указать точку 5
Select second object: указать точку 6

ТЕСТ 5
1. Переместить окружность и прямоугольник о центр

пересечения осей, используя привязки.
2. Назначить ширину полилинии прямоугольника 0.8.
3. Разместить линии основного контура д слое Контур,

осебые линии - о слое Осевые линии,
тонкие линии - б слое Тонкие линии.

4. Назначить тонким линиям пунктирный тип DASHED.
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ТЕСТ 6
Отредактировать контуры, используя команды
сопряжения (скругления), снятия фасок,
отсечения части объекта.

R8

ТЕСТ 7
Выполнить последовательно операции

Построить сопряжение окружностей с использованием команд
Circle и F i l l e t .

то R15

Последовательно отредактировать контур с помощью команды Tr im.

Назначить ширину линии контура 0.8.

х ^~Л
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Разработка чертежей в среде AutoCAD
Существует много способов разработки чертежей в среде AutoCAD. Квалифици-
рованные пользователи, обладающие большим опытом работы, имеют в своем ба-
гаже собственные подходы к разработке конструкторской документации. Вашему
вниманию предлагается методика на примере разработки чертежа детали, хотя, в
принципе, она может быть использована при разработке любых чертежей и слу-
жить основой для серьезной и регулярной работы в среде AutoCAD.

Создание чертежа детали, изображенной на рис. 7.5, рекомендуется выполнять
в следующей последовательности:

700

ПРОР.
UUL Лист [Пиетоб

Рис. 7.5. Чертеж детали
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1. Создать новый рисунок с помощью команды NEW, вызываемой из падающего
меню File > New... или щелчком по пиктограмме New стандартной панели ин-
струментов.

2. Для вызова Мастера подготовки в диалоговом окне Create New Drawing выбрать
пиктограмму Use a Wizard (см. рис. 1.35). Далее в списке Select a Wizard: выбрать
быструю подготовку Quick Setup.

3. В диалоговом окне быстрой подготовки Quick Setup в качестве единиц измере-
ния длины Units установить Decimal — десятичные (см. рис. 1.3). При определе-
нии границы области черчения Area установить ширину — 210 мм, длину —
2 97 мм. Щелкнуть мышью на кнопке Готово.

4. Включить отображение сетки на экране щелчком мыши на кнопке GRID в стро-
ке состояния или функциональной клавишей F7.

5. Отобразить всю область чертежа на экране командой ZOOM, вызываемой из па-
дающего меню View > Zoom > All (см. рис. 4.3) или щелчком мыши по пиктограм-
ме Zoom All в стандартной панели инструментов (см. рис. 4.4). См. упражне-
ние Z2 (раздел 2).

6. Установить шаг привязки курсора к узлам сетки 5 мм в диалоговом окне режи-
мов рисования Drafting Settings (см. рис. 1.36), загружаемом из падающего меню
Tools > Drafting Settings... или выбором пункта Settings... контекстного меню,
вызываемого щелчком правой кнопки мыши по кнопке SNAP в строке состо-
яния. Значение привязки устанавливанется в области Snap в текстовых полях
Snap X spacing: и Snap Y spacing:.

7. Сохранить рисунок с помощью команды QSAVE, вызываемой из падающего
меню File > Save или щелчком мыши по пиктограмме Save в стандартной панели
инструментов.

8. Вставить в рисунок рамку формата А4 (при условии, что эта заготовка уже су-
ществует). Вставка осуществляется командой INSERT, вызываемой из пада-
ющего меню Insert > Block... или щелчком мыши по пиктограмме Insert Block па-
нели инструментов рисования Draw. При этом загружается диалоговое окно
вставки блока Insert (см. рис. 5.17). См. упражнение Inl (раздел 3).

9. Создать новые слои в диалоговом окне Layer Properties Manager (см. рис. 3.1), ко-
торое загружается из падающего меню Format > Layer... или щелчком по пикто-
грамме Layer Properties Manager на панели инструментов Layers. См. упражне-
ние La (раздел 2). Рекомендуется создать 4 слоя:

1) Контур — для линий основного контура;

2) Размеры — для размерных линий;

3) Осевые линии — для осевых линий;

4 ) Тонкие линии — для штриховки.

10. В диалоговом окне Layer Properties Manager установить вес линий для вновь со-
зданных слоев: для слоя Контур — 0 . 8 ; для слоев Размеры, Осевые линии,
Тонкие линии — 0 . 3. Для слоя Осевые линии установить тип линии Center2.
Рекомендуется установить для всех слоев различные оттенки цветовой гаммы.
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11. Создать наклонный текстовый стиль в диалоговом окне Text Style (см. рис. 5.10),
вызываемом из падающего меню Format > Text Style.... В области Font в раскры-
вающемся списке поля Font Name: следует выбрать шрифт s implex. shx; в поле
Oblique Angle: установить угол наклона к нормали 15; в поле Height: установить
высоту 0 (ноль). См. упражнение Т7 (раздел 2).

12. Заполнить штамп. Рекомендуется увеличить изображение штампа с помощью
зумирования. Затем использовать команду DTEXT, вызываемую из падающего
меню Draw > Text > Single Line Text или щелчком мыши по пиктограмме Dtext па-
нели инструментов. При заполнении штампа удобно использовать ключ вырав-
нивания по ширине Fit команды DTEXT. См. упражнение Т4 '(раздел 2).

13. Прежде чем формировать основной контур, следует сделать слой Контур те-
кущим. См. упражнение Testl (раздел 2).

14. Включить привязку курсора к узлам сетки щелчком мыши по кнопке SNAP
в строке состояния или функциональной клавишей F9.

15. С помощью команд построения прямоугольника RECTANG и окружности CIRCLE
построить основной контур горизонтальной проекциии детали. С помощью
команды построения отрезков LINE сформировать основной контур ее фрон-
тальной проекции. См. упражнения Cl, Rel, L4 (раздел 2).

16. Сделать слой Осевые линии текущим и с помощью команды LINE сформиро-
вать осевые линии обеих проекций детали.

17. Сделать слой Тонкие линии текущим и заштриховать область разреза детали
с помощью команды ВНАТСН, вызываемой из падающего меню Draw > Hatch... или
щелчком мыши по пиктограмме Hatch на панели инструментов Draw. Обращение
к команде ВНАТСН загружает диалоговое окно Boundary Hatch and Fill (см. рис. 6.1),
в котором необходимо установить, в области Pattern: — образец ANSI31; в обла-
сти Scale: — значение масштабного коэффициента 2; в области Angle: — значе-
ние угла 0. См. упражнение HI (раздел 2).

18. Проставить размеры. См. упражнения R1-R11 (раздел 2). Слой Размеры сде-
лать текущим, затем создать размерный стиль с помощью команды DIMSTYLE
в диалоговом окне Dimension Style Manager (см. рис. 6.17). Команда вызывается
из падающего меню Dimension > Style... или щелчком мыши по пиктограмме
Dimension Style Manager панели инструментов Styles. См. упражнения RS1-RS6
(раздел 2). Рекомендуется установить: размер стрелок в поле Arrow size:, равный 5;
в поле Offset from origin: выбрать значение 0, определяющее отступ выносных
линий от объекта; в списке Text style: указать имя созданного наклонного тек-
стового стиля; в списке Text height: выбрать значение высоты текста 3 . 5, в поле
Offset from dim line: выбрать значение 1. 3, определяющее отступ от размерной
линии.

19. Для отображения веса (толщины) линий на экране необходимо щелкнуть
мышью по кнопке LWT в строке состояния, расположенной в нижней части Ра-
бочего стола (см. рис. 1.12).

20. Сохранить рисунок.



ГЛАВА 8 Пространство
и компоновка чертежа

Q Пространство модели
и пространство листа

G Работа в пространстве листа
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Формирование в AutoCAD модели объекта, в том числе трехмерной, обычно не яв-
ляется самоцелью. Это делается для дальнейшего использования такой модели в
системах прочностных расчетов и кинематического моделирования, при получе-
нии проектно-конструкторской документации, фотографически достоверного
изображения готового изделия до его производства, при экспорте трехмерных мо-
делей в другие программы компьютерной графики и т. д. Во всех случаях приме-
нения модели необходимо ее отображение либо на экране монитора, либо в виде
твердой копии.

В данной главе будут рассмотрены возможности отображения и редактирования
моделей в двух пространствах — пространстве модели Model Space и пространстве
листа Paper Space, используемых при создании чертежа. Важно понимать, как и
когда следует пользоваться пространством листа или модели. Овладев этим ин-
струментом, можно значительно ускорить разработку изделия и повысить произ-
водительность.

Обычно в пространстве модели создаются и редактируются модели разрабатыва-
емого объекта, а в пространстве листа формируется отображение этого объекта на
плоскости, то есть чертеж с необходимыми графическими изображениями, рамкой
чертежного листа, надписями и другой графической информацией, необходимой
для вывода на плоттер. Когда пользователь находится в пространстве листа, допуска-
ется создание плавающих видовых экранов, на которых размещаются различные
виДы рисунка. В зависимости от ситуации можно вычертить содержимое одного
или нескольких видовых экранов, задать элементы чертежа, выводимые на плот-
тер, выбрать способ компоновки изображения на листе бумаги. При этом не загро-
мождается рисунок пространства модели, что ускоряет и облегчает редактирова-
ние разрабатываемого объекта.

На чертеже в пространстве листа, как правило, представлены ортогональные (пря-
моугольные) проекции объекта с различных точек зрения на трехмерную модель,
а иногда и ее аксонометрическое изображение. Все изображения должны нахо-
диться в соответствующих областях просмотра. Создание окон просмотра, выбор
и модификация видов, показываемых через эти окна, необходимы как при форми-
ровании трехмерных моделей, так и при их модификации. Качественное отобра-
жение трехмерных объектов позволяет существенно упростить работу с моделью.

В AutoCAD 2005 окно рисунка разделено на закладки; на одной из них располо-
жена модель, а остальные (их может быть несколько) представляют собой анало-
ги листов бумаги. Для перехода в пространство модели необходимо либо выбрать
закладку Model, либо сделать текущим плавающий видовой экран на листе. Имен-
но в закладке Model работает пользователь, создавая и редактируя рисунок. Если
она активна, это всегда означает, что работа ведется в пространстве модели. За-
кладка Model может быть разделена на неперекрывающиеся видовые экраны, ко-
торые представляют различные виды модели.

Набор закладок Layout предназначен для компоновки и подготовки к печати листов,
представляющих собой изображения модели на бумаге. Листы в AutoCAD — это
элементы среды пространства листа, на каждом из которых создаются видовые
экраны и отдельно устанавливаются параметры печати. Последние сохраняются

•
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в рисунке вместе с листами. Имеется возможность сохранить набор параметров
листа, присвоив ему некоторое имя, и впоследствии назначать другим листам. Так-
же предусмотрено создание листов на основе имеющихся файлов шаблонов (.dwt
или .dwg).

Пространство модели и пространство
листа
Пространство модели (Model Space) — это пространство AutoCAD, где формиру-
ются модели объектов как при двумерном, так и при трехмерном моделировании.
О том, что в окне AutoCAD на текущий момент установлено пространство моде-
ли, говорят соответствующая пиктограмма ПСК на рабочем поле чертежа, инди-
кация кнопок Model в нижней части рабочего поля (рис. 8.1) и MODEL в строке со-
стояния. Если пользователь AutoCAD работает только с двумерными объектами,
ему нет особой необходимости переходить в пространство листа: все изображения
объекта, а также дополнительная информация (рамка формата, размеры, основная.
надпись и пр.) могут формироваться в пространстве модели.

Рис. 8.1. Пиктограмма пользовательской системы координат пространства модели

Работа в пространстве модели производится на неперекрывающихся видовых экра-
нах (окнах); там создается основной рисунок или модель. Если в окне программы
присутствует несколько видовых экранов, то редактирование, производимое в од-
ном из них, оказывает действие на все остальные. Несмотря на это, значения эк-
ранного увеличения, точки зрения, интервала сетки и шага для каждого видово-
го экрана могут устанавливаться отдельно.

Пространство листа (Paper Space) — это пространство AutoCAD, необходимое
для отображения объекта, сформированного в пространстве модели, на перекры-
вающихся (плавающих) видовых экранах. Пространство листа облегчает получение
твердых копий рисунков и чертежей, разработанных автоматизированным путем.
Если бы пространство листа не использовалось, пришлось бы загромождать про-
странство модели графической информацией, необходимой лишь для формирова-
ния чертежных листов. Ведь такие элементы, как рамка чертежного листа, основ-
ная надпись и другая графическая и текстовая информация, не имеют отношения
к реальной модели и требуются только в распечатке.

Листом называется компонент среды AutoCAD, имитирующий лист бумаги и хра-
нящий в себе набор установок, используемых при выводе на плоттер. На листе
можно размещать видовые экраны, а также строить геометрические объекты (на-
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пример, элементы основной надписи). Рисунок может содержать несколько листов
с разными видами модели; для каждого листа автономно задаются значения масш-
таба печати и размеров сторон. Изображение листа выглядит на экране точно так
же, как и вычерченный на плоттере лист.

Видовой экран (viewport) представляет собой участок графического экрана, на ко-
тором отображается некоторая часть пространства модели рисунка.

Пространство листа строго двумерно, и видеть его можно только с точки зре-
ния перпендикулярной плоскости листа. О том, что в AutoCAD на текущий мо-
мент установлено пространство листа, говорят соответствующая пиктограмма
ПСК и индикация кнопки PAPER в строке состояния внизу Рабочего стола AutoCAD
(рис. 8.2).

h IBS :
Reston t ing:.

Рис. 8.2. Рабочий стол в пространстве листа

В пространстве листа пиктограмма ПСК имеет треугольную форму; располагает-
ся она всегда в левом нижнем углу области рисунка.

После создания плавающих видовых экранов вносить изменения в модель можно,
переходя с закладки Layout на закладку Model. На листе в любое время допускается
изменение параметров, например формата бумаги или масштаба печати.

Чтобы сделать текущей закладку Model, необходимо щелкнуть по ней мышью
или ввести MS РАСЕ в командной строке. Чтобы перейти из этой закладки в про-

8 Зак. 1039
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странство листа, достаточно щелкнуть мышью по одной из закладок Layout или
ввести LAYOUT в командной строке.

Открыв лист, можно работать либо в пространстве листа, либо в пространстве мо-
дели (в последнем случае нужно сделать текущим какой-либо из видовых экра-
нов). Для того чтобы сделать видовой экран текущим, достаточно установить на
него указатель мыши и дважды щелкнуть ее левой кнопкой.

Чтобы текущим стало пространство листа, следует дважды щелкнуть мышью в том
месте, где нет ни одного видового экрана. Переключаться между пространствами
модели и листа можно также с помощью кнопок MODEL/PAPER в строке состояния.

При таком способе переключения в пространство модели текущим становится
видовой экран, который был активен последним.

Выполните упражнения Spa1 и Spa2 из раздела 4.

Перейти в пространство листа Spat
Для перехода б пространстйо листа

быбрать о нижней части рабочего
поля закладку Layout"!.
Признаком пространства листа
яоляется пиктограмма ПСК
и кнопка [PAPER
б строке состояния. .

Y

Для перехода б пространство модели
выбрать б нижней части рабочего
поля закладку Model.
Признаком пространства модели
яоляется пиктограмма ПСК

X и кнопка IMODEL
б строке состояния.

Перейти в пространство модели 8ра2

Находясь на листе можно работать
и о пространстве листа, и б пространстве модели.

Для перехода б пространство модели необходимо
щелкнуть по кнопке i_
б строке состояния |РАРЕН .

Обратите внимание на пиктограмму ПСК.

Для перехода о пространстйо листа необходимо
щелкнуть по кнопке i nб строке состояния |MDDtL

Обратите снимание на пиктограмму ПСК.
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Работа в пространстве листа
Пространство листа — это аналог листа бумаги, на котором производится компо-
новка чертежа перед его выводом на плоттер. В AutoCAD 2005 имеется несколько
закладок Layout, благодаря чему одна и та же модель может быть представлена на
чертеже в различных вариантах. Каждый лист рисунка можно считать отдельной
единицей комплекта проектной документации. После создания нового листа на
нем размещаются плавающие видовые экраны, которые представляют модель в раз-
личных видах. Каждому видовому экрану могут быть присвоены отдельные зна-
чение масштаба и состояние видимости слоев.

После щелчка мышью по закладке Layout AutoCAD переходит в среду простран-
ства листа (см. рис. 8.2). Прямоугольник с тенью соответствует на экране формату
бумаги, на который настроено устройство печати. Границы области печати обозна-
чены штриховыми линиями.

Управление отображением полей и разметки листа производится на вкладке
Display диалогового окна Options. Там же пользователь может указать, должно ли
при первом входе на лист открываться диалоговое окно Page Setup Manager.

Часто проект не ограничивается одним листом: для одной и той же модели пред-
усмотрено создание дополнительных листов, на которых размещаются ее различ-
ные виды и их комбинации.

Когда лист впервые делается активным и на нем создается первый видовой экран,
значение точности аппроксимации кривых на нем устанавливается равным анало-
гичному значению для видового экрана пространства модели.

Для создания нового листа необходимо щелкнуть правой кнопкой мыши по ярлы-
ку закладки Layout и в открывшемся контекстном меню выбрать пункт New layout.
Для переименования закладки Layout следует вызвать контекстное меню и вос-
пользоваться пунктом Rename.

Мастер компоновки листа
Настройка параметров листа может производиться с помощью Мастера компонов-
ки листа. Для этого необходимо загрузить диалоговое окно Create Layout, показан-
ное на рис. 8.3, из падающего меню Tools > Wizards > Create Layout... или ввести
LAYOUT/WIZARD в командной строке.

Мастер компоновки листа позволяет задать устройство печати, формат листа бу-
маги (то есть размеры его сторон), ориентацию чертежа (книжную или альбом-
ную), установить параметры каждого из имеющихся видовых экранов, а также до-
бавить рамку и основную надпись.

i
Мастер предлагает выбрать устройство печати из числа сконфигурированных
в системе. Если плоттера, на котором должна производиться печать, нет в списке,
следует зайти в папку «Принтеры» Панели управления Windows и выбрать ярлык
«Установка принтера».
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Рис. 8.5. Диалоговое окно определения параметров листа

Если не нужно, чтобы диалоговое окно Page Setup Manager открывалось при начале
работы с каждым новым листом, следует снять флажок Show Page Setup Manager for
new layouts на вкладке Display диалогового окна Options.

Для того чтобы программа AutoCAD не создавала автоматически видовой экран
на каждом новом листе, потребуется отключить там же опцию Create viewport in new
layouts.

Имеющиеся в рисунке листы можно удалять, переименовывать, переставлять
местами и копировать. Для этого достаточно щелкнуть правой кнопкой мыши
по ярлыку листа, а затем выбрать нужный пункт из контекстного меню.

'Если присвоить имя набору параметров, установленных для листа, и сохранить
этот набор, его разрешается впоследствии применять к другим листам. Используя
для листа различные наборы параметров, можно выводить его на печать в разных
вариантах, не затрачивая на это значительных усилий.

Видовые экраны
Видовой экран (viewport) представляет собой участок графического экрана, где
отображается некоторая часть пространства модели рисунка.

Существуют два типа видовых экранов — неперекрывающиеся и перекрывающи-
еся (рис. 8.6).
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Неперекрывающиеся видовые экраны располагаются на экране монитора подобно
кафельным плиткам на стене. Они полностью заполняют графическую зону и не
могут накладываться друг на друга. На плоттер неперекрывающиеся видовые эк-
раны выводятся только поодиночке.

Перекрывающиеся видовые экраны подобны прямоугольным окнам, которые рас-
полагаются на экране и перемещаются по нему произвольным образом.

Эти видовые экраны могут накладываться друг на друга и вычерчиваться одновре-
менно.

Рис. 8.6. Примеры неперекрывающихся и перекрывающихся видовых экранов

Именованные виды
С целью последующего использования виды можно сохранять под уникальными
именами. Допускается сохранение видового экрана целиком или только какой-
либо его части. Виды пространства модели и пространства листа сохраняются от-
дельно. Если использовано несколько видовых экранов, то восстанавливается вид
на активном видовом экране. Восстанавливая различные виды на разных видовых
экранах, можно одновременно получить несколько видов одной и той же модели.
При этом восстанавливаются следующие характеристики:

Q центральная точка;

Q направление взгляда;

Q коэффициент зумирования;

CI перспектива (фокусное расстояние).

Кроме того, может быть восстановлена текущая ПСК, если она была сохранена
с видом.

AutoCAD позволяет строить по методу прямоугольного проецирования шесть ос-
новных видов, соответствующих принятым в чертежной практике направлениям
взгляда. Эти виды широко используются для изображения трехмерных предметов.

В пространстве модели можно сохранять вид только на одном видовом экране.
При восстановлении сохраненный вид замещает ранее находившийся на выбран-
ном видовом экране.
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В пространстве листа сохраненный вид может содержать сразу несколько видовых
экранов.

В этом случае восстанавливается весь вид пространства листа с учетом положений
модели и масштабных коэффициентов для каждого видового экрана.

Щ Настройка отображения любого видового экрана, а также пространства листа
сохраняется под уникальным именем и затем восстанавливается с помощью
команды VIEW, которая вызывает диалоговое окно управления видами View
(см. рис. 8.7). Это же диалоговое окно можно открыть из падающего меню
View > Named Views... или щелчком мыши по пиктограмме Named Views на пане-
ли инструментов View.

Шт: -"lEli-

Рис. 8.7. Диалоговое окно управления видами

Для сохранения вида необходимо вначале нажать кнопку New... и в диалоговом
окне New View, показанном на рис. 8.8, ввести имя в текстовое поле View Name:.

[Вид 2

& .fiuuert display I" I

Рис. 8.8. Диалоговое окно определения нового вида
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Затем, если вид включает все изображение на экране, то следует поставить пере-
ключатель в позицию Current Display, а если вид включает часть изображения, то —
в позицию Define Window, и выбрать окно.

Неперекрывающиеся видовые экраны
Графическую область в пространстве модели можно разбить на несколько непе-
рекрывающихся видовых экранов, а в пространстве листа — создать перекрыва-
ющиеся (плавающие) видовые экраны.

Обычно работа с новым рисунком в пространстве модели вначале производится
на одном видовом экране, занимающем всю графическую область. Этот видовой
экран можно разделить на несколько, выводя на них одновременно различные
виды: например, на одном — общий вид, а на другом — вид какого-либо элемента.
При этом удобно наблюдать, как редактирование данного элемента отражается на
рисунке в целом. На неперекрывающихся видовых экранах допускается:

Q производить панорамирование и зумирование, настраивать режимы сетки, ша-
говой привязки и изображения пиктограммы ПСК;

Q задавать систему координат и восстанавливать виды для каждого отдельного
видового экрана;

Q переключаться с одного видового экрана на другой в ходе выполнения команд
рисования;

Q сохранять именованную конфигурацию видовых экранов в пространстве моде-
ли или применять ее в пространстве листа.

При работе с трехмерными моделями обычно требуется назначение различных
систем координат для отдельных видовых экранов. Можно также задать систем-
ную переменную UCSVP такой, чтобы ПСК в данном видовом экране совпадала с
ПСК текущего видового экрана. В процессе рисования все изменения, производи-
мые на одном из видовых экранов, немедленно отражаются на остальных. Пере-
ключение с одного видового экрана на другой можно производить в любой момент,
даже в ходе выполнения команды.

Создание нескольких видовых экранов
Конфигурации неперекрывающихся видовых экранов могут быть различными.
Возможности размещения видовых экранов зависят от их количества и размеров.

Щ! Когда системная переменная TILEMODE установлена в 1, для создания видо-
вых экранов и манипулирования ими используется команда VPORTS, откры-
вающая диалоговое окно Viewports (рис. 8.9). С помощью этой команды графи-
ческий экран разделяется на несколько неперекрывающихся частей, каждая из
которых может содержать отдельный вид рисунка. Команда VPORTS вызыва-
ется из падающего меню View > Viewports > New Viewports... либо щелчком мыши
по пиктограмме Display Viewports Dialog на плавающей панели инструментов
Viewports.
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Рис. 8.9. Диалоговое окно создания видовых экранов

Плавающие видовые экраны
Когда пользователь впервые переключается в пространство листа, графический
экран пуст и представляет собой «чистый лист», где будет компоноваться чертеж.
В пространстве листа создаются перекрывающиеся (плавающие) видовые экраны,
содержащие различные виды модели. Здесь эти видовые экраны рассматриваются
как отдельные объекты, которые можно перемещать и масштабировать, чтобы под-
ходящим образом расположить их на листе чертежа.

В отличие от неперекрывающихся видовых экранов, нет ограничений, разреша-
ющих вывод на плоттер только одного вида пространства модели. Допускается вы-
черчивать на бумаге любую комбинацию плавающих видовых экранов. Кроме того,
различного рода объекты (например, основную надпись или примечания) можно
создавать и непосредственно в пространстве листа, не затрагивая модель.

Поскольку плавающие видовые экраны трактуются как самостоятельные объек-
ты, редактировать модель в пространстве листа нельзя. Для получения доступа к
ней на плавающем видовом экране необходимо переключиться из пространства
листа в пространство модели. Редактирование при этом производится в пределах
одного из плавающих видовых экранов. На рисунке определить, какой из видовых
экранов является текущим, можно по находящемуся внутри него перекрестью.
Кроме того, о работе в пространстве модели говорит соответствующая форма пик-
тограммы ПСК. В результате появляется возможность при работе с моделью ви-
деть и скомпонованный лист. Как указывалось выше, пространство модели мож-
но увидеть из пространства листа через окна видовых экранов. Видовые экраны в
пространстве листа — это прямоугольники, где отображаются определенные части
и виды модели, сформированной в пространстве модели.
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Возможности редактирования и смены вида плавающих видовых экранов почти
те же, что и неперекрывающихся. Однако в первом случае имеется больше средств
управления отдельными видами. Например, на некоторых видовых экранах мож-
но заморозить либо отключить отдельные слои без воздействия на другие экраны.
Кроме того, предусмотрено включение и отключение тех или иных видовых экра-
нов. Есть возможность выравнивать вид на одном видовом экране относительно
вида в другом, а также масштабировать виды относительно масштаба листа в це-
лом. Плавающие видовые экраны создаются и управляются командой MVIEW. Не-
которые стандартные конфигурации (включая стандартную конструкторскую с
различными видами на каждом видовом экране) вызываются с помощью команды
MVSETUP.

Вновь создаваемые плавающие видовые экраны можно расположить в любом месте
области рисунка. Как и в случае с неперекрывающимися видовыми экранами, для
них допустим выбор одной из стандартных конфигураций.

После указания количества создаваемых видовых экранов задаются границы об-
ласти, которую эти экраны покрывают. Хотя плавающие видовые экраны форми-
руются одновременно, они представляют собой отдельные объекты, которые при
необходимости можно перемещать, стирать, изменять их размеры.

После создания плавающих видовых экранов, изменяя их положение и характе-
ристики, легко добиться требуемой конфигурации видов. Видовые экраны разре-
шено копировать, перемещать, растягивать, масштабировать и стирать с помощью
стандартных команд, а также большинства режимов редактирования с использо-
ванием «ручек». Кроме того, к ним применимы режимы объектной привязки. Ре-
дактирование видовых экранов ведется в пространстве листа; при этом отображе-
ние их границ должно быть включено. , ,

При масштабировании вида на видовом экране иногда требуется изменение его
размеров. Масштабирование и растягивание границы видового экрана не влияет
на находящийся в нем вид.

Перемещая границы видового экрана, можно «подрезать» вид так, чтобы отобра-
жалась только требуемая часть рисунка.

При создании плавающих видовых экранов существуют разные подходы к их раз-
мещению на листе. В некоторых случаях создают всего один видовой экран, зани-
мающий весь лист, в других же пользуются более сложными конфигурациями.
Для создания и размещения плавающих видовых экранов предназначено диало-
говое окно Viewports (см. рис. 8.9).

Созданная на листе конфигурация плавающих видовых экранов не может быть
сохранена под определенным именем. Такая операция допустима только для не-
перекрывающихся видовых экранов пространства модели.

Поскольку видовые экраны являются объектами AutoCAD, у них имеются все
свойства, присущие объектам: цвет, слой, тип и вес линии, масштаб типа линии,
стиль печати. Вес и тип линии отображаются только для видовых экранов произ-
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вольной формы; для прямоугольных же эти параметры игнорируются. Для изме-
нения свойств видового экрана необходимо его выбрать, а затем загрузить палит-
ру Properties из падающего меню Tools > Properties.

Масштабирование и растягивание границы плавающего видового экрана не влия-
ет на масштаб находящегося на нем вида. Для согласования масштабов всех видов
можно воспользоваться масштабированием относительно единиц пространства
листа — это обеспечивает корректность всех масштабов при выводе рисунка на
плоттер.

Когда работа ведется в пространстве листа, масштабный коэффициент выражает
отношение размера изображения на листе к действительному размеру модели на
видовом экране. Листы, как правило, выводятся на печать в масштабе 1:1. Для
определения величины коэффициента нужно разделить единицу длины простран-
ства листа на единицу длины пространства модели. Например, чтобы вывести чер-
теж в масштабе 1:4, в качестве коэффициента следует указать отношение одной
единицы пространства листа к четырем единицам пространства модели. Для из-
менения масштаба вычерчивания видового экрана можно воспользоваться палит-
рой свойств объектов Properties или панелью Viewports.

Видовые экраны произвольной формы
Удобными представляются возможность создания в пространстве листа непрямо-
угольных видовых экранов и связывание с видовыми экранами контуров подрез-
ки, благодаря которым их видимая форма может быть любой.

При создании видового экрана произвольной формы обычному видовому экрану
ставится в соответствие подрезающий контур — полилиния, окружность, область,
сплайн или эллипс. Ассоциативная связь между этими объектами действует, пока
они оба существуют в рисунке.

Допускается модификация уже имеющихся видовых экранов путем переопреде-
ления их границ. В качестве новой границы при переопределении можно задать
замкнутую полилинию, окружность, сплайн, эллипс, область или дуговой сегмент.

Для создания видовых экранов предназначены два ключа команды VPORTS -
Object и Polygonal.

Ключ Ob j ect позволяет преобразовать в видовой экран объект, построенный в про-
странстве листа. Вызов команды осуществляется из падающего меню View > View-
ports > Object.

Если выбирается полилиния, она должна быть замкнутой и иметь не менее трех
вершин. Допускается наличие в ней сегментов любого типа (как линейных, так и
дуговых), а также самопересечения. Полилиния связывается с вновь создаваемым
видовым экраном; в результате получается видовой экран неправильной формы.
Этот процесс происходит так: AutoCAD описывает прямоугольник вокруг вы-
бранного объекта, создает на его основе прямоугольный видовой экран, а затем
«подрезает» его этим объектом.
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Ключ Polygonal позволяет описать границу видового экрана путем указания
точек-вершин.

Последовательность запросов аналогична той, которая используется при постро-
ении полилиний. Вызов команды при этом осуществляется из падающего меню
View > Viewports > Polygonal Viewport.

Как и любые другие объекты, контуры подрезки можно редактировать с помощью
ручек.

Выполните упражнения Vpr1-Vpr3 и тест 9 из раздела 4.

Создать новый видовой экран Vpr1

7 Viewport
- Vports Ш
Падающее меню View - - Viewports
Specify corner of viewport or

[ON/OFF/Fit/Hideplot/Lock/Object/Polygonal/Restore/2/3/4]
указать щелчком мыши леоый нижний угол экрана (точку

Specify opposite corner: указать точку 2
Regenerating model.

Создать три видовых экрана Vpr2

+ Vports Щ Падающее меню

View —- Viewports—~ New Viewports..
В диалоговом окне Viewports 6 списке
Standard viewports выбрать Tree: Above

Specify first corner or [Fit] <Fit>: указать щелчком мыши
левый нижний угол экрана (точку 1)

Specify opposite corner: указать точку 2
Regenerating model.
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Создать видовой экран
сложной конфигурации Vpr3

У ports гЦ; Падающее меню
View '-—~ Viewports —- Polygonal Viewport

Specify corner of viewport or
[ON/OFF/Fit/Shodeplot/Lock/Object/Polygonal/Restore/2/3/4] <Fit>: _p

Specify start point: указать точку \
Specify next point or [Arc/Length/Undol: указать точку 2

Specify next point or [Arc/Close/Length/Undo]: Arc
Enter an arc boundary option [Angle/CEnter/CLose/Direction/Line/
Radius/Second pt/Undo/Endpoint of arc]<Endpoint>: указать точку З
Enter an arc boundary option [Angle/CEnter/CLose/Directron/Une/
Radius/Second pt/Undo/Endpoint of arc]<Endpoint>: Line

Specify next point or [Arc/Close/Length/Undo
Specify next point or [Arc/Close/Length/Undo
Specify next point or [Arc/Close/Length/Undo

указать точку 4
указать точку 5

Close

J

"ЛТест 9
1. Перейти 6 пространстбо модели.
2. Вернуться в пространство листа.
J. Находясь б листе, перейти б пространство модели.
4. Перейти из одного бидобого экрана б другой,

указыбая мышью произвольную точку
выбранного бидо&ого экрана.

Рамка выбранного экрана подсвечивается ярче.

1
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Q Построение тел
О Сложное тело
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Создание трехмерных моделей — более трудоемкий процесс, чем построение их
проекций на плоскости, но при этом трехмерное моделирование обладает рядом
преимуществ, среди которых:

О возможность рассмотрения модели из любой точки;

О автоматическая генерация основных и дополнительных видов на плоскости;

Q построение сечений на плоскости;

Q подавление скрытых линий и реалистичное тонирование;

Q проверка взаимодействий;

Q экспорт модели в анимационные приложения;

Q инженерный анализ;

Q извлечение характеристик, необходимых для производства.

AutoCAD поддерживает три типа трехмерных моделей: каркасные, поверхностные
и твердотельные. Каждый из них обладает определенными достоинствами и не-
достатками. Для моделей каждого типа существует своя технология создания и ре-
дактирования.

Поскольку перечисленным типам моделирования присущи собственные методы
создания пространственных моделей и способы редактирования, не рекомендует-
ся смешивать несколько типов в одном рисунке. AutoCAD предоставляет ограни-
ченные возможности преобразования тел в поверхности и поверхностей в каркас-
ные модели, однако обратные преобразования недопустимы.

Построение тел
Моделирование с помощью тел — это самый простой способ трехмерного модели-
рования. Средства AutoCAD позволяют создавать трехмерные объекты на основе
базовых пространственных форм: параллелепипедов, конусов, цилиндров, сфер, кли-
пов и торов (колец). Из этих форм путем их объединения, вычитания и пересече-
ния строятся более сложные пространственные тела. Кроме того, тела можно стро-
ить, сдвигая плоский объект вдоль заданного вектора или вращая его вокруг оси.

Твердотельный объект, или тело, представляет собой изображение объекта, хра-
нящее, помимо всего прочего, информацию о его объемных свойствах. Следова-
тельно, тела наиболее полно из всех типов трехмерных моделей отражают моде-
лируемые объекты. Кроме того, несмотря на кажущуюся сложность тел, их легче
строить и редактировать, чем каркасные модели и сети.

Модификация тел осуществляется путем сопряжения их граней и снятия фасок.
В AutoCAD имеются также команды, с помощью которых тело можно разрезать
на две части или получить его двумерное сечение.

Как и сети, тела выглядят аналогично проволочным моделям, до тех пор пока
к ним не применены операции подавления скрытых линий, раскрашивания и то-
нирования. В отличие от всех остальных моделей у тел можно анализировать мае-
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совые свойства: объем, момент инерции, центр масс и т. п. Данные о теле могут
экспортироваться в такие приложения, как системы числового программного
управления (ЧПУ) и анализа методом конечных элементов (МКЭ). Тела могут
быть преобразованы в более простые типы моделей — сети и каркасные модели.

Плотность линий искривления, используемых для визуализации криволинейных
элементов модели, определяется системной переменной ISOLINES. Системная пе-
ременная FACETRES задает степень сглаживания тонированных объектов с подав-
ленными скрытыми линиями.

Ниже приведены некоторые понятия и определения, принятые в трехмерном твер-
дотельном моделировании:

Q грань — ограниченная часть поверхности. Если поверхность может быть не-
ограниченной, как, например, планарная (плоская), коническая, цилиндриче-
ская, то грань ограничена всегда. Поддерживается пять типов граней: планарные,
цилиндрические, конические, сферические и тороидальные. Грани образуют
твердотельную модель;

Q ребро — элемент, ограничивающий грань. Поддерживается четыре типа ребер:
прямолинейные, эллиптические (круговые), параболические и гиперболиче-
ские. Например, грань куба ограничена четырьмя прямолинейными ребрами,
а коническая — в основании одним эллиптическим или круговым ребром;

Q полупространство — часть трехмерного пространства, лежащая по одну сторо-
ну от поверхности. Другими словами, каждая поверхность является границей
двух полупространств, на которые делится трехмерное пространство. Полупро-
странство — часть трехмерного пространства, имеющая объем, а поверхность —
часть трехмерного пространства, у которой есть площадь, но не объем;

О тело — часть пространства, ограниченная замкнутой поверхностью и имеющая
определенный объем;

Q тело (примитив) — наипростейший (основной, базовый) твердотельный объект,
который можно создать и строить из него более сложные твердотельные мо-
дели;

Q область — часть плоскости, ограниченная одной или несколькими планарны-
ми гранями, которые называются границами. Например, квадрат с кругом вну-
три имеет внешнюю границу, состоящую из четырех прямолинейных ребер,
и внутреннюю — из одного кругового ребра;

Q область (примитив) — замкнутая двумерная область, которая получена путем
преобразования существующих двумерных примитивов AutoCAD, имеющих
нулевую высоту (кругов, фигур, двумерных полилиний, многоугольников, эл-
липсов, колец и полос), и описана как тело без высоты;

Q составная область — единая область, получаемая в результате выполнения ло-
гических операций объединения, вычитания или пересечения нескольких об-
ластей. Она может иметь отверстия, и для нее так же, как и для твердых тел,
можно вычислить площадь и другие характеристики. Интеграция двумерного
и объемного конструирования позволяет создавать из областей твердые тела, и
наоборот. Например, автоматически преобразуя сечение тела в область, можно
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вычислить ее площадь, а выдавливая или вращая области, — создать сложные
тела;

О объект — общее наименование области или тел, причем тип объекта не имеет
значения: это может быть область, тело или составная модель (группа объек-
тов, связанных в единое целое);

Q пустой объект — составное тело, не имеющее объема, или составная область, не
имеющая площади.

Простейшие «кирпичики», из которых строятся сложные трехмерные объекты,
называют твердотельными примитивами. К ним относятся ящик (параллелепи-
пед, куб), цилиндр (круговой, эллиптический), шар, тор. С помощью команд BOX,
WEDGE, CONE, CYLINDER, SPHERE, TORUS можно создать модели любого из этих тел
заданных размеров, введя требуемые значения.

Примитивы заданной формы создаются также путем выдавливания, осуществля-
емого командой EXTRUDE, или вращения двумерного объекта — командой REVOLVE.
Из примитивов получают более сложные объемные модели объектов.

Запускаются все вышеназванные команды из падающего меню Draw > Solids или из
плавающей панели инструментов Solids.

Параллелепипед

Щ Команда BOX формирует твердотельный параллелепипед (ящик, куб). Осно-
вание параллелепипеда всегда параллельно плоскости XY текущей ПС К. Ко-
манда вызывается из падающего меню Draw > Solids > Box или щелчком мыши
по пиктограмме Box на панели инструментов Solids.

Запросы команды BOX:

Specify corner of box or [CEnter] < 0, 0, 0 > : — указать угол ящика;

Specify corner or\[Cube/Length] : —указатьпротивоположный угол;

Specify Height:—указать высоту.

При формировании параллелепипеда следует задать параметры в одном из ниже-
перечисленных вариантов:

LJ положение диагонально противоположных углов;

Q положение противоположных углов основания и высоты;

О положение центра ящика с назначением угла или высоты либо длины и шири-
ны ящика.

Ключи команды BOX:

Q Center — позволяет сформировать ящик, указав положение его центральной
точки. При этом выдаются запросы:
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Specify corner of box or [CEnter] <0,0,0>: С — переход в режим ука-
зания центра параллелепипеда;

Specify center of box < 0, 0, 0>: — указать центр ящика;

Specify corner or [Cube/Length] :—указать угол;

Specify height: — указать высоту.

Q Cube — создает куб, то есть параллелепипед, у которого все ребра равны. При
этом выдаются запросы:

Specify corner of box or [CEnter] <0, 0, 0 > : — указать у гол ящика;

Specify corner or [Cube/Length]: С — переход в режим формирования куба;

Specify length: — указать длину.

Q Length — создает параллелепипед заданных длины (по оси X), ширины
(по оси У) и высоты (по оси Z) текущей ПСК. При этом выдаются запросы:

Specify corner of box or [CEnter] <0, 0, 0>: —указать угол ящика;

Specify corner or [Cube/Length]: L — переход в режим указания длины,
ширины и высоты;

Specify length: — указать длину;

Speci f у width: — указать ширину;

Specify height:—указать высоту.

Выполните упражнение Вох1 из раздела 4.

Построить параллелепипед (ящик) (Вох1

Box Падающее меню DrO W Solids • Box

Specify corner of box or [CEnter] <0,0,0>: 100, 100

Specify corner or [Cube/Length]: 330, 200

Specify height: 80 высота

Установить точку зрения командой 3Dorbit.
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Клин

Ijjjj Команда WEDGE, формирующая твердотельный клин, вызывается из падающе-
го меню Draw > Solids > Wedge или щелчком мыши по пиктограмме Wedge на па-
нели инструментов Solids.

Запросы команды WEDGE:

Specify f irst corner of wedge or [CEnter] <0,0,0>: — указать пер-
вый угол клина;

Specify corner or [ Cube/ Length] : —указать противоположный угол клина;

Specify height: — указать высоту клина.

Основание клина всегда параллельно плоскости построений XYтекущей системы
координат; при этом наклонная грань располагается напротив первого указанного
угла основания.

Высота клина может быть как положительной, так и отрицательной и обязательно
параллельна оси Z. Все запросы и ключи команды WEDGE аналогичны запросам
и ключам команды BOX.

Выполните упражнение Wed1 из раздела 4.

Построить клин (Wedj)

Wedge Ц
Падающее меню Draw —- Solids Wedge

Specify first corner of wedge or [CEnter] <0,0,0>: 100, 100

Specify corner or [Cube/Length]: 330, 200

Specify height: 80 Высота
Установить точку зрения командой 3Dorbit.

Конус
Команда CONE формирует твердотельный конус, основание которого (окруж-
ность или эллипс) лежит в плоскости XYтекущей системы координат, а верши-
на располагается по оси Z. Команда вызывается из падающего меню Draw > So-
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lids > Cone или щелчком мыши по пиктограмме Cone на панели инструментов
Solids.

Запросы команды CONE:

Current wire frame density: ISOLINES=10 —текущаяплотность каркаса;

Specify center point for base of cone or [Elliptical] <0,0,0>: —
указать центральную точку основания конуса;

Specify radius for base of cone or [Diameter] : — указать радиус
основания конуса;

Specify height of cone or [Apex] :—указать высоту конуса.

Ключи команды CONE:

Q Elliptical — позволяет создавать основание конуса в виде эллипса. Запро-
сы аналогичны тем, что используются в AutoCAD при создании эллипса:

Current wire frame density: I SOL INES=10—текущая плотность каркаса;

Specify center point for base of cone or [Elliptical] <0,0,0>:
E — переход в режим указания основания конуса в виде эллипса;

Specify axis endpoint of ellipse for base of cone or [Center] : —
указать конечную точку оси эллипса для основания конуса;

Specify second axis endpoint of ellipse for base of cone:—
указать вторую конечную точку оси эллипса для основания конуса;

Specify length of other axis for base of cone:— указать длину
другой оси для основания конуса;

Specify height of cone or [Apex] :—указать высоту конуса.

Q Axis endpoint — создает эллиптическое основание конуса, для чего нужно
указать точки для определения диаметра по одной оси и радиуса — по другой.
Выбор этого ключа осуществляется автоматически при вводе координат точки;

О Center — позволяет задать эллиптическое основание конуса, для чего следует
указать координаты его центральной точки и значения радиуса по каждой из
осей;

Q Apex — определяет высоту и ориентацию конуса, для чего нужно задать точку
вершины;

d Height — устанавливает только высоту конуса, но не его ориентацию. Ориен-
тация определяется знаком, стоящим перед значением высоты: при знаке + (плюс)
высота откладывается вдоль положительной полуоси Z, при знаке - (минус) —
вдоль отрицательной полуоси Z;

Q Center point — создает круговое основание;
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Q Radius — позволяет задать круговое основание конуса с помощью радиуса, для
чего нужно указать его положение или ввести положительное ненулевое зна-
чение его длины;

О Diameter — позволяет задать круговое основание путем определения диаметра.

Чтобы построить усеченный конус или конус, ориентированный под некоторым
углом, нужно вначале нарисовать двумерную окружность, а затем с помощью ко-
манды EXTRUDE произвести коническое выдавливание под углом к оси Z. Если
необходимо усечь конус, следует, используя команду SUBTRACT, вычесть из него
параллелепипед, внутри которого находится вершина конуса.

Выполните упражнения Соп1 и Соп2 из раздела 4.

Построить круговой конус Соп1
Cone а

Падающее меню Draw '- So/ids Сопв
Current wire frame density: ISOLINES=20

Specify center point for base of cone or [Elliptical] <0,0,0>: 200,150

Specify radius for base of cone or [Diameter]: 140 радиус

Specify height of cone or [Apex]: 250 высота

Установить точку зрения командой 3Dorbit

Построить эллиптический конус

Cone 4i
Current wire frame density: ISOLINES=20

Specify center point for base of cone or [Elliptical] <0,0,0>: E
Specify axis endpoint of ellipse for base of cone or [Center]: 50,50

Specify second axis endpoint of ellipse for base of cone: 350, 250
Specify length of other axis for base of cone: 70

Specify height of cone or [Apex]: 200 высота
Установить точку зрения командой 3Dorbit
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Цилиндр
ЦЦ Команда CYLINDER, формирующая твердотельный цилиндр, вызывается из

падающего меню Draw > Solids > Cylinder или щелчком мыши по пиктограмме
Cylinder на панели инструментов Solids.

Запросы команды CYLINDER:

Current wire frame density: ISOLINES=10—текущая плотность каркаса;

Specify center point for base of cylinder or [Elliptical]
<0, 0, 0>: — указать центральную точку основания цилиндра;

Specify radius for base of cylinder or [Diameter] : —указатьради-
ус основания цилиндра;

Specify height of cylinder or [Center of other end]:—указать
высота цилиндра.

Информация, необходимая для описания цилиндра, аналогична той, что исполь-
зуется для описания конуса, поэтому запросы команды CYLINDER совпадают с за-
просами команды CONE.

Обратите внимание, что центральная ось цилиндра совпадает с осью Z текущей
системы координат, но при этом ключ Apex называется Center of other end.

Если необходимо построить цилиндр специальной формы (например, с пазами),
следует вначале при помощи команды PLINE создать двумерное изображение его
основания в виде замкнутой полилинии, а затем, используя команду EXTRUDE,
придать ему высоту вдоль оси Z

Выполните упражнение Су11 из раздела 4.

Построить цилиндр Су И
Cylinder Ш г, ^ , . , ~ ,. ,

Падающее меню Draw Sol/ds Cylinder
Current wire frame density: ISOLINES=20

Specify center point for base of cylinder or [Elliptical] <0,0,0>: 200,150

Specify radius for base of cylinder or [Diameter]: 140 радиус

Specify height of cylinder or [Center of other end]: 250 высота

Установить точку зрения командой 3Dorbit
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Шар
!|р Команда S PHERE формирует твердотельный шар (сферу). Для этого достаточ-

но задать его радиус или диаметр. Каркасное представление шара располага-
ется таким образом, что его центральная ось совпадает с осью 2текущей систе-
мы координат. Команда вызывается из падающего меню Draw > Solids > Sphere
или щелчком мыши по пиктограмме Sphere на панели инструментов Solids.

Запросы команды SPHERE:

Current wire frame density: ISOLINES=10 —текущая плотность каркаса;

Specify center of sphere <0, 0, 0>: '— указать центр шара;

Specify radius of sphere or [Diameter] : —указатьрадиус шара.

Чтобы построить часть шара в виде купола или чаши, нужно, используя команду
SUBTRACT, вычесть из него параллелепипед.

Если необходимо построить шарообразное тело специальной формы, следует вна-
чале создать его двумерное сечение, а затем, применив команду REVOLVE, вращать
сечение под заданным углом к оси Z.

Выполните упражнение Sph1 из раздела 4.

Построить шар Sph1

Sphere У|
Падающее меню Draw -So/ids -Sphere

Current wire frame density: ISOLINES=20

Specify center of sphere <0,0,0>: 200,150

Specify radius of sphere or [Diameter]: 150 радиус

Установить точку зрения командой 3Dorbit

Top
| Команда TORUS формирует твердотельный тор, напоминающий по форме каме-

ру автомобильной шины. При этом необходимо ввести значения радиуса обра-
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зующей окружности трубы и радиуса, определяющего расстояние от центра
тора до центра трубы. Тор строится параллельно плоскости XYтекущей систе-
мы координат. Команда вызывается из падающего меню Draw > Solids > Torus
или щелчком мыши по пиктограмме Torus на панели инструментов Solids.

Запросы команды TORUS:

Current wire frame density: ISOLINES=10—текущая плотность каркаса;

Specify center of torus < 0, 0, 0 > : — указать центр тора;

Specify radius of torus or [Diameter] : — указать радиус тора;

Specify radius of tube or [Diameter] : — указать радиус полости тора.

Радиус тора может иметь отрицательное значение, но радиус трубы должен быть
положительным и превосходить абсолютную величину радиуса тора (например,
если радиус тора равен -2, 0, то радиус трубы должен быть больше +2, 0).

Данное условие необходимо соблюдать, чтобы не получить в итоге пустое тело
(тело без объема).

При этом сформированный объект имеет форму мяча для регби.

Допускается построение самопересекающихся торов — таких, у которых нет цен-
трального отверстия.

Для этого нужно задавать радиус сечения большим, чем радиус тора.

Выполните упражнения Тог1-ТогЗ из раздела 4.

Построить тор ТоМ
Torus ф

Падающее меню Draw -Solids TorUS

Current wire frame density: ISOLINES=20

Specify center of torus <0,0,0>: 200,150

Specify radius of torus or [Diameter]: 100

Specify radius of tube or [Diameter]: 30
Установить точку зрения командой 3Dorbit
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Построить тор Тог2

Torus
Current wire frame density: ISOLINES=20

Specify center of torus <0,0,0>: 200,150

Specify radius of torus or [Diameter]: 70
Specify radius of tube or [Diameter]: 65

Установить точку зрения командой 3Dorbit

ч.
г

Построить тор ТогЗ

Torus

Current wire frame density: ISOLINES=20

Specify center of torus <0,0,0>: 200,150

Specify radius of torus or '[Diameter]: — 150
Specify radius of tube or [Diameter]: 200

Установить точку зрения командой 3Dorbit

Выдавленное тело

Щ Команда EXTRUDE позволяет создавать твердотельные объекты методом «вы-
давливания» двумерных примитивов (то есть объектам добавляется высота).
Команда вызывается из падающего меню Draw > Solids > Extrude или щелчком
мыши по пиктограмме Extrude на панели инструментов Solids.

Запросы команды EXTRUDE:

Current wire frame density: I SOL INES=4 — текущая плотность каркаса;

Select objects: — выбрать объекты;

Select objects : — нажать клавишу Enter по завершении выбора объектов;

Specify height of extrusion or [Path] : — указать глубину выдавливания;

Specify angle of taper for extrusion <0>: — указать угол сужения для
выдавливания.
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Допускается выдавливание таких примитивов, как многоугольник, прямоуголь-
ник, круг, эллипс, замкнутый сплайн, кольцо, область и полилиния (кроме име-
ющих более 500 вершин или пересекающиеся отрезки). С помощью одной команды
можно выдавить сразу несколько объектов. Направление выдавливания определя-
ется траекторией или указанием глубины и угла конусности.

Команда EXTRUDE часто используется для формирования моделей таких объектов,
как шестерни или звездочки. Особенно удобна она при создании объектов, име-
ющих сопряжения, фаски и аналогичного рода элементы, которые трудно воспро-
извести, не используя выдавливание сечений. Если рисунок сечения состоит из
отрезков и дуг, то перед вызовом команды EXTRUDE их нужно преобразовать либо
в замкнутую полилинию с помощью команды PEDIT, либо в область.

Конусное выдавливание часто применяется при рисовании объектов с наклонны-
ми сторонами, например литейных форм. Не рекомендуется задавать большие
углы конусности: в противном случае образующие конуса могут сойтись в одну
точку прежде, чем будет достигнута требуемая глубина выдавливания.

Глубину выдавливания можно определять ненулевым значением или указанием
двух точек. При вводе положительного значения происходит выдавливание объек-
тов вдоль положительной оси Z объектной системы координат, при вводе отрица-
тельного значения — вдоль отрицательной оси Z ,

Ключ команды EXTRUDE:

О Path — позволяет указать высоту и направление выдавливания по заданной
траектории. При этом выдается запрос:

Select extrusion path:—указать траекторию выдавливания.

Выполните упражнения Ext1-Ext3 из раздела 4.

Построить выдавленное тело Ext1

Extrude "3
Падающее меню Draw Solids-

Current wire frame density:
Select objects:
Select objects:

Specify height of extrusion or [Path]:
Specify angle of taper for extrusion <0>:

Extrude
ISOLINES=20
Выбрать объект рамкой
Enter
100 - высота
Enter
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Построить выдавленное с уклоном тело (Ext2
^Лч. ^

Extrude ~|
Current wire frame density:

Select objects:

Select objects:
Specify height of extrusion or [Path]:

Specify angle of taper for extrusion <0>:

ISOLINES=20

Выбрить ойьект рамкой

Enter
100 Высота

10 угол

Выдавить объект вдоль траектории Ext3

Extrude 31
Current wire frame density: ISOLINES=20

Select objects: . указать на окружность
Select objects: Enter

Specify height of extrusion or [Path]: P . no траектории

Select extrusion path: указать на линию
Path was moved to the center of the profile.

Тело вращения
HJJ Команда REVOLVE формирует твердотельные объекты путем вращения существу-

ющих двумерных объектов или областей на заданный угол вокруг оси X или У
текущей ПСК. Команда вызывается из падающего меню Draw > Solids > Revolve
или щелчком мыши по пиктограмме Revolve на панели инструментов Solids.

Запросы команды REVOLVE:

Current wire frame density: ISOLINES=20—текущая плотность каркаса;

Select obj ects : — выбрать объекты;

Select ob j ects: — нажать клавишу Enter по завершении выбора объектов;

Specify start point for axis of revolution or define axis by
[Object/X ( a x i s ) / Y (axis) ] : — указать начальную точку оси вращения;
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Specify endpoint of axis : — указать конечную точку оси вращения;

Specify angle of revolution <3 6 0>:—указать угол вращения.

Объект можно вращать вокруг отрезка, полилинии или двух заданных точек. Как
и EXTRUDE, команду REVOLVE удобно применять к объектам, имеющим сопряже-
ния и другие аналогичные элементы, которые трудно воспроизвести, не используя
вращение сечений. Если рисунок сечения состоит из отрезков и дуг, то перед вы-
зовом этой команды их нужно преобразовать либо в замкнутую полилинию с по-
мощью команды PEDIN, либо в область. Команда REVOLVE позволяет вращать
лишь один объект: полилинию, многоугольник, прямоугольник, круг, эллипс, об-
ласть. Все замечания касательно полилиний, используемых командой EXTRUDE,
справедливы и здесь. Невозможно применить вращение к объектам, входящим
в блоки, а также к трехмерным и самопересекающимся. Ключи команды REVOLVE:

Q Ob j ect — требует указания отрезка или прямолинейного сегмента полилинии,
используемого в качестве оси. Конец этого отрезка (сегмента), ближайший к
точке указания, становится началом оси. Ее положительное направление опре-
деляется по правилу правой руки. При этом выдается запрос:

Select an ob j ect: — указать объект в качестве оси вращения.

Q X — использует в качестве оси вращения положительную ось X текущей ПСК;

Q У — использует в качестве оси вращения положительную ось Y текущей ПСК.

Выполните упражнение Rev1 из раздела 4.

Построить тело вращения Rev1
Revolve^

Падающее пеню DrOW -So/ldS ReVOIVe
Current wire frame density: ISOLINES=20

Select objects: указать тачку на контуре
Select objects: Enter

Specify start point for axis of revolution or
define axis by [Object/X (axis)/Y (axis)]: указать тачку на оси

Specify endpoint of axis: указать вторую точку на оси
Specify angle of revolution <360>: Enter

Сложное тело
Ниже описано, как строить тела сложной формы, применяя объединение, вычита-
ние и пересечение уже построенных тел:
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О с помощью команды объединения UNION создается сложный объект, который
занимает суммарный объем всех его составляющих;

Q с помощью команды вычитания SUBTRACT из множества тел удаляются те час-
ти объема, которые также принадлежат другому множеству. Это можно исполь-
зовать, например, для получения отверстий в механических деталях путем вы-
читания цилиндров;

Q с помощью команды пересечения INTERSECT строится сложное тело, занима-
ющее объем, общий для двух или более пересекающихся тел. Непересекающи-
еся части объемов при этом удаляются из рисунка.

Перечисленные команды вызываются из падающего меню Modify У Solids Editing
или из плавающей панели инструментов Solids Editing.

Объединение объектов
И Команда UNION предназначена для объединения объектов. Она позволяет со-

здавать новые составные тела или области из нескольких существующих тел
или областей, в том числе не имеющих общего объема или площади (то есть
не пересекающихся). Команда вызывается из падающего меню Modify > Solids
Editing > Union или щелчком мыши по пиктограмме Union на панели инстру-
ментов Solids Editing. l

Запросы команды UNION:

Select objects :— выбрать объекты;

Select objects: — выбрать объекты; .

Select ob j ects : — нажать клавишу Enter для завершения работы команды.

Выполните упражнение Uni1 из раздела 4.

Сформировать тело путем объединения ( Uni1

Union ш
Падающее неню Modify So/ids Ed/ting Un/ОП

Select objects: указать точку на одном параллелепипеде
Select objects: указать точку на дрдгоп параллелепипеде
Select objects: указать точку на цилиндре
Select objects: Enter
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Вычитание объектов •
Щ Команда SUBTRACT обеспечивает вычитание одного объекта из другого. Та-

ким образом она позволяет сформировать новое составное тело или область.
Области создаются путем вычитания площади одного набора областей или
двумерных примитивов из площади другого набора. Тела создаются путем
вычитания одного набора объемных тел из другого подобного набора. Коман-
ду можно вызвать из падающего меню Modify > Solids Editing > Subtract или щелч-
ком мыши по пиктограмме Subtract на панели инструментов Solids Editing.

Запросы команды SUBTRACT:

Select solids and regions to subtract ' f rom . . — выбрать тела и обла-
сти, из которых будет выполняться вычитание;

Select obj ects : — выбрать объекты;

Select objects : — нажать клавишу Enter для завершения выбора объектов;

Select solids and regions .to subtract
для вычитания;

— выбрать тела или области

Select objects: — выбрать объекты;

Select ob j ects : — нажать клавишу Enter для завершения работы команды.

Выполните упражнение Sub1 из раздела 4.

Сформировать тело путем вычитания f Sub1

Sub trOC t 8D Падающее пеню

Modify Solids Editing—-Subtract
Select solids and regions to subtract from ..

Select objects: указать горизонтальный параллелепипед
Select objects: Enter

Select solids and regions to subtract ..
Select objects: указать Вертикальный параллелепипед
Select objects: указать цилиндр
Select objects: Enter

Пересечение объектов

Щр Команда INTERSECT позволяет при пересечении нескольких существующих
объектов создать новые составные тела и области. Команда вызывается из
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падающего меню Modify > Solids Editing > Intersect или щелчком мыши по пик-
тограмме Intersect на панели инструментов Solids Editing.

Запросы команды INTERSECT:

Select ob j ects : — выбрать объекты;

Select objects: — выбрать объекты;

Select objects: — нажать клавишу Enter для завершения работы команды.

Выполните упражнения Int1 и Int2 из раздела 4.

Сформировать тело путем пересечения ( Int1

Intersect QD
Modify •

Падающее меню

So/ids Editing • Intersect

Select objects: указать точку на параллелепипеде

Select objects: указать точку на цилиндре

Select objects: Enter

Сформировать тело путем пересечения та
Intersect

Select objects: указать точку на параллелепипеде

Select objects: указать точку на шаре

Select objects: Enter
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Команды редактирования в двумерном пространстве, например переноса MOVE,
копирования СОРУ, поворота ROTATE, зеркального отображения MIRROR и размно-
жения массивом ARRAY, могут использоваться и в трехмерном пространстве. Кро-
ме того, существуют команды редактирования только в трехмерном пространстве,
как-то: поворота, создания массива объектов, зеркального отображения, снятия
фаски, скругления.

Редактирование трехмерных объектов

Поворот вокруг оси
В двумерном пространстве команда ROTATE производит поворот объекта вокруг
указанной точки; при этом направление поворота определяется текущей ПСК.
При работе в трехмерном пространстве поворот производится вокруг оси. Ось
может определяться следующими способами: указанием двух точек, объекта, од-
ной из осей координат (X, У или Z) или текущего направления взгляда. Для пово-
рота трехмерных объектов можно использовать как команду ROTATE, так и ее трех-
мерный аналог — ROTATE 3D.

Команда ROTATE 3D, осуществляющая поворот объектов в трехмерном пространстве
вокруг заданной оси, вызывается из падающего меню Modify > 3D Operation > Rotate 3D.

Запросы команды ROTATE 3D:

Current positive angle: ANGDIR=counterclockwise ANGBASE=0— те-
кущие установки отсчета углов;

Select objects: — выбрать объекты;

Select obj ects : — нажать клавишу Enter по окончании выбора объектов;

Specify first point on axis or define axis by

[Object/Las t/View/Xaxi s/Yaxi s/Zaxi s/2points ] : — указать первую точ-
ку оси;

Specify second point on axis : — указать вторую точку оси;

Specify rotation angle or [Reference] : — указать угол поворота.

Ключи команды ROTATE 3D:

Q Ob j ect — поворот вокруг выбранного объекта. Такими объектами могут быть
отрезок, окружность, дуга или сегмент двумерной полилинии;

О Last — поворот вокруг оси, использовавшейся в предыдущей команде пово-
рота;

Q View — поворот вокруг оси, выровненной вдоль направления вида текущего
видового экрана и проходящей через заданную точку;
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О Xaxis, Yaxis , Zaxis — поворот вокруг оси, выровненной соответственно
вдоль направления осей X, F, Z и проходящей через заданную точку;

Q 2point — поворот вокруг оси, проходящей через две заданные точки.

Выполните упражнение Rot1 из раздела 4.

Повернуть тело вокруг оси Rot1

RotateJd Подающее меню
Modify—- 3D Operation —- Rotate 3D

:urrent positive angle: ANGDIR=counterclockwise ANG8ASE=0
Select objects: Выбрать объект
Select objects: Enter

Specify first point on axis or define axis by [Object/Last/
/View/Xaxis/Yaxis/Zaxis/2points]: указать точку на оси
Specify second point on axis: указать Вторую точку на оси
Specify rotation angle or [Reference]: 30 угол

Зеркальное отображение относительно плоскости
Команда MIRRORSD, осуществляющая зеркальное отображение объектов отно-
сительно заданной плоскости, вызывается из падающего меню Modify > 3D Operati-
on > Mirror 3D.

Запросы команды MIRROR3D:

Select pbj ects: — выбрать объекты;

Select objects: — нажать клавишу Enter по окончании выбора объектов;

Specify f irst point of mirror plane (3 points) or [Object/Last/
Zaxi s/View/XY/YZ/ZX/3points ] <3points>: — указать первую точку плос-
кости отражения (3 точки);

Specify second point on mirror plane: — указать вторую точку плоско-
сти отражения;

Specify third point on mirror plane: — указать третью точку плоскости
отражения;

\

Delete source objects? [Yes/No] <N>:—сохранить или удалить исход-
ные объекты.
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Ключи команды MIRROR3D:

Q Obj ect — отображение относительно выбранного плоского объекта: отрезка,
окружности, дуги или сегмента двумерной полилинии;

Q Last — отображение относительно плоскости, использовавшейся в предыду-
щей команде отображения;

Q Zaxis — отображение относительно плоскости, заданной двумя точками, первая
из которых лежит на плоскости, а вторая определяет вектор нормали к пло-
скости;

Q View — плоскость отражения ориентируется согласно плоскости взгляда те-
кущего видового экрана, проходящей через указанную точку;

Q XY, Y Z , ZX — плоскость отражения ориентируется вдоль одной из стандартных
плоскостей (XY, YZ или ZX), проходящей через указанную точку;

Q 3point — отображение относительно плоскости, проходящей через три задан-
ные точки.

Плоскость отображения может представлять собой:

О плоскость построения двумерного объекта;

Q плоскость, параллельную одной из плоскостей координат (XY, YZ или XZ) те-
кущей ПСК и проходящую через заданную точку;

Q плоскость, определяемую тремя указанными точками.

Выполните упражнение Mir1 из раздела 4.

Отобразить зеркально трехмерный объект ( Mir1

Mirror3d Падающее меню
Modify -3D Operation—-Mirror 3D

Select objects: быорать обьект
Select objects: Enter

Specify first point of mirror plane (3 points) or [Object/Last/
/Zaxis/View/XY/YZ/ZX/3points] <3points>: указать точку /
Specify second point on mirror plane: указать тачку 2

Specify third point on mirror plane: указать тачку З
3elete source objects? Г Yes/No] <N>: Enter не удалять

Размножение трехмерным массивом
Команда 3DARRAY позволяет создавать прямоугольный и круговой массивы объе'к-
тов в трехмерном пространстве. Отличие от аналогичной команды, применяемой
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в двумерном моделировании, состоит в том, что при создании прямоугольного
массива объектов, кроме количества столбцов и строк, запрашивается (задается
вдоль направления оси Z) количество уровней, а при создании кругового массива
вместо центра вращения используется ось вращения, начальная и конечная точки
которой следует указать в ответ на запросы. Команда 3DARRAY вызывается из па-
дающего меню Modify > 3D Operation > 3D Array. Запросы команды 3DARRAY:

Select objects : — выбрать объекты;

Select ob j ects : — нажать клавишу Enter по окончании выбора объектов;

Enter the type of array [Rectangular/Polar] <R>: — указать тип мас-
сива;

Enter the number of rows ( ) < 1 >:—указать количество рядов массива;

Enter the number of columns (I I I) <1>: — указать количество столбцов
массива;

Enter the number of levels ( . . . ) <1>: — указать количество уровней
массива;

Specify the distance between rows ( ) :—указать расстояние между
рядами;

Specify the distance between columns ( I I I ) : — указать расстояние
между столбцами;

Specify the distance between levels ( . . . ) : — указать расстояние меж-
ду уровнями.

Для формирования кругового массива следует выбрать ключ Polar. При этом
команда выдает следующие запросы:

V. ;_,

Select ob j ects : — выбрать объекты;

Select ob j ects : — нажать клавишу Enter по окончании выбора объектов;

Enter the type of array [Rectangular/Polar] <R>: R — выбрать кру-
говой тип массива;

Enter the number of items in the array:—указать количество элемен-
тов массива;

Specify the angle to f i l l (+=ccw, -=cw) < 3 6 0 > : — определить угол
заполнения;

Rotate arrayed objects? [ Y e s / N o ] < Y > : — указать, следует ли поворачи-
вать объекты массива;

Specify center point of array:—указать первую точку оси вращения;

Specify second point on axis of rotation: — указать вторую точку оси
вращения.
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Обрезка и удлинение трехмерных объектов
Любой трехмерный объект можно обрезать либо удлинить до другого объекта не-
зависимо от того, лежат ли они оба в одной плоскости и каким кромкам параллель-
ны: режущим или граничным.

Чтобы произвести обрезку (удлинение), с помощью системных переменных PRO J-
MODE и EXTEDGE следует выбрать одну из трех проекций: плоскость XYтекущей
ПСК, плоскость текущего вида или реальное трехмерное пространство.

Чтобы данные операции были выполнены успешно, объекты должны пересекать-
ся с граничными кромками в пространстве, иначе в результате обрезки (удлине-
ния) с проецированием на плоскость XY текущей ПСК новые границы объектов
могут не соответствовать указанным кромкам в пространстве.

При вызове команд TRIM и EXTEND, первая из которых выполняет обрезку части
объекта по заданной границе, а вторая осуществляет вытягивание до границы в
трехмерном пространстве, используется ключ Project, который определяет ре-
жим отсечения/вытягивания.

Сопряжение трехмерных объектов
В AutoCAD можно сопрягать любые объекты, расположенные в одной плоскости
и имеющие направления выдавливания, не параллельные оси Z текущей ПСК.
Направление выдавливания сопрягающей трехмерной дуги определяется следу-
ющим образом:

Q если объекты расположены в одной плоскости и имеют одно направление вы-
давливания, перпендикулярное ей, сопрягающая дуга лежит в той же плоско-
сти и имеет то же направление выдавливания;

Q если объекты расположены в одной плоскости, но имеют противоположные
или вообще различные направления выдавливания, сопрягающая дуга распо-
лагается в этой же плоскости. Направление ее выдавливания перпендикуляр-
но плоскости построения объектов; из двух перпендикуляров выбирается бли-
жайший к оси Zтекущей ПСК.

Предположим, например, что в одной плоскости трехмерного пространства нахо-
дятся две дуги — А и В.

Векторы направления выдавливания дуг противоположны: (0,0,5,0,8) и (0, -0,5, -0,8)
относительно текущей ПСК. Тогда для сопрягающей дуги будет принято направ-
ление выдавливания (0, 0,5, 0,8).

Редактирование трехмерных тел
В данном разделе описывается техника редактирования трехмерных твердотель-
ных объектов: снятие фасок, сопряжение, построение разрезов, сечений и деление
тел на части.
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Существует возможность непосредственно редактировать грани и ребра модели.
Есть функция, которая удаляет дополнительные поверхности и ребра, появивши-
еся после выполнения команд FILLET и CHAMFER.

Допускается изменение цвета граней и ребер, а также создание их копий, представ-
ляющих собой ACIS-тела, области, отрезки, дуги, круги, эллипсы и сплайны. Пу-
тем клеймения (то есть нанесения геометрических объектов на грани) создаются
новые грани или сливаются имеющиеся избыточные.

Смещение граней изменяет их пространственное положение в твердотельной мо-
дели; с помощью этой операции, например, можно увеличивать и уменьшать диа-
метры отверстий. Функция разделения создает из одного тела несколько новых
независимых. И наконец, имеется возможность преобразования тел в тонкостен-
ные оболочки заданной толщины.

Снятие фасок на гранях

Щр Команда CHAMFER осуществляет снятие фасок (скашивание) на пересечени-
ях смежных граней тел, как и в двумерном пространстве. Команда вызывается
из падающего меню Modify > Chamfer или щелчком мыши по пиктограмме Chamfer
на панели инструментов Modify. При использовании команды необходимо вна-
чале выбрать базовую поверхность, затем ввести размеры фаски и выбрать
ребра (рис. 10.1).

Рис. 10.1. Пример снятия фаски с тела

Запросы команды CHAMFER:

(TRIM mode) Current chamfer Distl = 10.0000, Dist2 = 10.0000-
режим с обрезкой, параметры фаски;

Select f irst line or [Polyl ine/Distance/Angle/Trim/Method]: —
выбрать первый отрезок;

Base surface selection. ..—выбирается базовая поверхность;

Enter surface selection option [Next/OK (current)] <OK>:—на-
жать клавишу Enter, если подсвечена нужная поверхность. Если требуется другая
поверхность, следует ввести N, для того чтобы подсветить смежную поверхность,
а затем нажать клавишу Enter;
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Specify'base surface chamfer distance <10.0000>: — указать длину
фаски для базовой поверхности;

Specify other surface chamfer distance <10.0000>: —указатьдлину
фаски для другой поверхности;

Select an edge or [Loop] :—указать ребро;

Select an edge or [Loop] : — указать ребро;

Se/lect an edge or [Loop] : — нажать клавишу Enter для завершения работы
команды.

Ребра можно выбирать индивидуально либо сразу все, если использовать ключ
Loop и затем указать любое ребро.

Выполните упражнения Chaf и Cha2 из раздела 4.

Снять фаску с ребра трехмерного тела

f: , Падающее меню Modify Chamfer
(TRIM mode) Current chamfer Dist! = 10.0000, Dist2 = 10.0000
Select first line or [Polyline/Distance/Angle/Trim/Method/mUltiple]: указать точку 1
Base surface selection...
Enter surface selection option [Next/OK (current)] <OK>: Enter

Specify base surface chamfer! distance <10.0000>:30
Specify other surface chamfer distance <10.0000>:3Q

Select an edge or [Loop]: указать верхнюю границу ребра
Select an edge or [Loop]: Enter

Снять фаску с ребра трехмерного тела

Ch am fer 'p*~
(TRIM mode) Current chamfer Dist! = 10.0000, Dist2 = 10.0000

elect first line or [Polyline/Distance/Angle/Trim/Method/mUltiple]: указать точку
на дерхней окружности цилиндра . Ьыорао берхнюю грань объекта

3ase surface selection...
Enter surface selection option [Next/OK (current)] <OK>: Enter

Specify base surface chamfer distance <10.0000>: 70
Specify other surface chamfer distance <10.0000>: 70

Select an edge or [Loop]: указать берхнюю окружность цилиндра
Select an edge or [Loop]: Enter
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Сопряжение граней
|Ц| Команда FILLET осуществляет плавное сопряжение (скругление) граней, как

и в двумерном моделировании. Для скругления тел можно воспользоваться
несколькими способами: Во-первых, так же, как и для плоских объектов, можно
задать радиус и затем указать ребра. Второй путь — указать радиус скругления
для каждого ребра. И, наконец, еще один способ — скруглять последовательность
касательных ребер. Команда вызывается из падающего меню Modify > Fillet или
щелчком мыши по пиктограмме Fillet на панели инструментов Modify. Запро-
сы команды FILLET:

Current settings: Mode = TRIM, Radius = 10 . О О О О — текущие настрой-
ки: режим и радиус сопряжения;

Select f i rst object or [Polyl ine/Radius/Trim] :—выбрать первый
объект;

Enter f i l let radius < 10 . О О О О > : — указать радиус сопряжения;

Select an edge or [Chain/Radius] :—выбрать ребро;

Select an edge or [Chain/Radius] :—выбрать ребро;

Select an edge or [Chain/Radius] : — нажать клавишу Enter для заверше-
ния работы команды. I

Если нажать клавишу Enter на первый запрос Select an edge or:, то ранее
выбранное ребро скруглится, и работа команды завершится. Но можно выбрать
одно за другим еще несколько ребер. При этом допускается установить новый ра-
диус перед выбором следующего ребра, используя ключ Radius, или задать по-
следовательность касательных ребер, используя ключ Chain. На рис. 10.2 приве-
ден пример скругления последовательности касательных ребер трехмерного тела
одинаковым радиусом.

Рис. 10.2. Пример скругления тела
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Выполните упражнения Fill и F1I2 из раздела 4.

/""
Построить сопряжение (скругление) граней ( Fill

Fille t fP? Падающее пеню Modify Fill61
Current settings: Mode = TRIM, Radius = 5.0000
Select first object or [Polyline/Radius/Trim/mUltiple]: указать

верхнее скругляемое ребро параллелепипеда
Enter fillet radius <5.0000>: 20

Select an edge or [Chain/Radius]: указать скругляемое ребро
Select an edge or [Chain/Radius]: указать скругляемое ребро
Select an edge or [Chain/Radius]: Enter

Построить сопряжение (скругление) граней ( FN2

Fillet |Ц Падающее меню Modify -Fillet
Current settings: Mode = TRIM, Radius = 5.0000
Select first object or [Polyline/Radius/Trim/mUltiple]: указать

верхнее скругляемое ребро параллелепипеда
Enter fi"et radius <5.0000>: 50

Select an edge pr [Chain/Radius]: указать нижнее
скругляемое ребро параллелепипеда

Select an edge or [Chain/Radius]: Enter

Построение сечений

Щ Команда SECTION осуществляет построение поперечного сечения тела в виде
области или неименованного блока. Поперечное сечение — это пересечение
плоскости и выбранного тела (рис. 10.3). Команда SECTION вызывается из
падающего меню Modify > Solids > Section или щелчком мыши по пиктограмме
Section на плавающей панели инструментов Solids.

'

Запросы команды SECTION:

Select objects: — выбрать объекты;

Select ob j ects : — нажать клавишу Enter по завершении выбора объектов;
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Specify f i r s t point on Section plane by [ O b j e c t / Z a x i s / V i e w / X Y /
YZ/ZX/3points] <3points>: — указать первую точку на секущей плоскости;

Specify second point on plane:—указать вторую точку на секущей пло-
скости;

Specify third point on plane: — указать третью точку на секущей плоскости.

Рис. 10.3. Изображение сечения

По умолчанию секущая плоскость задается путем указания трех точек. При ис-
пользовании других методов она определяется плоскостью построения другого
объекта, плоскостью текущего вида, осью Z или одной из плоскостей координат
(XY, YZ или XZ). AutoCAD помещает секущую плоскость в текущий слой.

Поперечное сечение представляет собой область или неименованный блок, фор-
мируемые на текущем слое, а не на слое, где находится объемное тело, поперечное
сечение которого создается.

Выполните упражнение Sec1 из раздела 4.

Построить сечение тела Sec1
с 4- ' 'Section Падающее меню

Draw — _ Solids — - Section
Select objects: указать но ооьект
Select objects: Enter

Specify first point on Section plone by [Object/
/Zaxis/View/XY/YZ/ZX/3points] <3points>: указать точку )

Specify second point on plane: указать точку 2
Specify third point on plane: указать точку 3

_ Переместить образовавшееся сечение
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Получение разрезов

Щ Команда SLICE осуществляет построение нового тела путем разрезания како-
го-либо существующего тела плоскостью (рис. 10.4). Команда вызывается из
падающего меню Modify > Solids > Slice или щелчком мыши по пиктограмме
Slice на плавающей панели инструментов Solids.

Рис. 10.4. Изображение разреза

Запросы команды SLICE:

Select objects : — выбрать объекты;

Select ob j ects : — нажать клавишу Enter по завершении выбора объектов;

Specify f i rst point on slicing plane by [ 'Object/Zaxi s/View/XY/
Y Z / Z X / 3 p o i n t s ] <3points>: — указать первую точку на режущей плоскости;

Specify second point on plane:—указать вторую точку на режущей пло-
скости;

Specify third point on plane:—указать третью точку на режущей пло-
скости;

Specify a point on desired side of the plane or [keep Both
sides ] : — указать точку с нужной стороны от плоскости.

Полученные части можно оставить на рисунке или же удалить одну из них. Разре-
занные тела наследуют слой и цвет исходного тела, но являются новыми состав-
ными телами.

При разрезании по умолчанию тремя точками задается режущая плоскость, а за-
тем указывается, какая часть (или обе) должна быть сохранена.
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При использовании других способов режущая плоскость может определяться дру-
гим объектом, плоскостью текущего вида, осью Z или одной из координатных
плоскостей (XY, 72илиХ2Г).

Ключи команды SLICE:

О Ob j ect — задает плоскость с помощью выбранного плоского объекта: отрезка,
окружности, дуги, эллипса, эллиптической дуги, двумерного сплайна или сег-
мента двумерной полилинии;

Q Zaxis — задает плоскость двумя точками, первая из которых лежит на ней,
а вторая определяет вектор нормали к плоскости;

Q View — задает плоскость, выровненную с плоскостью вида текущего видового
экрана и проходящую через заданную точку;

Q XY, Y Z , ZX — задают плоскость, выровненную соответственно с плоскостью XY,
YZ или ZX и проходящую через заданную точку;

О 3points — определяет плоскость, проходящую через три заданные точки;

О keep Both sides — оставляет обе части разрезанного тела.

Выполните упражнение SIM из раздела 4.

Получить разрез тела SH1

Slice ||»! Падающее меню Draw So/ids Slice
Select objects: указать на объект
Select objects: Enter

Specify first point on slicing plane by [Object/
/Zaxis/View./XY/YZ/ZX/3points]<3points>: указать тачку 1

Specify second point on plane: указать точку 2
Specify third point on plane: указать точку З

Specify a point on desired side of the plane or [keep Both sides]:
указать точку той части тела . которую надо оставить на рисунке

Формирование чертежей
с использованием трехмерного
моделирования
При формировании чертежа на основе трехмерной твердотельной модели (напри-
мер, приведенной на рис. 10.5) следует придерживаться следующего порядка:
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Рис. 10.5. Чертеж трехмерной твердотельной детали

1. Создать новый рисунок с помощью команды NEW, вызываемой из падающего
меню File > New..., или щелчком по пиктограмме New стандартной панели ин-
струментов.

2. Для вызова Мастера подготовки в диалоговом окне Create New Drawing выбрать
пиктограмму Use a Wizard (см. рис. 1.35). Далее в списке Select a Wizard: выбрать
Quick Setup.

3. В диалоговом окне Quick Setup в качестве единиц измерения длины Units уста-
новить десятичные Decimal (см. рис. 1.3). При определении границы облас-
ти черчения Area установить ширину — 420 мм, длину — 297 мм.

4. Щелчком мыши на кнопке GRID в строке состояния или функциональной кла-
вишей F7 включить отображение сетки на экране.

5. Отобразить всю область чертежа на экране командой ZOOM, вызываемой из па-
дающего меню View > Zoom > All (см. рис. 4.3) или щелчком мыши по пиктограм-
ме Zoom All в стандартной панели инструментов (см. рис. 4.4). См. упражне-
ние Z2 (раздел 2).

6. Сохранить рисунок с помощью команды QSAVE, вызываемой из падающего
меню File > Save или щелчком мыши по пиктограмме Save в стандартной панели
инструментов.



Формирование чертежей с использованием трехмерного моделирования .;. 271

7. Установить значение системной переменной ISOLINES равное 20, что соот-
ветствует количеству образующих линий, отображаемых на искривленных по-
верхностях.

!-

8. С помощью команд BOX и CYLINDER построить параллелепипед и цилиндры.
См. упражнения Boxl и Cyll (раздел 4). При построении рекомендуется уста-
новить удобную точку зрения, используя плавающую панель инструментов
View или команду 3DORBIT, которая вызывается из падающего меню View > 3D
Orbit или щелчком мыши по пиктограмме 3D Orbit одноименной панели инстру-
ментов. См. упражнения Vptl, Orbl и Orb2 (раздел 4).

9. Выполнить логические преобразования. Объединить параллелепипед и внеш-
ний цилиндр с помощью команды UNION, вызываемой из падающего меню
Modify > Solids Editing > Union или щелчком мыши по пиктограмме Union панели
инструментов Solids- Editing. Затем из полученного тела вычесть внутренний
цилиндр с помощью команды SUBTRACT, вызываемой из падающего меню
Modify > Solids Editing > Subtract или щелчком мыши по пиктограмме Subtract па-
нели инструментов Solids Editing. См. упражнения Unil и Subl (раздел 4).

10. Подавить невидимые линии командой HIDE, вызываемой из падающего меню
View > Hide или щелчком мыши по пиктограмме Hide плавающей панели ин-
струментов Render.

11. Установить ПСК параллельно главному виду детали. Для этого необходи-
мо воспользоваться командой UCS, вызвав ее из падающего меню Tools > New
UCS > 3 Point.

12. Перейти из пространства модели в пространство листа щелчком мыши по за-
кладке Layout. См. упражнения Spal и Spa2 (раздел 4).

13. Настроить параметры листа с помощью Мастера компоновки листа. Для этого
необходимо загрузить диалоговое окно Create Layout, показанное на рис. 8.3, из
падающего меню Tools > Wizards > Create Layout....

14. Вставить в рисунок рамку формата A3 (при условии, что эта заготовка уже суще-
ствует). Вставка осуществляется командой INSERT, вызываемой из падающего
меню Insert > Block... или щелчком мыши по пиктограмме Insert Block панели
инструментов Draw. При этом загружается диалоговое окно Insert (см. рис. 5.17).
См. упражнение Inl (раздел 3).

15. Создать наклонный текстовый стиль в диалоговом окне Text Style (см. рис. 5.10),
вызываемом из падающего меню Format > Text Style.... В области Font в раскры-
вающемся списке поля Font Name: следует выбрать шрифт simplex. shx; в поле
Oblique Angle: установить угол наклона к нормали 15; в поле Height: установить
высоту 0 (ноль). См. упражнение Т7 (раздел 2).

16. Заполнить штамп. Рекомендуется увеличить изображение штампа с помощью
зумирования. Затем использовать команду DTEXT, вызываемую из падающего
меню Draw > Text > Single Line Text или щелчком мыши по пиктограмме Dtext па-
нели инструментов. При заполнении штампа удобно использовать ключ вырав-
нивания по ширине Fit команды DTEXT. См. упражнение Т4 (раздел 2).
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17. Создать на чертеже видовые экраны с необходимыми проекциями (рис. 10.6),
используя команду SOLVIEW, вызываемую из падающего меню Draw > Solids > Set-
up > View.

• Получить главный вид — фронтальную проекцию детали:

_solview

Enter an option [Ucs/Ortho/Auxiliary/Section]: U — ПСК;

Enter an option [Named/World/?/Current] <Current>: <Enter>;

Enter view scale <1>: 0 . 5 — указать масштаб вида;

Specify view center:—указать центр вида;

Specify view center <specify viewport>: <Enter>;

Specify f i r s t corner of v iewport :— указать первый угол видового эк-
рана;

Specify opposite corner of 'v iewport :—указать второй угол видового
экрана;

Enter view name : Front — ввести имя формируемого вида.

• Получить вид сверху — горизонтальную проекцию детали:

UCSVIEW = 1 UCS will be saved with view

Enter an option [Ucs/Ortho/Auxiliary/Section]: О—орто;

Specify side of viewport to project: — указать верхнюю границу видо-
вого экрана главного вида;

Specify view center:—указать центр вида;

Specify view center <specify viewport>: <Enter>;

Specify f i rs t corner of v i e w p o r t : — указать первый угол видового эк-
рана;

Specify opposite corner of v iewport :— указать второй угол видового
экрана;

. • /

Enter view name: Gor iz on t — ввести имя формируемого вида.

• Получить вид слева — профильную проекцию детали:

UCSVIEW = 1 UCS will be saved with view

Enter an option [Ucs/Ortho/Auxi l iary/Section]: О—орто;

Specify side of viewport to project: — указать левую границу видового
экрана главного вида;
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Specify view center:— указать центр вида;
/

Specify view center <specify viewport>: <Enter>;

Specify f irst corner of viewport:— указать первый угол видового
экрана;

Specify opposite corner of viewport:— указать второй угол видового
экрана;

Enter view name: Prof il — ввести имя формируемого вида.

• Получить разрез детали:

UCSVIEW = 1 UCS will be saved with view

Enter an option [Ucs/Ortho/Auxil iary/Section] : S — сечение;

Specify first point of cutting plane: CEN — указать на профильной
проекции первую точку режущей плоскости с объектной привязкой к центру верх-
него основания Цилиндра;

Specify second point of cutting plane: CEN — указать на профильной
проекции вторую точку режущей плоскости с объектной привязкой к центру ниж-
него основания цилиндра;

Specify side to view from: — указать слева на профильной проекции точку
направления взгляда (сторону просмотра);

Enter view scale <0 . 5>: <Enter>;

Specify view center:—указать центр вида;

Specify view center <specify viewport>: <Enter>;

Specify first corner of viewport: — указать первый угол видового экрана;

Specify opposite corner of viewport:— указать второй угол видового
экрана;

Enter view name: Section — ввести имя формируемого вида;

UCSVIEW = 1 UCS will be saved with view

Enter an option [Ucs/Ortho/Auxiliary/Section] : <Enter> — завершить
работу команды.

18. Всем слоям с невидимыми линиями (<имя вида>-НЮ) установить тип ли-
нии HIDDEN. Выполнить команду SOLDRAW, вызываемую из падающего меню
Draw > Solids > Setup > Drawing. В ответ на последовательность запросов Select
obj ects : следует указать рамки всех видовых экранов.

19. Отключить слой VPORTS, в котором находятся рамки видовых экранов.

20. Находясь в пространстве листа провести на проекциях детали осевые линии.
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Рис. 10.6. Видовые экраны с проекциями детали

40

01

А-А

100

Рис. 10.7. Чертеж детали

21. Проставить на проекциях детали размеры в слоях с именами <имя euda>-DIM
(рис. 10.7).
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Q Типы трехмерных изображений
Q Подавление скрытых линий

и раскрашивание
Q Тонирование
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Использование AutoCAD для создания трехмерных моделей и их изображений
имеет множество преимуществ по сравнению с применением программы в двумер-
ном моделировании, но вместе с тем требует несколько иного подхода. Работа в
трехмерном пространстве представляет собой сочетание рисования, редактирова-
ния и установки видов и видовых экранов для изображения модели. Следовательно,
от пользователя требуется умение сформировать корректную трехмерную модель,
работать с различными трехмерными системами координат, правильно задавать
пользовательские системы координат, а также корректно устанавливать необходи-
мые виды трехмерных моделей.

При построении трехмерной модели приходится работать более чем с одним ви-
дом объекта. Возможно, что изображение объекта будет достаточно информатив-
ным на одном виде и нечитаемым на другом. В любом случае при работе с трех-
мерными объектами следует установить несколько видовых экранов, например
один — с видом в плане, другой — с видом слева, дополнительный — с аксономе-
трическим видом.

Чтобы повысить удобство работы, для каждого видового-экрана можно задать и со-
хранить отдельную ПСК. Независимо от того, что происходит с ПСК на текущем
видовом экране, системы координат на остальных видовых экранах остаются не-
изменными и при переключении между экранами не происходит потери инфор-
мации о ПСК каждого из них.

Находясь в пространстве модели, можно рассматривать сформированные объекты
с любой точки зрения. Точкой зрения (видом) называется направление, задаваемое
из трехмерной точки пространства на начало системы координат. Установка направ-
ления взгляда производится в начале работы с моделью или при необходимости
рассмотреть завершенную модель из какой-либо конкретной точки. AutoCAD по-
зволяет взглянуть на рисунок из любой точки пространства, даже изнутри изобра-
жаемого объекта. Перемещая точку зрения в нужную позицию, удобнее формиро-
вать объекты, редактировать их, а также получать изображения со скрытыми
линиями, закрашенные и тонированные. Можно получать виды в ортогональной
и перспективной проекциях.

Установка нового вида в пространстве модели производится с помощью команд:

Q VPOINT — позволяет вводить из командной строки точку зрения или угол по-
ворота вида;

Q DDVPOINT — отображает диалоговое окно определения точки зрения Viewpoint
Presets;

Q PLAN — отображает вид в плане пользовательской или мировой системы коорт
динат;

О DVIEW — определяет параллельную проекцию или перспективные виды;

Q 3 DORBIТ — обеспечивает интерактивное отображение видов.
I

Важно помнить: при работе в пространстве листа не разрешается устанавливать
виды с помощью команд VPOINT, DVIEW и PLAN. Пространство листа отображает-
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ся всегда в плане. При попытке использовать перечисленные команды в простран-
стве листа AutoCAD выдает сообщение:

** Command only valid in Model space **

Интерактивное управление точкой взгляда

Щ Команда 3 DORBIТ активизирует на текущем видовом экране режим интерак-
тивного управления точкой взгляда при работе в трехмерном пространстве.
Видом модели в это время можно управлять с помощью мыши. С орбиты мо-
гут рассматриваться как вся модель, так и ее отдельные объекты. Команда вы-
зывается из падающего меню View > 3D Orbit или щелчком мыши по пиктограм-
ме 30 Orbit на плавающей панели инструментов 3D Orbit.

Вид, на котором действует режим орбиты, помечается орбитальным кольцом. Гео-
метрически оно представляет собой большой круг, разделенный на квадранты че-
тырьмя малыми кругами.

В процессе выполнения команды 3DORBIT неподвижной остается точка, на кото-
рую направлен взгляд, то есть точка цели. Позиция наблюдателя (точка камеры)
перемещается относительно цели. Считается, что цель в данном случае совмеще-
на с центром орбитального кольца.

Для установки орбитального вида необходимо выбрать один или несколько объек-
тов, которые должны быть рассмотрены с орбиты. Если же предварительно ниче-
го не было выбрано, в рассмотрении будет участвовать вся модель. Тем не менее
рекомендуется ограничивать круг вовлекаемых в операцию объектов, так как это
ускоряет работу программы.

Для того чтобы приступить к вращению вида, нужно нажать кнопку мыши и на-
чать перемещать ее. Указатель мыши изменяет свое состояние в зависимости от
того, на какой части орбитального кольца находится. Форма указателя помогает
понять, как именно будет вращаться вид:

Q если указатель находится внутри орбитального кольца, он выглядит как малень-
кая сфера с двумя внешними окружностями-орбитами. Нажатие кнопки и дви-
жение мыши в этом случае вызывают свободное перемещение вида. Вид ведет
себя так, как будто бы пользователь захватил мышью воображаемую сферу,
окружающую объекты, и начал вращать ее вокруг точки цели. Указатель мож-
но перемещать по горизонтали, по вертикали и по диагонали;

Q если указатель мыши находится вне орбитального кольца, он выглядит как ма-
ленькая сфера с внешней окружностью-стрелкой. Нажатие кнопки и перемеще-
ние указателя вокруг орбитального кольца вызывает вращение вида относи-
тельно оси, проходящей через центр кольца перпендикулярно экрану. Если
указатель переходит через орбитальное кольцо, он приобретает форму сферы с
двумя орбитами и начинает свободно перемещать вид, как было описано выше.
После выхода указателя обратно во внешнюю часть восстанавливается режим
вращения вида вокруг центральной оси;
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Q если указатель мыши находится на левом или правом малом круге орбиталь-
ного кольца, он выглядит как маленькая сфера с горизонтальным эллипсом-
стрелкой. Нажатие кнопки и перемещение указателя из этих точек вызывает
вращение вида относительно вертикальной оси, проходящей через центр коль-
ца. Вертикальная линия на указателе символизирует направление этой услов-
ной оси Y;

Q если указатель мыши находится на верхнем или нижнем малом круге орбиталь-
ного кольца, он выглядит как маленькая сфера с вертикальным эллипсом-
стрелкой. Нажатие кнопки и перемещение указателя из этих точек вызывают
вращение вида относительно горизонтальной оси, проходящей через центр
кольца. Горизонтальная линия на указателе символизирует направление этой
условной оси X.

Для улучшения восприятия трехмерных орбитальных видов на них можно раз-
местить одно или несколько средств визуализации: компас, сетку и пиктограмму
ПСК. В контекстном меню активные средства визуализации помечаются галочкой
и сохраняются на экране по завершении работы команды 3DORBIT.

Для вызова средства визуализации необходимо в процессе выполнения команды
3DORBIT щелкнуть правой кнопкой мыши в области рисования и выбрать пункт
Visual Aids из контекстного меню, а затем отметить один из следующих вариантов:

Q Compass — орбитальное кольцо дополняется тремя пространственными пунк-
тирными окружностями, символизирующими проекции осейХ, У и Zna сферу;

О Grid — строится вспомогательная сетка из линий, параллельных осям X и У
и перпендикулярных оси Z. Трехмерный уровень, на котором она расположе-
на, задается системной переменной ELEVATION.

Перед входом в режим трехмерной орбиты можно, воспользовавшись командой
GRID, задать параметры отображения сетки. Количество основных ее линий за-
висит от того, какой установлен шаг в системной переменной GRIDUNIT. Про-
межутки между основными линиями делятся еще на десять частей с помощью
дополнительных линий (на рисунке они выделены серым цветом).

При изменении коэффициента экранного увеличения (зумировании) на трех-
мерном орбитальном виде AutoCAD подбирает количество линий сетки так,
чтобы они не сливались, но и не отстояли друг от друга слишком далеко. Если
вид отдаляется от наблюдателя, линий становится меньше. Напротив, с при-
ближением вида количество линий увеличивается до тех пор, пока не начинает
вновь соответствовать значению GRIDUNIT;

Q DCS Icon — включение и отключение пиктограммы ПСК. Если она была вклю-
чена перед вызовом команды 3DORBIT, на орбитальном виде сразу же появля-
ется цветная пиктограмма в виде тройки осей. Ось X имеет красный цвет,
ось Y— зеленый, ось Z— синий или голубой. Режим отображения трехмерной
пиктограммы ПСК устанавливается также системной переменной UCSICON.

Выполните упражнения ОгЫ и ОгЬ2 из раздела 4.
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Установить точку зрения ОгЫ

3d orbit Падающее меню VlGW

Удерживая нажатой левую кнопку мыши,
устанобите желаемую точку зрения,
Для быхода из команды нажать Enter —

JD Orbit

Exit.

Установить точку зрения ОгЬ2

3d с orb it
More-В контекстном меню Idorbit:

Удерживая нажатой левую кнопку мыши, задать
вращательный момент детали и отпустить кнопку.
Для фиксации точки зрения сделать щелчок мышью.
Для быхода из команды нажать Enter • Exit.

Continuous Orbit

Типы трехмерных изображений
В процессе проектирования различных объектов большая часть графических ра-
бот приходится на формирование каркасных, поверхностных или твердотельных
моделей. Отображение объектов на экране дисплея должно происходить быстро,
в реальном времени. Как правило, по завершении работы над моделью, а иногда и
в процессе проектирования, требуется максимально правдоподобное изображение
сконструированного объекта, то есть должны быть использованы реальные цвета,
специфическая текстура поверхности, естественная светотень, перспектива и другие
эффекты. Это бывает необходимо, например, при предъявлении заказчику закон-
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ченного проекта или при проверке правильности выполнения дизайн-проектиро-
вания. Кроме того, визуализация моделей объектов, сформированных в AutoCAD,
может быть вполне самоценной, в том числе при создании рекламы или анимаци-
онных клипов. Данный подход в последнее время получил широкое распростра-
нение благодаря простоте формирования в AutoCAD сложных трехмерных объектов.
Подготовленные для визуализации трехмерные объекты могут быть импортиро-
ваны вместе с наложенными на их грани цветом и текстурой в другие графические
пакеты, например 3D Studio MAX.

Если перечислять способы отображения моделей объектов в порядке усложнения,
последовательность будет такова: изображения с подавленными скрытыми лини-
ями; изображения с раскрашенными поверхностями; тонированные изображения
с поверхностями, которым присвоены цвет и свойства определенных материалов;
изображения объекта с заданным освещением.

Решая вопрос о способе представления объекта, следует учитывать, какого каче-
ства нужно добиться и сколько времени на это потребуется. Например, для обыч-
ного технического отчета вполне подойдет изображение с подавленными скрытыми
линиями или раскрашенное; для презентаций, дизайнерских проектов, рекламы
необходимо применять тонирование и подсветку. Чем выше требования к реали-
стичности изображения, тем более сложный алгоритм применяется для его фор-
мирования: с освещением из одного или нескольких источников света; со светотенью;
с трассировкой всех световых лучей для достижения абсолютной достоверности.
При обычной же, повседневной работе над проектом вполне достаточно время от
времени скрывать невидимые линии модели для текущего контроля.

Подавление скрытых линий
и раскрашивание

Чтобы в процессе разработки дизайна и по окончании формирования трехмерных
поверхностных и твердотельных моделей улучшить их визуализацию, использу-
ют следующие команды:

Q HI DE — подавляет скрытые линии на трехмерном изображении объекта;

Q SHADEMODE — формирует раскрашенное изображение модели на текущем ви-
довом экране;

Q RENDER — создает реалистическое изображение модели в трехмерном про-
странстве.

Щ Команда HIDE обеспечивает создание рисунка без скрытых линий. Сложные
трехмерные модели часто оказываются перегруженными, что затрудняет их
чтение и просмотр результатов выполнения какой-либо команды на объекте.
Можно устранить эту проблему, подавив скрытые (невидимые с данной точ-
ки зрения) линии. Команда HIDE вызывается из падающего меню View > Hide
или щелчком мыши по пиктограмме Hide на плавающей панели инструментов
Render.
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Команда HIDE интерпретирует окружности, фигуры, полосы, широкие сегменты
полилиний, трехмерные грани, прямоугольные сети и выдавленные края прими-
тивов как непрозрачные поверхности, скрывающие объекты, которые лежат за
ними. Если кругам, фигурам, полосам и широким сегментам полилиний присво-
ена некоторая высота, то они рассматриваются как сплошные объекты с верхней
и нижней поверхностями (телами).

Пока невидимые линии не подавлены или не произведено тонирование, тела ото-
бражаются в виде каркаса. При таком представлении поверхность тела аппрокси-
мируется ребрами граней и образующими линиями искривленных поверхностей.
Количество образующих линий, отображаемых на искривленных поверхностях,
задается значением системной переменной ISOLINES в момент создания объекта.
При подавлении невидимых линий твердотельного объекта генерируются и уда-
ляются невидимые линии объекта, представленного сетью. Этим процессом управ-
ляет системная переменная DISPSILH: если ее значение равно 0, то объект с по-
давленными линиями отображается в виде сети, если 1 — в виде силуэтных линий
тела. Например, для сферы силуэтной линией будет окружность. Подавленные
скрытые линии остаются невидимыми до тех пор, пока не будет произведено ка-
кое-либо действие, вызывающее регенерацию, после чего на экране вновь появит-
ся изображение в виде каркасной модели.

Выполните упражнение Hid1 из раздела 4.

Подавить скрытые линии (ню.
Hide ф

Падающее меню View Hide

Команда SHADEMODE обеспечивает раскрашивание изображения (удаление неви-
димых линий и нанесение однотонных цветов на видимые поверхности) на те-
кущем видовом экране. Хотя удаление скрытых линий значительно улучшает вос-
приятие рисунка, изображение модели будет выглядеть более реалистично, если
ее раскрасить. При осуществлении этой процедуры на текущем видовом экране
AutoCAD автоматически удаляет скрытые линии. Подразумевается, что источник
света один и расположен за спиной пользователя («свет из-за плеча»). Команда
SHADEMODE вызывается из падающего меню View > Shade; далее выбирается один
из вариантов:
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О 2D Wireframe — объекты представляются в виде отрезков и кривых, как кромки
граней и тел. Видны растровые и OLE-объекты, учитываются типы и веса ли-
ний. Даже если системная переменная COMPAS S включена, компас на виде не
отображается;

Q 3D Wireframe — объекты представлены в виде отрезков и кривых, как кромки
граней и тел. Появляется цветная трехмерная пиктограмма системы координат.
Растровые и OLE-объекты не видны, типы и веса линий не учитываются. Если
системная переменная COMPASS включена, на виде отображается компас. Объек-
ты показаны с учетом цветов присвоенных им материалов;

Q Hidden — объекты представляются в каркасном виде. При этом линии, отно-
сящиеся к задним граним, не отображаются;

Q Flat Shaded — грани многоугольников окрашены в некоторый цвет. В отличие от
раскрашивания по Гуро, эффектов плавного перехода здесь не создается. Вид-
ны материалы, присвоенные объектам;

Q Gouraud Shaded — грани многоугольников окрашены в некоторый цвет, причем
переходы от одной грани к другой сглаживаются благодаря использованию
цветовых оттенков. Видны материалы, присвоенные объектам;

Q Flat Shaded, Edges On — комбинация ключей Flat и Wireframe. К граням применя-
ется плоское раскрашивание, каркас просвечивает сквозь них;

Q G'ouraud Shaded, Edges On — комбинация ключей Gouraud и Wireframe. К граням
применяется раскрашивание по Гуро, каркас просвечивает сквозь них.

При вычислении оттенка цвета (то есть яркости) каждой грани учитываются два
фактора: угол наклона поверхности к направлению взгляда и установка системной
переменной SHADEDIF. Чем больше значение системной переменной, тем выше
контрастность отображения. Чем круче угол наклона поверхности по отношению
к направлению взгляда, тем темнее оттенок ее раскраски. Расстояние от точки зре-
ния до объекта при раскрашивании не играет никакой роли.

Результаты раскрашивания различны для разных точек зрения. Для достиже-
ния наилучшего эффекта рекомендуется поэкспериментировать с различными ви-
дами.

Значение диффузного отражения, используемое программой для вычисления
оттенка каждой поверхности, определяется системной переменной SHADEDIF.
Системная переменная FACETRES регулирует плавность изображения при раскра-
шивании.

При раскрашивании моделей с помощью команды SHADEMODE невозможно полу-
чать блики, перемещать имеющийся источник света и добавлять новые. Все эти
эффекты доступны лишь при тонировании, которое выполняется командой RENDER.
Скорость раскрашивания повышается с уменьшением площади видового экрана,
поэтому для ускорения работы рекомендуется уменьшать видовой экран, насколь-
ко это возможно.
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ом™ И3°бражения (Рис' 1 1-1-11-3) выглядят ещеболее реалистично чем
рисунки с удаленными невидимыми линиями или раскрашенные.

Операция тонирования позволяет получить изображения, в некоторых случа

" КаЧеСТВеННЫС красками, цветнымии л т у ь

Рис. 11.1. Тонированное сложное тело, полученное путем вычитания

Рис. 11.2. Тонированное тело вращения
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Рис. 11.3. Тонированное сложное тело, полученное путем объединения

Тонирование обычно представляет отдельную задачу при создании проекта и вы-
полняется в несколько этапов:

1. Подготовка моделей объектов для тонирования: на этом этапе важно прокон-
тролировать способы формирования объектов и задать настройки точности
отображения.

2. Определение освещения моделей: необходимо создать источники света и на-
строить их соответственно текущей задаче.

3. Определение материалов для поверхности объектов: следует задать или вы-
брать из библиотеки отражательные характеристики материалов и присвоить
их видимым поверхностям.

4. Тонирование: обычно эта операция повторяется многократно, с изменением
различных настроек и возвратом к предыдущим этапам, пока не будет достиг-
нут желаемый результат.

Такое деление на этапы достаточно условно; в реальной работе перечисленные
операции часто неотделимы друг от друга и необязательно выполняются в выше-
описанном порядке.

Подготовка моделей для тонирования
Важный этап процесса тонирования — подавление скрытых поверхностей, так как
тонирование скрытых поверхностей и поверхностей заднего плана не имеет смысла.
Чтобы можно было установить, передней или задней является грань, в AutoCAD
используется нормаль к каждой из граней.

Направление нормали определяется тем, как нарисована грань в правоориентиро-
ванной системе координат, принятой в AutoCAD. Если углы грани заданы в на-
правлении против часовой стрелки, нормаль направлена наружу; если по часовой
стрелке — внутрь. Все грани следует рисовать одним и тем же методом: смешение
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способов рисования может привести к непредсказуемым результатам. Во время
тонирования AutoCAD вычисляет все нормали, направленные от точки зрения, и
удаляет из сцены связанные с ними многоугольники. Этот процесс называется
подавлением задних граней,

После того как задние грани подавлены, AutoCAD сравнивает относительные рас-
стояния по оси Z Если одна из граней перекрывает другую, AutoCAD подавляет
невидимую грань.

Ш Команда RPRE F обеспечивает игнорирование невидимых граней. Она вызыва-
ется из падающего меню View > Render > Preferences... или щелчком мыши по
пиктограмме Render Preferences на панели инструментов Render. В области
Rendering Options появившегося диалогового окна Rendering Preferences, пока-
занного на рис. 11.4, следует нажать кнопку More Options... и в области Face
Controls диалогового окна Render Options поставить флажок, включающий по-
давление задних граней, Discard back faces (см. рис. 11.5).

1 1 fl
ll Ijij

1 '
1 Ц 1

и.ь; 1

. 11.4. Диалоговое окно установки режимов тонирования

Рис. 11.5. Диалоговое окно установки параметров упрощенного тонирования

Если приходится тонировать модель, которую ранее тонировать не предполага-
лось, то есть она была создана без учета требований к векторам нормалей поверх-
ностей, возможно, понадобится снять флажки Discard back faces и Back face normal is
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negative. Хотя в результате процесс тонирования значительно замедлится, лучше
пожертвовать быстротой, чтобы получить корректное изображение объектов.

На этапе тонирования трехмерной модели важна техника построения модели
объекта. Рекомендуется применять для этого однотипные методы. Не следует
строить, например, модели зданий, одни стены которых представляют собой гра-
ни, другие — выдавленные отрезки, а третьи — каркасные сети.

К твердотельным моделям не рекомендуется добавлять двумерные и трехмерные
грани, а также трехмерные поверхности. Не всегда приемлемо добавление двумер-
ных и трехмерных граней, если модель состоит из трехмерных поверхностей.
Впрочем, эти рекомендации даются только для упрощения процесса тонирования:
даже если модель сформирована из произвольно ориентированных поверхностей,
ее можно корректно тонировать (правда, тогда на это потребуется гораздо больше
времени).

Время, требуемое для построения тонированного изображения, зависит от числа
граней и вершин объектов. Любая криволинейная поверхность, используемая в
процессе тонирования, предварительно разбивается на грани — треугольные и че-
тырехугольные участки плоскости с вершинами в углах граней. При минимизации
числа граней процесс значительно упрощается: чем проще структура поверхности,
тем меньше времени тратится на определение цвета каждого пиксела грани. Если
при тонировании геометрических объектов возникают проблемы, то работать с та-
кими объектами необходимо в режимах Photo Real и Photo Raytrace.

Большие трудности при тонировании создают объекты с пересекающимися и пе-
рекрывающими друг друга гранями.

Иногда случается так, что одна грань в модели проходит через другую — обычно
при попытках упростить формирование модели, так как построить пересекающи-
еся грани легче, чем отдельные пересекающиеся объекты. Подобные упрощения
приводят к тому, что модель тонируется неправильно, если только в систему то-
нирования не заложена проверка таких ситуаций. В режимах Photo Real и Photo
Raytrace проверка предусмотрена обязательно, хотя и при работе с ними возможны
проблемы, особенно при тонировании с низким разрешением.

Тонирование перекрывающихся граней с противоположно направленными нор-
малями может приводить к неоднозначным результатам. Подобную проблему
удастся предотвратить, если постоянно следить, чтобы линии контура граней ниг-
де не перекрывались.

Режим плавного тонирования перехода через кромку грани назначается ключом
Smooth Shade из области Rendering Options диалогового окна Rendering Preferences,
которое вызывается командой RPREF. Сложности возникают, когда угол между
соседними гранями превышает определенную величину. В этом случае сглажива-
ния не происходит, и поверхность получается как бы граненой.

Управление точностью и разрешением отображения тонированных моделей осу-
ществляется с помощью команды VIEWRES. Величина точности аппроксима-
ции, устанавливаемая этой командой, влияет на плавность линий, формирующих
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окружности, дуги и эллипсы. AutoCAD отображает такие фигуры на экране в виде
множества коротких прямолинейных сегментов. Чем выше точность аппроксима-
ции, тем плавнее дуги и окружности, но одновременно продолжительнее процесс
их регенерации. Если окружности на рисунке похожи на многоугольники, они и
после тонирования останутся такими же. Для повышения производительности
рекомендуется в ходе рисования устанавливать как можно меньшую точность ап-
проксимации, а перед тонированием (если в рисунке есть дуги и окружности) уве-
личить ее для достижения требуемого качества.

Плавность линий, образующих тонированные тела с криволинейными поверхно-
стями, регулирует системная переменная FACETRES. Она связана с точностью ап-
проксимации, заданной в команде VIEWRES. Если значение системной переменной
FACETRES равно 1, степень аппроксимации криволинейных поверхностей тел рав-
на степени аппроксимации окружностей, дуг и эллипсов. Если этой переменной
присвоить значение 2, точность аппроксимации для тел будет вдвое выше, чем для
окружностей, дуг и эллипсов, и т. д. По умолчанию FACETRES установлена в 0 . 5.
Диапазон допустимых значений — от 0 . 01 до 10. Параметры тонирования настра-
иваются в диалоговом окне Render.

Ijjjf Диалоговое окно Render загружается командой RENDER, вызываемой из пада-
ющего меню View > Render > Render... или щелчком мыши по пиктограмме Render
на одноименной панели инструментов. Окно содержит следующие области и оп-
ции (рис. 11.6):

1Ш11|;!̂ Ш1Ш~3

Рис. 11.6. Диалоговое окно тонирования

О раскрывающийся список Rendering Type:, где задается режим тонирования изоб-
ражения;

О область, определяющая процедуру тонирования Rendering Procedure, в которой
представлены следующие параметры:
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• Query for Selections — дает возможность тонировать только предварительно
выбранные объекты;

• Crop Window — позволяет задавать в текущем видовом экране область тони-
рования;

• Skip Render Dialog — отменяет появление диалогового окна команды RENDER.
Последний флажок можно снять в диалоговом окне команды RPREF;

Q поле Light Icon Scale:, где устанавливается значение коэффициента масштаби-
рования блоков/пиктограмм источников света;

Q поле Smoothing Angle:, определяющее минимальный угол между гранями, при
котором начинает работать режим сглаживания;

Q область Rendering Options с кнопкой More Options..., по нажатии которой загру-
жаются различные диалоговые окна в зависимости от установленного режима
тонирования. Здесь также расположены следующие флажки:

• Smooth Shade — включает режим плавного отображения криволинейных по-
верхностей;

• Apply Materials — включает режим отображения материалов, назначенных
объектам;

• Shadows — позволяет формировать тени объектов. Работает только в режи-
мах Photo Real и Photo Raytrace;

• Render Cache — дает возможность сохранять результаты отображения на
жестком диске компьютера, что при повторном тонировании без изменений
значительно сокращает время работы;

Q область Destination, содержащая раскрывающийся список выбора, куда следует
поместить тонированное изображение;

Q область Sub Sampling с раскрывающимся списком режимов обработки эффектов
типа «тень». При выборе режима 1:1 (Best), установленного по умолчанию, фор-
мируются тени наивысшего качества. В режиме 8:1 (Fastest) этот процесс про-
текает с максимальной скоростью, но в ущерб качеству;

О кнопка Background..., по нажатии которой открывается диалоговое окно коман-
ды определения фона BACKGROUND;

Q кнопка Fog/Depth Cue..., по нажатии которой вызывается диалоговое окно ко-
манды определения тумана и затемнения FOG;

О кнопка Render, при щелчке по которой запускается процесс визуализации.

Настройка тонирования
Настройка тонирования для различных режимов определяется качеством изобра-
жения, которое может предоставить используемый компьютер. Основные пара-
метры, влияющие на качество отображения, — разрешение экрана дисплея и глу-
бина цветности — зависят как от типа выбранного для компьютера дисплея, так
и от типа установленной видеокарты.
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Вывод тонированного изображения на один из видовых экранов, в отдельное
окно Render или в файл можно настроить, используя диалоговые окна Render —
см. рис. 11.6 — и Rendering Preferences — см. рис. 11.4. Они открываются командами
RENDER и RPREF соответственно.

jjji Команда RENDER вызывается из падающего меню View > Render > Render... или
щелчком мыши по пиктограмме Render на одноименной панели инструментов.

Маршрут вывода тонированного изображения определяется в области Destination;
здесь нужно выбрать один из трех пунктов раскрывающегося списка: Viewport —
вывод изображения в видовой экран, Render W i n d o w — в отдельное окно Render или
File — в файл. Если применен вывод в отдельное окно Render, пользователю пре-
доставляются широкие возможности дальнейшей обработки изображения. Его
можно скопировать в буфер обмена для экспорта в другие приложения, вывести
на системный принтер или в файлы различных форматов.

Поскольку изображение на мониторе состоит из дискретных элементов (пиксе-
лов), жестко расположенных в виде прямоугольной матрицы, наклонные или кри-
вые линии могут выглядеть неровно — с зазубринами, то есть мелкими ступенька-
ми. Чем выше разрешение экрана (и, соответственно, мельче пикселы), тем менее
заметен эффект зазубрин. Чтобы улучшить изображение, существует еще один
метод, кроме увеличения разрешения экрана. Нужно, запустив команду RENDER
или RPREF, установить в области R e n d e r i n g Type диалогового окна Render или
Rendering Preferences режим Photo Real либо Photo Raytrace. Затем после нажатия
кнопки More Options... в появившемся диалоговом окне Photo Real Render Options —
рис. 11.7 — или Photo Raytrace Render Options — рис. 11.8 — следует в области, регу-
лирующей уровень устранения зазубрин Anti-Aliasing, определить разрешающую
способность сглаживания.
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Рис. 11.7. Диалоговое окно установки параметров фотореалистичного тонирования

Возможные позиции переключателя: минимальный Minimal — низкий Low — сред-
ний Medium — высокий High. Данная опция отвечает за алгоритм вычисления цвета

10 Зак. 1039
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пикселов, смежных с наклонными и кривыми линиями. Качество изображения
улучшается от позиции Minimal к High, но и время, затрачиваемое на этот процесс,
возрастает в 16 раз.

Рис. 11.8. Диалоговое окно установки параметров тонирования методом трассировки луча

Глубина цветности 1 бит означает, что цвет пиксела может быть либо черным, либо
белым. При глубине цветности 8 бит пиксел принимает любой из 256 оттенков.

Для высококачественных изображений необходима глубина цветности 24 бита;
таким образом обеспечивается отображение около 16,8 миллиона цветов. Мини-
мальная глубина цветности при тонировании может составлять 8 бит, максималь-
ная — 32 бита.

Техника тонирования
В AutoCAD существуют три режима тонирования, которые определяются в диа-
логовом окне Render или Rendering Preferences, вызываемом командой RENDER или
RPREF соответственно. Режимы устанавливаются в области Rendering Type:

О! Render — упрощенный тип тонирования;

Q Photo Real — фотореалистичное тонирование с возможностью отображения раст-
ровых и прозрачных материалов, а также с улучшенным отображением теней;

Q Photo Raytrace — еще более реалистичное тонирование, основанное на алгорит-
ме трассировки луча. Позволяет генерировать эффекты отражения, рефракции,
еще точнее строить тени.

В первом, простейшем режиме Render тонирование производится без добавления
источников света, присвоения материалов и определения сцен. Источник света,
используемый для такого тонирования, расположен как бы за спиной наблюдате-
ля. Этот источник нельзя ни перенести, ни изменить. Данный режим обеспечива-
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ет довольно быстрое тонирование, хотя и не всегда позволяет получить реалистич-
ное изображение модели.

Загрузка системы тонирования происходит автоматически при первом запуске
любой команды тонирования: RENDER, SCENE, LIGHT, RMAT, MATLIB, BACKGROUND
и т. п. Кроме того, систему можно загрузить и при необходимости выгрузить с по-
мощью команды ARX.

Выполните упражнение Ren1 из раздела 4.

Тонировать объекты ReiVL
Render Щ

падающее меню View —- Render —- Render
В диалоговом окне Render нажать кнопку Render.

Важный момент в процессе тонирования — определение фона, которое произво-

дится в диалоговом окне Background, вызываемом командой BACKGROUND, — см.
рис. 11.9. Команда загружается из падающего меню View > Render > Background...
или щелчком мыши по пиктограмме Background на панели инструментов Render.

• 1 •
iff/'lii

Рис. 11.9. Диалоговое окно определения фона тонирования
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В диалоговое окно Background также можно перейти из диалогового окна Render
или Rendering Preferences, нажав кнопку Background... . По умолчанию в качестве
фона тонированного изображения AutoCAD использует цвет фона графическо-
го окна. Фон тонированного изображения может быть установлен следующим об-
разом:

ГД Solid — сплошной одноцветный фон, выбранный из палитры цветов;

Q Gradient — градиент, плавный переход между тремя цветами: Top/Middle/Bottom —
верхний/средний/нижний. Настройка этого перехода определяется в правой
нижней области окна движками Horizon:, Height: и Rotation:;

О Image — фон в виде растровой картинки, которую можно подогнать по размеру
и положению или же размножить по прямоугольной сетке, заполняя весь фон;

Q Merge — в качестве фонового выступает текущее изображение AutoCAD. Дан-
ная опция доступна только в том случае, если установлен вывод на видовой
экран.

Выполните упражнение Bad из раздела 4.

Тонировать объект с установкой фона (Bad

Background Щ
подающее меню View —- Render —- Background

В диалоговом окне Background установить режим Gradient.

Тонировать объект командой Render.

Назначение и редактирование материалов

Чтобы сделать тонированные изображения более правдоподобными, можно придать
поверхностям объектов оптические свойства различных материалов. Материалы
могут быть как реальными, так и не существующими в природе; в первом случае
подбирают характеристики таким образом, чтобы они соответствовали какому-
либо металлу или пластмассе, стеклу и т. д. Материалы обычно объединяют в биб-
лиотеки для дальнейшего использования. Если имеющийся набор не удовлетво-
ряет разработчика, он может сам создать материал, который будет соответствовать
его требованиям.

Материалы, определенные в AutoCAD, можно связывать с конкретными объекта-
ми, индексами цветов AutoCAD, блоками и слоями.
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Определение материалов
|р Команда RMAT, позволяющая определить материалы, вызывается из падающего

меню View > Render > Materials... или щелчком мыши по пиктограмме Materials
на панели инструментов Render. Эта команда выводит на экран диалоговое окно
Materials, показанное на рис. 11.10.

Рис. 11.10. Диалоговое окно определения материалов

Перед созданием нового материала необходимо определить его тип: Standard — мате-
риал, обладающий наиболее широким диапазоном настроек, или специальные ма-
териалы: Marble — со свойствами мрамора, Granite — со свойствами и трехцветной
текстурой гранита, Wood — со свойствами и двухцветной текстурой дерева. В отличие
от стандартных, специальные материалы нельзя экспортировать в другие прило-
жения, например в 3D Studio MAX. Для точной настройки материалов необходи-
мо нажатием кнопки New... открыть дополнительное диалоговое окно New Standard
Material и воспользоваться его опциями. В диалоговом окне Materials расположены:

Q поле Materials: со списком имен всех определенных в чертеже материалов;

О кнопка Preview с окном для просмотра материала на сферической или кубиче-
ской поверхности;

Q кнопки Modify... и Duplicate..., используемые для редактирования и копирова-
ния уже существующих материалов;

Q кнопка Materials Library..., предназначенная для перехода к диалоговому окну
библиотеки материалов Materials Library, вызываемому командой MATLIB;

Q кнопка Selects, по нажатии которой можно определить имя материала, присво-
енного объекту;

Q кнопки Attach<, Detach<, By ACL.. и By Layer..., с помощью которых производится
присвоение материала объекту, снятие материала с объекта, присвоение мате-
риала объектам с заданным цветом AutoCAD и объектам с заданным слоем.
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Основными элементами диалогового окна New Standard Material, изображенного на
рис. 11.11, являются:

Q область Material Name:, предназначенная для ввода уникального имени материала;
Q область Attributes, где задаются и изменяются следующие характеристики ма-

териала:
• Color/Pattern — основной цвет поверхности. Параметр определяет основной

цвет отражаемого объектом света, то есть его диффузное отражение. Тексту-
ра определяется как накладываемое на модель растровое изображение. Оно
может быть представлено в любом из поддерживаемых AutoCAD форматов:
TGA, BMP, TIFF, JPEG или PCX. Выбранная для тонирования область за-
полняется элементарными образцами текстуры. Текстура и цвет материала
могут использоваться совместно. На слайде-образце видно, как будут вы-
глядеть основной цвет и выбранная текстура на модели;

• Ambient — цвет рассеянного освещения. Параметр определяет цвет тени ма-
териала, а также цвет, отражаемый поверхностью при освещении ее рассе-
янным светом. Рекомендуется устанавливать значение не более 0,3 или
оставлять заданное по умолчанию 0,1. использование большей величины
может привести к размыванию тонированного изображения;

• Reflection — отраженный цвет бликов. Параметр определяет цвет бликов
(зеркальных отражений) на отражающей поверхности. Блестящие поверх-
ности, например гладкие металлические, отражают свет узким пучком, а при
освещении тел сферической или цилиндрической формы блик представля-
ет собой яркое пятно;

• Roug h ness — шероховатость поверхности. Параметр определяет размер бликов
на изображении. Именно шероховатостью, например, обусловлено внешнее
различие двух стальных шариков от подшипника, один из которых отполи-
рован, а второй обработан наждачной бумагой. Чем более гладкая поверх-
ность, тем меньше размер бликов;

• Transparency — прозрачность материала. Можно сделать весь объект или его
часть прозрачными или полупрозрачными. Степень прозрачности матери-
ала регулируется в пределах от 0 до 1,0. Установка прозрачности увеличи-
вает продолжительность тонирования;

• Refraction — преломление прозрачного материала;

• Bump Map — текстура выдавливания. Параметр позволяет имитировать эффект
выдавливания на поверхности объекта. Значения яркости в точках текстуры
выдавливания создает эффект появления высоты у поверхности объекта;

Q область Value:, где можно изменить значение любой характеристики;
Q область Color, применяемая для цветового определения характеристик, с флаж-

ками By ACI, Lock и Mirror, которые позволяют воспользоваться цветом объекта
AutoCAD, основным цветом материала и цветом, зеркальным по отношению
к основному;

Q области Bitmap Blend: и File Name:, где определяются пропорция присутствия
текстуры в характеристике и имя этой текстуры;

Q кнопки Adjust Bitmap... и Find File..., используемые для подгонки текстур и по-
иска файлов с текстурами.
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Рис. 11.11. Диалоговое окно определения материала

Присвоение материалов
После того как материал создан и, если необходимо, отредактирован, остается при-
своить его поверхностям тех или иных объектов.

Для этого в области Material Name: диалогового окна Materials сначала выбирают под-
ходящий материал, а затем, нажав кнопку Attactx, — требуемые объекты на чертеже.

В процессе дальнейшей работы программы регистрируется количество объектов,
которым уже присвоен данный материал. Эти объекты автоматически выделяют-
ся на чертеже для того, чтобы устранить повторное присвоение того же материала.

Выполните упражнение Mat1 из раздела 4.

Тонировать объект с установкой материала (Mat1

Rmat <§
Падающее меню Vie w • Render- Materials...

В диалоговом окне Materials выбрать кнопку Materials Library...
В диалоговом окне Materials Library... в области
Current Library пододрать материал.
просматривая его 6 окне Preview ' .
Импортировать материал б область Current Drawing,
нажав кнопку <—Import.
В И.о. Materials выбрать
кнопку Attach< (присбоить).

Выбрать объект.
Тонировать объект
командой Render.
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Наложение текстур
Применительно к тонированию наложение текстур означает проецирование дву-
мерной растровой картинки на поверхность трехмерного объекта для достижения
специальных эффектов. Форматы растровых изображений могут быть самыми
разными - BMP, TGA, TIP, PCX или JPG.

Наложение текстур производится по координатам UV. Эти буквы специально вы-
браны так, чтобы подчеркнуть независимость от координат XYобъектов AutoCAD.
Накладываемые текстуры масштабируются в соответствии с текущей системой
единиц AutoCAD.

В фотореалистических режимах тонирования растровые картинки можно исполь-
зовать как:

Q цветовые текстуры, определяющие раскраску поверхности объекта, как если
бы на нее была нанесена растровая картинка. Например, для имитации покры-
того плиткой пола на горизонтальную поверхность накладывают текстуру, на-
поминающую по виду шахматную доску;

О текстуры отражения, имитирующие предметы, как бы отражающиеся от глад-
кой поверхности объекта;

Q текстуры прозрачности, задающие прозрачные и непрозрачные участки на
объекте. Например, если взять растровое изображение черного круга в середи-
не белого прямоугольника и наложить его на объект в качестве текстуры про-
зрачности, то поверхность будет выглядеть так, как будто на объекте имеется
круглое прозрачное отверстие;

*
Q текстуры выдавливания — имитирующие эффект небольшого выдавливания

участков изображения над остальной поверхностью.

Эффекты, создаваемые наложением текстур, отображаются только в фотореали-
стических режимах тонирования.

По умолчанию текстура накладывается на объект в масштабе 1:1 — при этом тони-
рование занимает минимальное время.

Если растровая картинка меньше объекта, при ее проецировании следует задать
способ ее наложения: либо несколько экземпляров картинки с расположением
«плитками», либо наложение одиночного экземпляра.

В первом случае картинка копируется столько раз, сколько нужно, чтобы она пол-
ностью покрыла объект. При одиночном наложении на объект проецируется толь-
ко один экземпляр картинки. Остальная часть объекта тонируется на основании
данных о его основном материале. Область в пределах наложенной картинки мо^ж-
но настроить так, чтобы через текстуру просвечивал основной материал.

Текстуры, связанные с материалами, могут накладываться на объекты путем впи-
сывания или с фиксированным масштабом. Если текстура вписывается в объект,
материал сразу заполняет границы тонируемой поверхности, а рисунок текстуры
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растягивается или уменьшается. При наложении с фиксированным масштабом
материал вначале заполняет некоторую фиксированную область, а затем получен-
ная структура размножается, покрывая всю поверхность.

Наложение картинки в качестве цветовой текстуры определяет раскраску поверх-
ности объекта. Например, растровая картинка с узором накладывается на изобра-
жение сиденья стула для имитации обивки.

Текстуры прозрачности задают прозрачные и непрозрачные области объекта, со-
здавая эффект наличия отверстий и проемов. Степень прозрачности определяет-
ся яркостью элементов текстуры: чисто белые ее области соответствуют непро-
зрачным участкам, чисто черные — прозрачным. Если текстура цветная, то для
вычисления степени прозрачности программа берет в расчет эквивалент в оттен-
ках серого.

Более светлые участки картинки, наложенной как текстура выдавливания, выгля-
дят как бы возвышающимися над поверхностью объекта. Простейший пример —
картинка с белыми буквами на черном фоне. Наложение ее на плоскость в каче-
стве текстуры выдавливания дает эффект выпуклых букв на плоском фоне, хотя
в действительности объект остается плоским.

Если текстура цветная, для вычисления «высоты» элементов, кажущихся выпук-
лыми при выдавливании, программа оперирует эквивалентом в оттенках серого.
Применение текстур выдавливания не ограничено картинками с текстами — лю-
бая регулярная растровая структура может быть использована для придания по-
верхности рельефного облика.

Экспорт и импорт материалов
Пользователь, который создает модели объектов, но не является профессионалом
в разработке материалов, обычно задействует готовую библиотеку материалов.

Ц; Для вызова диалогового окна Materials Library, показанного на рис. 11.12, необ-
ходимо запустить команду MATLIB из падающего меню View > Render > Materials
Library.... Это окно может также открываться либо нажатием кнопки Materials
Library... в диалоговом окне Materials, загружаемом командой RMAT, либо щелч-
ком мыши по пиктограмме Materials Library на плавающей панели инструмен-
тов Render. Необходимо отметить, что можно не толькб брать материалы из
библиотеки, но и модифицировать их, а затем добавлять туда. Таким образом,
вы через некоторое время сформируете свою собственную библиотеку мате-
риалов, часто используемых в ваших проектах.

Ниже перечислены основные опции диалогового окна Materials Library:

Q список Current Drawing, содержит названия материалов, имеющихся в рисунке.
Здесь могут быть представлены материалы, не присвоенные ни одному объек-
ту. В списке можно выбрать материалы, которые следует сохранить в рисунке
или удалить из него. Выбор материалов в списке Current Library отменяет выде-
ление элементов списка Current Drawing, и наоборот;
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Рис. 11.12. Диалоговое окно библиотеки материалов

Q список Current Library показывает материалы, имеющиеся в выбранном библио-
течном файле. По умолчанию используется библиотека render.mli;

О кнопка Save As... предназначена для вызова диалогового окна Library File — стан-
дартного окна выбора файлов, где задается имя MLI-файла, в котором будет
сохранен список Current Drawing;

D по нажатии кнопок Open... и Save можно открывать новые библиотеки и сохра-
нять все изменения в открытой библиотеке;

Q Preview — область просмотра образца материала, выбранного в списке Current
Library или Current Drawing. Тип тела, используемого для создания образца (сфе-
ра или куб), выбирается из раскрывающегося списка, расположенного ниже.
Образцы материалов можно просматривать только по одному.

Q кнопки <-Import и Export»: первая добавляет выбранный в библиотеке матери-
ал в рисунок, вторая — новый материал в библиотеку;

Q кнопка Delete, с помощью которой можно удалять из рисунка и библиотеки все
неприсвоенные материалы;

fJ Purge — опция удаления неиспользуемых материалов.
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3D — построение трехмерных объектов в виде полигональных сетей.

3DARRAY — построение трехмерных массивов.

3DCLIP — вызов диалогового окна Adjust C l i p p i n g Planes для просмотра сечений
трехмерной модели с помощью двух динамических плоскостей, которые ограни-
чивают пространство чертежа по глубине отображаемой области.

3DCONFIG — настройка системы трехмерной графики в командной строке.

3DCORBIT — установка режима интерактивного трехмерного просмотра с динами-
ческим вращением вида.

3DDISTANCE — управление расстоянием от камеры до объекта при просмотре
в трехмерном пространстве.

i
3DFACE — построение трехмерных граней.

3DMESH — построение полигональных сетей произвольной формы.

3DORBIT — интерактивный просмотр объектов в трехмерном пространстве.

3DORBITCTR — активация на текущем видовом экране трехмерного вида, вывод на
экран орбитального кольца и предоставление возможности указать центральную
точку орбиты с помощью мыши.

3DPAN — динамическое панорамирование объекта при его просмотре в трехмер-
ном пространстве.

3DPOLY — создание трехмерных полилиний из линейных сегментов.

3DSIN — импорт файлов из программы 3D Studio MAX.

3DSOUT — экспорт выбранных объектов в файлы 3D Studio MAX.

3DSWIVEL — имитация эффекта поворота камеры при просмотре модели в трех-
мерном пространстве.

3DZOOM — динамическое зумирование при просмотре модели в трехмерном про-
странстве.

А

ABOUT — вывод на экран информации об AutoCAD.

AC IS IN — импорт ACIS-файлов, в которых содержится описание твердых тел.

ACISOUT — экспорт твердотельных объектов AutoCAD в файлы формата ACIS.

ADCCLOSE — закрытие Центра управления AutoCAD DesignCenter.

ADCENTER — загрузка Центра управления AutoCAD DesignCenter, обеспечивающего
управление содержимым, — блоками, внешними ссылками и образцами штриховки.
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ADCNAVIGATE — перемещение в зоне структуры Центра управления A u t o C A D
DesignCenter на конкретный файл, папку или сетевой ресурс.

А1_ВОХ — создание поверхности прямоугольного параллелепипеда.

AI_CONE — создание поверхности полного или усеченного конуса.

AI_DISH — создание поверхности чаши (нижней полусферы).

AI_DOME — создание поверхности купола (верхней полусферы).

AI_FMS — переключение в пространство модели с плавающими видовыми экра-
нами.

AI_MESH — создание трехмерной сети произвольной прямоугольной формы с за-
данным количеством узлов.

AI_MOLC — установка текущего слоя, соответствующего выбранному объекту.

AI_PYRAMID — создание поверхности полной или усеченной пирамиды с основа-
ниями произвольной треугольной или четырехугольной формы.

AI_SPHERE — создание поверхности сферы.

AIJTORUS — создание поверхности тора.

AI_WEDGE — создание поверхности клина.

ALIGN — выравнивание объектов относительно других объектов в двумерном
и трехмерном пространстве.

AMECONVERT — конвертирование твердотельных моделей АМЕ в объекты AutoCAD.

APERTURE — изменение размера прицела и величины области влияния объектной
привязки.

APPLOAD — загрузка и выгрузка приложений; составление набора приложений для
автозагрузки.

ARC — построение дуг.

AREA — вычисление площадей и периметров объектов или заданных областей.

ARRAY — создание прямоугольных и круговых массивов объектов.

ARX — загрузка, выгрузка и предоставление информации о приложениях Object ARX.

ASSIST — открытие окна Помощника с предоставлением контекстной информа-
ции автоматически или по запросу пользователя.

ATTACHURL — добавление гиперссылок к объектам и зонам рисунка.

ATTDEF — создание описаний атрибутов.
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ATTDISP — управление текущим режимом отображения атрибутов.

ATTEDIT — глобальное управление видимостью атрибутов.

АТТЕХТ — экспорт данных из атрибутов блоков текущего рисунка во внешний
файл формата .txt или .dxx.

ATTREDEF — переопределение блока и обновление связанных с ним атрибутов.

ATTSYNC — обновление всех вхождений блока после редактирования описаний его
атрибутов.

AUDIT — проверка рисунка и его целостности.

В
\

BACKGROUND — указание фона для сцен.

BASE — указание базовой трчки вставки для текущего рисунка.

BATTMAN — редактирование свойств атрибутов в описаниях блоков.

ВНАТСН — нанесение ассоциативной штриховки или градиентной заливки внутри
замкнутого контура.

BLIPMODE — управление видимостью маркера на экране при рисовании.

BLOCK — создание описания блока из выбранных объектов.

BLOCKICON — формирование изображений-образцов для блоков, представленных
в Центре управления.

BMPOUT — сохранение выбранных объектов в файле аппаратно-независимого растро-
вого формата .bmp.

BOUNDARY — создание области или полилинии из замкнутого контура.

BOX — построение трехмерных твердотельных параллелепипедов (ящиков).

BREAK — разрыв выбранного объекта между двумя точками.

BROWSER — вызов интернет-браузера, зарегистрированного в системном реестре.

С

CAL — вычисление математических и геометрических выражений.

CAMERA — установка положения камеры и цели при настройке трехмерного вида.

CHAMFER — снятие фасок в местах пересечения объектов.

CHANGE — управление свойствами объектов.

CHECKSTANDARDS — проверка текущего рисунка на соответствие установленным
стандартам оформления.
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CHPROP — изменение цвета, слоя, типа линии, масштаба типа линии, веса (толщи-
ны) линии, трехмерной высоты и стиля печати объекта.

CIRCLE — построение окружностей.
(

CLOSE — закрытие текущего рисунка.

CLOSEALL — закрытие всех открытых в данный момент рисунков.

COLOR — установка цвета для вновь создаваемых объектов.

COMPILE — компиляция файлов форм и файлов шрифтов PostScript.

CONE — построение трехмерного твердотельного конуса.

CONVERT — преобразование двумерных полилиний и ассоциативных штриховок,
созданных в AutoCAD более ранних версий.

CONVERTCTB — преобразование таблиц цветозависимых стилей печати (СТВ)
в таблицы именованных стилей печати (STB).

CQNVERTPSTYLES — настройка рисунка на использование именованных или цве-
тозависимых стилей печати.

COPY — создание копии объекта.

COPYBASE — копирование объектов в буфер обмена с указанием базовой точки без
их удаления из рисунка.

COPYCLIP — копирование объектов в буфер обмена без их удаления из рисунка.

COPYHIST — копирование текста из окна командной строки в буфер обмена.

COPYLINK — копирование текущего вида в буфер обмена для связывания с други-
ми OLE-приложениями.

CUSTOMIZE — адаптация панелей инструментов, кнопок и клавиш быстрого вызова.

CUTCLIP — занесение объектов в буфер обмена с их удалением из рисунка.

CYLINDER — построение трехмерных твердотельных цилиндров.

D

DBCCLOSE — закрытие Диспетчера подключения к базам данных.

DBCONNECT — интерфейс AutoCAD для работы с таблицами внешних баз данных.

DBLCLKEDIT — управление реакцией системы на двойной щелчок мыши.

DBLIST — вывод на экран информации базы данных для всех объектов рисунка.

DDEDIT — редактирование текстов (в том числе размерных), описаний атрибутов
и допусков формы и расположения.
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DDPTYPE — установка стиля отображения и величины точечных объектов.

DDVPOINT — установка направления взгляда в трехмерном пространстве.

DELAY — установка паузы при выполнении пакета команд.

DETACHURL — удаление гиперссылок из рисунка.

DIM and DIM1 — переход в режим нанесения размеров.

DIMALIGNED — нанесение параллельных линейных размеров.

DIMANGULAR — нанесение угловых размеров.

DIMBASELINE — нанесение новых линейных, угловых или ординатиых размеров
от базовой линии предыдущего или выбранного размера.

DIMCENTER — нанесение маркеров центра или центровых линий на кругах и дугах.

DIMCONTINUE — нанесение цепи линейных, угловых или ординатных размеров от
второй выносной линии предыдущего или выбранного размера.

DIMDIAMETER — нанесение диаметров окружностей, дуг и эллипсов.

DIMDISASSOCIATE — отмена ассоциативности выбранных размеров.

DIMEDIT — редактирование размеров.

DIMLINEAR — нанесение линейных размеров.

DIMORDINATE — нанесение ординатных размеров.

DIMOVERRIDE — переопределение установок размерных переменных без пере-
определения стиля.

DIMRADIUS — нанесение радиусов окружностей, дуг и эллипсов.

DIMREASSOCIATE — связывание выбранных размеров с геометрическими объек-
тами.

DIMREGEN — обновление расположения всех ассоциативных размеров.

DIMSTYLE — создание и модификация размерных стилей.

DIMTEDIT — перемещение и поворот размерных текстов.

DIST — измерение расстояний и углов между точками.

DIVIDE — равномерная размещение объектов-точек или блоков вдоль или по пе-
риметру объектов.

DONUT — построение закрашенных кругов и колец.

DRAGMODE — управление отображением объектов при перетаскивании.



Приложение * 305

DRAWORDER — изменение порядка вывода растровых изображений и других объек-
тов на экран.

DSETTINGS — настройка параметров шаговой привязки, сетки, полярного и объект-
ного отслеживания.

DSVIEWER — вызов диалогового окна Aerial View, обеспечивающего интерактивное
управление экранным увеличением текущего видового экрана.

DTEXT — формирование текста.

DVIEW — установка параллельных проекций и видов в перспективе.

DWGPROPS — настройка и просмотр свойств текущего рисунка.

DXBIN — импорт двоичных файлов в специальной кодировке.

Е
EATTEDIT — редактирование атрибутов во вхождениях блоков.

ЕАТТЕХТ — экспорт информации из атрибутов блоков во внешний файл.

EDGE — изменение видимости кромок трехмерных граней.

EDGESURF — построение трехмерных полигональных сетей (поверхностей Кунса).

ELEV — установка уровня и трехмерной высоты выдавливания вновь создаваемых
объектов.

ELLIPSE — построение эллипсов и эллиптических дуг.

ETRANSMIT — формирование комплектов, состоящих из файла рисунка и всех ис-
пользуемых в нем внешних файлов.

ERASE — удаление выбранных объектов из рисунка.

EXPLODE — разбиение составного объекта (без изменения геометрии) на состав-
ляющие его объекты.

i
EXPORT — сохранение объектов в файлах различных форматов.

EXTEND — удлинение объектов до пересечения с другими объектами.

EXTRUDE — создание тел путем выдавливания двумерных объектов.

F

FILL — управление закрашиванием таких объектов, как штриховки, фигуры и ши-
рокие полилинии.

FILLET — скругление углов и сопряжение объектов.

FILTER — создание фильтров многократного использования для выбора объектов
на основе их свойств.
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FIND — поиск, замена, выбор и показ текста на рисунке.

FOG — создание эффекта тумана или воздушной перспективы для визуального
представления объектов.

G
GOTOURL — открытие файла или интернет-страницы, на которые указывает гипер-
ссылка в выбранном объекте.

GRAPHSCR — переключение из текстового окна в графическую область.

GRID — включение и отключение точечной сетки на текущем видовом экране.

GROUP — создание именованных наборов (групп) объектов и управление ими.

Н

HATCH — заполнение указанного контура неассоциативной штриховкой по вы-
бранному образцу.

HATCHEDIT — редактирование нанесенных штриховок или градиентной заливки.

HELP — вызов справочной системы.

HIDE — регенерация трехмерной модели с подавлением скрытых линий.

HLSETTINGS — настройка параметров отображения невидимых линий.

HYPERLINK — создание гиперссылки для объекта или изменение существующей
гиперссылки.

HYPERLINKOPTIONS — управление отображением курсора и подсказок к гипер-
ссылкам.

I

ID — определение координат указанных точек.

IMAGE — управление растровыми изображениями.

IMAGEAD JUST — регулировка яркости, контрастности и степени слияния с фоном
вставленных в рисунок растровых изображений.

IMAGEATTACH — вставка нового растрового изображения в текущий рисунок.

IMAGECLIP — создание контуров подрезки изображений.

IMAGE FRAME — управление видимостью границ контуров подрезки растрового
изображения.

IMAGEQUALITY — управление качеством вывода вставленных в рисунок растро-
вых изображений на экран.

IMPORT — импорт в AutoCAD файлов различных форматов.
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INSERT — вставка в текущий рисунок именованного блока или другого рисунка.

INSERTOB J — вставка связанного или внедренного объекта.

INTERFERE — создание сложного трехмерного тела, занимающего общий объем
двух или более тел.

INTERSECT — создание составных тел или областей из пересечения двух или бо-
лее тел или областей с удалением непересекающихся участков объектов.

ISOPLANE — выбор текущей изометрической плоскости.

J

JPGOUT — сохранение выбранных объектов в файле формата jpg.

JUSTIFYTEXT — изменение размеров текстовых объектов без изменения их место-
положения.

L

LAYER — управление слоями и их свойствами.

LAYERP — отмена последних изменений состояния и свойств слоев.

LAYERPMODE — включение и отключение режима записи последовательности из-
менений свойств слоев.

Л

LAYOUT — создание и модификация листов в рисунке.

LAYOUTWIZARD — вызов Мастера компоновки листа для настройки параметров
компоновки и печати нового листа.

LAYTRANS — изменение системы слоев рисунка в соответствии с установленными
пользователем стандартами.

LEADER — построение линии-выноски, соединяющей пояснительные надписи
с поясняемыми элементами.

LENGTHEN — увеличение длин объектов и центральных углов дуг.

LIGHT — управление источниками света и световыми эффектами для фотореали-
стичной визуализации.

LIMITS — указание пределов границ рисунка и лимитов сетки, отображаемой
в пространстве модели или на текущем листе рисунка.

LINE — построение отрезков.

LINETYPE — создание, загрузка и установка типов линий.

LIST — получение информации о выбранных объектах из базы данных рисунка.

LOAD — загрузка файла с описанием форм, определенных пользователем, для
вставки в рисунок командой SHAPE.
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LOGFILEOFF — закрытие файла журнала, открытого командой LOGFILEON.

LOGFILEON — включение записи содержимого текстового окна в файл.

LSEDIT — редактирование объектов ландшафта.

LSLIB — управление библиотеками объектов ландшафта.

LSNEW — вставка в рисунки реалистичных элементов ландшафта (изображений
деревьев, кустов и т. п.).

LTSCALE — определение глобального масштаба типов линий.

LWEIGHT — установка текущего веса линий, параметров отображения линий в за-
висимости от их веса и единиц веса линий.

М

MASS PROP — вычисление масс-инерционных характеристик областей и тел.

, MATCHPROP — копирование свойств объекта в другие объекты.

MATLIB — импорт материалов из библиотек и экспорт их в библиотеки.

MEASURE — размещение объектов-точек или блоков на объекте с заданными ин-
тервалами.

MENU — загрузка файла меню.

MENULOAD — загрузка фрагментов меню.

MENUUNLOAD — выгрузка фрагментов меню.

MINSERT — множественная вставка блоков с расположением их в узлах прямо-
угольного массива.

MIRROR — зеркальное отображение объекта.

MIRROR3D — зеркальное отображение трехмерных объектов относительно задан-
ной плоскости.

MLEDIT — редактирование мультилиний.

MLINE — построение мультилиний.

MLSTYLE — описание стилей мультилиний.

MODEL — переключение из пространства листа в видовой экран пространства мо-
дели.

MOVE — перемещение объектов на заданное расстояние в указанном направлении.

MREDO — отмена действия команды UNDO. Допускается многократное повторение
этой операции.
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MSLIDE — создание файла слайда из текущего видового экрана пространства мо-
дели или текущего листа.

MS РАСЕ — установка текущим пространства модели в видовом экране.

МТЕХТ — создание многострочных текстовых надписей.

MULTIPLE — многократное повторение следующей команды.

MVIEW — создание видовых экранов на листах и управление ими.

MVSETUP — настройка параметров рисунка.

N

NEW — создание файла рисунка.

О

OFFSET — построение эквидистанты, то есть концентрических окружностей, па-
раллельных отрезков или кривых, подобных существующим.

OLELINKS — обновление, изменение и разрыв имеющихся OLE-связей.

OLESCALE — настройка размера, масштаба и других свойств выбранного OLE-
объекта.

OOPS — восстановление объектов, стертых командой ERASE.

OPEN — открытие существующего файла рисунка.

OPTIONS — настройка параметров рабочей среды AutoCAD.

ORTHO — включение режима рисования только параллельно осям координат.

OSNAP — установка текущих режимов объектной привязки.

Р

PAGESETUP — указание устройства печати, формата бумаги и других параметров
для листов.

PAN — перемещение изображения на текущем видовом экране.

PARTIALOAD — дополнительная загрузка геометрии в частично открытый рисунок.

PART IALO PEN — частичное открытие рисунка путем его загрузки в текущий ри-
сунок геометрии с выбранного вида или слоя.

PASTEBLOCK — вставка скопированных ранее объектов в виде блока.

PASTECLIР — вставка в активный рисунок содержимого буфера обмена Windows.

PASTEORIG — вставка скопированного блока в новый рисунок с координатами,
которые этот блок имел в исходном рисунке.
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PASTESPEC — вставка данных из буфера обмена Windows, при которой обеспечи-
вается управление их форматом.

PCINWIZARD — вызов Мастера импорта параметров печати из .рср и .рс2 файлов
для закладки Model или текущего листа.

PEDIT — редактирование полилиний и трехмерных полигональных сетей.

PFACE — создание многогранной сети произвольной сложности.

PLAN — установка вида в плане (сверху) относительно заданной ПСК.

PLINE — построение двумерных полилиний.
/;

PLOT — вывод рисунка на плоттер, принтер или в файл.

PLOTSTAMP — нанесение штемпеля в определенном углу каждого чертежа и запись
соответствующей информации в файл журнала.

PLOTSTYLE — установка стиля печати для новых или выбранных объектов.

PLOTTERMANAGER — вызов диалогового окна Plotter Manager, с помощью которого
можно настроить новый плоттер или изменить его конфигурацию.

PNGOUT — сохранение выбранных объектов в файле формата .png (Portable Network
Graphics).

POINT — создание объекта-точки.

POLYGON — построение равносторонних многоугольников в виде замкнутых поли-
линий.

PREVIEW — предварительный просмотр рисунка на экране перед выводом на пе-
чать.

PROPERTIES — управление свойствами объектов.
.

PROPERTIESCLOSE — закрытие палитры свойств объектов.

PSETUPIN — импорт набора параметров листа из другого файла рисунка во вновь
создаваемый лист.

PSPACE — переключение видовых экранов из пространства модели в пространство
листа.

PUBLISH — создание многолистовых наборов рисунков для вывода в многолисто-
вой файл формата DWF (Design Web Format), на устройство печати или в файл
чертежа.

PUBLISHTOWEB — создание HTML-страниц с изображениями выбранных рисунков.

PURGE — очистка рисунка от неиспользуемых именованных объектов (например,
блоков, слоев и т. п.).
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Q
QDIM — быстрое нанесение размера.

QLEADER — быстрое построение выноски и пояснения для нее.

QNEW — создание нового рисунка с использованием шаблона по умолчанию.

QSAVE — быстрое сохранение текущего рисунка.

QSELECT — быстрое создание наборов объектов на основе определенного крите-
рия выбора.

QTEXT — управление показом на экране и выводом на плоттер текста и атрибутов.

QUIT — завершение работы с AutoCAD.

R

RAY — построение лучей, то есть линий, бесконечных в одном направлении.
i •

RECOVER — восстановление поврежденного рисунка.

RECTANG — построение полилинии в виде прямоугольника.

REDEFINE — восстановление внутренних команд AutoCAD, подавленных коман-
дой UNDEFINE.

REDO — отмена действия последней команды UNDO или U.

REDRAW — перерисовка содержимого текущего видового экрана.

REDRAWALL — перерисовка содержимого всех видовых экранов.

REFCLOSE — сохранение или отказ от изменений, произведенных в ходе редакти-
рования блоков или внешних ссылок.

REFEDIT — выбор вхождения блока или ссылки для редактирования.

REFSET — добавление и исключение объектов из рабочего набора при редактиро-
вании блоков и внешних ссылок.

REGEN — регенерация рисунка и перерисовка содержимого текущего видового эк-
рана.

REGENALL — регенерация рисунка и перерисовка всех видовых экранов.

REGENAUTO — управление автоматической регенерацией рисунка.

REGION — преобразование объектов, ограничивающих некоторую площадь,
в области.

REINIT — повторная инициализация портов ввода-вывода, дигитайзера, монито-
ра и файла параметров программ.
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RENAME — изменение имен объектов.

RENDER — создание реалистичного тонированного изображения трехмерной кар-
касной или твердотельной модели.

RENDS CR — повторный вывод на экран последнего изображения, созданного ко-
мандой RENDER..

REPLAY — просмотр растровых изображений в форматах .bmp, .tga и .tif.

RESUME — возобновление прерванного процесса выполнения пакета (макроса).

REVCLOUD — создание полилиний с дуговыми сегментами, используемых в каче-
стве «облаков» для пометок.

REVOLVE — создание тела путем вращения двумерных объектов вокруг оси.

REVSURF — создание поверхности вращения вокруг выбранной оси.

RMAT — управление материалами для тонирования трехмерной модели.

RMLIN — вставка в рисунок электронных пометок из RML-файлов.

ROTATE — поворот объектов вокруг заданной точки.

ROTATE 3D — поворот объектов вокруг оси в трехмерном пространстве.
i •

RPREF — настройка режимов тонирования трехмерной модели.

RSCRIPT — повторное выполнение пакетного файла.

RULESURF — создание трехмерной поверхности, натянутой на две кривые.

S

SAVE — сохранение рисунка под текущим или заданным именем.

SAVEAS — сохранение рисунков, которым еще не было присвоено имя, или пере-
именование текущего рисунка.

SAVEIMG — сохранение тонированных изображений в файлах.

SCALE — масштабирование объектов — пропорциональное изменение размеров
объектов в направлениях X,YnZ.

SCALETEXT — изменение точки выравнивания для выбранных текстовых объек-
тов без изменения их положения.

SCENE — управление сценами в пространстве модели.

SCRIPT — выполнение последовательности команд из пакетного (командного)
файла (макроса).

SECTION — создание областей (сечений) в результате пересечения плоскостей и тел.
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SECURITYOPTIONS — управление настройками режимов безопасности.

SELECT — занесение выбранных объектов в текущий набор.

/SETIDROPHANDLER — выбор типа содержимого, вставляемого в текущее приложе-
ние Autodesk из точек загрузки.

SETUV — наложение текстур на поверхности трехмерных объектов.

SETVAR — получение списка системных переменных, изменение их значений.

SHADEMODE — управление способом раскрашивания твердотельных объектов на
текущем видовом экране.

SHAPE — вставка формы.

SHELL — доступ к командам операционной системы.

SHOWMAT — получение списка типов материалов и методов их присвоения выбран-
ным объектам.

SIGVALIDATE — вывод информации о цифровой подписи для файла.

SKETCH — выполнение контурных эскизов «от руки».

SLICE — формирование разреза трехмерного объекта.

SNAP — ограничение перемещения указателя мыши определенными интервалами
в режиме шаговой привязки.

SOLDRAW — построение профилей и сечений на видовых экранах, созданных ко-
мандой SOLVIEW.

SOLID — создание закрашенных или контурных многоугольников.

'SOLIDEDIT — редактирование граней и ребер трехмерных тел.

SOLPROF — создание профилей трехмерных тел. ,

SOLVIEW — создание плавающих видовых экранов, использующих ортогональную
проекцию для размещения многовидовых рисунков и сечений твердотельных
объектов и ACIS-тел.

SPACETRANS — преобразование расстояний между единицами пространства моде-
ли и пространства листа.

SPELL — орфографическая проверка надписей в рисунке.

SPHERE — построение трехмерного твердотельного шара.

SPLINE — создание неоднородных рациональных В-сплайнов (NURBS).

SPLINEDIT — редактирование сплайнов или сглаженных сплайнами полилиний.
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STANDARDS — управление подключением файлов стандартов к рисункам AutoCAD.

STATS — показ на экране статистических данных по тонированию.

STATUS — вывод на экран статистической информации о рисунке, режимах и гра-
ницах.

STLOUT — сохранение тел в двоичном или ASCII-файле.

STRETCH — растягивание объектов путем перемещения одной из его частей без
разрыва объектов.

STYLE — создание и изменение текстовых стилей, а также установка текущего тек-
стового стиля.

STYLESMANAGER — вызов Диспетчера стилей печати Plot Style Manager.

SUBTRACT — создание составной области или тела путем булевой операции вычи-
тания.

SYSWINDOWS — упорядочение значков окон открытых рисунков.
\ ' ,.

Т

TABLET — настройка и калибровка планшета.

TABSURF — создание поверхности сдвига по определяющей кривой и вектору на-
правления.

TEXT — создание однострочных текстовых надписей.

TEXTSCR — открытие текстового окна AutoCAD.

TIFOUT — сохранение выбранных объектов в файле формата .tif.

TIME — получение сведений о дате, времени и общей продолжительности работы
над созданием и изменением рисунка.

TOLERANCE — нанесение условных обозначений допусков формы и расположения
поверхностей на чертеже.

TOOLBAR — включение, отключение и адаптация панелей инструментов.

TOOLPALETTES — открытие окна инструментальных палитр.

TOOLPALETTESCLOSE — закрытие окна инструментальных палитр.

TORUS — построение трехмерного твердотельного тора.
/

TRACE — построение линейных закрашенных сегментов заданной ширины.

TRANSPARENCY — управление прозрачностью фоновых пикселов растровых изоб-
ражений.
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TRAYSETTINGS — управление показом значков и уведомлений в строке состояния.

TREESTAT — получение информации 6 пространственных индексах рисунка.

TRIM — обрезка объекта по кромке, заданной другими объектами.

U

U — отмена действия последней выполненной команды.

UCS — управление пользовательскими системами координат.

UCSICON — управление видимостью и расположением пиктограммы ПСК.

UCSMAN — управление пользовательскими системами координат, открытие диало-
гового окна DCS.

UNDEFINE — подавление внутренней команды AutoCAD одноименной командой,
определенной в приложении.

UNDO — последовательная отмена команд текущего сеанса.

UNION — создание составной области или тела путем булевой операции объединения.

UNITS — управление форматом и точностью представления линейных и угловых
единиц измерения.

V

VBAIDE — вызов редактора V i s u a l Basic.

VBALOAD — глобальная загрузка проекта VBA в текущий сеанс AutoCAD.

VBAMAN — загрузка, выгрузка, сохранение, создание, внедрение и извлечение про-
ектов VBA.

VBARUN — запуск VBA-макроса.

VBASTMT — выполнение команды VBA-приложения в командной строке AutoCAD.

VBAUNLOAD — глобальная выгрузка проекта VBA.

VIEW — сохранение и восстановление именованных видов.

VIEWRES — указание точности аппроксимации объектов на текущем видовом эк-
ране.

, • • • -

VLISP — вызов интегрированной среды разработки приложений Visual LISP.

VPCLIP — подрезка объектов на видовых экранах.

VPLAYER — управление видимостью слоев для отдельных видовых экранов.

VPOINT — установка в пространстве направления взгляда на трехмерный объект.
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VPORTS — деление области рисования на несколько неперекрывающихся или пла-
вающих видовых экранов.

VSLIDE — просмотр файла-слайда на текущем видовом экране.

W
WBLOCK — запись набора объектов или блока в отдельный файл.

WEDGE — построение трехмерного клиновидного тела с наклонной гранью, при-
ближающейся к оси X.

WHOHAS — выдача информации о том, кем открыт указанный файл рисунка.

WIPEOUT — скрытие существующих объектов рисунка за маскирующим объектом
цвета фона.

WMFIN — импорт графической информации в формате метафайла Windows.

WMFOPTS — настройка параметров команды WMFIN.

WMFOUT — экспорт объектов в файл формата .wmf (Windows metafile).

X

ХАТТАСН — вставка внешних ссылок в текущий рисунок.

XBIND — внедрение именованных объектов, определенных во внешней ссылке,
в текущий рисунок.

XCLIP — присвоение контура подрезки внешней ссылке или блоку и установка
передней и задней плоскостей обрезки.

XLINE — построение бесконечных прямых линий.

XOPEN — открытие выбранной внешней ссылки в новом окне.

XPLODE — разбиение составного объекта на составляющие объекты.

XREF — управление внешними ссылками.
i

ZOOM — увеличение или уменьшение видимого размера объектов на текущем ви-
довом экране.
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